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Chapter 1    Introduction

Information in This Guide
This guide contains reference information and instructions relevant for the
configuration of specific photon and electron dose calculation, optimization and
other algorithms used in the Eclipse treatment planning system. Instructions for
using Beam Configuration to configure the algorithms: Beam Configuration Reference
Guide.

Note: For information on the Pencil Beam Convolution (PBC) and Generalized Gaussian
Pencil Beam (GGPB) algorithms, refer to the Eclipse user documentation for version 11.0 or
version 10.0.

Who Should Read This Guide
This guide is written mainly for physicists or any other users responsible for
commissioning, configuring and validating beam data.

The Eclipse Treatment Planning System (Eclipse TPS) is used to plan radiotherapy
treatments for patients with malignant or benign diseases. Eclipse TPS is used to plan
external beam irradiation with photon, electron and proton beams, as well as for
internal irradiation (brachytherapy) treatments. In addition, the Eclipse Proton Eye
algorithm is specifically indicated for planning proton treatment of neoplasms of the
eye.

Eclipse should only be used by qualified medical professionals.

Note: Ensure that individuals authorized to perform treatment planning functions are
appropriately trained for the functions they perform.

Note: All treatment plan reports shall be approved by a qualified person before the information
in them is used for radiotherapy treatment purposes.

WARNING: It is the responsibility of the user to ensure the validity and integrity of the
input data, and to understand that the quality of the output depends critically on the
quality of the input. Any irregularities or uncertainties about input data, units,
identification, or quality of any other nature shall be thoroughly investigated before the
data are used.
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WARNING: Acceptance tests done during installation are not adequate measures for
clinical acceptance of the system. You need to separately commission each algorithm
and beam data with additional tests.

Visual Cues
This publication uses the following visual cues to help you find information:

WARNING: A warning describes actions or conditions that can result in serious injury or
death.

CAUTION: A caution describes hazardous actions or conditions that can result in minor or
moderate injury.

NOTICE: A notice describes actions or conditions that can result in damage to equipment
or loss of data.

Note: A note describes information that may pertain to only some conditions, readers, or sites.

Tip: A tip describes useful but optional information such as a shortcut, reminder, or suggestion,
to help get optimal performance from the equipment or software.

Related Publications
■ Eclipse Photon and Electron Reference Guide—Provides background information and

detailed instructions for creating external treatment plans.
■ Beam Configuration Reference Guide—Provides reference information and

procedures for beam data configuration required for performing dose calculation
for external treatment plans.
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What is New in Eclipse Algorithms
Eclipse algorithms contain the following changes. In addition to the items included
below, there are several minor enhancements:
■ The AAA dose calculation algorithm can now be used to calculate the dose

distribution for cobalt plans.
■ AAA and Acuros XB now support dose calculation of plans that contain Elekta

Agility MLC 160.
■ The new eMC version supports the configuration and the dose calculation for

Varian, Elekta (except Beam Modulator) and Siemens electron beams. For Siemens
machines, energies from 6 MeV to 20 MeV and for Elekta machines energies from
6 MeV to 18 MeV are supported. The new eMC version supports now 4 MeV up
to 22 MeV on Varian machines. Applicator air profiles can now be used as an
optional input for the eMC beam data configuration. If no applicator air profile
measurements are provided, the radially symmetric fluence from the open field
air profile is used during dose calculation. In case where the fluence within the
applicator opening is different from the open field air profile (for example on
Elekta and Siemens machines), it is recommended to include applicator air
profiles.

■ AAA and Acuros XB algorithms now support dose calculation of flat beams for
the Elekta machines (Synergy and Versa HD) equipped with Agility 160 MLC
collimator. In Beam Configuration, the machine model ‘Elekta Agility’ for Elekta
Synergy machine and ‘Elekta VersaHD’ for Elekta Versa HD machine are available
for configuring the algorithms. Both algorithms also support dose calculation of
flattening-filter free beams for the Elekta Versa HD machine.

Contacting Varian Customer Support
Varian Customer Support is available on the internet, by e-mail, and by telephone.
Support services are available without charge during the initial warranty period.

The my.varian.com website provides contact information, product documentation,
and other resources for all Varian products.

Get Online Customer Support
You can browse the my.varian.com site without having a Varian account or logging
in. However, you must have a Varian account to get online customer support and to
access product information for products at your institution or clinic.

1. Go to http://my.varian.com.
2. Click Contact Us at the top of the window to display customer support and

training options, and international e-mail addresses and telephone numbers.
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3. Choose an option:
■ If you do not already have an account, click Create New Account and follow

the instructions. Establishing an account may take a few days.
■ If you have an account, go to the next step.

4. Enter your user name and password.
5. Browse the information and then click the link that corresponds to what you

want to do:
■ Fill out and submit a support request.
■ Find documents. Online documents in PDF format include customer technical

bulletins (CTBs,) manuals, and customer release notes (CRNs).
■ Send an e-mail to Varian support. You can browse for international e-mail

addresses and telephone numbers by geographic area, and for oncology-
specific contacts such as for brachytherapy.

■ Find parts and services by geographical area.

E-Mailing Varian
Send e-mail inquiries through the my.varian.com website.

Alternatively, you can use a support e-mail address that corresponds to your location
or interest:

Location E-mail Address

North America support-americas@varian.com

Latin America soporte.al@varian.com

Europe support-emea@varian.com

Australia and New Zealand support-anz@varian.com

China support-china@varian.com

Japan support-japan@varian.com

South East Asia support-sea@varian.com

Brachytherapy Systems brachyhelp@varian.com

Ordering Documents by Phone
You can order documents by phone by calling Varian Medical Systems support.

Location Telephone Number

North America + 1 888 827 4265 (Press 2 for parts)

Global Call your local Varian office.
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Chapter 2    General About Eclipse Algorithms

Using Eclipse Configured Beam Data
Eclipse Beam Data, available only for the AAA and Acuros XB algorithms, is valid for
Varian Clinac 21/23EX Series medical linear accelerators and other Clinacs
conforming to the beam specifications detailed in Sections 1.0 and 2.0 of Clinac
21/23EX Equipment Specification (Document RAD 4205), the Clinac iX Accelerator
Specifications (Document RAD 9510), the Trilogy Accelerator Specifications
(Document RAD 9515), and Clinac Beam Matching (Document RAD 2055). These
include all Clinac iX accelerators, all Trilogy accelerators, Clinac 2100C/CD/EX
accelerators with Serial Number 865 or later and Clinac 2300CD/EX accelerators with
Serial Number 146 or later. For older machines that have been upgraded to EX
specifications, it is necessary to confirm that the part number of the 6-MV photon-
field-flattening filter is P/N 1103282.

Compare the dosimetric beam data acquired from the treatment machine at the site
to the dosimetric beam data used in the configuration of the preconfigured beam
data and ensure that the variations do not exceed user tolerance. If variations exceed
the tolerance, use the dosimetric beam data acquired at the site for calculation
algorithm configuration.

Eclipse Algorithms and CT Image Data
The CT image data is handled differently in different Eclipse dose calculation
algorithms. The HU values in the image are converted either to electron density, mass
density or proton stopping power depending on the type of plan and algorithm used.
The conversion is done following CT calibration curves configured in Beam
Configuration. Multiple CT scanners can be configured in the system and each CT
scanner has its own set of calibration curves.

For each CT scanner the following curves are available:
■ Electron Density: This curve is used by the AAA and MRDC algorithms to

convert HU values to relative electron density.
■ Mass Density: This curve is used by the Acuros XB and eMC algorithms to

convert HU values to mass density. From the derived mass density, Acuros XB
and eMC determine the material composition of voxels in the image. More
information on the mass density to material conversion method employed by
Acuros XB: CT to Material Mapping on page 122. More information on the mass
density to material conversion method employed by eMC: Preprocessing the CT
Volume on page 154.
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■ Proton Stopping Power: This curve is used by the PCS algorithm to convert HU
values to Proton Stopping Power (relative to water). More information: Proton
Algorithm Reference Guide.

To achieve accurate dose calculations, it is essential to define a valid CT calibration
curve for each CT scanner in Beam Configuration. For each CT image imported into
the system, the CT scanner name in the image header is compared with CT scanners
stored in the database. If a match is found, the custom CT calibration curve is used
for all dose calculations. If a matching CT scanner is not found, you need to manually
define the CT scanner to use for the image series. All used CT calibration curves must
be approved. Instructions on approving a CT calibration curve: Beam Configuration
Reference Guide.

Calibration curves are defined up to a certain maximum HU value. You can modify
these curves and extend their defined range of HU values. It is possible that HU
values found in CT images are higher than the maximum HU value for which the
calibration curves are defined. Instructions on modifying CT calibration curves: Beam
Configuration Reference Guide.

To verify that the CT calibration curve is correctly configured, take a CT image of the
calibration phantom, import it in the system and check that the values shown by the
Physical Property tool are correct. (Information on the Physical Property tool: Eclipse
Photon and Electron Reference Guide.)

The table describes how the Eclipse algorithms handle HU values that fall outside the
range covered by the CT calibration curves.

Table 1 Eclipse Algorithms and CT Image Data

Algorithm How CT Image Data is Handled

AAA The AAA algorithm truncates all HU values higher than the max-
imum HU value defined in the CT calibration curve to the max-
imum electron density value. A warning is shown in the DCF status
window and logged in the field calculation notes when such a situa-
tion occurs. Additionally, the maximum electron density modeled in
AAA is 15. Electron densities larger than that are truncated to the
maximum value (that is, the value 15 is used).
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Algorithm How CT Image Data is Handled

Acuros XB The Acuros XB algorithm stops the calculation if an HU value in the
CT image is higher than or equal to the maximum HU value defined
in the CT calibration curve. The volume spanned by CT image
pixels whose mass density (derived either from the HU value in the
image or assigned to a structure) exceeds the maximum mass den-
sity of the materials used in automatic conversion (3.0 g/cm3) is cal-
culated. If this volume is higher than a user defined maximum
volume for automatic material assignment to high density artifacts,
the calculation is prevented until a material is assigned via a struc-
ture. For smaller volumes, automatic conversion to a user defined
material takes place. This is to prevent incorrect material assign-
ment to a significant volume of a high density material.

MRDC The MRDC algorithm truncates all HU values higher than the max-
imum HU value defined in the CT calibration curve to the max-
imum electron density value. MRDC does not give any warning
message if truncation is done. In addition, for speed and memory
reasons, electron density values are binned so that for each calcula-
tion voxel the MRDC uses a density value averaged over a small
subvolume, typically 4x4x4 voxels.

eMC The eMC algorithm truncates all HU values higher than the max-
imum HU value defined in the CT calibration curve to the max-
imum mass density value. A warning is shown in the DCF status
window and logged in the field calculation notes when such a situa-
tion occurs.

Accuracy of Eclipse Dose Calculation Algorithms
The following information is provided as a reference indicating the methods used to
evaluate Eclipse algorithm accuracy. The information is provided as an example,
more comprehensive set of data is needed for testing the accuracy for clinical use.

Accuracy of the dose calculation algorithms is evaluated by comparing measured
data against the calculation results obtained in the same field geometry and the same
MU values. Accuracy evaluation measurements and the beam data that is used for
configuring dose calculation algorithms must be obtained from the same machine so
that between the measurements machine sustains the same calibration and identical
beam properties.
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Algorithms’ accuracy is quantified in terms of gamma error. Gamma error is defined
as the shortest distance in four dimensional space where the relative dose represents
the fourth dimension. For gamma metric, the unit of the distance and the dose are
rescaled: dose is in units of a percent of the maximum dose, and the distance in units
of given number of mm. For example, with gamma scale 3% and 3 mm, gamma error
smaller than 1 guarantees that at that point dose difference is no more than 3%, or the
distance to agreement no more than 3 mm. Dose calculation accuracy goal defined by
the gamma error scale is considered to be fulfilled when gamma error value for 95%
of the examined measurement points is no more than 1.

The accuracy goal is evaluated separately for two regions (sets of measurement
points): the high dose region consists of measurement points with higher dose than
20% of the maximum measured dose. The global region consists of measurement
points higher than 3% of the maximum dose in our example case. It is further
required that the gamma error in this example exceeds the value 1.67.

In the following, dose comparison examples are shown for depth dose curves
measured for static fields with SSD = 100 cm. The table below summarizes the field
geometries and gamma error scales stating the algorithms’ accuracy in these
conditions. Comparison results are shown in the figures below, source of the
measured data is indicated before each figure.

Table 2 Accuracy of Eclipse Dose Calculation Algorithms

Algo-
rithm

Field setup Gamma error scale Figure

AAA Open field,
10 cm× 10 cm,
SSD = 100 cm

2%, 2 mm Figure 1 on
page 20

Acuro
s XB

Open field,
10 cm × 10 cm,
SSD = 100 cm

2%, 2 mm Figure 2 on
page 20

CDC 20 mm conical
collimator,
SSD = 100 cm

2%, 1 mm Figure 3 on
page 21

eMC Applicator field,
10 cm × 10 cm,
SSD = 100 cm

2%, 2 mm1 Figure 4 on
page 21

1. Note that typically the eMC accuracy is 3%. More information: Known Limitations of the eMC Algorithm
on page 170.

Dose is calculated with AAA using calculation resolution 0.25 cm. Depth dose curve
is measured on Elekta SL18 in water phantom with ionization chamber IC15.
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Figure 1 Depth dose curve comparison for AAA

Dose is calculated with Acuros XB using calculation resolution 0.25 cm. Depth dose
curve is measured on Elekta SL18 in water phantom with ionization chamber IC15.

Figure 2 Depth dose curve comparison for Acuros XB

Dose is calculated with CDC using calculation resolution 0.1 cm and fine grid setting.
Depth dose curve is measured on Varian TrueBeam in water phantom with SRS
Diode and ionization chamber CC01-IC.
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Figure 3 Depth dose curve comparison for CDC

Dose is calculated with eMC using the following calculation options: calculation
resolution 0.25 cm, statistical uncertainty 1, dose threshold for uncertainty 50, no
smoothing. Depth dose curve is measured on Varian TrueBeam in water phantom
with ionization chamber IC15.

Figure 4 Depth dose curve comparison for eMC
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Chapter 3    Implementation of AAA and Acuros XB
in Eclipse

About Implementation of AAA and Acuros XB in Eclipse
The AAA and Acuros XB dose calculation algorithms are separately licensed features
in Eclipse. The photon beam source model, used by AAA and Acuros XB, is
configured in Beam Configuration. The resolution of the dose calculation grid can be
selected in the range of 1–5 mm for AAA and 1–3 mm for Acuros XB during
treatment planning in Eclipse External Beam Planning.

The dose calculation in External Beam Planning with the AAA and Acuros XB fully
supports the use of beam modifiers, such as blocks, hard wedges, dynamic wedges,
compensators, MLCs and Intensity Modulated Radiation Therapy (IMRT) with
Dynamic MLC (DMLC). The algorithms also support calculation of VMAT fields
(Volumetric Modulated Arc Therapy), and account for patient support devices (for
example couch structures) and bolus linked to a field in the dose calculation. Dose
inside a bolus is visualized, but dose inside support structures is not visualized. The
AAA and Acuros XB process all pixels outside the body, including those in
contoured structures, as air, except for bolus and patient support devices.

The dose calculation in IRREG Planning with AAA supports the use of open fields,
fields with blocks, fields with static MLC, fields with hard wedges and fields with
dynamic wedges (Elekta Motorized Wedges and Elekta OmniWedges are not
supported). Acuros XB cannot be used in IRREG Planning. In IRREG, AAA calculates
the dose at a given point based on SSD and depth information. The result
corresponds to a water phantom measurement at that point with the field
perpendicular to the phantom surface which is assumed to be flat. In the case of
several fields, the contribution of each field to a given point is calculated
independently and added to the total dose at that point. In the case of several points,
this is repeated for each point.

AAA dose calculation supports the use of cobalt treatment units in External Beam
Planning and IRREG Planning. It allows the configuration of blocks, wedges and
compensators for cobalt machines.

Information on how to select a calculation model for dose calculation in Eclipse:
Eclipse Photon and Electron Reference Guide. Information on configuring the source
model: Configuration of Photon Beams on page 45. Information on using Beam
Configuration: RT and Imaging Online Help or Beam Configuration Reference Guide.
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Monitor Unit Calculation
The calculation of MU is based on output factor measurements performed for
different field sizes in a certain reference geometry (more information: Output Factor
Geometry on page 84), and calibration calculations made for the reference field size.

The change in the output factor as a function of field size is caused by changes in
phantom scatter, head scatter and collimator backscatter into the monitor chamber.
The phantom and head scatter effects are accounted for by the photon beam source
model and the volumetric dose calculation algorithm (AAA or Acuros XB). The
remaining change in the output factors is assumed to be caused by collimator
backscatter. It is estimated from the measured output factor table as shown in the
equation.

Equation 1

 
CBSF X, Y = OFref

OF X, Y × D′ X, Y
D′ref

 

where   

X,Y = Collimator settings (X = X2-X1, Y = Y2-Y1)

CBSF(X,Y) = Collimator backscatter factor for an open field with same collimator set-
tings.

OFref = Output factor table value for reference field size. The value is normally 1.0.
The reference field size is given by the parameter Absolute dose reference
field size, defined in the AAA and Acuros XB Parameters (more informa-
tion: Table 12 on page 59).

OF(X,Y) = Output factor table value for field size X,Y.

D’(X,Y) = Dose at the reference point calculated by the AAA or Acuros XB for the
field size X,Y and the reference geometry when ignoring the effect of colli-
mator back scatter.

D’ref = Dose calculated by the AAA or Acuros XB for the reference conditions in
the reference geometry (more information: Output Factor Geometry on
page 84) when ignoring the effect of collimator back scatter.

The reference field geometry used in the measurement of the output factor table is
indicated by the Source-Phantom Distance parameter defined in the output factor
table in Beam Configuration (more information: Table 5 on page 48). The reference
point depth from the surface of the phantom is given by the Detector depth from
phantom surface parameter, also defined in the output factor table.

Chapter 3    Implementation of AAA and Acuros XB in Eclipse 23



The final MU are calculated from the prescribed dose, plan normalization, field
weight, field normalization and a normalization factor determined by the dose
calculation algorithm. The normalization factor determined by the AAA and
Acuros XB is the MU value for 1 Gy to 100% of the current field. AAA and Acuros XB
calculate the monitor units at the normalization point MUnorm for open field, hard
wedge, Enhanced Dynamic Wedges and physical compensators as in the equation:

Equation 2

 
MUnorm = CBSF X, Y × MUcalib

Dcalib
× Dref

Dnorm X, Y
× 1

WCF X, Y

 

where   

CBSF(X,Y) = Collimator backscatter factor for an open field with same collimator set-
tings (more information: Equation 1 on page 23).

In case of treatment units where MLC defines the field size (for example
Elekta), the collimator backscatter factor is calculated based on the effec-
tive field size in X and Y direction instead of the collimator jaw settings (X,
Y).

MUcalib = User-defined value of parameter Reference Dose In MU at Calibration
Depth. (For hard wedges, this parameter is read from the wedge parame-
ters. More information: Hard Wedge Parameters on page 65.)

Dcalib = User-defined value of parameter Reference Dose In Gy at Calibration
Depth. (For hard wedges, this parameter is read from the wedge parame-
ters. More information: Hard Wedge Parameters on page 65.)

Dref = Dose calculated by the AAA or Acuros XB for the reference conditions
(more information: Output Factor Geometry on page 84) at the calibra-
tion depth, which is the value of the Absolute Dose Scaling Factor param-
eter. (For hard wedges, this parameter is read from the wedge parame-
ters.)

Dnorm(X,Y) = Dose calculated by the AAA or Acuros XB at the field normalization
point, based on the selected field normalization method.

WCF(X,Y) = Wedge correction factor for hard wedge field with the collimator jaw set-
tings (X,Y).

In case the field contains a block or an MLC, the wedge correction factor is
calculated based on the effective field size in X and Y direction instead of
the collimator jaw settings (X, Y).
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Reference dose calculation is similar to MU calculation. AAA and Acuros XB
calculate a reference dose factor as in the following equation. The reference dose
(Ref. D) shown in the Info Window is calculated from this reference dose factor by
taking into account the prescribed dose, plan normalization, field weight, field
normalization and a normalization factor determined by the dose calculation
algorithm. Note that the reference dose is not calculated if the central axis is outside
the field aperture, or at the boundary of field aperture, or if the central axis is blocked
by an MLC or block. It is also not calculated for an arc field or when the plan dose
calculation mode is used for Acuros XB.

Equation 3

 

Ref_dose =
Ddmax
Dnorm

 

where   

Ddmax
= Maximum dose along the central axis

In the case of an IMRT field, the LMC calculates the field MU. For this, the LMC
needs from the AAA or Acuros XB the MUGY10 parameter and the collimator
backscatter factor for an open field. Information on the LMC and MU calculation for
IMRT fields: MU Calculation in the LMC on page 245. Information on how the
collimator backscatter factor is defined in the AAA: Equation 1 on page 23.

Normalization
The normalization modes used in the AAA and Acuros XB for volumetric dose
calculation can be selected in Beam Configuration in the Calculation Options of the
calculation model. The selected field normalization mode is used for all fields, with a
few exceptions. If the result of using the selected normalization mode will be
unacceptable, or if the mode cannot be used for a field, another field normalization
type is automatically selected for that field.

The table describes the field normalization modes available, and the cases where the
selection is automatically changed.

Table 3 Field Normalization Methods in AAA and Acuros XB

Norm. Mode Meaning Exceptions

No field normali-
zation

Field dose is normal-
ized to 100% at 1Gy/
100MU.

IMRT field: Normalization method is automati-
cally changed to IMRT field normalization.
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Norm. Mode Meaning Exceptions

100% to isocenter Field dose is normal-
ized to 100% at the iso-
center.

Isocenter in air / isocenter covered by block / low
dose* at isocenter:

Static fields: The dose is normalized to a point
on the isocenter plane that has the highest dose.
If the dose at that point is low, the normalization
method is changed to 100% to field central axis
Dmax.

Standard arc fields / conformal arc fields: The
normalization method is changed to “100% to
field Dmax”.

*Dose at isocenter is considered low if it is lower
than 10% of the maximum field dose. For fields
that are not components of Elekta Motorized
Wedge or Elekta OmniWedge, the dose is also
considered low if it is lower than 50% of the
maximum dose on the isocenter plane.

Fixed SSD field: Normalization method is
changed to 100% to field central axis Dmax.

IMRT field: Normalization method is automati-
cally changed to IMRT field normalization.

VMAT field and AAA or Acuros XB: Normaliza-
tion method is automatically changed to No field
normalization.

Acuros XB and plan dose calculation (non-IMRT
fields): Normalization method is automatically
changed to No field normalization.

100% to field cen-
tral axis Dmax

Field dose is normal-
ized to 100% at the
dose maximum along
the CAX.

Entire CAX in air / CAX covered by a block / low
dose** along the CAX: Normalization method is
changed to 100% to field Dmax.

** Dose lower than 10% of the maximum field
dose.

IMRT field: Normalization method is automati-
cally changed to IMRT field normalization.

Arc fields and AAA or Acuros XB: Normaliza-
tion method is automatically changed to No field
normalization.

Acuros XB and plan dose calculation: Normali-
zation method is automatically changed to No
field normalization.
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Norm. Mode Meaning Exceptions

100% to field
Dmax

Field dose is normal-
ized to 100% at the
field dose maximum.

IMRT field: Normalization method is automati-
cally changed to IMRT field normalization.

Arc fields and AAA or Acuros XB: Normaliza-
tion method is automatically changed to No field
normalization.

Acuros XB and plan dose calculation: Normali-
zation method is automatically changed to No
field normalization.

IMRT field nor-
malization

For IMRT fields, Mon-
itor Unit calculation is
performed by the Leaf
Motion Calculator
(LMC). The AAA nor-
malizes the field dose
to be compatible with
the MU calculated by
the LMC. More infor-
mation on MU calcula-
tion for IMRT fields: 
MU Calculation in the
LMC on page 245.

This normalization method cannot be selected in
Beam Configuration. It is automatically selected
by the AAA and Acuros XB algorithms for IMRT
fields.

Acuros XB and plan dose calculation: Normali-
zation method is automatically changed to No
field normalization.

The figure describes how the user-selected field normalization mode 100% to
isocenter is changed by the AAA and Acuros XB if the mode is not applicable to the
field.
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Figure 5 Selection of Field Normalization in AAA and Acuros XB

Calculation Options
The following calculation options can be configured for AAA and Acuros XB:
■ Calculation grid
■ Heterogeneity correction
■ Field normalization
■ Angular resolution in conformal arc and VMAT calculations
■ Dose reporting mode (Acuros XB only)
■ Plan dose calculation (Acuros XB only)
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■ Automatic high density material (Acuros XB only)
■ Maximum automatic high density volume in cm3 (Acuros XB only)

Default calculation options are defined in Beam Configuration. Angular resolution in
conformal arc and VMAT calculations is defined in DCF settings.

Calculation Grid
The calculation grid value for AAA can be any value between 1 and 5 mm, and for
Acuros XB any value between 1 and 3 mm. When using small grid sizes (smaller than
2 mm), the size of the dose matrices may lead to a shortage of computer memory
resources.

During dose calculation, AAA calculates the dose first into a divergent dose matrix.
The width of the divergent dose matrix depends on the jaw positions. An additional
margin is added in order to calculate also the low dose tail resulting from head
scatter and phantom scatter. This margin depends on the field size and the selected
calculation resolution. The default margin size is 12 cm. However, the margin is
reduced so that the number of calculation points at isocenter plane does not exceed
74000, that is:

FS_X + 2 × M × FS_Y + 2 × M
h × h ≤ 74000

where:   

FS_X = Field size in cm in X-direction.

FS_Y = Field size in cm in Y-direction.

M = Size of the additional margin in cm. The margin is always at least
7 cm.

h = Calculation grid size in cm.

Thus, for AAA the divergent dose matrix, as well as the input fluences (2D fluence
for primary source, 3D fluences for second source, electron contamination and wedge
scatter) extend 7-12 cm beyond the field edge at the isocenter plane. For Acuros XB,
the same margin is used as in AAA for the input fluences. However, as the dose
deposition is done in the Cartesian coordinate system covering the entire calculation
volume (as opposed to the divergent system for AAA), the phantom scatter may
extend further out in Acuros XB than in AAA, where the dose attains zero value
outside the margin.

Within each image plane, the resolution of the dose calculation corresponds to the
defined grid size. With AAA, the corner of one of the voxels in the dose matrix that is
sent back to Eclipse client after dose calculation is located in a point, whose DICOM
X and Y coordinates are the same as the DICOM X and Y coordinates of the isocenter
of the first field in the plan. If the isocenter is outside the calculation volume, this is
true for the dose grid mesh extended outside the calculation volume.
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With Acuros XB, if the pixel size of the image slices is, within 0.01 mm, the same as
the calculation grid size, or the calculation grid size divided or multiplied by an
integer, the dose matrix that is sent back to the Eclipse client is aligned with the
image, and the calculation grid size is automatically modified (by adding or
subtracting 0.01 mm or less) so that the exact match is obtained. That is, a dose voxel
boundary coincides with an image pixel boundary whenever possible. If this is not
possible, the center of one of the voxels in the dose matrix that is sent back to Eclipse
client after dose calculation is located in a point, whose DICOM X and Y coordinates
are the same as the DICOM X and Y coordinates of the isocenter of the first field in
the plan. If the isocenter is outside the calculation volume, this is true for the dose
grid mesh extended outside the calculation volume.

In the axis perpendicular to the image slices, AAA and Acuros XB adapt the grid
resolution to ensure that the dose is always calculated exactly on the image slices. If
the slice thickness is larger than the defined grid size, AAA and Acuros XB may
calculate the dose on dose planes between the image slices. If the slice spacing is
smaller than the defined grid size, AAA and Acuros XB may skip calculating the
dose on some slices. For image slice thickness IS, AAA and Acuros XB calculate IS/
n...IS/3, IS/2, IS, IS × 2, ΙS × 3...ΙS × n and sets the dose plane
spacing to the value closest to the defined grid size. For examples, see the figure.
Note that when the slice separation is larger than the defined grid size, AAA and
Acuros XB also produce an internal image with smaller slice separation. When the
slice thickness is divided by an even number according to the above procedure, one
of these extra slices will be located exactly in the middle between two original slices,
and therefore a possible sharp boundary in the original (phantom) image will be
“blurred” due to an extra slice with an intermediate density.
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Figure 6 Grid Size and Dose Matrix Resolution in AAA and Acuros XB

Heterogeneity Correction
Heterogeneity correction can be on or off:
■ On—Heterogeneity inside the Body is taken into account in the dose calculation.
■ Off—The whole Body is treated as water. However, bolus and support structures,

if any, use their specific CT values.

Field Normalization
More information: Normalization on page 25.

Angular Resolution in Conformal Arc and VMAT Calculations
This option specifies the angular resolution in degrees for arc field calculations. It
integrates the existing machine control points into beams placed along the arc at the
defined interval. For conformal arc and VMAT fields, OFF means that the beams used
to calculate the arc coincide to the machine control points. For standard arc fields,
OFF means that the angular resolution is 5 degrees.

This option is defined either in global or local DCF calculation settings (choose Tools
> Workstation Configuration > Settings for Distributed Calculation Framework,
and either global or local settings).
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Information on configuration of beam data: Beam Configuration Reference Guide.

Dose Reporting Mode
This option defines whether Acuros XB reports dose to medium or dose to water. The
Acuros XB transport calculation is identical regardless of the selected reporting
mode, only the post-processing step is different. In both cases, the energy dependent
fluence calculated by Acuros XB is multiplied by a response function to get the local
dose. For dose to water, the same response function (that of water) is used
everywhere. For dose to medium, the dose response of the material in the output
grid voxel is used. More information on dose to water and dose to medium: Fluence
to Dose Conversion on page 120.

Plan Dose Calculation
This option defines whether the plan dose is calculated. Plan dose calculation can be
on or off.

Plan dose calculation on - The total dose from all the fields in the plan is calculated
with one Acuros XB run. With this option, only one dose matrix per plan is obtained,
whereas the field dose matrices are not calculated.

Plan dose calculation off - The individual field doses are calculated in separate
Acuros XB runs. With this option, the field dose matrices are obtained in addition to
the plan dose matrix. This allows, for example, the modification of field weights
without the need to re-calculate the plan dose with Acuros XB.

If field doses are not needed, and a single machine is available to perform the dose
calculation, it is faster to calculate a plan with multiple fields with plan dose
calculation on. For RapidArc plans with multiple arcs, however, calculating with plan
dose calculation off may decrease calculation time when more than one computer is
available through the DCF. In such cases, each arc will be calculated on a separate
machine, enabling the parallelization of both the source model and the ray tracing of
the sources into the patient. Since both these components scale linearly with the
number of fields, they can become significant for RapidArc plans with multiple arcs.

Acuros XB plan dose calculation occurs only when:
■ the plan dose calculation option is set on, and
■ the plan has more than one field, and
■ all fields in the plan use the same treatment unit, particle type, energy and

primary fluence mode, and
■ none of the fields in the plan have either a motorized wedge or an OmniWedge,

and
■ dose calculation has not been requested for fixed reference point values (Calculate

Dose with Preset Values dialog), and
■ the plan is not a verification plan, and
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■ all fields in the plan are IMRT fields, or all fields in the plan are VMAT fields, or
there are no IMRT fields and no VMAT fields in the plan.

■ If there is a bolus in the plan, it must be assigned to all fields in the plan.

When plan dose calculation is on, the field normalization used will be no field
normalization. For IMRT fields, the normal IMRT normalization is used. As a
consequence, the field MU will be proportional to the field weights. Therefore,
calculating the same plan with plan dose calculation on and with plan dose
calculation off may result in different field MU and therefore different plan dose
distributions. When plan dose calculation is used, the desired MU are known in
advance, with the possible exception of an overall normalization factor. You can then
either calculate the volume with preset values and define the desired MU, or define
field weights proportional to the desired MU in the Info Window.

Automatic High Density Material
This option defines the material assigned automatically to high density pixels in the
image, for which no material has been manually assigned. The volume where the
automatic assignment of a high density material is made is limited by the calculation
option Maximum automatic high density volume in cm3. When the automatic
material assignment is made, the default density of each material is used. This option
can be changed in Beam Configuration.

Table 4 Automatic High Density Materials

Material ID Description

Bone Material name1 : Bone. Default density 1.85 g/cm3.

Muscle_Skeletal Material name: Muscle Skeletal. Default density 1.05 g/cm3.

Stainless_Steel Material name: Stainless Steel. Default density 8.00 g/cm3.

Ti6Al4V_ELC Material name: Titanium alloy. Default density 4.42 g/cm3.

1. Note that material IDs are always the same, but material names change depending on the localized lan-
guage.

High density pixels are pixels whose mass density (derived from the HU value in the
image) exceeds the maximum mass density of the materials used in automatic
conversion (3.0 g/cm3). List of materials for automatic CT to material conversion: CT
to Material Mapping on page 122.

Maximum automatic high density volume in cm3

This option defines the maximum volume where the automatic assignment of a high
density material can be made. This option can be changed in Beam Configuration.
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Dose Calculation for Siemens mARC
Dose for a Siemens mARC field is determined by calculating a static field at each
optimization point. The dose distribution is not calculated if one or more arclets span
more than 5 degrees. In that case, an error message is displayed.

The mARC arclets are delivered using one of the following three modes
automatically selected by the Control Console:
■ Burst/Single Speed Mode (preferred mode): The arclet is delivered using the same

gantry speed as the one used during the beam-off interval. This is only possible, if
the arclet MU are small enough to allow delivery within the arclet angle defined
by the treatment plan. If possible, the arclet is delivered using a smaller angle than
the arclet angle defined by the treatment plan.

■ Burst/Dual Speed Mode: If the arclet MU are too large to be delivered within the
nominal arclet size at the setup gantry speed, the gantry speed will be reduced
during the delivery of that arclet.

■ Hybrid Mode: Several arclets are statically delivered at a fixed gantry angle in the
same optimization point. The first arclet of an mARC treatment or treatment
resumption is always delivered at a fixed gantry angle.

In Burst modes, dose is deposited only during short arclets near the middle points
between each pair of control points that have non-zero meterset weight.

For mARC, flat as well as unflat photon energy modes with dose rates up to 2000
MU/min are available. Eclipse supports the following energy modes for mARC fields:
■ STANDARD mode: 6X, 10X, 15X, 18X
■ UF (unflat) mode: 7X, 11X, 14X, 17X

Dose Calculation for Cobalt Machines
AAA supports dose calculation for cobalt treatment units. For these machines, the
photon energy mode is 1X. Instead of monitor units, AAA returns a timer setting
(seconds or minutes, as determined for the machine in RT Administration). The
displayed timer setting is corrected for the radioactive decay of cobalt, and uses the
activity of the source at the time of calculation. Cobalt calibration date and half-life
must be set (more information: Table 15 on page 63). For each AAA dose
calculation, the calibration and calculation date are shown in the Dose Calculation
Log and printouts to allow for manual checks.

WARNING: Verify the dose calculation and dose display against manual calculations for
cobalt machines to ensure that the source decay used in the calculation corresponds to
the actual source decay.
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Chapter 4    Photon Beam Source Model

About the Photon Beam Source Model
The photon beam source model is used only by the AAA and Acuros XB dose
calculation algorithms. When configuring the Acuros XB, beam data configured for
AAA can be imported and reconfigured with the Acuros XB configuration program
and vice versa. Information on AAA: Chapter 5 Anisotropic Analytical Algorithm
(AAA) for Photons on page 95. Information on Acuros XB: Chapter 6 Acuros
External Beam Algorithm (Acuros XB) for Photons on page 106.

Clinical Beam Modeling of Photon Beams
An accurate parameterized model of the radiation output of medical linear
accelerators was developed by using previously published results from Monte Carlo
simulations of the treatment unit head. For each clinical beam, the parameters of the
model are modified to construct a customized phase-space specific to the clinical
beam to be modeled. The clinical beam is represented using a photon beam source
model, which has the following main components, or sources: primary photon
source, second photon source, electron contamination source, and photons scattered
from the hard wedge (wedge scatter source). The sources are characterized by a
number of parameters derived in the configuration of the source model. More
information: Configuration of Photon Beams on page 45.

The broad clinical beam is divided into finite-sized beamlets β, as illustrated in the
figure. Beamlet size is a function of the calculation grid size. Additionally, the
separate photon and electron components each have a different beamlet intensity.
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1. Beamlet β.
2. Calculation voxel grid.
3. Source.
4. Target.
5. Primary collimator.
6. Flattening filter.
7. Ionization chamber.
8. Jaws.
9. Blocks, MLC, DMLC (IMRT), dynamic wedges.

10. Hard wedge.
11. Patient.

Figure 7 Treatment Unit Components, Broad Beam Division
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Primary Source
In the photon beam source model, the primary source is a point source located at the
target plane. The physical effects of the finite size of the primary source are modeled
by the effective target spot size parameters (AAA and Acuros XB Parameters on
page 59). The source models the bremsstrahlung photons created in the target that
do not interact in the treatment unit head. The initial photon spectra after the target
on the beam central axis were simulated with BEAMnrc using realistic target
materials and thicknesses. Beam hardening in the flattening filter is modeled by
attenuating the initial spectrum by a radially varying amount of the flattening filter
material. Separate energy spectra for every fanline of the broad beam are derived
from the mean energy curve (Figure 9 on page 40). The non-uniform photon energy
fluence is modeled by a radially varying intensity profile curve (Figure 10 on
page 40).

Second Source
The second source is a Gaussian plane source located at the bottom plane of the
flattening filter. It models the photons that result from interactions in the accelerator
head outside the target (primarily in the flattening filter, primary collimators and
secondary jaws). As a result of the lower location of the second source, radiation
from the second source diverges more than radiation from the primary source; hence
the effect is most noticeable outside the beam defined by the primary source. The
second source modeling has been disabled for flattening filter free (FFF) beams, since
the most important source of scattered radiation is not present in the beamline. The
second source modeling has been disabled also for hard wedges, except for the
Elekta motorized wedge.

Electron Contamination
Electron contamination source describes the dose deposited in the build-up region
not accounted for by the primary and extra-focal photon components. Electron
contamination is also used to model photon contamination (photons created in
electron interactions). Electron contamination is modeled with a radiological depth
dependent curve that describes the total amount of electron contamination dose at a
certain radiological depth. The parameters for electron contamination for hard
wedges are configured in Beam Configuration.
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Photon Scatter from Wedge
Each point in the wedge acts as an auxiliary scatter source. The intensity of scatter
radiation from each point is assumed to be proportional to the amount of primary
radiation hitting that point. The scatter radiation is assumed to have a slightly
forward-directed directional distribution. This model is implemented with a dual
Gaussian model, where the width of the Gaussian kernel increases with the distance
from the wedge.

Phase Space Model
The beam is modeled using physics-based parameters. These parameters give a
description of the phase space of the particles comprising the treatment beam. A
model based on physics-based parameters enables accurate dose calculation in
conditions that are different from the measurement conditions, which is a different
approach from that of semi-empirical models. The model requires only minimal
technical information about the construction of the treatment unit head. The
parameters of the model can be easily and quickly adapted to an individual
accelerator.

For a specific beam with a static gantry angle, modulated by jaws and possibly a
static or dynamic MLC, the source model generates a phase space, which is sent to
the dose calculation algorithm. Physical jaws are assumed to have zero transmission,
except for Elekta virtual wedge calculation, for which jaw transmission needs to be
defined in Beam Configuration. The phase space consists of a primary source phase
space and one or more non-primary source phase spaces. The primary phase space
consists of a two-dimensional energy fluence grid and a two-dimensional grid of
spectra. The non-primary phase space consists of a three-dimensional energy fluence
grid (that is, a two-dimensional energy fluence grid that varies with distance from
source) and a single spectrum. For an arc field, the source model calculates several
static beam phase spaces.

Modeling of the Primary Source
In order to generate the phase space for the primary source, the photon beam source
model requires as input the primary opening ratio matrix (static jaw/MLC opening or
actual fluence for an IMRT field / arc segment) as well as the following source model
parameters:
■ Photon energy spectrum
■ Mean radial energy
■ Intensity profile

38 Eclipse Photon and Electron Algorithms Reference Guide



Photon Energy Spectrum

Dose calculation algorithms for photon beams require information about the energy
spectrum of the primary photons in the beam. The initial photon spectra were
determined for a generic machine from Monte Carlo simulations of the
bremsstrahlung spectrum of the electrons impinging on the target. The figure shows
an example of an initial photon spectrum for a 6 MV beam.

1. Relative particle fluence
2. Energy [MeV]
3. Spectrum

Figure 8 Example of 6 MV Photon Spectrum

Mean Energy

Another important parameter that affects the energy spectrum used by the source
model is the mean energy as a function of the radius from the beam CAX. An
example of the mean radial energy for a 6 MV beam is given in the figure. This curve
is used by the source model to determine the beam hardening effect of the flattening
filter on the photon spectrum. Based on the mean energy curve and the user-specified
flattening filter material, the source model determines the energy spectrum of the
beam as a function of radial distance from the beam CAX. For flattening filter free
(FFF) beams, the mean radial energy curve models the off-axis variation in the initial
bremsstrahlung spectrum.
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1. Mean energy [MeV]

2. Radial distance [mm]

3. Mean radial energy

Figure 9 Example of the Mean Energy as a Function of Distance from the CAX of a 6 MV Photon
Beam

Intensity Profile

The intensity of the photon beam varies slightly across the treatment field. The
varying photon fluence is modeled with the help of a parameter called the intensity
profile curve. The intensity profile is computed as the photon energy fluence
(number × energy of photons) as a function of the radial distance from the CAX.

The figure shows an example of the intensity profile for a 18 MV beam:

1. Intensity

2. Radius [mm]

3. Intensity profile

Figure 10 Example of Intensity Profile of an 18 MV Beam

The figure shows an example of the intensity profile for a 10 MV flattening filter free
beam:
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1. Relative intensity [%]
2. Off-axis distance [mm]
3. Intensity profile

Figure 11 Example of Intensity Profile of a 10 MV Flattening Filter Free Beam

Modeling of the Second Source
Extra-focal photon radiation (all photons emerging from outside the target) is
modeled using a finite-size second source located at the bottom surface of the
flattening filter. This virtual source is called the second source. The second source has
a Gaussian intensity distribution. Its energy fluence distribution is wider than that of
the primary source, since it is located closer to the patient in the beamline. The
energy fluence is also blurred near the edges because of the finite size of the source

Second Source Energy Fluence

The second source fluence at an arbitrary plane is computed by adding the
contributions from each element of the source for each pixel in the destination
fluence array. The contributions vary depending on whether the beam ray hits the
collimator jaws or MLC leaves. This calculation models both the upper and lower
edge of the collimator jaws, but the MLC as a single plane. The contribution is scaled
by the Gaussian weight of the source element, by the inverse square of the distance
between the elements at the source and destination planes, and by the cosine of the
ray angle.
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Second Source Parameters

The second source model includes a spectrum whose energy axis is scaled to obtain a
given mean energy. Off-axis variation in the second source spectrum is not modeled.
The weight of the second source compared to the primary photon source, the width
of the Gaussian at the source plane, and the mean energy are free parameters.
Information on how these parameters are derived: Configuration Program for Photon
Beams on page 74. The distance from the target to the second source and the
distances from target to each collimating device are read from the library at the
beginning of the configuration. These parameters are defined in the configuration
according to the machine geometry, and are not changed during the optimization
process. The distance parameters can be modified by the user to make them match
with the actual treatment machine before beginning the configuration.

Modeling of the Electron Contamination
The electron contamination is modeled with a depth-dependent curve that describes
laterally integrated electron contamination dose at different depths. Acuros XB
requires additionally an energy spectrum for the contamination electrons. It is
determined by fitting a set of monoenergetic electron depth doses to the depth-
dependent curve.

The shape of the electron fluence is obtained as a convolution of the aperture shape
and a 2D kernel consisting of two Gaussian components. The Gaussian component
with a smaller effective sigma allows the photon beam source model to better model
the electron scattering that occurs in air.

In the beam data, the width of these Gaussians is denoted with electron
contamination parameters Sigma0 and Sigma1 and their mutual weight ratio is
described by the Relative fraction of sigma0 parameter.

The figure shows an example of the electron contamination curve.
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1. Relative electron dose
2. Depth [mm]
3. Electron contamination

Figure 12 Example of Electron Contamination Curve

Beam Modifiers in the Treatment Beam Model
Most beam modifying accessories affect only the beam fluence used in dose
calculation. Blocks, trays and MLCs employ a user-defined transmission factor to
model the radiation transmitted through the accessory. Compensators, Dynamic
Wedges and IMRT fields also modify the fluence of the beam. The head scatter effects
are taken into account by using a finite size second source located at the bottom
surface of the flattening filter (Modeling of the Second Source on page 41). The
contribution of the contaminating electrons also depends on the photon beam fluence
shape.

Hard wedges modify the fluence and the spectral characteristics of the beam. The
configuration program determines these effects from the depth dose and profile
measurements for several field sizes. The wedge scatter effects are derived
simultaneously to the above effects during the beam configuration. The user-defined
wedge material and the wedge transmission derived during configuration process
are used to determine the 2D energy spectrum after the wedge from the configured
open field energy spectrum.
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Physical compensators (also referred as standard compensators, as opposed to
dynamic beam compensation with MLC) modify the fluence and the spectral
characteristics of the beam. The fluence is modified based on the thickness matrix of
the compensator and the effective linear attenuation coefficients (EAC). The
compensator scatter is taken into account by utilizing field size dependent EACs
determined by the configuration program. If a block is placed under the compensator
in a treatment beam, the equivalent field size calculation for defining the EAC value
ignores all blocks, even if some of them reside above the compensator. In this case, no
blocks are taken into account for compensator scatter and a warning is given in the
calculation log. The compensated beam spectrum is hardened according to the
compensator thickness and user-defined compensator material properties.

The EAC values are used in dose calculation by AAA or Acuros XB. The linear
attenuation factor configured for a dosimetric material in RT Administration is used
by Eclipse client to calculate compensator thickness matrix based on the transmission
matrix created by PBC. The linear attenuation factor should correspond to the
average calculated EAC value for the given configured compensator material in RT
Administration.

Note: For dose calculation and field visualization, External Beam Planning models photon
treatment unit collimators as a system of X and Y jaws together with blocks or MLC. In the
case of Siemens treatment units, this model is not entirely accurate, because the MLC device
replaces the collimator X jaws.

Known Limitations of the AAA and Acuros XB Algorithms
AAA and/or Acuros XB dose calculation algorithms have the following known
limitations.

AAA Accuracy in Lung
For 4 MV to 6 MV energies and field sizes larger than or equal to  5x5 cm2, AAA
tends to underestimate the dose in lung and overestimate the dose in water-
equivalent tissue after the lung. For 6 MV, the errors are smaller than 3% of the field
CAX dose maximum. However, error from local dose can become significantly larger,
if the local dose is small relative to the dose maximum.

For 10 MV to 20 MV energy modes and field sizes smaller than or equal to 5x5 cm2,
AAA tends to overestimate the dose in lung. The errors become larger as the field
size decreases and the lung density decreases. For 18 MV and 3x3 cm2 field, the
maximum error in lung with density 1.85 g/cm3 is approximately 7% of the field dose
maximum.
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Accuracy of AAA and Acuros XB for static MLC fields
For 18 MV, AAA and Acuros XB tend to underestimate the dose at shallow depths
for certain static MLC shapes. At 3 cm depth, the error can reach 3% of the local dose.

For 6 MV, AAA and Acuros XB may underestimate the dose at large depths (larger
than or equal to 20 cm) for certain static MLC shapes. The errors are more
pronounced for elongated (for example H-shaped) openings. The errors can reach up
to ~4% of the local dose.

Accuracy of AAA and Acuros XB for hard wedges
Accuracy is typically within 3% of dose maximum or 3 mm in the areas of high dose
gradients. Larger errors can be observed in the build-up region for low (4 MV) and
high (18 MV and 20 MV) nominal energies. For high energy photon beams, larger
dose differences may also be observed outside the field edge for large field sizes
(larger than or equal to 15x15 cm2).

Configuration of Photon Beams
Monte Carlo simulations of the radiation generated by treatment head were used to
determine the fundamental medical linear accelerator model used in the photon
beam source model. The model parameters are adapted for each clinical beam by the
source model configuration program. These parameters determine a customized
phase space that defines the fluence and energy spectrum specific to each treatment
unit and energy.

The input of the source model configuration program consists of specific measured
beam data and parameter values that are either defined by the user or read in from
the parameter library. The parameters describe the measurement geometry and the
physical characteristics of the beam.

The measured beam data files can be imported into Eclipse for the source model
configuration, or you can use Varian Eclipse Beam Data. Information on the
configuration: Configuring Photon Beams in Beam Configuration on page 86.
Detailed information on using Beam Configuration: Eclipse online help system or
Beam Configuration Reference Guide. Information on how to select a calculation model
for dose calculation in Eclipse: Eclipse Photon and Electron Reference Guide.
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Note: When performing measurements and configuring the photon beam source model, notice
the following:
■ The instructions for beam data measurements are recommendations only. Varian Medical

Systems is not responsible for incorrect measurements or inaccurate configuration
resulting from erroneous measurements.

■ Clinical physicists responsible for the measurements must always use their own judgment
in deciding the level of acceptable accuracy of the measurements in relation to the
calculations, and find the compromises needed for each specific accelerator as far as
measurements are concerned.

■ It is important to configure the system so that it corresponds to the characteristics of the
treatment machine. Wedges must be configured with particular care.

■ Periodically perform follow-up measurements and compare with the dosimetric beam data
used for configuring the beam. If fluctuations are large and the configured beam data no
longer represents the average beam delivered by the machine, reconfigure the beam data
using the newer dosimetric beam data.

■ Measure all dosimetric beam data in as stable conditions as possible.
■ Perform all measurements as accurately as possible. However, the source model

configuration program is able to recover from small measurement errors in the input files,
such as small lateral shifts (tolerance +/- 2.5 mm) or noise.

■ Use the same file naming conventions in beam data measurements (input files) and in
Beam Configuration (Therapy Unit name), and name the input files so that it is easy to
match the beam data to the treatment unit during the configuration process.

■ Perform the effective point of measurement correction. The source model does not perform
this correction automatically, and neglecting this correction will shift the measured dose
maximum positions. This will result in an error in the electron contamination model.

■ When measuring profiles, especially for large field sizes, use the available width of the
phantom as efficiently as possible. Avoid measuring near the walls of the phantom: missing
water volume near the point of measurement also implies missing scatter in the profiles.
Instead of using measurement points close to the phantom wall, reposition the phantom so
that the full width of the measured profile fits well inside the phantom.

■ It is recommended to use an ionization chamber for all beam data measurements for the
source model.

Small Field Support

Note: If measurements for very small field sizes are included in the beam data, the selected
detector needs to be suitable for the measurement of small fields. The positioning of the
phantom and detector needs to be done carefully.

A single beam data containing both small and large field measurements is expected
to produce accurate results for all field sizes. There is no need to create separate
models for the calculation of small and large field sizes.
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Refer to literature for more discussion on small fields in the photon beam source
model1.

Recommended Measurements for Open Beam

Measure the following for small fields:
■ Depth dose curves and profiles from 3 × 3 cm2 up to maximum field size

deliverable with the machine (for example 40 × 40 cm2).

The measurement set must contain field sizes at least up to 10 × 10 cm2.

Inclusion of measurements for smaller field sizes than 3 × 3 cm2 does not have a
significant impact on the calculated beam data parameters. Beam model should be
accurate even though the measurement data does not contain very small field
sizes (1 × 1 cm2 and 2 × 2 cm2). Note also, that depth dose curve and profile
measurements for field sizes smaller than 2 × 2 cm2 are ignored by the
configuration program.

■ Diagonal profiles for the maximum field size.
■ Output factors from 3 × 3 cm2 up to the maximum field size deliverable with the

machine. Output factors for field sizes 1 × 1 cm2 and 2 × 2 cm2 can be included, if
desired. However, these will not affect the calculation results for small MLC
collimated fields in treatment units, where MLC is located below the jaws (for
example Varian). This is because the backscatter in these cases is determined from
the size of the jaw opening. If small jaw-collimated fields are used in the
treatments, the inclusion of output factor measurements for these field sizes may
improve the accuracy.

Tuning of the effective spot size parameters

The beam data includes parameters Effective target spot size in X-
direction and Effective target spot size in Y-direction, which have
a significant effect on the calculated absolute dose level for very small field sizes (<=
1x1 cm2) and for the shape of the calculated penumbra for all field sizes.

These parameters should be manually adjusted for each treatment unit based on
high-resolution measurements (such as film). After changing the parameter value,
pay attention on the agreement in the absolute dose level for small field sizes and on
the penumbra region for all field sizes.

More information on the effective spot size parameters: AAA and Acuros XB
Parameters on page 59.

1 T. Torsti, L. Korhonen, V. Petäjä: Using Varian Photon Beam Source Model for Dose
Calculation of Small Fields. Clinical Perspectives, Varian Medical Systems, September
2013.
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Beam Data Measurements for Photon Beams
The photon beam source model needs specific measured beam data for performing
dose distribution calculations. All beam data must be measured under the same
setup conditions (Figure 13 on page 84).

Required Source Model Beam Data Measurements for Open Fields

To be able to configure the source model correctly for open fields, measure at least
the data listed in the following table and import it to Beam Configuration. Perform
beam data measurements for open fields as follows:
■ Measure depth dose curves and profiles using the same field sizes. The effective

measurement point correction must be applied to the measured depth dose
curves before importing the data in Beam Configuration.

■ All profile measurements can be performed at the X- or the Y-axis.
■ Use a single Source Phantom Distance (SPD) between 70–140 cm for all

measurements. For cobalt machines the minimum SPD is 50cm.

Configuration program for the photon beam source model may use only a subset of
the measured field sizes. More information: Adaptation of Measurements in the
Configuration on page 75.

The mandatory open field measurements for the Elekta Beam Modulator differ
slightly from the other open field measurements of the photon beam source model.
More information: Required Measurements for Elekta Beam Modulator on page 54.

Table 5 Open Field, Mandatory Beam Data Measurements

Measured Parameter Scan Axis / Depth Field Size in cm2

Depth dose curves1 CAX Field sizes smaller than
10 × 102

10 × 10

Intermediate field size(s)

Largest field size

Profiles1,3 dmax, 5 cm,
10 cm, 20 cm,
30 cm depth4

Field sizes smaller than
10 × 102

10 × 10

Intermediate field size(s)

Largest field size
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Measured Parameter Scan Axis / Depth Field Size in cm2

Diagonal profile dmax, 5 cm,
10 cm, 20 cm,
30 cm depth4

Largest field size

Output factors 5 cm depth ≤
15 MV

10 cm depth
for > 15 MV

Table 6 on page 50

1. The same set of field sizes for depth dose curve and profile measurements should be used. Measurements
for field sizes that appear only in either the depth dose curve measurements or the profile measurements
are excluded from configuration.2. It is mandatory to include depth dose and profile measurements for at
least two valid field sizes smaller than 10 x 10 cm2.3. Measure profiles at least 35 mm past the 50% of the
CAX point.4. These are recommended depths. Also other depths may be used. A field size is considered valid
if it contains at least three valid profile measurements and a valid depth dose curve measurement.

The following table lists the open field sizes for which the output factor
measurements are performed. Optional field sizes are on gray background. Perform
output factor measurements as follows:

■ The correct measurement depth is 5 cm or 10 cm, depending on the energy. Do not
perform the output factor measurements at the dmax.

■ Measure the output factor for each field size with the same SPD and detector depth.
Changing the detector depth (for instance, to match the dmax of each field size) is
not allowed.

■ Indicate the field sizes in centimeters to have them displayed correctly in Beam
Configuration.

■ Note that it is not necessary to measure every field size combination. However,
make the measurements in such a way as to allow completion of the entire table
by linear interpolation between measured values. This interpolation can be done
automatically in Beam Configuration (more information: Beam Configuration
Reference Guide). Information on the selection of field sizes for collimator
backscatter: Adaptation of Measurements in the Configuration on page 75.

■ Usually it is not necessary to measure output factors for fields smaller than 2 cm
in any direction, because such small apertures are typically delimited by the
multileaf collimator instead of the collimator jaws. However, if these are
measured, extra care should be taken in selecting the measurement device and
performing the measurements. If the jaw field size is smaller than the smallest
field size used for output factor measurement, a warning that MU or timer setting
may be incorrect is displayed in the calculation log when calculating the final dose
in External Beam Planning.
The table shows the field sizes for open field output measurements when the
smallest field size is 3 × 3 cm and the largest field size is 40 × 40 cm.

The table shows the field sizes for open field output measurements when the smallest
field size is 3 × 3 cm and the largest field size is 40 × 40 cm.
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Table 6 Field Sizes for Open Field Output Factor Measurements

 Width (FX)

Height
(FY)

 3 5 7 10 15 20 30 40

3 3 × 3 3 × 5 3 × 7 3 × 10 3 × 15 3 × 20 3 × 30 3 × 40

5 5 × 3 5 × 5 5 × 7 5 × 10 5 × 15 5 × 20 5 × 30 5 × 40

7 7 × 3 7 × 5 7 × 7 7 × 10 7 × 15 7 × 20 7 × 30 7 × 40

10 10 × 3 10 × 5 10 × 7 10 × 10 10 × 15 10 × 20 10 × 30 10 × 40

15 15 × 3 15 × 5 15 × 7 15 × 10 15 × 15 15 × 20 15 × 30 15 × 40

20 20 × 3 20 × 5 20 × 7 20 × 10 20 × 15 20 × 20 20 × 30 20 × 40

30 30 × 3 30 × 5 30 × 7 30 × 10 30 × 15 30 × 20 30 × 30 30 × 40

40 40 × 3 40 × 5 40 × 7 40 × 10 40 × 15 40 × 20 40 × 30 40 × 40

In addition to the output factors for different field sizes, additional parameters are
used to determine the geometry of the output factor measurements (Output Factor
Parameters on page 71).

Each value in the output factor table indicates the ratio of the measured dose at the
detector depth for each measured field size and the dose at the detector depth for the
reference field size, when using the reference MU or timer setting. Information on
output factor formats: Appendix D Table Input Formats on page 316.

Measurements for Absolute Point Doses

The configuration of Elekta Beam Modulator requires measurements of absolute
point doses for a set of asymmetrical fields. These values are used by the
configuration program to optimize the mean radial energy, intensity profile and
second source parameters by minimizing the gamma error.

This data type is recommended for all Elekta machines. For all other machine
vendors and models, absolute point dose data is optional.

You can import the absolute point doses supported by the source model
configuration program into Beam Configuration in a separate measurement file. You
need to manually create the file for the import. To enable Beam Configuration to read
the file, it must use a specified file format. Information on the file format and example
files: Appendix C File Formats for Measured Beam Data on page 304.

For each measured field, the table indicates the asymmetrical jaw positions (X1, X2,
Y1, Y2) in millimeters, the detector position (X, Y, Z) in millimeters and the measured
point dose at the detector in cGY/MU.
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The recommended set of measurements is the following.
■ One small field size (for instance, 4 × 4 cm2) located at the extreme positions of the

open collimator jaws in the X- and Y-directions, and in a few locations in between
the extremes.

■ One larger field size (for instance, 10 × 10 cm2) located at the extreme positions of
the open collimator jaws in the X- and Y-directions and in a few middle positions.

The recommended measurement geometry is the following:
■ Source-to-Phantom Distance (SPD) = 950 mm
■ Detector depth (Z) = 50 mm. The depth increases from the phantom top surface

towards the floor. Additional measurements at other depths can also be used.
■ Detector position (X, Y, Z) is entered in orthogonal coordinates. The origin of the

coordinate system is at the surface of the phantom, at beam central axis.

Asymmetrical jaw positions are indicated in the IEC 61217 scale.

Required Measurements for Wedge Fields

The minimum set of measured data required for physical wedge fields to correctly
configure the photon beam source model is described in the table.

Table 7 Wedge Field, Required Beam Data Measurements

Measured Param-
eter

Scan Axis Field Size in cm2 Status

Depth doses1 CAX 4 × 4 Recommended

10 × 10 Recommended

15 × 15 Recommended for
wedges of width 20 cm

20 × 20 Recommended for
wedges of width 30 cm

Max.square field size Mandatory

Max. field size to both di-
rections2

Recommended

Output factors3 5 cm depth ≤ 15 MV

10 cm depth
for > 15 MV

Table 6 on page 50 Mandatory
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Measured Param-
eter

Scan Axis Field Size in cm2 Status

Profiles1, 4 dmax, 5 cm, 10 cm,
20 cm, 30 cm depth

4 × 4 Recommended

10 × 10 Recommended

15 × 15 Recommended for
wedges of width 20 cm

20 × 20 Recommended for
wedges of width 30 cm

Max. square field size Mandatory

Max. field size to both di-
rections2

Recommended

Longitudinal pro-
file1

dmax, 5 cm, 10 cm,
20 cm, 30 cm depth

Max.square field size or
Max. field size to both di-
rections2

Mandatory at one depth
(e.g. 5 cm); Recom-
mended at other depths

1. The largest field size in depth doses, profiles and longitudinal profiles can be either the maximum square
field size or the maximum field size to both directions. However, the largest field size must be the same for
both profiles and longitudinal profiles.2. The field size must not be specified in terms of the equivalent field
size for source model configuration. The field size can be specified in w2CAD either, for example, as %FLSZ
400*200 or %FLSZ 200*400. The order must be the same for all of the measurement types (PDD, pro-
files). Note that if dose for wedge field sizes larger than the maximum square field is calculated, and the
depth dose curve for the “max field size to both directions” is not present in Beam Configuration, a warning
of possibly deteriorated dose calculation accuracy is shown in the calculation notes.3. The required wedge
position for all output factor measurements is collimator rotation = 0°. Output factors can be measured
with any wedge rotation.4. All measured wedge profiles have to be measured in the same direction, that is,
either the dose increases from left to right in all profiles, or the dose increases from right to left in all pro-
files. Mixing both types of profiles is not allowed.

Optional Measurements for Wedge Fields

In addition to the required beam data measurements (Table 7 on page 51), you may
perform optional measurements for configuring wedges for the source model. The
optional measurements are needed for running the last configuration step for wedges
(configure wedge correction factors for different SSDs). Performing the last
configuration step improves the accuracy for short and long SSDs for wedged fields.
This is achieved by modifying the electron contamination and wedge scatter
components based on the additional measurements.

The optional measurements are the following:
■ Measured wedge depth doses for SSD = 80 cm and SSD = 120 cm
■ Absolute point doses at different SSD—Needed if the wedge depth doses for
different SSDs are imported.
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Define Measured Wedge Depth Doses

Wedge depth doses can be measured for SSD = 80 cm and SSD = 120 cm.

1. Measure the wedge depth doses for 1–5 field sizes, which are the same field sizes
or a subset of the field sizes as used for the default SPD (more information: 
General Parameters on page 57). Use the same field sizes for both SSDs.

2. To be able to import the curves, edit the w2CAD file. Change the depth dose type
from WDD either to WDD_SSD80 or WDD_SSD120.

3. In the Beam Configuration Context Window, select a wedge.
4. To import the measured depth doses for the selected wedge, choose Import  >

Measured Wedge Depth Doses for SSD 80 cm or Import  > Measured Wedge
Depth Doses for SSD 120 cm.

Define Absolute Point Doses at Different SSDs

The absolute point doses at different SSDs are needed if the wedge depth doses for
different SSDs are imported into Beam Configuration. The absolute point doses at
different SSDs are given in a table, which contains the SSD and measured dose in
cGy/MU for each field size.

1. To add a blank table, in the Context Window, select a wedge and then choose
Insert  > New Absolute point doses at different SSDs.

2. In the blank table, for each measurement (Meas<n>), give the SSD, field size in X-
direction (FSX), field size in Y-direction (FSY) and the measured dose (for either
SSD = 800 mm or SSD = 1200 mm). The figure shows examples.

1. Values for measurements performed for 4 field sizes and SSD = 800.
2. Values for measurements performed for 4 field sizes and SSD = 1200.
3. Cells of field sizes for which no measurement has been made.

If you have measured fewer than 5 field sizes, type “0.0” in the extra cells.
3. In the Parameter View below the table, define the detector depth in millimeters

and the wedge orientation.
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Required Measurements for Compensator Fields

Point dose measurements for compensators are required for five different square
field sizes (for example, 2 cm, 5 cm, 10 cm, 20 cm and 30 cm), with and without a slab
of compensator material inserted into the beam. In addition, the compensator
thickness must be defined in compensator parameters. Each of these point dose
measurements must be performed in the same measurement geometry, for example,
SSD = 95 cm and depth = 5 cm. It is recommended to perform the measurements
deeper than the depth of the dose maximum. For clarity, it is also recommended to
deliver the same amount of MU in each point dose measurement.

Field sizes used in measurements should span the range of field sizes used in
treatment. Measured point dose data, field sizes and measurement geometry are
defined in a table in Beam Configuration.

Define Point Dose Data and Field Sizes for Compensators

1. In the Context Window, select Measured compensator data.
2. In the FS[mm] column, type the field sizes in millimeters.
3. In the Open[cGy/MU] column, type the measured point doses for the open fields

in cGy/MU.
4. In the Comp[cGy/MU] column, type the measured point doses for the fields with

the flat compensator in cGy/MU.
5. In the Parameter View below the table, define the measurement source-phantom

distance and measurement depth in millimeters.

Required Measurements for Elekta Beam Modulator
The photon beam source model needs specific measured beam data for performing
dose distribution calculations. For Elekta Beam Modulator, open field measurements,
output factor measurements, and wedge field measurements must be performed.

Open Field Measurements for the Elekta Beam Modulator

The table lists the open field measurements required for the configuration of the
Elekta Beam Modulator.

The required field sizes are determined by the width of the Elekta Beam Modulator
leaves (4 mm). Example field sizes:
■ FX direction: 2.4, 3.2, 4.0, 5.6, 8.0, 10.4, 12.0, 16.0 and 21.0 cm
■ FY direction: 2.4, 3.2, 4.0, 5.6, 8.0, 10.4, 12.0, 16.0 cm.
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Table 8 Elekta Beam Modulator, Mandatory Open Field Measurements

Measured Param-
eter

Scan Axis/
Depth

Field Size in cm2

Depth dose curves1 CAX Field sizes smaller than 10.4 × 10.42

10.4 × 10.4

Intermediate field size(s)

21.0 × 16.0

(largest rectangular field size)3

Profiles1, 4 dmax, 5 cm,
10 cm, 20 cm,
30 cm depth5

Field sizes smaller than 10.4 × 10.42

10.4 × 10.4

Intermediate field size(s)

21.0 × 16.0

(largest rectangular field size)3

Diagonal profile6 dmax, 5 cm,
10 cm, 20 cm,
30 cm depth5

21.0 × 16.0 (largest rectangular field size)3

1. The same set of field sizes for depth dose curve and profile measurements should be used. Measurements
for field sizes that appear only in either the depth dose curve measurements or the profile measurements
are excluded from configuration.2. It is mandatory to include depth dose and profile measurements for at
least two valid field sizes smaller than 10.4 x 10.4 cm2.3. The measurement of the largest rectangular field
size must be recorded in this order in the w2CAD file (the correct syntax is %FLSZ 210*160).4. Measure
profiles at least 35 mm past the 50% of the CAX point.5. These are recommended depths. Also other depths
may be used. A field size is considered valid if it contains at least three valid profile measurements and a
valid depth dose curve measurement.6. The diagonal profile shall always be measured along the direction
from one field corner to the other field corner. In case of Elekta Beam Modulator, the angle between diag-
onal and cross-line profile will differ from 45 degrees, since the maximum field size is not a square.

Output Factor Measurements for the Elekta Beam Modulator

The output factors for the Elekta Beam Modulator can be imported into Beam
Configuration in a separate file. To enable Beam Configuration to read the file, it
must use a specified file format. Information on the file format and example files: 
Appendix D Table Input Formats on page 316.

The table lists the field sizes to be used for the output factor measurements for the
Elekta Beam Modulator.
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Table 9 Field Sizes for Output Factor Measurements for Elekta Beam Modulator

 Width (FX) in IEC 61217 Scale

Heigh
t (FY)
in IEC
61217
Scale

 2.4 3.2 4 5.6 8 10.4 12 16 21

2.4 2.4 ×
2.4

2.4 ×
3.2

2.4 × 4 2.4 ×
5.6

2.4 × 8 2.4 ×
10.4

2.4 ×
12

2.4 ×
16

2.4 ×
21

3.2 3.2 ×
2.4

3.2 ×
3.2

3.2 × 4 3.2 ×
5.6

3.2 × 8 3.2 ×
10.4

3.2 ×
12

3.2 ×
16

3.2 ×
21

4 4 × 2.4 4 × 3.2 4 × 4 4 × 5.6 4 × 8 4 ×
10.4

4 × 12 4 × 16 4 × 21

5.6 5.6 ×
2.4

5.6 ×
3.2

5.6 × 4 5.6 ×
5.6

5.6 × 8 5.6 ×
10.4

5.6 ×
12

5.6 ×
16

5.6 ×
21

8 8 × 2.4 8 × 3.2 8 × 4 8 × 5.6 8 × 8 8 ×
10.4

8 × 12 8 × 16 8 × 21

10.4 10.4 ×
2.4

10.4 ×
3.2

10.4 ×
4

10.4 ×
5.6

10.4 ×
8

10.4 ×
10.4

10.4 ×
12

10.4 ×
16

10.4 ×
21

12 12 ×
2.4

12 ×
3.2

12 × 4 12 ×
5.6

12 × 8 12 ×
10.4

12 × 12 12 × 16 12 × 21

16 16 ×
2.4

16 ×
3.2

16 × 4 16 ×
5.6

16 × 8 16 ×
10.4

16 × 12 16 × 16 16 × 21

Wedge Field Measurements for the Elekta Beam Modulator

The table lists the required wedge field measurements for the Elekta Beam
Modulator.

Table 10 Required Wedge Field Measurements for Elekta Beam Modulator

Measured Param-
eter

Scan Axis Field Size in cm2 Status

Depth dose
curves

CAX 3.2 × 3.2 Recommended

5.6 × 5.6 Recommended

8.0 × 8.0 Recommended

10.4 × 10.4 Recommended

16 × 16 Mandatory

21 × 16

(largest rectangular field
size)1

Recommended

Output factors2 5 cm depth Table 9 on page 56 Mandatory
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Measured Param-
eter

Scan Axis Field Size in cm2 Status

Profiles dmax, 5 cm, 10 cm,
20 cm, 30 cm depth

3.2 × 3.2 Recommended

5.6 × 5.6 Recommended

8.0 × 8.0 Recommended

10.4 × 10.4 Recommended

16 × 16 Mandatory at 10 cm
depth; Recom-
mended at other
depths

Longitudinal pro-
file

dmax, 5 cm, 10 cm,
20 cm, 30 cm depth

21 × 16 (16 × 16 is also al-
lowed)

Mandatory at 5 cm
depth; Recom-
mended at other
depths

1. The measurement of the largest rectangular field size must be recorded in this order in the w2CAD file
(the correct syntax is %FLSZ 210*160).2. The required wedge position for all output factor measurements
is collimator rotation = 0°. Output factors can be measured with any wedge rotation.

Configuration Parameters for Photon Beams
Beam Configuration uses measured beam data and a number of parameter values for
calculating the configured beam data. Part of these parameter values are read from
RT Administration, part from the parameter files of the algorithm.

If you are using Varian Eclipse Beam Data without any modifications to the
parameter values or without using your own measured beam data, you only need to
enter the absolute dosimetry parameters (AAA and Acuros XB Parameters on
page 59 and Hard Wedge Parameters on page 65) and verify the parameters
contained in the data; no changes are required unless the parameter values are
clearly incorrect.

General Parameters

The photon beam source model requires that the following general treatment unit
parameters are either read from RT Administration or defined in Beam
Configuration. Some default values are read from the Data Type Specification file of
the algorithm. When configuring the source model, verify that the parameters read
from RT Administration are correct, and ensure that no required parameters are
missing.
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General Parameters read from RT Administration
■ Nominal energy in MV

The nominal energy can be specified either according to BJR-11 or BJR-17
specifications, and both lead to equally accurate results in the dose calculations.
The nominal energy according to BJR-11 specification is assumed to be equal to
the energy of the monoenergetic electron beam that hits the target, thereby
producing bremsstrahlung photons. The spectrum of these photons has been
precalculated by Monte Carlo simulation for all available nominal energies and is
stored in the machine data library. The nominal energies according to BJR-17 are
internally mapped to those of BJR-11.

Table 11 BJR-11 and BJR-17 energies

BJR-11 BJR-17

6 MV 6 MV

10 MV 10 MV

15 MV 16 MV

18 MV 23 MV

20 MV 25 MV

■ Default source-phantom distance for depth dose and profile measurements,
expressed in cm

Define the SPD used in the actual beam data measurements in Beam
Configuration.

■ Source-axis distance expressed in cm

General Parameters defined in Beam Configuration
■ Therapy unit name
■ Radiation type (must be “photon”)
■ Vendor
■ Source-to-phantom distance used during the beam data measurements, expressed

in cm
■ Smallest open beam size in X and Y directions
■ Largest open beam size in X and Y directions.

For the Elekta Beam Modulator, set the maximum size in X-direction to 21 cm,
and the maximum size in the Y-direction to 16 cm.

■ Number of profiles (minimum 3, maximum 5 profiles)
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■ 1st–5th profile depth in cm

AAA and Acuros XB Parameters

The AAA and Acuros XB require defining the following parameters in Beam
Configuration.

Table 12 AAA and Acuros XB Parameters

Parameter Description

Absolute dose reference field
size [mm]

Size of the reference field used in configuration, expressed in
millimeters. Usually, this should be the same size that was
used to normalize the measured output factor table (that is,
the field size for which the output factor = 1.0).

Absolute dose calibration
depth [mm]

Depth of the reference point used in configuration, expressed
in millimeters. The recommended depth for 6 MV, 10 MV and
15 MV is 50 mm, and the recommended depth for 18 MV and
20 MV is 100 mm. (Illustration of the geometry: Figure 15 on
page 86.)

Absolute dose calibration
source-phantom distance

Distance between the source and the surface of the phantom
(SPD) used during the absolute dose calibration, expressed in
millimeters. (Illustration of the geometry: Figure 15 on
page 86.)

Reference dose at calibration
depth [Gy]

Absolute dose in water for the reference field size at the refer-
ence point at the calibration depth, expressed in Gray.

Do not introduce a “dose to muscle” correction with
Acuros XB. When the dose to medium calculation option is
selected, Acuros XB reports dose to muscle, and any other
medium. If values with a “dose to muscle” correction are
used in Beam Configuration, then a double correction will be
done in the dose distributions.

Reference MU at calibration
depth [MU]

MU given to produce the reference dose for calibration.

Machine type Type of treatment unit.

AAA and Acuros XB support several types of treatment
units.

This parameter also specifies the nominal energies supported
for the selected treatment unit. The energies available depend
on the particular treatment unit.
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Parameter Description

Effective target spot size in X-
direction (IEC61217)[mm]

Models the broadening of the penumbra in X-direction1. The
modeling is done by applying a Gaussian smoothing to the
energy fluence of primary photons.

This parameter equals the width of the Gaussian distribution
in the X-direction (IEC 61217 scale) at isocenter plane, ex-
pressed in millimeters.

Effective target spot size in Y-
direction (IEC61217)[mm]

Models the broadening of the penumbra in Y-direction1. The
modeling is done by applying a Gaussian smoothing to the
energy fluence of primary photons.

This parameter equals the width of the Gaussian distribution
in the Y-direction (IEC 61217 scale) at isocenter plane, ex-
pressed in millimeters.

Leaf transmission for Elekta
Beam Modulator

Elekta Beam Modulator only.

Relative MLC leaf transmission for the Elekta Beam Modu-
lator head design. This parameter is used only in the configu-
ration of the dose calculation algorithm, and not in dose cal-
culation. The MLC parameters for forward dose calculation
are defined as dosimetric data in RT Administration (Radia‐
tion and Imaging Devices > MLC tab).

Open field profile measure-
ment direction (IEC61217)

Direction of open field profile measurements in IEC 61217
scale. Possible values are “Collimator X” and “Collimator Y”.

1. In addition to the finite size of the bremsstrahlung target, also the beam limiting devices may contribute
to the effects modeled. For example, rounded MLC leaf tips can be modeled using an elliptic effective target
spot size. As a result, different values for the effective target spot size may be necessary for MLC-limited and
jaw-limited fields. In the case of IMRT fields, one should also consider that Smart LMC takes the rounded
leaf tips into account in fluence calculation, whereas other LMC algorithms do not. Also note that because
the effective target spot size is defined in the collimator coordinate system, it cannot be used to accurately
describe an elliptic focal spot at the target plane.

Defining the Machine Type Parameter

The selected machine type has an effect on certain parameters that are retrieved from
the machine data library when the first configuration step for open beam is run.
These parameters can be manually modified after this step before starting the actual
configuration process. Specifically, the selection has an effect on the distances of
second source, jaws and MLC from the target (specified in Open Beam Parameters)
and on the initial spectrum used in the configuration. The table lists the distance
values defined in the machine data library for different treatment unit types.
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The selected machine model has a limited effect on the way the configuration process
works. It affects, for example, the checks done to ensure that mandatory input data is
available. The selection also affects the way the collimator backscatter factor (CBSF) is
determined during forward dose calculation. For treatment units where the MLC is
the topmost collimator (Elekta), the field size for CBSF-table lookup is determined
based on the MLC opening in X and Y direction. For treatment units where the jaws
are the topmost collimators, and both X and Y jaws exist (Varian), the field size for
CBSF-table lookup is determined based on the jaw opening in X and Y direction. For
treatment units that do not have X jaws, and Y jaws are the topmost collimators
(Siemens), the field size for CBSF-table lookup in Y direction is determined based on
the Y jaw opening, and the field size for CBSF-table lookup in X direction is
determined based on the MLC opening.

If the machine model used is not found from the list, but is supported by the
algorithm, select the closest model or Generic. Then, check the distance parameters
listed in the table and the spectrum before starting the actual configuration process.

Note: The distance of hard wedge from target varies for different treatment unit types. The correct
value needs to be specified in the Hard Wedge Parameters or in Elekta Motorized Wedge (MW)
Parameters.

Table 13 Distance Values for Different Treatment Unit Types Defined in the Machine Data Li-
brary

 Varian Elekta ElektaBM Elekta
Agility MLC
160

Siemens

Distance of second
source from target [mm]

125 158 151.5 159 94.6

Distance of Y-jaw top
surface from target [mm]

280 431 376 432 197

Distance of Y-jaw bottom
surface from target [mm]

358 509 468 509 275

Distance of X-jaw top
surface from target [mm]

367 396 479.9 309 283

Distance of X-jaw bottom
surface from target [mm]

445 426 522.7 401.8 359

Distance of MLC from
target [mm]

509 336 425.3 349.3 283
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Adjusting Target Spot Parameters

The Effective target spot size in the X- and Y-direction
parameters are not automatically optimized. Instead, these parameters should be
manually adjusted based on the characteristics of the individual treatment unit.

The spot size parameters have significant effect on the calculated absolute dose for
very small fields (width less than 1 cm in either x- or y-direction) and on the
calculated profiles in the penumbra region for all field sizes. Hence, the spot size
parameters can be adjusted by matching measurements and calculations in these
situations.

However, for both types of measurements, extra care should be taken when selecting
the measurement device to avoid artefacts arising, e.g., from volume averaging
effects. Film, for example, could be used for these types of measurements.

Table 14 Example Values for Target Spot Size Parameters

Algorithm / Treatment Unit Spot Size X-direction
[mm]

Spot Size Y-direction
[mm]

AAA / Varian treatment unit 0.0

1.0 if MLC in field

0.0

0.0 if MLC in field

Acuros XB / Varian treatment unit 1.0

1.5 if MLC in field

1.0

0.0 if MLC in field

AAA / Elekta Beam Modulator 2.5 0.0

Acuros XB / Elekta Beam Modulator 2.5 0.0

AAA / Other Elekta treatment units 0.0

1.0 if MLC in field

0.0

0.0 if MLC in field

Acuros XB / Other Elekta treatment units 1.0

1.5 if MLC in field

1.0

0.0 if MLC in field

AAA / Siemens treatment units 2.0 2.0

Acuros XB / Siemens treatment units 2.5 2.5

In all cases, fine-tuning of the spot size parameter values can be performed based on
matching measurements and calculations.

AAA Parameters for Cobalt Machines

If the treatment unit has been defined as a cobalt machine in RT Administration,
AAA requires parameters describing the absolute calibration of the radioactive
source. These parameters are needed in addition to the parameters in listed in 
Table 12 on page 59.
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Table 15 AAA Parameters for Cobalt Machines

Parameter Description

Time required to deliver ref-
erence dose at calibration [s]

The timer setting in seconds required to produce the refer-
ence dose on the calibration date.

Calibration Date
[dd.mm.yyyy]

The date on which the source was calibrated. This is required
to correct for decay when calculating the required timer set-
ting. The format must be “day.month.year”. For example, if
the source was calibrated on the 15 June 2012, then enter
“15.6.2012”.

Half-life of radioactive source
in years

The radioactive half-life of the source in years.

For cobalt units, the effective spot size of the source is larger than that for linear
accelerators. The spot size affects the penumbra width. These parameters should be
adjusted so that the calculated and measured beam profiles match.

Open Beam Parameters

The photon beam source model requires defining open beam parameters in Beam
Configuration to model extra-focal radiation of the open beam. The open beam
parameters are read from the machine parameter library (Machine Parameter Library
for Photon Beams on page 72.) The values read from the library can also be edited
manually.

The table uses the jaw names in accordance with the IEC 61217 standard.

Table 16 Open Beam Parameters

Parameter Description

Distance of second
source from primary
source [mm]

Distance between the virtual secondary source and the primary
source, expressed in millimeters. The distance is defined by the treat-
ment head geometry. The beam emerging from the secondary source
is more divergent than the beam from the primary source.

The secondary source is a virtual radiation source, located by default
at the same distance as the bottom plane of the flattening filter (more
information: Clinical Beam Modeling of Photon Beams on page 35
and Beam Modifiers in the Treatment Beam Model on page 43).

Distance of Y-jaw top
surface from target
[mm]

Distance between the primary source and top surface of the colli-
mator Y-jaw, expressed in millimeters. The distance is defined by the
treatment head geometry. If the distance changes with jaw opening,
use the distance where the jaw is as close to the central axis as pos-
sible.

This parameter affects the sharpness of the penumbra of a beam
from the secondary source.
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Parameter Description

Distance of Y-jaw
bottom surface from
target [mm]

Distance between the primary source and bottom surface of the colli-
mator Y-jaw, expressed in millimeters. The distance is defined by the
treatment head geometry. If the distance changes with jaw opening,
use the distance where the jaw is as close to the central axis as pos-
sible.

This parameter affects the sharpness of the penumbra of a beam
from the secondary source.

Distance of X-jaw top
surface from target
[mm]

Distance between the primary source and top surface of the colli-
mator X-jaw, expressed in millimeters. The distance is defined by the
treatment head geometry. If the distance changes with jaw opening,
use the distance where the jaw is as close to the central axis as pos-
sible.

This parameter affects the sharpness of the penumbra of a beam
from the secondary source.

Distance of X-jaw
bottom surface from
target [mm]

Distance between the primary source and bottom surface of the colli-
mator X-jaw, expressed in millimeters. The distance is defined by the
treatment head geometry. If the distance changes with jaw opening,
use the distance where the jaw is as close to the central axis as pos-
sible.

This parameter affects the sharpness of the penumbra of a beam
from the secondary source.

Distance of MLC from
target [mm]

Distance between the primary source and the MLC device, expressed
in millimeters. The distance is defined by the treatment head geom-
etry. If the distance changes with jaw opening, use the distance
where the leaves are as close to the central axis as possible.

If the MLC has rounded leaf tips, use the distance to the middle of
the leaves. For double focused MLCs where the leaf tip is not
rounded, use the distance to the top surface of the leaves.

This parameter affects the sharpness of the penumbra of a beam
from the secondary source.

Size of second source
[mm]

Size of the secondary source, expressed in millimeters. Defines the
size of the Gaussian shaped source distribution, defined at the
source plane. The formula for the distribution is:

k x, y; σ = 1
2πσ2 e

− x2 + y2

2σ2

where σ is the size parameter. This determines the shape and range
of secondary source effect, and the field size from which this effect is
seen. Typical value range 20–80 mm.

Relative intensity of
second source

Intensity of the radiation emerging from the secondary source in re-
lation to the primary source. Affects the magnitude of the profiles in
the tail regions in particular.

Typical value range 0.02–0.10.
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Parameter Description

Mean energy of
second source [MeV]

Mean energy of the radiation emerging from the secondary source,
expressed in megaelectronvolts. Determines the depth dose curve of
the second source. The energy is typically lower than the mean en-
ergy of the primary source. Typical value is approximately 1.0 MeV.

Hard Wedge Parameters

The hard wedge (or fixed wedge) parameters are listed in the table.

Table 17 Hard Wedge Parameters

Parameter Description

Wedge length [mm] Maximum wedge size in the longitudinal wedge direction,
expressed in millimeters. Usually this value is 400 mm.

Wedge width [mm] Maximum wedge size in the lateral wedge direction (direc-
tion which the thin edge of the wedge points to), expressed in
millimeters. Usually this value is 150, 200 or 300 mm.

Wedge angle [degrees] Wedge angle used by the configuration program to deter-
mine wedge scatter parameters. It also automatically deter-
mines the wedge angle based on the measured wedge pro-
files.

Wedge material [Fe, Cu, Pb] Wedge material

Fe = Iron

Cu = Copper

Pb = Lead.

Wedge orientation in output
factor table (IN/OUT/LEFT/
RIGHT)1

Wedge orientation in the output factor table measurements,
expressed in relation to the treatment unit:

IN = thin edge points in (IEC 61217 wedge filter coordinate
system: 0°)

OUT = thin edge points out (IEC 61217 wedge filter coordi-
nate system: 180°)

LEFT = thin edge points left (IEC 61217 wedge filter coordi-
nate system: 270°)

RIGHT = thin edge points right (IEC 61217 wedge filter coor-
dinate system: 90°)

Reference dose for hard
wedge at calibration depth
[Gy]

Absolute dose in water at the reference point at the calibra-
tion depth and field size at SSD, expressed in Gray.
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Parameter Description

Reference MU or timer setting
for hard wedge at calibration
depth [MU] or [s]

MU, or timer setting in seconds for cobalt machines, given to
produce the reference dose for calibration.

Distance of wedge from pri-
mary source [mm]

Distance of wedge from primary source.

Relative intensity of wedge
scatter source

Relative intensity of the scatter source of the wedge.

Mean energy of wedge scatter
source [MeV]

Mean energy of the radiation emerging from the wedge
scatter source, expressed in megaelectronvolts.

1. Notice that the LEFT and RIGHT wedge orientations are reversed in w2CAD and IEC 61217.

Enhanced Dynamic Wedge (EDW) Parameters

The Enhanced Dynamic Wedge (EDW) parameters are listed in the table.

Table 18 EDW Parameters

Parameter Description

Size of second source
[mm]

Size of the secondary source, expressed in millimeters. More infor-
mation: Table 16 on page 63.

Relative intensity of
second source

Relative intensity of the radiation emerging from the secondary
source. More information: Table 16 on page 63.

Mean energy of second
source [MeV]

Mean energy of the radiation emerging from the secondary
source, expressed in megaelectronvolts. More information: 
Table 16 on page 63.

These parameters are copied from the open field parameters by running the
configuration step Copy second source parameters from open field.

Elekta Motorized Wedge (MW) Parameters

The Elekta motorized wedge (MW) parameters are listed in the table.

Table 19 MW Parameters

Parameter Description

Wedge length [mm] Maximum wedge size in the longitudinal wedge direction,
expressed in millimeters. Usually this value is 400 mm.
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Parameter Description

Wedge width [mm] Maximum wedge size in the lateral wedge direction (direc-
tion which the thin edge of the wedge points to), expressed
in millimeters. Usually this value is 150, 200 or 300 mm.

Wedge material [Fe, Cu, Pb] Wedge material

Fe = Iron

Cu = Copper

Pb = Lead.

Wedge orientation in output
factor table (IN/OUT/LEFT/
RIGHT)

Wedge direction in the output factor table measurements,
expressed in relation to the treatment unit:

IN = thin edge points in (IEC 61217 wedge filter coordinate
system: 0°)

For motorized wedges, only the IN direction is possible.

Reference dose for hard wedge
at calibration depth [Gy]

Absolute dose in water at the reference point in the calibra-
tion geometry defined for the open field, expressed in Gray.

Reference MU for hard wedge
at calibration depth [MU]

MU given to produce the reference dose for calibration.

Size of second source [mm] Size of the secondary source, expressed in millimeters. More
information: Table 16 on page 63.

Relative intensity of second
source

Intensity of the radiation emerging from the secondary
source in relation to the primary source. More information: 
Table 16 on page 63.

Mean energy of second source
[MeV]

Mean energy of the radiation emerging from the secondary
source, expressed in megaelectronvolts. More information: 
Table 16 on page 63.

Distance of wedge from pri-
mary source [mm]

Distance of wedge from primary source, expressed in milli-
meters.

Relative intensity of wedge
scatter source

Relative intensity of the scatter source of the wedge.

Mean energy of wedge scatter
source [MeV]

Mean energy of the scatter source of the wedge, expressed in
megaelectronvolts.

Elekta Virtual Wedge Parameters

Elekta Virtual Wedges (EVW) are similar to Varian Enhanced Dynamic Wedges
(EDW) and Siemens Virtual Wedges (SVW) in that the angled dose distribution is
produced by moving a collimator jaw. In this case, only the backup diaphragm,
which moves in the same direction as the MLC leaves, can be moved.
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An EVW field is one of the components that form Elekta OmniWedge fields. These
components are the following:
■ Open field component
■ Elekta Virtual Wedge component
■ Elekta Motorized Wedge field component

Elekta OmniWedge fields containing a wedge in arbitrary directions and angles are
produced2 by the combination of the different components. The backup diaphragm
has a finite transmission, whose value depends on the energy mode.

Table 20 Elekta Virtual Wedge Parameters

Parameter Description

Transmission of Backup dia-
phragm [1]

Transmission (between 0 and 1) of the backup diaphragm. This
value has to be manually adjusted for each energy mode to ob-
tain a good match between the calculated and measured EVW
fields. Good starting points are the following:

4X—Start at 0.09

6X—Start at 0.10

15X—Start at 0.12

Configure Elekta OmniWedge

To configure Elekta OmniWedge, you need to add wedges both in RT Administration
and Beam Configuration. More information about using RT Administration: RT
Administration Reference Guide. More information about using Beam Configuration:
Beam Configuration Reference Guide.

1. In RT Administration, create a new dynamic wedge for the Elekta treatment unit.
In the Dynamic Wedge Properties dialog box, select the Enhanced check box.

2. Create a new standard wedge. In the Standard Wedge Properties dialog box,
select the Omniwedge check box and the Motorized check box.

3. In addition to the above wedges, you can also create a second new standard
wedge. In the Standard Wedge Properties dialog box, select the Motorized check
box. The two motorized wedges will have different limits for jaw positions.

4. In Beam Configuration, create a motorized wedge and an enhanced dynamic
wedge.

5. Match and assign the wedge add-ons. Match the enhanced dynamic wedge to the
wedge that has the Enhanced check box selected in RT Administration.

2 More information on the Elekta OmniWedge: M.H. Phillips et al.: Dynamic and omni
wedge implementation on an Elekta SL linac. Medical Physics 27, 1623—1634, 2000.
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Siemens Virtual Wedge Parameters

With Siemens Virtual Wedges (SVW), like Varian Enhanced Dynamic Wedges
(EDW), the angled dose distribution is created by moving the collimators during
beam-on3. Although the source model configuration program does not need the
virtual wedge parameters, they are used in dose calculation to produce the angled
dose distribution.

In treatment planning, virtual wedges are used in the same way as an EDW. Eclipse
is capable of calculating virtual wedge angles of 0–60°. The source model is able to
calculate the virtual wedge in both the FX and FY-directions, but this may not be
possible for the accelerator.

The Siemens Virtual Wedge parameters are listed in the table.

Table 21 SVW Parameters

Parameter Description

Effective linear attenua-
tion coefficient [1/cm]

Effective linear attenuation coefficient (supplied by Siemens) of
the virtual wedge for the nominal beam energy. Fluence across the
field can be expressed with the formula g x = ec ∙ μ ∙ x ∙ tanα , where c
= attenuation correction factor, μ = effective linear attenuation co-
efficient, x = position away from the central axis and α = desired
wedge angle. The unit is 1/cm.

Attenuation correction
factor

Correction factor (supplied by Siemens) to accurately specify the
linear attenuation for the specific accelerator and energy. The same
attenuation factor has to be configured for the virtual wedge as is
used in the accelerator.

Maximum overtravel for
X-jaws [mm]

Used for calculating the size of the gap for larger fields when
using a FX-direction virtual wedge. This parameter is 5 mm
smaller than the normal overtravel distance, meaning that the
overtravel of the virtual wedge in the FX direction is by default
15 mm. You can check the overtravel in your Siemens treatment
machine and change the value in Beam Configuration accordingly.

Maximum overtravel for
Y-jaws [mm]

Used for calculating the size of the gap for larger fields when
using a FY-direction virtual wedge. This parameter is 5 mm
smaller than the normal overtravel distance, meaning that the
overtravel of the virtual wedge in the FY direction is by default
95 mm.

3 More detailed discussion on Siemens Virtual Wedge: J. P. C. van Santvoort:
Dosimetric evaluation of the Siemens Virtual Wedge. Physics in Medicine and Biology
43, 2651–2663, 1998.
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Parameter Description

Minimum gap [mm] Before delivering a field using a virtual wedge, the dynamic jaw is
moved close to the opposing static jaw. When the beam is turned
on, the jaws remain static for the first few MU to create a sharper
edge at the toe of the wedge. The minimum gap defines the min-
imum width of the gap left between the jaws before the delivery
of the field.

Compensator Parameters

The parameters required by compensator configuration are listed in the table.

Table 22 Compensator Parameters

Parameter Description

Attenuation curve for
compensator material

The attenuation curve for a compensator material. If Brass, Cer-
robend, Al or Cu are selected, the corresponding default attenua-
tion curve is used. For any other attenuation curves, also the at-
tenuation curve data must be imported using the Read from file
command.

Attenuation curve data A user-defined attenuation curve data for the compensator. Define
the full path to the data file for importing the user-defined attenua-
tion curve data. The data is read from the file when the compen-
sator configuration is performed. Once the data is read from the
file, this text box is cleared.

The attenuation curve data file must be a text file containing two
columns separated by a space. The first column is for the energy
(in MeV), the second column is for the mass attenuation coefficient
μ/ρ (in cm2/g). For each energy value, only one mass attenuation
value is allowed. An example of the attenuation curve data file: 
Compensator Attenuation Curve Data File Format on page 314.

The mass attenuation curve data can be obtained from: http://
www.nist.gov/pml/data/xraycoef/index.cfm

Compensator mass den-
sity [g/cm3]

Mass density of the compensator. This affects the beam hardening
properties of the compensator.

Compensator thickness
[mm]

Thickness of the flat compensator used in configuration measure-
ments, expressed in millimeters.

Source-to-compensator
tray distance [mm]

Distance from the source to the compensator tray, expressed in mil-
limeters. The value has to match the source-to-tray distance value
shown in the Slot section of the Compensator Properties dialog
box.
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Parameter Description

Compensator mounting
position

The value can be either PATIENT_SIDE or SOURCE_SIDE. In the
Tray section of the Compensator Properties dialog box, the values
are:

Selected Above tray check box: SOURCE_SIDE.

Unselected Above tray check box: PATIENT_SIDE.

Beam hardening correc-
tion factor for EAC
[1/cm2]

Beam hardening correction factor (bhcf) is an optional parameter
to modify EACs for compensator thickness values that deviate
from the configuration thickness. By default the value is 0.0.

The compensator modifies the fluence as:

Equation 4

a = b x exp[-c x [d+e x (c-f)]]

where   

a = Fluence with compensator at (x, y)

b = Fluence without compensator at (x, y)

c = Compensator thickness at (x, y), expressed in cm

d = Effective attenuation coefficient (EAC) for the given field size interpo-
lated from the calculated EAC values defined in Beam Configuration, ex-
pressed in 1/cm

e = Beam hardening correction factor for EAC, expressed in 1/cm2

f = Thickness of the flat compensator used in configuration measurements,
expressed in cm

Output Factor Parameters

In addition to the output factors for different field sizes (Table 6 on page 50), the
following parameters are used in Beam Configuration to determine the geometry
used in the output factor measurements:
■ Source-Phantom Distance [mm]—Distance from the treatment unit source to the

surface of the phantom during the output factor measurements.
■ Detector depth from phantom surface [mm]—Distance from the surface of the

phantom to the dose detector during the output factor measurements.

Note: In order for Beam Configuration to be able to handle non-integer centimeter field sizes, the
output factors for the Elekta Beam Modulator head must be imported with the Import  > Output
Factors for Elekta Beam Modulator command.
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Machine Parameter Library for Photon Beams

The installation of AAA and Acuros XB includes a library containing parameters that
describe the treatment unit type and energy. These parameters are used in and have a
significant effect on the optimization of machine parameters. The parameters may
also contain initial guesses for some treatment unit parameters.

The library parameters are used as input in the configuration, and the parameter
values read from the library are shown in Beam Configuration. The parameter values
read from the library may be different for different manufacturers and energies.

The source model machine parameter library contains initial guesses for the
following machine parameters:
■ Photon energy spectrum
■ Mean radial energy
■ Location of the virtual second source, the X and Y collimator jaws and the MLC

device
■ Intensity, energy and size of the virtual second source
■ Material of the flattening filter (The material is None for flattening filter free

beams)

Absolute Dosimetry Parameters in Varian Eclipse Beam Data

The table describes the absolute dosimetry parameters used for the Varian Eclipse
Beam Data. The reference dose at calibration depth and Reference MU at calibration
depth parameters must be adjusted to reflect the machine specific calibration.

The Varian Eclipse Beam Data defines the output factor table in the isocentric field
geometry. It is recommended to use this same geometry for the configuration of
absolute dosimetry, in which case the parameter values in the table should be used
for all energies.

Table 23 Absolute Dosimetry Parameters

Parameter Energy Value

Absolute Dose Calibration Source-Phantom Dis-
tance [mm]

6, 10, 15 MV,
6 MV SRS

950

18, 20 MV 900

Absolute Dose Reference Field Size [mm] 6, 10, 15 MV,
6 MV SRS

100

18, 20 MV 100
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Parameter Energy Value

Absolute Dose Calibration Depth [mm] 6, 10, 15 MV,
6 MV SRS

50

18, 20 MV 100

Reference Dose At Calibration Depth [Gy] 6, 10, 15, 18, 20 MV,
6 MV SRS

To be measured

Reference MU At Calibration Depth [MU] 6, 10, 15, 18, 20 MV,
6 MV SRS

To be set

Wedges in Varian Eclipse Beam Data

Varian Eclipse Beam Data for photon beams contains 13 sets of measurement data for
each energy mode: one set of measurements for the open field and one set for each of
the 12 different wedges. However, the Varian Eclipse Beam Data for the stereotactic
high dose rate 6 MV energy mode (6 MV SRS) does not contain any data for wedges.

The characteristics of the data are:

■ Open field: Identified with code 00
■ Wedge:

■ Treatment units equipped with an MLC have two slots (upper and lower slot),
and a separate wedge for each slot

■ Treatment units without an MLC have one slot
■ Wedge size for the 15 and 30 degree wedges: 20 and 30 cm in the wedge

direction, 40 cm in longitudinal direction. The sizes of the 45 and 60 degree
wedges in the wedge direction are always 20 and 15 cm, respectively.

The table lists the wedge angles and sizes corresponding to the identification codes
used in the Eclipse Beam Data, grouped into six different wedge sets.

Table 24 Eclipse Beam Data Wedge Angles, Sizes and Codes

MLC Units Non-MLC Units

Angle Size Wedge Code Angle Size Wedge
Code

Upper Wedge Set (20 cm) 20 cm Wedge Set

15° 20 01 15° 20 01

30° 20 02 30° 20 02

45° 20 03 45° 20 03

60° 15 04 60° 15 04
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MLC Units Non-MLC Units

Angle Size Wedge Code Angle Size Wedge
Code

Upper Wedge Set (30 cm) 30 cm Wedge Set

15° 30 09 15° 30 09

30° 30 10 30° 30 10

45° 20 03 45° 20 03

60° 15 04 60° 15 04

Lower Wedge Set (20 cm)    

15° 20 05    

30° 20 06    

45° 20 07    

60° 15 08    

Lower Wedge Set (30 cm)    

15° 30 11    

30° 30 12    

45° 20 07    

60° 15 08    

Configuration Program for Photon Beams
The optimization process used by the photon beam data configuration program is
particularly suitable for model-based algorithms such as the AAA and Acuros XB.
The photon beam source model uses a set of parameters (Machine Parameter Library
for Photon Beams on page 72) to describe the beam characteristics, and, consequently,
the calculated dose distribution in a water phantom. The photon beam configuration
program optimizes these parameters to match the calculated distribution with the
(processed) measured distribution as accurately as possible.
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The optimization process uses an objective function that consists of two terms:
■ Total gamma error4 for the calculated data points with respect to the measured

curves (primary term). This error measure is usable in both low and high dose
gradient regions. The gamma error measure is defined by two scaling constants,
the distance axis unit (3 mm by default) and the relative dose axis unit (1% by
default) (Evaluating Gamma Error Histograms on page 93).

■ Penalty term (secondary term) to, for instance, filter out noise from the profile and
the mean energy curve, or to dampen the effects of certain measurement artifacts.
The penalty function consists of penalties for noise, an increasing mean energy
curve and an increasing intensity profile (outside the field edge), and for
unphysical second source parameters.

The total objective function is a mapping from the parameter set to a single real
number. This objective function can be given to a standard multi-dimensional
optimization routine that returns the set of parameters giving (approximately) the
minimum of the objective function. The source model configuration program uses
Powell’s method5 in the multi-dimensional optimization, and a simple, fast quadratic
optimization for single-dimensional line searches inside Powell’s method.

Due to their nature, parameters related to electron contamination are excluded from
the optimization process. They are optimized separately from the other parameters.
In practice, all regions in the dose distribution with a significant effect from
contaminating electrons are initially excluded from the first optimization round, and
the electron contamination parameters are optimized after that. Finally, the
optimization process is restarted using full measurement data to reach consistency.

Adaptation of Measurements in the Configuration

Prior to the optimization of the machine parameters, the source model configuration
program verifies the measured beam data and adapts the measured values if
possible. You can review the adapted and original measurements in the Beam Data
workspace of Beam Configuration (Evaluating the Configured Source Model Data on
page 92).

The source model configuration program performs the following detections and
adaptations in the following order:

1. No measured diagonal profiles: Optimization stops, you are prompted to import
diagonal profiles.

2. Mandatory field sizes not measured: Configuration stops.

4 Daniel A. Low, William B. Harms, Sasa Mutic, and James A. Purdy: A technique for
the quantitative evaluation of dose distributions. Medical Physics 25 (5), 656–661
(1998).

5 M. J. D. Powell: An efficient method for finding the minimum of a function of several
variables without calculating derivatives. Comp. J. 7 (2), 155–162 (1964).
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3. Depth dose curves or profiles saturate into a constant value before the
measurement ends: These values are removed.

4. Depth dose curves or profiles drop to zero before the measurements end: These
values are removed from the measurements.

5. Profiles measured deeper than the corresponding depth dose curve: Depth dose
curve is extrapolated to the required depth. A notification is issued.

6. X-coordinate of the 50% value deviates from the assumed field edge position:
Profiles with a deviation > 2.5 mm are ignored, and a warning is issued.
Otherwise the profile is shifted by the required amount.

For flattening filter free beams, the field edge position is detected from the
location of the maximum gradient of the profile.

7. Profile tails missing from the measurements:
■ Tails of both profile halves missing (measurements past the X-coordinate

corresponding to the 50% value on the Y-axis)—Profile excluded from the
configuration. A warning message is issued.

■ Tail of one profile missing—Longer profile half is included in the
configuration.

■ Both profile halves fully measured—Maximum gamma error between the
profile halves is calculated. Profiles with gamma error exceeding 1.0 are
ignored, and a warning is issued. Otherwise, the optimization uses the
average of the profile halves.

8. Incorrectly positioned detector (leading to missing scatter in the central field
region): A notification is issued. The profile is ignored at, for instance, r < 10 cm.

This does not apply to flattening filter free beams.
9. Too large dose outside the field in profile tail region: Due to the use of an

incorrect detector, for instance, the dose outside the field edge may become
unphysically large and affect the second source intensity parameter. In this case,
a notification is issued.

10. Selection of field sizes used when optimizing the source model parameters: The
configuration program may use only a subset of the measured field sizes for
depth dose curves and profiles when optimizing the source model parameter
values. If the input data contains more field sizes than in the list of field sizes
below, the configuration program selects input field sizes that are closest to the
listed field sizes. Otherwise, all input field sizes are used in the configuration.
Field sizes smaller than 20 mm are ignored.

Field sizes in Acuros XB configuration:

Machine Field Sizes in mm

Elekta Beam Modulator 24.0 40.0 56.0 80.0 104.0 160.0 210.0

Novalis 20.0 30.0 40.0 60.0 80.0 100.0  
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Machine Field Sizes in mm

Other machine types 20.0 40.0 60.0 100.0 200.0 400.0  

Field sizes in AAA configuration:

Machine Field Sizes in mm   

All machines 20.0 30.0 40.0 60.0 80.0 100.0 150.0 200.0 250.0

300.0 350.0 400.0       

11. Selection of field sizes for the collimator backscatter table for Elekta Beam
Modulator: To select the X- and Y-field sizes for the CBSF table for the Elekta
Beam Modulator, the field sizes found in the output factor table are used if there
are less than 9 X-field sizes and 8 Y-field sizes. However, field sizes smaller than
24 mm in either X- or Y- direction are not selected. If the number of field sizes in
output factor table is greater, the field sizes closest to the field sizes in the
following list are selected from the output factor table.

X-field sizes in mm
(IEC61217)

24.0 32.0 40.0 56.0 80.0 104.0 120.0 160.0

210.0        

Y-field sizes in mm
(IEC61217)

24.0 32.0 40.0 56.0 80.0 104.0 120.0 160.0

12. Selection of field sizes for collimator backscatter table for machines other than
Elekta Beam Modulator: The field sizes from the following list that are between
the smallest and the largest field size found from the output factor are selected.

Field Sizes in mm

20.0 30.0 50.0 70.0 100.0 150.0 200.0 300.0 400.0

In addition, the smallest field size in the output factor table is added in case it
differs by 5 mm or more from the otherwise smallest field size in the list. Also,
the largest field size in the output factor table is added in case it differs by 50 mm
or more from the otherwise largest field size in the list.

For severe errors in the measurement data, a notification is issued about the error, the
severity of the error, and whether the corresponding curve was ignored in the
configuration. Warnings are also issued if the maximum field size in both directions
is not used for wedge fields.
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Source Model Configuration Steps

Measurements for all field sizes are used in the configuration process to determine
the optimal parameter values. The steps are shown in the Calculate Beam Data dialog
box, in which you select the items to be calculated. (More information on the step file:
Beam Configuration Reference Guide.)

You can perform all of the configuration steps at once (complete configuration) or
any selected steps one at a time for the selected add-on. You can modify the initial
guesses for the machine parameters fetched from the library in the configuration
parameters (Configuration Parameters for Photon Beams on page 57) or by using the
Curve Editor tool in Beam Configuration.

The source model beam data is calculated for each add-on separately in configuration
steps.

Note: The calculation of configured beam data in Beam Configuration modifies the values of
some of the parameters. The configured Mean radial energy, Spectrum, Intensity profile and
Second source parameters are retained as initial values if the configuration is performed
several times (unless the parameters are re-fetched from the library).

Configuration Steps for Open Field

The source model beam data is calculated for the open field add-on in the following
configuration steps:

1. Get parameters from machine data library. Creates initial guesses for the
configuration. Mean radial energy, intensity profile, second source parameters,
electron contamination, and spectrum are set to machine-specific default values.
These values are not yet configured to match the measurements.

2. Configure open beam (complete configuration). This is the recommended method.
Optimizes the Mean Radial Energy, Intensity Profile, Spectrum and second
source parameters by minimizing the gamma error, configures Electron
Contamination curve and Sigmas, and calculates the absolute dose parameters
and the CBSF table.

3. Partial configuration steps. Each of the partial configuration steps can be run
either one at a time or as a sequence to consume less of your computer memory.
Selecting all of the partial configuration steps produces the same result as
running the first configuration step only.
■ Partial configuration 1 (optimize open beam parameters).
■ Partial configuration 2 (absolute dosimetry).
■ Partial configuration 3 (CBSF table).

4. Calculate error histogram.
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The following parameters must be defined and the following measured data
imported before performing the configuration steps:
■ General Parameters (nominal energy, source-axis distance, source-phantom

distance)
■ Parameters: Absolute dose parameters, machine type, target spot parameters, leaf

transmission (for Elekta Beam Modulator)
■ Open Beam Parameters (automatically fetched from the library if not found)
■ Measured diagonal profiles (DPR)
■ Measured depth doses (OPD)
■ Measured profiles (OPP)
■ Output factor table, or Output factor table for Elekta Beam Modulator
■ Absolute point doses. Required for Elekta Beam Modulator, recommended for all

Elekta machines, optional for other machine models and vendors.
■ Spectrum (automatically fetched from the library if not found)
■ Intensity Profile (fluence map). Can be obtained by running the configuration step

“Get machine parameters from library”. This step uses the shallowest measured
diagonal profile as an initial guess.

■ Mean radial energy. Can be obtained by running the configuration step “Get
machine parameters from library”

■ Electron Contamination. Can be obtained by running the configuration step “Get
machine parameters from library”. This step creates an initial guess which
attenuates from the surface value 1e-15 to value 0 at the depth of 8 cm.

Configuration Steps for Hard Wedges

All open field configuration steps must be performed before configuring wedges.

The source model beam data is calculated for the hard wedge add-ons in the
following configuration steps:

1. Configure hard wedge (all steps). 
Optimizes the relative intensity and energy of the wedge scatter source and the
wedge transmission curve, and calculates the absolute dose parameters and the
CBSF table.

2. Configure wedge transmission, scatter and electron contamination
3. Configure absolute dosimetry
4. Configure wedge correction factor table
5. Optional: Configure wedge correction factors for different SSDs

The following parameters must be defined and the following measured data
imported before performing the wedge configuration steps:
■ Hard wedge parameters (Table 17 on page 65)
■ Measured wedge depth doses (WDD)
■ Measured wedge profiles (WDP)
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■ Measured wedge longitudinal profile (WLP)
■ Measured output factor table for the wedge
■ Optional: Measured depth doses for different SSDs and a point dose

measurement in absolute scale for each curve. These affect electron contamination
and wedge scatter.

Configuration Steps for Compensators

All open field configuration steps must be performed before configuring
compensators.

The source model beam data for compensator add-ons is calculated in a single
configuration step:
■ Configure physical compensator

The following parameters must be defined and the following measured data must be
entered before performing the compensator configuration:
■ Compensator parameters (Table 22 on page 70)
■ Compensator calibration measurements: Point doses for five square fields with

and without a slab of compensator material (Required Measurements for
Compensator Fields on page 54).

Beam Data Generated for Open Fields

The source model configuration program generates the following data for open field
add-ons:
■ Mean radial energy curve
■ Intensity profile curve
■ Spectrum
■ Electron contamination curve and parameters for the electron contamination
fluence kernel (Equation 16 on page 104):
■ Electron contamination curve—Describes both electron and photon

contamination (photon scatter from contaminant electrons or collimator
leaves).

■ Sigma parameters—Sigma0 and Sigma1 smoothing factors (size of the
Gaussian) for the electron contamination, Relative fraction of Sigma0
parameter

The exact values of the electron contamination sigma parameters are sensitive
to changes in the dose calculation algorithm and fluctuations in the measured
depth dose curves. Thus, the sigma values may change between the algorithm
versions. More information: Modeling of the Electron Contamination on
page 42.
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■ Gamma error histograms

■ PDD before dmax—Histogram of gamma error values of depth dose curves
before the dose maximum, expressed as a percentage of the measurement
points.

■ PDD after dmax—For measurement points in the depth dose curve after the
dose maximum.

■ Profile in Flat Region—For lateral and diagonal profiles before the field edge.
■ Profile in Field Edge—For lateral and diagonal profiles in the field edge.
■ Profile Outside Field Edge—For lateral and diagonal profiles outside the field

edge.
■ Processed measured diagonal profiles: Profiles possibly modified by the
configuration program. Some curves may be removed (original curves remain
intact).

■ Processed measured depth doses: Curves possibly modified by the configuration
program. Some curves may be removed (original curves remain intact).

■ Processed measured profiles: Profiles possibly modified by the configuration
program. Some curves may be removed (original curves remain intact).

■ Calculated diagonal profiles: Profiles for the same depths as the measured
diagonal profiles.

■ Calculated depth doses for all measured field sizes.
■ Calculated profiles for all measured field sizes and depths.
■ Collimator backscatter factor table: Radiation scattered back towards the

ionization chamber.
■ Open Beam parameters: Second source size, intensity, and energy.
■ Model parameters: Calculated absolute dose scaling factor.

Beam Data Generated for Wedge Fields

The source model configuration program generates the following data for hard
wedge and motorized wedge add-ons:

■ Wedge parameters

■ Calculated absolute dose in water (Gy) at the calibration depth.
■ Wedge scatter source intensity
■ Energy of the wedge scatter source

■ Wedge transmission curve: Relative amount of incident photons that transport
through the wedge without interacting.

■ Wedge electron contamination: Separate electron contamination parameters for
the wedge

■ Wedge correction factors: Corrects the error between the measured and calculated
output factors.
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■ Wedge correction factors for SSD: Created, if the last optional configuration step is
performed. Contains scaling factors for electron contamination and wedge scatter
as a function of SSD.

Enhanced Dynamic Wedges have one configuration step, which copies the second
source parameters from open field.

Siemens Virtual Wedges do not require configured beam data.

For hard wedges, the MU/Gy factor is determined based on separate user-defined
hard wedge values for the absolute dose at the reference point and the MU or timer
setting used.

Beam Data Generated for Elekta Motorized Wedge

The source model configuration program generates the following data for Elekta
motorized wedge:

■ Second source size, energy and intensity
■ Calculated MW parameters: Calculated absolute dose in water (Gy) at the

calibration depth.
■ Wedge transmission curve: Relative amount of incident photons that transport

through the wedge without interacting.
■ Wedge correction factors: Corrects the error between the measured and calculated

output factors.

Beam Data Generated for Compensator

The source model configuration program generates the following data for
compensator:

■ Calculated EACs for five square field sizes.
■ The mass attenuation coefficient curve.

EACs are calculated as follows:

Equation 5

 
EAC = − 1

f log ad
bc

 

where   

a = Measured dose of a compensator field, expressed in cGy/MU

b = Calculated dose of an open field, but using compensator beam hard-
ening, expressed in cGy/MU

82 Eclipse Photon and Electron Algorithms Reference Guide



c = Measured dose of an open field, expressed in cGy/MU

d = Calculated dose of an open field, expressed in cGy/MU

f = Thickness of the flat compensator used in configuration measurements,
expressed in cm

Absolute Dosimetry Parameters

For open fields, Beam Configuration calculates how much dose is deposited at the
reference point used in the configuration geometry (not using normalization). In
addition to this, the MU/Gy factor used by Eclipse to calculate the MU for each field
(Monitor Unit Calculation on page 23), is determined based on user-defined values
for the absolute dose at the reference point and the MU used. For cobalt fields, the
timer setting is determined based on the absolute dose and timer setting at the
calibration date, which is corrected for decay.

The source model configuration program calculates the following AAA and
Acuros XB parameters, and wedge parameters:

Table 25 Calculated AAA and Acuros XB Parameters

Parameter Calculated for Description

Absolute Dose Scaling Factor Open field

Hard wedge

Elekta Motorized Wedge

Is used to define the relationship
between the dose calculated by
the algorithm and the absolute
calibration reference conditions.
Non-modifiable.

Configuration and Measurement Geometries for Photon Beams
The following phantom geometries are used in the photon beam source model
configuration:
■ Measurement geometry for measuring the depth dose and profiles
■ Output factor table geometry for the configuration of CBSF table
■ Absolute dosimetry geometry for the configuration of MU calculation

Measurement Geometry

The measurement geometry for profiles and depth doses is defined in the figure.
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1. Profile measurement depths.
2. SPD
3. Focus.
4. CAX.
5. Depth dose measurement.

Figure 13 Profile Measurement Geometry

In the profile measurement geometry:
■ SPD is the Source-Phantom Distance in General Parameters in Beam
Configuration (General Parameters on page 57).

■ Measurement depths (d) are the 1st to 5th profile depths in General Parameters
(General Parameters on page 57).

Output Factor Geometry

The expected geometry for output factor measurements is defined in the figure.
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1. SPD
2. Focus.
3. CAX.
4. Measurement point.

Figure 14 Output Factor Geometry

In the output factor geometry:
■ SPD is the Source-Phantom Distance in the output factor table. The isocenter

location depends on the SAD.
■ Measurement depth (d) is the Detector Depth in the output factor table (Output

Factor Parameters on page 71).
■ Reference field size is the value of the Absolute Dose Reference Field Size

parameter in the AAA and Acuros XB Parameters (AAA and Acuros XB
Parameters on page 59).

Absolute Dosimetry Geometry

The geometry for the configuration of the absolute dosimetry is defined in the figure.
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1. Focus.
2. CAX.
3. Isocenter.
4. Measurement point.
5. SPD

Figure 15 Absolute Dosimetry Geometry

For the absolute dosimetry configuration:
■ Measurement depth (d) is the value of the Absolute Dose Calibration Depth

parameter in the AAA and Acuros XB parameters.
■ Reference field size is the value of the Absolute Dose Reference Field Size

parameter in the AAA and Acuros XB Parameters.

Configuring Photon Beams in Beam Configuration
The source model for AAA and Acuros XB can be configured by importing measured
beam data into Eclipse, or by using CadPlan or Eclipse beam data, or by using Varian
Eclipse Beam Data. Acuros XB can also be configured by importing the configured
AAA beam data and reconfiguring, and vice versa.
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Measured beam data can be imported into Beam Configuration in ASCII format
(w2CAD beam data), CadPlan format (data previously configured in CadPlan), or
Eclipse beam data.

Configure the AAA or Acuros XB Using Measured ASCII Beam Data

1. In Beam Configuration, go to the Beam Data workspace. Instructions on how to
use the Beam Configuration: Eclipse online help system or Beam Configuration
Reference Guide.

2. Add new beam data.

The Parameters file of the algorithm is read.
3. Verify the validity of the treatment unit parameters, model parameters and other

parameters. More information on the parameters: General Parameters on page 57.
4. In the Focus window, right-click an add-on and choose Import  > Measured <nn.
5. In the Look in list box of the dialog box that opens, navigate to the folder

containing the files to be imported and click OK to start the import.

If you notice errors in the measured data, stop the import process. Trace the
source of the error to a problem in the measured data, and correct the measured
data before resuming the import procedure.

6. Repeat steps 4 and 5 for each type of measured beam data to be imported.
7. When you have added all necessary measured beam data, calculate the
configured beam data:

a. To calculate the configured beam data for all add-ons in a therapy unit, go to
the Focus window, select the therapy unit and then choose Beam Data  >
Calculate All Beam Data.

b. To calculate the configured beam data for each individual add-on at a time,
go to the Focus window, select each add-on for which you wish to calculate
configured beam data, and choose Beam Data  > Calculate Beam Data. Then,
in the Calculate Beam Data dialog box, select the check boxes of each item
you wish to calculate.

Remember to save and approve your configured beam data. Validate the
configured beam data in the Beam Analysis workspace. If you need to
continue the configuration after validating the data, unapprove the data first.
Instructions for approving, validating and unapproving beam data: Beam
Configuration Reference Guide.
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Configure the AAA or Acuros XB Using CadPlan Beam Data

Note: Use this method to import the measured beam data of an existing configured PBC model for
the configuration of the AAA or Acuros XB.

1. In Beam Configuration, go to the Beam Data workspace. Instructions on how to
use Beam Configuration: Eclipse online help system or Beam Configuration
Reference Guide.

2. Add new beam data.

The Parameters file of the algorithm is read.
3. Verify the validity of the treatment unit parameters, model parameters and other

parameters. More information on the parameters: General Parameters on page 57.
4. In the Focus window, right-click an add-on and choose Insert  > New Measured

<nn>.
5. Repeat step 4 for each type of measured beam data.
6. In the Focus window, right-click a measured beam data item and choose Import

CadPlan Measurement Data File.
7. In the Look in list box of the dialog box that opens, navigate to the folder

containing the files to be imported, select the beam data file and click Open.
8. Repeat steps 6 and 7 for each type of measured beam data.
9. When you have imported all necessary measured beam data, calculate the
configured beam data for the add-ons.

a. In the Focus window, click each add-on for which you wish to calculate
configured beam data, choose Beam Data  > Calculate Beam Data.

b. In the Calculate Beam Data dialog box, select the check boxes of each item
you wish to calculate.

Remember to save and approve your configured beam data. Validate the
configured beam data in the Beam Analysis workspace. If you need to
continue the configuration after validating the data, unapprove the data first.
Instructions for approving, validating and unapproving beam data: Beam
Configuration Reference Guide.

Configure the AAA or Acuros XB Using Existing Eclipse Beam Data

1. In Beam Configuration, go to the Beam Data workspace. Instructions on how to
use Beam Configuration: Eclipse online help system or Beam Configuration
Reference Guide.

2. Add new beam data.

The Parameters file of the algorithm is read.
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3. Verify the validity of the treatment unit parameters, model parameters and other
parameters. More information on the parameters: General Parameters on page 57.

4. In the Focus window, select the treatment unit and then choose File  > Import >
Eclipse Beam Data.

5. To navigate to the directory containing the Eclipse beam data, click Browse. The
active directory is shown in the Eclipse data box.

Navigate to the level of general data files of the calculation model. This level is
above the folders containing the configured beam data files. For instance, the
general data folder may be named “AAA”, and the configured data folders below
it “000”, “001”, “002”, and so on. You should navigate to the folder named
“AAA” in this example.

6. In the list box on the left, select the data set containing the Eclipse beam data to
import.

7. In the Into beam data box, define a name for the beam data.
8. Click OK.

The Eclipse beam data appears in the Context window.
9. Match and assign the add-ons.

10. When you have imported all necessary measured beam data, calculate the
configured beam data for the add-ons.

a. In the Focus window, click each add-on for which you wish to calculate
configured beam data, and choose Beam Data  > Calculate Beam Data.

b. In the Calculate Beam Data dialog box, select the check boxes of each item
you wish to calculate.

Remember to save and approve your configured beam data. Validate the
configured beam data in the Beam Analysis workspace. If you need to
continue the configuration after validating the data, unapprove the data first.
Instructions for approving, validating and unapproving beam data: Beam
Configuration Reference Guide.

Configure the Acuros XB Using AAA Beam Data

When configuring the Acuros XB, you can either start from the measured beam data,
or import the existing AAA beam data and reconfigure.

1. Import the AAA beam data for Acuros XB by choosing File  > Import > Eclipse
Beam Data.

2. Select the Open Field and choose Beam Data  > Calculate Beam Data.
3. Select each wedge one at a time and choose Beam Data  > Calculate Beam Data,

if applicable.
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Configuring the AAA or Acuros XB Using Varian Eclipse Beam Data

Varian Eclipse Beam Data is provided by Varian at the installation of the calculation
algorithm. Using this beam data, you only need to do minimal manual configuration
in Beam Configuration to match and assign your add-ons (open field, wedges and
Enhanced Dynamic Wedge). You can also modify the beam data manually.

If you are using Varian Eclipse Beam Data without any modifications to the
parameter values or without using your own measured beam data, you only need to
enter the absolute dosimetry parameters (AAA and Acuros XB Parameters on
page 59 and Hard Wedge Parameters on page 65) and verify the parameters
contained in the beam data; no changes are required unless the parameter values are
clearly incorrect.

The preconfigured Varian Eclipse Beam Data for AAA and Acuros XB were acquired
with a Wellhofer IC-10 ionization chamber following standard protocols used at the
Varian factory for verification of specifications. This is documented in “Varian High
Energy Clinac Machine Configuration and Beam Tuning Specification for the
CadPlan Preload Beam Data”. However, the percent depth doses in the
preconfigured beam data are corrected for the effective depth of measurement by
shifting them 1.8 mm closer to the surface.

Varian Eclipse Beam Data is representative for a Varian high energy clinac accelerator
conforming to the specifications detailed in Sections 1.0 and 2.0 of “Clinac 21/23EX
Equipment Specification” (RAD 4205) and “Clinac Beam Matching” (RAD 2055).

The data is valid only for:

■ 2100-series (C, CD, EX, etc.) S/N 865 or higher
■ 2300-series (CD, EX) S/N 146 or higher
■ All iX and Trilogy

Compare the dosimetric beam data acquired from the treatment machine at the
site with the dosimetric beam data used in the configuration of the preconfigured
beam data, and ensure that the variations do not exceed the user tolerance. If
variations exceed the tolerance, use the dosimetric beam data acquired at the site
for calculation algorithm configuration.

Configure the AAA or Acuros XB Using Varian Eclipse Beam Data

1. In Beam Configuration, go to the Beam Data workspace. Instructions on how to
use Beam Configuration: Eclipse online help system or Beam Configuration
Reference Guide.

2. Add new beam data.

The Parameters file of the algorithm is read.
3. Verify the validity of the treatment unit parameters, model parameters and other

parameters (General Parameters on page 57).
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4. In the Focus window, right-click the treatment unit and then select Import
Eclipse Data to add Varian Eclipse Beam Data.

5. Navigate to the directory on the server where the beam data is installed
(normally \\<Server name>\DCF$\client\PreconfiguredBeamData
\Anisotropic Analytical Algorithm (<version number>) and \
\<Server name>\DCF$\client\PreconfiguredBeamData
\Acuros External Beam (<version number>))

6. Select the desired beam data and click OK.
7. Match and assign the add-ons.

The Varian Eclipse Beam Data identifies wedges in a particular way. Some
absolute dosimetry parameter values must be defined separately. Information on
correctly matching and assigning your wedges: Absolute Dosimetry Parameters
in Varian Eclipse Beam Data on page 72.

a. To match the wedges, select the check box of a hard wedge in the ID column,
and then click Single.

b. In the Automatically Match Add-On Data dialog box, go to the Match list,
select the degree corresponding to the selected hard wedge, and then click
OK.

c. Repeat A. and B. for each hard wedge you want to configure.
d. To match an Enhanced Dynamic Wedge, click EW in the ID column, go to the

Automatic Match box and click Single.
e. Click Close.

Remember to save and approve your configured beam data. Validate the
configured beam data in the Beam Analysis workspace. If you need to
continue the configuration after validating the data, unapprove the data first.
Instructions for approving, validating and unapproving beam data: Beam
Configuration Reference Guide.

Modify AAA or Acuros XB Beam Data Configured Using Varian Eclipse Beam Data

1. In the Focus window, select Parameters under the treatment unit that contains
your configured Varian Eclipse Beam Data.

2. To modify the absolute dosimetry parameters, click on the cell of the parameter
to be modified and type in your new parameter value.

3. Calculate the configured beam data for the add-ons.
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a. In the Focus window, click each add-on for which you wish to calculate
configured beam data, and choose Beam Data  > Calculate Beam Data.

b. In the Calculate Beam Data dialog box, select the check boxes of each item
you wish to calculate.

Remember to save and approve your configured beam data. Validate the
configured beam data in the Beam Analysis workspace. If you need to
continue the configuration after validating the data, unapprove the data first.
Instructions for approving, validating and unapproving beam data: Beam
Configuration Reference Guide.

Evaluating the Configured Source Model Data
The configured source model data for AAA and Acuros XB can be visually verified in
Beam Configuration.

Evaluating Electron Contamination Curve for Open Beam and Hard Wedges

The source model configuration program produces the electron contamination curve
and the Sigma parameters related to this curve.

The electron contamination curve defines the values to be added to the non-
normalized results of the dose calculation at each depth. Electron contamination is
also used to model photon contamination (photons created in electron interactions).
The electron contamination curve is defined by value pairs (<depth in mm>,
<laterally integrated electron contamination dose>). The depth values should always
be positive and in an ascending order. The electron contamination curve usually
peaks at appr. 0.5 mm at the surface, and falls rapidly close to zero within
approximately 50 millimeters (depending on the energy).

The Sigma parameters are smoothing factors for the electron contamination. The
value of the Sigma parameters are always positive, and the value range is wide.
Large values produce less electron contamination for small field sizes and spread the
electron contamination more in the lateral direction. The coefficient c0 specifies the
relative weight of the first Gaussian, which is always between 0 and 1.

Evaluating the Collimator Backscatter Factor Table

The collimator backscatter factor table (CBSF) contains the backscatter factors for the
same field sizes as output factor measurements. The horizontal rows define the field
size in the X-direction (positive); columns define the field size in the Y-direction
(positive). These values are > 1 for field sizes smaller than the reference field size, and
< 1 for larger field sizes (always positive). Generally, the CBSF-values remain within a
few percents of 1.0.
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Note: It has been observed that the above does not generally hold for the smallest field sizes (1
cm × Y and X × 1cm). Beams with SRS flattening filter are also exceptional in that the values
are < 1 for field sizes smaller than the reference field size.

Evaluating Wedge Transmission Curve

The wedge transmission curve is defined by value pairs (<distance in mm on wedge
axis>, <relative wedge transmission>). The maximum value on the curve is scaled to
1.0, and the relative wedge transmission values are > 0. The distance values can be
negative or positive, but they are always in ascending order.

Evaluating the Energy Spectrum

The energy spectrum curve is usually peaked at very low energies. The curve is
defined by value pairs (<energy in MeV>, <particle fluence>). The curve is initially
fetched from the machine library and a scaler for the energy axis is optimized during
the configuration process. You can check that the highest energy in the curve roughly
corresponds to the nominal energy (exact match should not be expected).

Evaluating the Radial Energy

The radial energy curve determines the average energy curve of photons after the
flattening filter, which attenuates low-energy components of the spectrum. Usually
the energy decreases smoothly when moving from the field central axis (radial
distance 0.0 mm) to the field edge. The mean radial energy curve is defined by value
pairs (<radial distance at SAD in mm>, <energy in MeV>), in which the values are
positive and in an ascending order.

Evaluating Gamma Error Histograms

Evaluating gamma error histograms is available only for AAA. Using the fully
configured source model, the gamma error6 is calculated for each processed
measurement curve by comparing it with calculated points. For this purpose, the
measured and calculated curves are superimposed to the same graph, in which the
X-axis corresponds to position (mm) and the Y-axis to relative dose (%) as in the
figure.

6 Daniel A. Low, William B. Harms, Sasa Mutic, and James A. Purdy: A technique for
the quantitative evaluation of dose distributions. Medical Physics 25 (5), 656–661
(1998).
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1. Relative dose %
2. Off-axis distance (mm)
3. Point closest to calculated point
4. Measured curve
5. Gamma = 1
6. Calculated point

Figure 16 Definition of Gamma Error Norm

In the figure, the continuous line represents the measured profile, the black dot and
the grey dot indicating the calculated point and the point closest to it on the
measured curve, respectively. For the gamma metric, the unit of measurement of the
off-axis distance is 3 (mm), and the unit of measurement of the relative dose
difference is 1 (%). The area surrounding the calculated point in which the calculated
gamma norm is 1 or smaller is shown with an ellipse. The resulting gamma error is
approximately 1.33.

For at least 99% of the measurement points in the Varian Eclipse Beam Data for the
AAA, the gamma error norm is lower than 1.0.
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Chapter 5    Anisotropic Analytical Algorithm (AAA)
for Photons

About the Anisotropic Analytical Algorithm (AAA)
The AAA is a 3D pencil beam convolution/superposition algorithm that uses
separate Monte Carlo derived modeling for primary photons, scattered extra-focal
photons, and electrons scattered from the beam limiting devices. The lateral dose
deposition characteristics are modeled with six exponential curves. The functional
shapes of the fundamental physical expressions in the AAA enable analytical
convolution, which significantly reduces the computational time.

The AAA was originally conceived by Dr. Waldemar Ulmer7,8,9 and Dr. Wolfgang
Kaissl10,11. The development of the algorithm culminated in the publication of the
triple-Gaussian photon kernel model in 199512.

Before being implemented in Eclipse, the AAA approach has been applied to
stereotactic radiation therapy planning13. The implementation of the AAA in Eclipse
continues the research and development of the algorithm and is based on the earlier
work by Ulmer and Kaissl.

Important improvements have been made to the AAA dose calculation algorithm in
the areas of treatment unit and tissue heterogeneity modeling, and increasing the
accuracy of the scattered dose calculation14.

7 Max-Planck-Institut für Biophysik, Göttingen, Germany.
8 Ulmer W, Harder D: A Triple Gaussian Pencil Beam Model for Photon Beam

Treatment Planning, 2. Medical Physics 5 (1995) 25–30.
9 Ulmer W, Harder D: Applications of a Triple Gaussian Pencil Beam Model for

Photon Beam Treatment Planning, 2. Medical Physics 6 (1996) 68–74.
10 Varian Medical Systems Imaging Laboratory GmbH, Baden, Switzerland.
11 Ulmer W and Kaissl W: The inverse problem of a Gaussian convolution and its

application to the finite size of the measurement chambers/detectors in photon and
proton dosimetry. Physics in Medicine and Biology 48 (2003) 707–727.

12 Ulmer W, Harder D: A Triple Gaussian Pencil Beam Model for Photon Beam
Treatment Planning, 2. Medical Physics 5 (1995) 25–30.

13 Ulmer W, Brenneisen W: Application of an Analytical Pencil Beam Model to
Stereotactic Radiation Therapy Planning. Journal of Radiosurgery, Vol 1, No.3, 1998.

14 Tillikainen L, Helminen H, Torsti T, Siljamäki S, Alakuijala J, Pyyry J and Ulmer W:
A 3D pencil beam based superposition algorithm for photon dose calculation in
heterogeneous media. Physics in Medicine and Biology 53 (2008) 3821–3839.
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The AAA accounts for tissue heterogeneity anisotropically in the entire three-
dimensional neighborhood of an interaction site, by using photon scatter kernels in
multiple lateral directions (Scatter Kernels). The final dose distribution is obtained by
the superposition of the dose calculated with photon and electron convolutions.

Dose Calculation in the Anisotropic Analytical Algorithm
(AAA)

The clinical implementation of the AAA is divided into:
■ Photon beam source model: Determines the fundamental physical parameters

required for the actual dose calculation (Modeling of the Primary Source on
page 38 and Modeling of the Second Source on page 41).15

■ Dose calculation algorithm: Calculates the dose deposition using the fundamental
physical parameters. These parameters characterize the particle fluences and
energy spectra of the photons and electrons comprising the clinical beam
(Volumetric Dose Calculation on page 99).16

Patient Scatter Model
The patient scatter model is used in depositing the dose inside the patient, while
phase-space parameters give the description of the treatment beam upstream of the
patient. The full treatment beam entering the patient is divided into finite-sized
beamlets, each of which is modeled using several monoenergetic scatter kernels.

Scatter Kernels

The scatter kernels describe the phantom-scatter effects for different beam qualities.
The EGSnrc17 Monte Carlo code was used to compute scatter kernels for
monoenergetic pencil beams in water. A polyenergetic scatter kernel is constructed as
a weighted sum of the monoenergetic scatter kernels. During the 3D dose calculation
these kernels are scaled according to the densities of the actual patient tissues
determined from the CT images.

15 Tillikainen L, Siljamäki S, Helminen H, Alakuijala J and Pyyry J: Determination of
parameters for a multiple-source model of megavoltage photon beams using
optimization methods. Physics in Medicine and Biology 52 (2007) 1441–1467.

16 Tillikainen et al.: A 3D pencil-beam-based superposition algorithm for photon dose
calculation in heterogeneous media. Physics in Medicine and Biology 53 (2008) 3821–
3839.

17 NRCC Report PIRS-701: The EGSnrc Code System: Monte Carlo Simulation of
Electron and Photon Transport, I. Kawrakow and D.W.O. Rogers; Nov 7, 2003.
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Beamlets
The figure shows the geometrical definitions of the coordinates referring to a single
beamlet β on the X–Z plane, with the Y-axis pointing outwards from the paper. The
coordinates are defined in two coordinate systems:
■ Patient coordinate system
■ Beamlet coordinate system

The coordinates of the calculation point (P) in the figure are (X, Y, Z) in the patient
coordinate system, and (x,y,z) in the beamlet coordinate system. The depth
coordinate z is measured from the intersection point of the central fanline and the
skin in the beamlet coordinate system.

Chapter 5    Anisotropic Analytical Algorithm (AAA) for Photons 97



1

3

2

4

5

6
7

8

1. Field focus

2. Central fanline β
3. Beamlet coordinate system

4. Skin

5. Calculation point P

6. Patient coordinate system

7. Beamlet β
8. Field central axis

Figure 17 Coordinates in Patient Coordinate System and Beamlet Coordinate System on X–Z
Plane

The broad clinical beam is divided into finite-size beamlets β. The side length of the
beamlet corresponds to the resolution of the calculation grid on the isocenter plane.

The dose calculation is based on the convolutions over the beamlet cross-sections
separately for the primary photons, extra-focal photons (second source), scatter from
hard wedges, and for electrons contaminating the primary beam. The dose is
convolved by using the physical parameters defined for every beamlet β.
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All depth-dependent functions used in the beamlet convolutions are computed along
the central fanline of the beamlet using the depth coordinate z. Lateral dose
scattering due to photons and electrons is defined on the spherical shell
perpendicular to the central fanline of the beamlet. The AAA makes the assumption
that the dose resulting from photon and electron scatter can be calculated by a
division into two main directions, which are the lateral and the depth scatter. As can
be seen in the figure, the lateral calculation plane has a spherical shape, where the
center of the sphere is located in the field focus. The use of spherical coordinate
systems allows us to use more uniform models of the pencil beams across the broad
beam.

The dose to an arbitrary calculation point (X, Y, Z) in the patient is obtained by
summing up the dose contributions of all individual beamlets β of the broad beam in
the final global superposition.

Volumetric Dose Calculation
For volumetric dose distribution calculation, the patient body volume is divided into
a matrix of 3D calculation voxels based on the selected calculation grid (Figure 7 on
page 36). The geometry of the calculation voxel grid is divergent, aligning the
coordinate system with the beam fanlines. Every calculation voxel is associated with
the mean electron density ρ that is computed from the patient CT images according
to a user-specified calibration curve. The maximum allowed value for electron
density in AAA is 15. Electron densities larger than that are truncated to the
maximum value (that is, value of 15 is used).

Note: When a beam traverses lung tissue, the AAA tends to overestimate dose at the lung-soft
tissue interface, where the beams exits the lung and enters soft-tissue again. The effect is more
pronounced as the interface depth increases.

Convolution Models

The 3D dose distribution is calculated from separate convolutions for the primary
photon source, second photon source, wedge scatter source and contaminating
electron source. The convolutions are performed for all finite-sized beamlets that
comprise the clinical broad beam. The final dose distribution is obtained by a simple
superposition of the individual beamlet contributions.
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Photon Dose Calculation

The photon beam attenuation is modeled with an energy deposition density function
Iβ(z,ρ). The photon scatter is modeled with a scatter kernel Kβ(x,y,z) that defines the
lateral energy scattering. Both functions Iβ and Kβ are defined individually for each
beamlet β. The primary and extra-focal photons are calculated in the same way, with
the exception of their spectral composition and the position and size of the focal spot.

The dose convolution in the AAA is performed in terms of energy. In comparison
with dose-based convolution, which is more common, energy convolution allows the
energy to be conserved more accurately even in more complex heterogeneous
convolutions. The energy is converted to dose using the scaled-water approximation.

The energy distribution resulting from an arbitrary beamlet β due to photons in a
sufficiently large homogenous neighborhood is calculated by the following formula:

Equation 6

 
Eph, β X, Y, Z = Φβ × Iβ z, ρ × Kβ X, Y, Z

 

In the convolution, the calculation point (X, Y, Z) is represented by (x,y,z) relative to
the origin of the beamlet coordinate system. The photon fluence Φβ is assumed to be
uniform over the small cross-section of beamlet β.

The energy deposition function Ιβ(z,ρ) denotes the area integral of the deposited
energy over the sphere surface of the pencil beam at depth z.

Equation 7

 
Iβ z = hβ t, v, z  dt dv

 

where   

hβ = poly-energetic pencil beam kernel derived from Monte Carlo simulations
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The energy deposition function Iβ(z,ρ) accounts for tissue heterogeneity by
employing the concept of radiological scaling. This is performed by setting
Iβ z, ρ = Iβ z′ ⋅ ρ 0,0,z

ρwater
 , where the radiological depth z’ is defined as:

Equation 8

 

Z′ =∫
0

Z

ρ 0,0,t
ρwater

dt

 

where   

ρ = electron density

The photon scatter kernel Kβ(x, y, z) is composed of the weighted sum of six
exponential functions (Equation 9 on page 101). Here we assume a homogeneous
phantom. Information on the effect of lateral heterogeneities: Lateral Density Scaling
of the Photon Scatter Kernels on page 102.

Equation 9

 

Kβ x, y, z = ∑
k = 0

5
ck z′ 1

r e
−μkr

 

where r = x2 + y2

 and definition of z’: Equation 8 on page 101.

Here z’ is used instead of z to take into account the effect of heterogeneity between
the calculation point and the beamlet entry point in the scatter properties of the
pencil beam.

The exponential kernels are characterized with the decay constants μk. The factors ck
define the weights for the exponential kernels and ensure the unity normalization of
the total kernel energy. The parameters ck(z’)of the polyenergetic scatter kernel Kβ(x,
y, z) are determined by doing a least squares fit of the basis functions 1

r e
−μkr to the

Monte Carlo derived pencil beam scatter kernels. The constants μk are chosen such
that 1/μk vary from 1 to 100 mm with equal logarithmic intervals.

Note that although the equation above implies that there is a singularity at r = 0, the
actual integral is two-dimensional and does not diverge.
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Lateral Density Scaling of the Photon Scatter Kernels

Density scaling of the individual pencil beams is done by scaling the energy at each
location by the average density between the calculation point and the origin of the
pencil beam.

In practice, this is done by dividing the kernel of the following equation into a finite
number (16) of rays that emerge from the origin. Distribution of absorbed energy at a
location Kβ(x, y, z) in presence of heterogeneity is then calculated as:

Equation 10

 

Kβ x, y, z = ρ x, y, z
ρwater

∑
k = 0

5
ck z′ 1

r e
−μ

k
r

d
x, y, z

 

where   

rd(x, y, ρ) = ∫
R

ρ( t )
ρwater

d t × z′

z

rd = Radiological distance from kernel origin (0,0,z) to (x,y,z) along ray R that
passes through (x,y).

z′
z

= Ratio correcting for the diverging coordinate system.

Heterogeneity History Correction of the Photon Scatter Kernels

Using the previous formulas would result in an overtly abrupt estimation of the
changes in scatter conditions at the borders of heterogeneities in slab-like phantoms.
This is avoided by moving the energy distribution in the depth direction using a one-
dimensional scatter kernel. This takes care of the gradual changes of the scatter
conditions after the heterogeneity borders. But since this transform would result in
moving the dose deeper, this is pre-compensated by applying the reverse transform
to the poly-energetic pencil beam kernel hβ (x,y,z).

The one-dimensional scatter kernel kz(z) is of the following form:

Equation 11

 

k
z

z = ∑
i = 1

2
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1
μ

i

e
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i
z
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The parameters μi and ci are determined using optimization methods such that the Iβ
function calculated for the pre-compensated pencil beam kernel h’β (Equation 14 on
page 103) does not have any build-up.

The one-dimensional convolution of energy Eph,β is then defined as:

Equation 12

 
E′

ph, β
x, y, z = E

ph, β
x, y, z ⊗ k

z
z

 

where   

 ⊗  = Convolution operator

In the presence of heterogeneities, the convolution kernel is scaled by the local
electron density as follows:

Equation 13

 

k
z

z = ρ z
ρ

water
∑

i = 1

2
ci

1
μ

i

e
−μ

i
z′

 

where   

ρ(z) = Local electron density

z’ = Radiological distance from the kernel origin

The pre-compensation to the poly-energetic pencil beam kernel hβ(x,y,z) is of the
following form:

Equation 14

 
h′

β
x, y, z = h

β
x, y, z ⊗ inv k

z
z

 

where   

inv(kz(z)) = Deconvolution kernel derived from kz(z)

The above formulations result in a modified pencil beam h'β(x,y,z), which replaces
the original hβ(x,y,z) (Photon Dose Calculation on page 100). The heterogeneity
history correction method has been defined so that it has no effect in the absence of
heterogeneities.
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Contaminating Electrons

The primary photon beam is contaminated with electrons originating mainly in the
flattening filter, collimating jaws and air. If beam modifiers are used, the modifiers
may absorb most of the electrons in the open beam, but the modifier itself becomes a
secondary source of contaminating electrons. In general, electron contamination
depends strongly on the beam energy and the field size.

The energy distribution resulting from an arbitrary beamlet β due to the
contaminating electrons is calculated by the following equation:

Equation 15

 
Econt, β X, Y, Z = Φcont, β × Icont, β

 

In the above equation, the calculation point X, Y, Z  is represented by (x,y,z) in the
beamlet coordinate system. The electron fluence Φcont,β and the energy deposition
function Icont,β are assumed to be uniform over the cross-section of beamlet β. In the
presence of heterogeneities, the energy deposition function is scaled in a similar way
as the Iβ function for photons.

The fluence of the contaminating electrons is determined by convolving photon
fluence with a sum-of-Gaussians kernel Kfl,e.

Equation 16

 

K
f l, e

x, y = ∑
K = 0

1
Ccont, k

1
2πσcont, k

2 exp − x2 + y2

2σcont, k
2

 

The parameters ck specify the relative weights of the two Gaussian components
where c1 = 1-C0

The energy deposition density function Icont,β(z,ρ) for the contaminating electrons is
determined from the measured data and tabulated as a function of the depth z.
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Superposition

The absorbed energy E X, Y, Z  at an arbitrary calculation point in the patient is
obtained by a superposition of the separate energy contributions from the primary
photons (ph1) (Equation 6 on page 100), extra-focal photons (ph2) (Equation 6 on
page 100), and contaminating electrons (Equation 15 on page 104) from all individual
beamlets denoted by index β:

Equation 17

 

E X, Y, Z =∑
β

  E
ph1,β

X, Y, Z + E
ph2,β

X, Y, Z + E
cont, β

X, Y, Z

 

Conversion to Dose

As a final step, the absorbed energy distribution is converted to a dose. An
assumption is made that the different heterogeneities can be modeled as scaled
water. Electron densities are used to convert the energy to dose instead of mass
density. The final dose is given by:

Equation 18

 

D X, Y, Z = cE X, Y, Z ⋅
ρ

water

ρ X, Y, Z

 

where c handles the unit conversion from J/m3 to Gy.
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Chapter 6    Acuros External Beam Algorithm
(Acuros XB) for Photons

About the Acuros External Beam Algorithm (Acuros XB)
The Acuros XB algorithm was developed to provide accurate and rapid dose
calculations for external photon beam radiotherapy treatments ranging from 4 MV to
25 MV, with calculation grid voxel sizes ranging from 1 to 3 mm. In external photon
beam radiotherapy, heterogeneities introduced by materials such as lung, air, bone
and implants may significantly influence the dose distribution in the patient,
especially in the presence of small or irregular fields. Through solving the linear
Boltzmann transport equation (LBTE), Acuros XB directly accounts for the effects of
these heterogeneities.

Dosimetric comparison of Acuros XB to AAA and Monte Carlo can be found in the
literature18.

Dose Calculation with Acuros XB Algorithm
The LBTE is the governing equation that describes the macroscopic behavior of
radiation particles (neutrons, gamma-rays, electrons, etc.) as they travel through and
interact with matter. For a given volumetric domain of matter, subject to a radiation
source, the solution to the LBTE would give an ‘exact’ description of the dose within
the domain. However, since closed form, or analytic, solutions to the LBTE can only
be obtained for a few simplified problems, the LBTE must be solved in an open form,
or non-analytic, manner.

18 Han et al.: Dosimetric comparison of AcurosXB deterministic radiation transport
method with Monte Carlo and model-based convolution methods in heterogeneous
media. Medical Physics 38 (5), 2651 May 2011.
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There are two general approaches to obtaining open form solutions to the LBTE. The
first approach is the widely known Monte Carlo method, which stochastically
predicts particle transport through media by tracking a statistically significant
number of particles through successive random interactions. Although Monte Carlo
methods do not explicitly solve the LBTE, they do indirectly obtain the solution to
this equation. The second approach is to explicitly solve the LBTE using numerical
methods19. Methods used to explicitly solve the LBTE are relatively new to the
medical physics community, where Monte Carlo and correction based algorithms,
which employ pre-calculated Monte Carlo dose kernels, have generally been used for
dose calculation.

Both Monte Carlo and explicit LBTE solution methods are convergent. That is, with
sufficient refinement both approaches will converge on the same solution. The
achievable accuracy of both approaches is equivalent and is limited only by
uncertainties in the particle interaction (cross-section) data and uncertainties in the
problem being analyzed.

However, in practice, neither Monte Carlo nor explicit LBTE solution methods are
exact, and both methods produce errors. In Monte Carlo, errors are stochastic, and
result from simulating a finite number of particles. When Monte Carlo methods
employ certain techniques to accelerate solution times, however, systematic errors
may also be introduced. In explicit LBTE solution methods, errors are primarily
systematic, and result from discretization of the solution variables in space, angle,
and energy. Additionally, differences may also result from the treatment of charged
particle coulomb interactions, which are generally approximated in both Monte Carlo
and explicit LBTE solution methods.

In both Monte Carlo and explicit LBTE solution methods, a trade-off exists between
speed and accuracy. Reduced computational time may be achieved when less
stringent accuracy criteria are specified, and vice versa.

Overview of Calculation Steps

The Acuros XB dose calculation proceeds according to the following steps:

1. Creating the physical material map.
2. Transporting the components of the photon beam source model (primary photon

source, secondary photon source and electron contamination source) into the
patient.

3. Transporting the scattered photon fluence in the patient.
4. Transporting the electron fluence in the patient.
5. Calculating the desired dose mode (dose to medium, or dose to water).

19 Lewis EE, Miller WF: Computational methods of neutron transport. Wiley, New
York, 1984.
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The following figure describes the steps in the Acuros XB calculation process:

  

Photon Beam Source Model

Step2: Ray Tracing of
Beams into the Patient

Step 3: Scattered Photon
Fluence Calculation

Step 4: Collided Electron
Fluence Calculation

Step 5: Dose Calculation

Eclipse

Figure 18 Acuros XB Calculation Steps

where:

qprimary
γ = Primary photon source (from Photon Beam source model)

qsecondary
γ = Secondary photon source (from Photon Beam source model)

qcontaminant
e = Electron contamination source (from Photon Beam source model)

qunc
γγ = First scattered photon source (produced from primary and secondary

photon sources)
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qunc
γe = First scattered electron source (produced from primary and secondary

photon sources)

qunc
ee = First collided electron source (produced from electron contamination

source)

qcoll
γe = Collided electron source (produced from scattered photon interactions)

Ψcoll
e = Angular electron fluence

DW = Dose to water

DM = Dose to medium

Information on the Photon Beam source model: Chapter 4 Photon Beam Source
Model on page 35. More information on calculation options: Calculation Options on
page 28.

Background of the Acuros XB Algorithm
The impetus behind the development of explicit LBTE solution methods in general
was to provide a rapid alternative to Monte Carlo simulations, which often require
long calculation times. Similarly, many of the methods contained within Acuros XB
were originally developed in a prototype solver as part of research in the X-Division
of Los Alamos National Laboratories. The prototype solver developed at Los Alamos
National Laboratories, called Attila, was co-authored by the founders of Transpire,
Inc20, 21.

20 Wareing TA, McGhee JM, Morel JE, Pautz SD: Discontinuous Finite Element Sn
Methods on Three-Dimensional Unstructured Grids. Nuclear Science and Engineering,
Volume 138, Number 2, July 2001.

21 Wareing TA, Morel JE, McGhee JM: Coupled Electron-Photon Transport Methods on
3-D Unstructured Grids. Transactions of the American Nuclear Society, Washington
D.C., Vol 83, 2000.
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Transpire, Inc. established an exclusive licensing agreement to commercialize the
prototype Attila solver and, since 2002, has continually developed it for commercial
use as a general purpose radiation transport software product. Attila has been
extensively validated for a broad range of applications, including publications
presenting the application of Attila towards external photon beam dose
calculations22, 23. Acuros XB builds upon many of the methods in Attila, but
represents a ground-up solver rewrite in which the methods were adapted and
optimized for external photon beam dose calculations.

Acuros XB Solution Methods
For a spatial domain with volume, V, and surface, δv, Acuros XB solves the time-
independent three-dimensional system of coupled Boltzmann transport equations
(LBTE), which are given by (for brevity the dependent variables have been
suppressed in the equations):

Equation 19

 

Ω ⋅ ∇ Ψ γ + σt
γΨ γ = qγγ + qγ

 

Equation 20

 

Ω ⋅ ∇ Ψ e + σt
eΨ e − ∂

∂E S
R
Ψ e = qee + qγe + qe

 

Equation 21

 
r ∈ V,  Ω ∈ 4π and E > 0

 

where   

22 K. Gifford, J. Horton, T. Wareing, G. Failla, F. Mourtada: Comparison of a finite-
element multigroup discrete-ordinates code with Monte Carlo for radiotherapy
calculations. Physics in Medicine and Biology, May 2006, 7;51(9):2253-65.

23 O. Vassiliev, T. Wareing, I. Davis, J. McGhee, D. Barnett, J. Horton, K. Gifford, G.
Failla, U. Titt, F. Mourtada: Feasibility of a multigroup deterministic solution method
for three-dimensional radiotherapy dose calculations. International Journal of
Radiation Oncology Biology Physics, September 2008, 1;72(1):220-7.
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Ψγ = Angular photon fluence (or flux if not time integrated), Ψ γ( r , E, Ω) , as a
function of position, r = x, y, z  , energy, E, and direction, Ω = μ, η, ζ

Ψε = Angular electron fluence, Ψ e( r , E, Ω)

qγγ = Photon-to-photon scattering source, qγγ( r , E, Ω) , which is the photon
source resulting from photon interactions

qεε = Electron-to-electron scattering source, qee( r , E, Ω) , which is the electron
source resulting from electron interactions

qγε = Photon-to-electron scattering source, qγe( r , E, Ω) , which is the electron
source resulting from photon interactions

qγ = External photon source, qγ(E, Ω) . This source term represents all photons
coming from the machine source model.

qε = External electron source, qe(E, Ω) . This source term represents all elec-
trons coming from the machine source model.

σt
γ = Macroscopic photon total cross section, σt

γ r , E  , units of cm-1

σt
e = Macroscopic electron total cross section, σt

e r , E  , units of cm-1

SR = Restricted collisional plus radiative stopping power, S
R

r , E

Equations (Equation 19 and Equation 20 on page 110) solve for the photon and
electron transport, respectively. These equations (Equation 19 and Equation 20) are
subject to all possible standard boundary conditions on surface, δv. In Acuros XB, all
external surfaces have vacuum or non-reentrant boundary conditions applied:

Equation 22

Ψγ = 0, for Ω ⋅ n < 0 ,

Equation 23

Ψe = 0, for Ω ⋅ n < 0

where   

n = Normal vector to surface δV, pointing outward normal from the
computational grid boundary.

The first term on the left hand side (Equation 19 and Equation 20 on page 110) is the
streaming operator. The second term on the left hand side (Equation 19 and 
Equation 20) is the collision or removal operator. The Boltzmann Fokker-Planck
transport equation (Equation 20) is solved for the electron transport.
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The third term on the left (Equation 20) represents the continuous slowing down
(CSD) operator, which accounts for coulomb ‘soft’ electron collisions. The right hand
side (Equation 19 and Equation 20) represent the scattering, production, and external
source terms. The external source terms, qγ and qe, represent the photons and
electrons output from the photon beam source model, including the primary source,
the second source, and the electron contamination source.

The scattering and production sources are defined by:

Equation 24

 

qγγ( r , E, Ω) =∫
0

∞

dE′∫
4π

dΩ′σs
γγ( r , E′ E, Ω ⋅ Ω′)Ψ γ r , E′, Ω′

 

Equation 25

 

qγe( r , E, Ω) = ∫
0

∞

dE′∫
4π

dΩ′σs
γe( r , E′ E, Ω ⋅ Ω′)Ψ γ r , E′, Ω′

 

Equation 26

 

qee( r , E, Ω) = ∫
0

∞

dE′∫
4π

dΩ′σs
ee( r , E′ E, Ω ⋅ Ω′)Ψ e r , E′, Ω′

 

where   

σs
γγ = Macroscopic photon-to-photon differential scattering cross section

σs
γe = Macroscopic photon-to-electron differential production cross section

σs
ee = Macroscopic electron-to-electron differential scattering cross section

112 Eclipse Photon and Electron Algorithms Reference Guide



The basic assumptions used (Equation 19 and Equation 20 on page 110) are briefly
summarized as follows. Both charged pair production secondary particles are
assumed to be electrons instead of one electron and one positron. Also, the partial
coupling technique is assumed, whereby photons can produce electrons, but
electrons do not produce photons. Regarding the latter, the energy from photons
produced by the electrons is accounted for, but assumed to be deposited locally.

These assumptions have only a minor effect on the energy deposition field, and are
similar to those employed in clinical Monte Carlo codes. A primary assumption
(Equation 20 on page 110) is that the Fokker-Planck operator (of which the CSD
operator is the first order term), is used for coulomb, or “soft”, interactions that result
in small-energy losses. Catastrophic interactions that result in large energy losses are
represented with the standard Boltzmann scattering.

To represent the anisotropic behavior of the differential scattering and production
sources, the macroscopic differential scattering cross sections are expanded into
Legendre polynomials, P1(μ0), where μ

0
= Ω ⋅ Ω′ . This expansion allows the

differential scattering or production cross section(s) to be expressed as:

Equation 27

 

σs
γγ /γe/ee( r , E′ E, Ω ⋅ Ω′) = ∑

l = 0

∞ 2l + 1
4π

σs
γγ /γe/ee r , E′ E P

l
μ

0

 

   

where   

σs,l = Macroscopic differential scattering cross section for legendre moment l

Similarly, the angular fluence appearing in the scattering source is expanded into
spherical harmonics moments:

Equation 28

 

Ψ r , E′, Ω′ = ∑
l = 0

∞ ∑
m = − 1

l

ϕl, m r , E′ Y
l,m

Ω′

 

where   

Y
l,m

(Ω) = Spherical harmonic functions

l,m = Angular indices
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ϕ
l,m

r , E′ = Spherical harmonics moments of the angular fluence, calculated as:

∫
4π

dΩ′Y*
l, m Ω′ Ψ r , Ω′, E  ,

where * denotes the complex conjugate

The equations above are exact. Additionally, for purely isotropic scattering, l=0 is also
exact. However, Acuros XB sets a limit on the scattering order, 0 < l ≤ 7 , and hence
the number of spherical harmonic moments kept in the scattering/production source.
Using the Legendre addition theorem, the scattering and production sources become:

Equation 29

 

qγγ /γe/ee( r , E, Ω) = ∑
l = 0

7 ∑
m = − 1

l ∫
0

∞

dE′σs
γγ /γe/ee r , E′ E ϕ

l,m
r , E′ Y

l
(Ω)

 

Photon and Electron Sources
The external photon and electron sources, qγ and qe, are modeled as anisotropic
point sources in Acuros XB. At each static beam phase space, a separate point source
exists for each of the three sources of the photon beam source model. For the primary
source, the anisotropy of qγ is described through a 2D fluence grid, in which both the
particle fluence and energy spectra are spatially variable. For the second source, the
anisotropy of qγ is described through a 3D fluence grid, and the energy spectra is
spatially constant. For the electron contamination source, the anisotropy of qe is
described through a 3D fluence grid, and the energy spectra is spatially constant. All
point sources are located at the target for the respective control static beam.
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For a photon point source, qγ(E, Ω) located at position, r p , equations (Equation 19
and Equation 20 on page 110) become:

Equation 30

 

Ω ⋅ ∇ Ψ γ + σt
γΨ γ = qγγ + qγ(E, Ω)δ r − r

p

 

Equation 31

 

Ω ⋅ ∇ Ψ e + σt
eΨ e − ∂

∂E S
R
Ψ e = qee + qγe + qe

 

where   

δ = Dirac-delta function

The principle of linear superposition may be used to define the photon angular flux
as the summation of uncollided and collided flux components:

Equation 32

 
Ψ γ ≡ Ψunc

γ + Ψcoll
γ

 

where   

Ψunc
γ = Uncollided, or unscattered, photon angular flux. Refers to photons which

have not yet interacted with the patient/phantom.

Ψcoll
γ = Collided, or scattered, photon angular flux. Refers to photons which

were produced or scattered by a photon interaction in the patient/
phantom.
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Substituting equations (Equation 32 on page 115 into Equation 30 on page 115 and 
Equation 31 on page 115), and using linear superposition leads to the following
system of transport equations:

Equation 33

 

Ω ⋅ ∇ Ψunc
γ + σt

γΨunc
γ = qγ(E, Ω)δ r − r p

 

Equation 34

 

Ω ⋅ ∇ Ψcoll
γ + σt

γΨcoll
γ = qcoll

γγ + qunc
γγ

 

Equation 35

 

Ω ⋅ ∇ Ψe + σt
eΨe − ∂

∂E S
R
Ψ e = qee + qcoll

γe + qunc
γe + qe

 

where   

qunc
γγ = First scattered photon source. Refers to photons which are created or

scattered from the first photon interaction inside the patient/phantom.

qcoll
γγ = Secondary scattered photon source. Refers to photons which are created

or scattered from secondary photon interactions inside the patient/
phantom.

qunc
γe = First scattered electron source. Refers to electrons which are created or

scattered from the first photon interaction inside the patient/phantom.

qcoll
γe = Secondary scattered electrons source. Refers to electrons which are cre-

ated or scattered from secondary photon interactions inside the patient/
phantom.

The solution to the equations (Equation 33 on page 116 through Equation 35 on
page 116) is identical to that of Equation 30 on page 115 and Equation 31 on page 115.
However, Equation 33 on page 116 is decoupled from Equation 34 on page 116 and 
Equation 35 on page 116 and can be solved independently. Once the solution to 
Equation 33 on page 116 is known, qunc

γ  and qunc
γe  are formulated and considered fixed

sources in Equation 34 on page 116 and Equation 35 on page 116, which then may be
solved within the patient/phantom geometry.
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A property of Equation 33 on page 116 is that Ψunc
γ  can be solved for analytically.

Doing so provides the following expression for the uncollided photon angular flux
from a point source.

Equation 36

 

ψunc
γ ( r , E, Ω) = δ(Ω − Ω

r , r p
)qy(E, Ω)e−τ( r , r p)

4π r − r p

2

 

where   

Ω
r , r p

= r − r p

r − r p

 , where r p and r  are the source and destination points of the ray

trace, respectively.

τ r , r p
= The optical distance (measured in mean-free-paths) between r  and r p .

The electron contaminant source is modeled in a similar manner to the above, but
with the inclusion of the CSD operator to account for charged particle interactions.

Acuros XB discretizes in space, angle, and energy to solve the equations (Equation 34
on page 116 through Equation 36 on page 117).

Spatial Discretization
For spatial discretization, the computational volume domain, V, is subdivided into
variable sized Cartesian elements, where material properties are assumed to be
constant within each computational element. The computational grid in Acuros XB is
spatially variable; the local element size is adapted to achieve a higher spatial
resolution inside the beam, with reduced resolution in lower dose and lower gradient
regions outside the beam penumbra.

Internally Acuros XB employs a finer resolution (equal to the user requested dose
grid resolution h) to calculate the electron fluence inside the primary volume of
interest (PVOI) and a coarser resolution (equal to 2xh) outside the PVOI. The PVOI is
defined as the volume where the dose is estimated to be 10% or more of the
maximum dose for static fields, or plans containing static fields, and 15% or more of
the maximum dose for non-short arc fields, or plans containing non-short arc fields.
A non-short arc field has more than 20 calculation directions and spans an arc of
more than 10 degrees.
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Commonly referred to as adaptive mesh refinement (AMR), the mesh is limited to
refinement in factors of 2 (from one level to the next) in any direction, allowing for
localized refinement to resolve areas of sharp gradients. Equations (Equation 34 and 
Equation 35 on page 116), which solve for the collision components, are discretized
using a linear discontinuous Galerkin finite-element method24, providing a linear
solution variation throughout each element, with discontinuities permitted across
element faces.

The first scattered photon and first produced electron sources (Equation 36 on
page 117) are also represented as linear varying functions in each element, since these
sources are used for the linear discontinuous discretization (Equation 34 and 
Equation 35 on page 116). To accurately integrate these first scattered sources, the
analytic solution is computed at a density inside the primary beam and penumbras
of at least 8 ray traces per output grid voxel.

Energy Discretization
Energy discretization is performed through the standard multigroup method25,
which is used in both the energy dependence (Equation 34 on page 116 and 
Equation 36 on page 117) and the Boltzmann scattering (Equation 35 on page 116). In
energy, the energy derivative of the continuous slowing down (CSD) operator
(Equation 35) is discretized using the linear discontinuous finite-element method26.
The Acuros XB cross section library includes 25 photon energy groups and 49
electron energy groups, although not all groups are used for energies lower than 20
MV.

24 Lewis EE, Miller WF: Computational methods of neutron transport. Wiley, New
York, 1984.

25 Lewis EE, Miller WF: Computational methods of neutron transport. Wiley, New
York, 1984.

26 Wareing TA, Morel JE, McGhee JM: Coupled Electron-Photon Transport Methods on
3-D Unstructured Grids. Transactions of the American Nuclear Society, Washington
D.C., Vol 83, 2000.
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Angular Discretization
For spatially transporting the scattered particle field in the patient, the discrete
ordinates method is used to discretize in angle27. The discrete ordinates method
consists of requiring equations (Equation 34 on page 116 and Equation 35 on
page 116) to hold for a fixed number of directions, Ωn . These discrete directions are
chosen from an angular quadrature set that also serves to compute the angular
integrals (Equation 26 on page 112) for the generation of the scattering source.

Square-Tchebyshev legendre quadrature sets are used and the quadrature order
ranges from N=4 (32 discrete angles) to N=16 (512 discrete angles). The angular
quadrature order varies both by particle type and energy. Higher energy particles
have longer mean free paths, or ranges for electrons, and thus for each particle type,
the angular quadrature order is increased with the particle energy.

A special mode is triggered in cases where a total volume of low density material
(density below 0.12 g/cm3) larger than approximately 250 cm3 is present inside the
body structure. When triggered, this mode will improve accuracy in large volumes of
low density material. These conditions are typically only present in non-clinical
heterogeneous phantom geometries.

Spatial Transport Cutoff
Acuros XB employs a spatial cutoff for electron energies below 200 keV, and for
photon energies below 1 keV. When a particle passes below the cutoff energy, it is
assumed to deposit all of its energy in the corresponding dose grid voxel.

27 O. Vassiliev, T. Wareing, I. Davis, J. McGhee, D. Barnett, J. Horton, K. Gifford, G.
Failla, U. Titt, F. Mourtada: Feasibility of a multigroup deterministic solution method
for three-dimensional radiotherapy dose calculations. International Journal of
Radiation Oncology Biology Physics, Sep 2008, 1;72(1):220-7.
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Fluence to Dose Conversion
Once the electron angular fluence is solved for all energy groups, the dose in any
output grid voxel, i, of the problem is obtained through the following equation.

Equation 37

 

Di = ∫
0

∞

dE∫
4π

dΩ
σED

e r , E

ρ( r )
ψe( r , E, Ω)

 

where   

Di = Dose in voxel i

σED
e = Macroscopic electron energy deposition cross sections in units of

MeV/cm.

ρ = Material density in g/cm3

When dose to medium is calculated, σED
e  and ρ are based on the material properties

of output grid voxel, i. When dose to water is calculated, σED
e  and ρ are based on

water.

As described above, Acuros XB calculates the energy dependent electron fluence
based on the material properties of the patient, regardless of whether dose to water
or dose to medium is selected. When dose to water is selected, in non-water materials
this is analogous to calculating the dose received by a volume of water which is small
enough to not significantly perturb the energy dependent electron fluence. Due to the
very short range of low energy electrons, this volume may be much smaller than
either the output dose grid voxel size or detectors used to experimentally measure
dose to water. This effect is most significant for non-biologic, high density materials
such as aluminum, titanium, and steel. For biologic materials, the effect is most
significant in bone. In such cases, when comparing Acuros XB to experimental
measurements of dose to water, it is recommended to explicitly model a small water
volume representing the detector in Acuros XB.

Both Acuros XB and Monte Carlo methods calculate dose to medium based on
energy deposition, and produce very similar results. When calculating dose to water
in non-water materials, Acuros XB and Monte Carlo methods employ different
approaches. The approach employed by Acuros XB is described in the above. Monte
Carlo methods directly calculate dose to medium, and generally employ stopping
power ratios to convert dose to medium to dose to water28.
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The figure shows a comparison between energy deposition ratios (water/medium)29

and collisional stopping power ratios (water/medium)30 in different biologic
materials as a function of electron energy. The energy deposition ratios (left in the
figure) show the ratio of dose to water/dose to medium which would be calculated
by Acuros XB, and the collisional stopping power ratios (right in the figure) show the
ratio of dose to water/dose to medium which would generally be calculated by
Monte Carlo methods.

Energy deposition
ratio

Collisional stopping
power ratio

MeV MeV

lung
adipose tissue
muscle
cartilage
bone

Figure 19 (left) Energy deposition ratios (water/medium) and (right) collisional stopping power
ratios (water/medium), as a function of electron energy (MeV).

28 JV Siebers, PJ Keall, AE Nahum, and R Mohan: Converting absorbed dose to
medium to absorbed dose to water for Monte Carlo based photon beam dose
calculations. Physics in Medicine and Biology 45 (2000) 983-995.

29 Lorence L, Morel J, and Valdez G: Physics Guide to CEPXS: A Multigroup Coupled
Electron-Photon Cross Section Generating Code. SAND89-1685, Sandia National
Laboratory, 1989.

30 http://www.nist.gov/physlab/data/star/index.cfm
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Material Properties
The fundamental data used by Acuros XB are macroscopic atomic cross sections. A
macroscopic cross section is the probability that a particular interaction will occur per
unit path length of particle travel, so it has units of cm-1. Macroscopic cross sections
are composed from two values: the microscopic cross section for a given interaction
(generally given in barns/atom = 10-24 cm2/atom and symbolized by σ ) and the mass
density of the material (ρ, given in g/cm3). The expression for the macroscopic cross
section, σ, is:

Equation 38

 
σ = Nαρ

M σ

 

where   

M = Mass of the atom in atomic mass units (AMU)

Nα = Avogadro’s number

Acuros XB uses coupled photon-electron cross sections produced by CEPXS31. For
photon interactions, CEPXS includes Compton scatter (also known as incoherent
scatter), the photo-electric effect, and pair production. CEPXS does not account for
Rayleigh scatter (also known as coherent scatter). Additionally, the energy from
Bremsstrahlung photons, produced by electron interactions inside the patient, is
discarded. The effect of these assumptions is insignificant for dose distributions at
energies typical in photon beam radiotherapy.

CT to Material Mapping
In order to perform a calculation, Acuros XB must know the macroscopic cross
section in each element in its computational grid. Eclipse provides Acuros XB with a
mass density and material type in each voxel of the image grid (Eclipse Algorithms
and CT Image Data on page 16).

31 Lorence L, Morel J, and Valdez G: Physics Guide to CEPXS: A Multigroup Coupled
Electron-Photon Cross Section Generating Code. SAND89-1685, Sandia National
Laboratory, 1989.
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The Acuros XB algorithm stops the calculation if an HU value in the CT image is
higher than or equal to the maximum HU value defined in the CT calibration curve.
The volume spanned by CT image pixels whose mass density (derived either from
the HU value in the image or assigned to a structure) exceeds the maximum mass
density of the materials used in automatic conversion (3.0 g/cm3) is calculated. If this
volume is higher than a user defined maximum volume for automatic material
assignment to high density artifacts, the calculation is prevented until a material is
assigned via a structure. For smaller volumes, automatic conversion to a user defined
material takes place. This is to prevent incorrect material assignment to a significant
volume of a high density material.

For higher densities, extend the calibration curve so that it includes the highest
density material you think of using. The highest density supported by Acuros XB is
8 g/cm3, stainless steel. The CT calibration curve should be extended at least to a
density of 8.1 g/cm3 to cover all materials.

Any noise present in the CT image is transformed directly into a noise in the mass
density map of the image. In the regions of the CT image where the mass density is
very close to a minimum/maximum value of two materials (e.g., 1.075 g/cm3, Table 26
on page 124) the discrete nature of the material assignment and the noise in the CT
image may lead to a rapid alternation between two different material assignments.
Depending on the strength of the noise and on the calculation grid size this effect
may be seen in these regions as a slight noise in the dose distribution.

Overlapping Density Ranges in CT to Material Mapping

If the mass density ρ derived from the HU value is within the range of two materials
A and B that are used in automatic CT to material conversion, a mixture of these two
materials is assigned to the voxel. Assume that the minimum and maximum density
of material A are ρmin,A and ρmax,A, respectively, and those of material B are ρmin,B
and ρmax,B, and that ρmax,Α>ρmin,Β and ρmin,A<ρmin,B. The overlapping range is from

ρmin,B to ρmax,Α. The percentage of material A will be 100% ×
ρ

max,A
− ρ

ρ
max,A

− ρ
min,B

 . In other

words, when materials A and B overlap, there is a linear change from 100% material
A to 100% material B.

Handling of Structures with Density and Material Assignments

Acuros XB resamples the CT image received from the Eclipse client in the following
way:
■ If the pixel size in each slice is smaller than the calculation grid size, the slices are

used as is. Otherwise, they are resampled into the calculation grid.
■ If the slice spacing is larger than the calculation grid size, extra slices are created

so that the slice spacing of the new CT image is as close to the calculation grid size
as possible.
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More information on the calculation grid: Calculation Options on page 28.

During Acuros XB calculation, the average mass density and material is calculated in
each voxel of the internal CT image grid. If the structure boundary divides a voxel so
that only a part of the voxel belongs to the structure, the density of the voxel will be a
weighted average of the density of the structure and the density that the voxel would
have received otherwise (which may be derived from another overlapping structure
or from the CT image). Similarly, the material of this boundary voxel will be a
mixture of two materials with the percentages derived from the volume fractions into
which the voxel is subdivided. However, note that each voxel material will be
described as a mixture of at most two materials.

Supported Materials

The list of supported materials with associated density ranges is provided in the
table.

Table 26 Material Mass Densities

Material Density

Minimum (g/
cm3)

Default (g/cm3) Maximum (g/
cm3)

Automatic CT to material conversion

Air (STP) 0.00121 0.0012 0.0204

Lung (ICRP 1975) 0.0110 0.26 0.6242

Adipose Tissue (ICRP 1975) 0.5539 0.92 1.0010

Muscle, Skeletal (ICRP 1975) 0.9693 1.05 1.0931

Cartilage (ICRP 1975) 1.0556 1.10 1.60

Bone (ICRP1975) 1.10 1.85 3.00

Manual material assignment

Aluminum 2.2750 2.70 3.56

Titanium Alloy 3.56 4.42 6.21

Stainless Steel 6.21 8.00 8.00

Gold  19.32  

Water 0.00121 1.00 3.00

Wood 0.30 0.70 1.00
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Material Density

Minimum (g/
cm3)

Default (g/cm3) Maximum (g/
cm3)

Cork 0.10 0.19 0.40

Polystyrene 0.59 1.05 1.0750

Epoxy  1.04  

PMMA  1.19  

Radel  1.30  

PEEK  1.31  

PVC  1.38  

Acetal  1.42  

PVDF  1.77  

PTFE  2.20  

1. For air and water, the value 0.0000 visible in RT Administration is set to 0.0012 by the algorithm.

Each Acuros XB algorithm version comes with a physical material table that lists the
material densities used by the algorithm. RT Administration shows the material
tables for different Acuros XB algorithm versions. More information: RT
Administration Reference Guide.

In the following table, physical materials are defined in terms of atomic cross sections
for Acuros XB, given the weight fractions, or chemical formula where applicable.

Table 27 Material Compositions

Material Element Weight Fraction

Air (STP) C 0.000124

N 0.755268

O 0.231781

Ar 0.012827
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Material Element Weight Fraction

Lung (ICRP 1975) H 0.101278

C 0.102310

N 0.028650

O 0.757072

Na 0.001840

Mg 0.000730

P 0.000800

S 0.002250

Cl 0.002660

K 0.001940

Ca 0.000090

Fe 0.000370

Zn 0.000010

Adipose Tissue (ICRP 1975) H 0.119477

C 0.637240

N 0.007970

O 0.232333

Na 0.000500

Mg 0.000020

P 0.000160

S 0.000730

Cl 0.001190

K 0.000320

Ca 0.000020

Fe 0.000020

Zn 0.000020
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Material Element Weight Fraction

Muscle, Skeletal (ICRP 1975) H 0.100637

C 0.107830

N 0.027680

O 0.754773

Na 0.000750

Mg 0.000190

P 0.001800

S 0.002410

Cl 0.000790

K 0.003020

Ca 0.000030

Fe 0.000040

Zn 0.000050

Cartilage (ICRP 1975) H 0.096

C 0.099

N 0.022

O 0.744

Na 0.005

Mg NA

P 0.022

S 0.009

Cl 0.003

K NA

Ca NA
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Material Element Weight Fraction

Bone (ICRP 1975) H 0.047234

C 0.14433

N 0.04199

O 0.446096

Mg 0.0022

P 0.10497

S 0.00315

Ca 0.20993

Zn 0.0001

Aluminum Al 1

Titanium alloy (Ti6Al4V)1 Ti .90

Al .06

V .04

Stainless Steel C 0.00080

Si 0.01000

P 0.00045

Cr 0.19000

Mn 0.02000

Fe 0.68375

Ni 0.09500

Gold Au 1

Water H 0.111894

O 0.888106

Wood and Cork H 0.06216

C 0.44445

O 0.49339
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Material Element Weight Fraction

Polystyrene H 0.07742

C 0.92258

All other plastics:

Epoxy, PMMA, Radel, PEEK,
PVC, Acetal, PVDF, PTFE

H 0.05011

C 0.73282

O 0.14461

S 0.07246

1. Titanium alloys are commonly used in implants. Dose differences between pure Titanium and Titanium
alloy are very small.

Output Dose Grid Control
The user can specify the geometric extents on which Acuros XB will output the 3D
dose grid by using the Calculation Volume tool in Eclipse.

Regardless of the output grid size, Acuros XB will account for the effects of photon
and electron transport throughout the full CT extents on the dose within the output
dose grid. However, Acuros XB will reduce the spatial resolution external to the
output dose grid to reduce the calculation time (Spatial Discretization on page 117).

Through this feature, the user can minimize the Acuros XB dose calculation time by
limiting the volume of interest for the dose calculation (Factors Affecting Run Time
and Memory Consumption on page 130).

Discretization Errors
In both Acuros XB and Monte Carlo a trade-off exists between computational speed
and accuracy. In Monte Carlo, errors are generally stochastic, which are reduced
when solutions are calculated to tighter statistical uncertainties. In Acuros XB, errors
are deterministic and primarily result from the discretization resolution in space,
angle, and energy.

Energy discretization errors are generally manifested as solution biases present over
a large region. Angular discretization errors typically result in ‘ray-effects’, which are
non-physical angular oscillations in the solution. These effects are most pronounced
at far distances from localized sources in low density media. Lastly, due to the
discontinuous nature of the DFEM spatial differencing used by Acuros XB, spatial
discretization errors would typically be manifested by local solution over/under
shooting, and caused by the requirement to fit a linear solution in each element while
conserving particle balance. The energy, space, and angle discretization settings in
Acuros XB are specified internally, and are not under direct user control.
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Additional errors may also be present from the internally set convergence tolerances
in Acuros XB. These tolerances control how tightly the inner iterations in Acuros XB
are converged in energy group. These errors will generally be under 0.1% of the local
dose in any element.

Factors Affecting Run Time and Memory Consumption
The factors influencing Acuros XB calculation times and memory consumption are
different than those influencing pencil beam and Monte Carlo methods. Acuros XB is
similar to Monte Carlo in the sense that calculation times are only weakly dependent
on the number of fields.

However, memory consumption in Acuros XB is generally higher than that of other
methods such as Monte Carlo. A principal reason for this is the large number of
variables that Acuros XB has to solve. Although the output from Acuros XB is only a
single dose value for each output voxel, to calculate this it is necessary for Acuros XB
to solve for the full angular and energy dependence of the photon and electron
fluences throughout the CT extents. The two dominant factors governing Acuros XB
memory consumption and calculation time are the output grid voxel size and the
volume of the radiation beams over the patient/phantom within the output grid
extents.

Both memory consumption and calculation time are approximately inversely
proportional to the output grid voxel volume. For example, an output grid voxel size
of 1 mm will require approximately 8 times the memory and calculation time
compared with 2 mm output grid voxels.

Memory consumption and calculation time are also roughly proportional to the total
patient/phantom volume intersected by the beams, including associated penumbra
regions. Acuros XB locally refines the calculation grid to resolve the solution field
internal to the beams and penumbra in the patient/phantom. External to these
regions, where the dose magnitude and gradients are low, the calculation grid is
locally coarsened to reduce the computational effort.

The calculation grid is also coarsened in the air regions external to the patient/
phantom. The net effect of this behavior is that in a majority of cases, except for small
fields in large phantoms, most of the computational effort is dedicated to calculating
the photon and electron fluences inside the beams.

Since the calculation grid is also coarsened external the output grid extents, even
inside the beams, users can significantly reduce calculation time and memory
consumption by decreasing the output grid extents encompassing the beams.
Reducing the output grid size will only have a significant effect when it also reduces
the volume of the beams covering the patient/phantom within the output grid. In
most cases, the total reduction in calculation time and memory consumption will be
proportional to this decrease in volume.
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To illustrate this, three calculations of a 10x10 cm2 field oriented in the z-direction on
a 40x40x40 cm3 phantom are considered. In the first calculation, the output grid
volume is equal to the phantom size, 40x40x40 cm3. In the second calculation, the
output grid volume is reduced by half in the depth-wise direction, to 40x40x20 cm3.
Including the effects of beam spreading with increasing distance from the source, the
second calculation will generally require less than half the calculation time and
memory consumption of the first calculation. In a third calculation, the output grid
volume is changed to 20x20x40 cm3. In this case, the third calculation will not reduce
the phantom volume intersected by the beam, and therefore the calculation time or
memory consumption will not significantly differ from that of the first calculation.

The calculation time and memory consumption are both only weakly dependent on
the number of fields. Even in the range of most RapidArc calculations, 90 to 180 dose
calculation directions per field, the dominant contributor to both calculation time and
memory consumption is generally in calculating electron and photon transport in the
patient/phantom, and not ray tracing of the primary, secondary, or electron
contaminant sources into the patient/phantom. However, the ray tracing component
is linearly dependent on the number of fields, and for RapidArc cases with increasing
numbers of dose calculation directions, ray tracing will eventually become the
dominant factor.

There is some dependence on the beam energy for both memory consumption and
calculation times. With increasing beam energy, more energy groups are required to
achieve an accurate solution, which requires a commensurate increase in both
calculation time and memory consumption. As an example, a 20 MV calculation may
require approximately 75% more CPU time than the same calculation with 4 MV
beams.
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Chapter 7    Cone Dose Calculation Algorithm (CDC)

Dose Calculation Model
The Cone Dose Calculation (CDC) algorithm is used in Eclipse Cone Planning to
calculate the dose for stereotactic cone applicators used in stereotactic radiosurgery
(SRS) treatments.

The CDC algorithm ignores bolus and any non-body structures. In Cone Planning, it
is not possible to attach a bolus to an arc field or open a field that contains a bolus.

The CDC algorithm uses Tissue Maximum Ratios (TMR) and Off-Axis Ratios (OAR)
to determine the dose at any point within the irradiated volume.

Outline of Dose Calculation
The dose, D, at any point, P, in the beam is determined as:

Equation 39

 

D r, d, SSD, S = MU × DRref × OFTMRmax
S × TMR d, S × SAD

SSD+d
2 × OAR r, S

 

where   

r = Off-axis distance to point of interest

d = Depth to location of interest along central axis

SSD = Source-to-skin distance

S = Nominal diameter of conical collimator

D(d,r,S) = Dose at location of interest (point ‘p’: Figure 20 on page 134).

MU = Monitor unit

Dref = Reference dose rate = 
Dref

MUref
 , where Dref is the absolute dose in water

for the reference field size at the reference point at the calibration depth,
expressed in Gray, and where MUref is the MU given to produce the ref-
erence dose for calibration (Table 29 on page 139).
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OF(S) = Output factor = 
DS
Dref

 , where DS is the dose at a specific point on the cen-
tral axis (at the isocenter) with depth, d, when conical collimator, S, is
used, and where Dref is the dose measured in the same spatial location
and d, as DS, using reference field size.

OFTMRmax
S =

Output factor at TMRmax(S), OF(S) ×
PDD S,SSD,dmax

PDD S,SSD,d ×
SSD+dmax

SAD

2
 , where

d is the depth used to measure OF(S).

TMR(d,S) = Tissue-maximum ratio, 
Dd

Ddmax
 , where Ddmax

 is the dose at a specific point

on the central axis (at the isocenter), with maximum dose depth dmax of
tissue equivalent material overlying the point, and where Dd is the dose
at the same spatial point with an arbitrary depth, d, of overlying tissue
equivalent material.

SAD = Source-axis distance.

OAR(r,S) = Off-axis ratio, 
Dr
Da

 , where Da is the dose on the central axis at depth, d,
and Dr is the dose at an arbitrary off-axis distance, r, with the same cen-
tral axis depth, d.

The parameters are illustrated in the figure.
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Figure 20 Cone Dose Calculation Geometry

Dose Matrix
When the dose calculation is initiated, dose is calculated for an array of points in two
matrices. One of the matrices is coarse, with a point separation of 5.0 mm within the
stereotactic space. The other matrix is fine, with a default point separation of 1.0 mm.
The point separation of the fine matrix is configurable.

The size of the finer matrix depends on the size of the collimator at the isocenter
plane. The distance of the matrix edge from the isocenter equals twice the diameter of
the collimator plus an additional 5 mm margin.
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Monitor Unit Calculation
The monitor units for a given field are calculated using the equation:

Equation 40

 
Monitor Units = Reference Dose

Calibration Factor
 

where   

Reference Dose = Repeat Factor×Weight Factor
TMRave

Calibration Factor = OFTMRmax
S × DRref

Repeat Factor × Weight
Factor

= Absolute dose contribution from an arc into the iso-
center.

TMRave = Average Tissue Maximum Ratio from the isocenter
to the edge of the body contour.

Note that the arcs are given only relative weightings during the planning process,
and their true relative dose weightings are not assigned until the time of dose
prescription. The number of times the weights need to be multiplied to deliver the
prescribed dose is indicated by the ratio of the dose at isocenter to the relative arc
weight.

Limitations of the Dose Calculation Model
The dose calculation model has several limitations.

Approximating Arc Beams as Static Beams
The CDC algorithm approximates arc dosimetry calculations as multiple static
beams. To determine the average TMR for the arc, the system represents the arc as a
set of a static beams at user-specified arc increments (between 1-10 degrees). The
increments are specified using the Arc Angle Resolution setting in the Calculation tab
in Eclipse Cone Planning. The system then averages the TMR from all of these beams
to determine an average for dosimetry calculations. The dose contribution for any
particular arc is normalized to 1.0 at its isocenter and then multiplied by its weight.
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Note: The Dosimetry Report print-outs provide an average depth for each treatment arc. These
are provided to enable an approximate hand calculation of monitor units. Monitor units
calculated by hand using these average depths are not exact, but will be within approximately
2% of the correct values.

Tissue Inhomogeneity
Tissue inhomogeneity is not taken into consideration, and all CT values are treated as
having water equivalent densities once the entry point has been determined. All CT
values before the entry point are treated as air. This is true also for beams entering
through the base plate or any support structure. The entry point is the first point in
the field central axis that hits the body structure. A base plate or a support structure
should never be included in the body structure, as the air gap between the body
structure and the base plate or support structure is treated as water.

This tissue inhomogeneity limitation is generally acceptable in the head, since most
beam paths are through approximately water equivalent densities. For example, skull
density is approximately 1.4 times that of water, and the skull thickness is
approximately 0.75 cm. This means the equivalent thickness of the skull is 1.4 ×
0.75cm = 1.05cm, resulting in a 0.3 cm error. For a 6MV beam, attenuation is
approximately 4%/1 cm, resulting in a dose error of 0.3cm × 4%

1cm = 1.2% .

Beam paths that traverse air cavities result in slightly higher errors, and you may
want to alter beam entry points to avoid large path lengths through these cavities.
For beams that enter or exit through cavities, you need to take into account that these
areas are treated as having water equivalent densities.

Oblique Entry of Beams
The beam axis is assumed to always be normal to the patient contour, and no
consideration is made for beam obliquity. Due to the small field sizes encountered in
radiosurgery, this error is negligible.

Backscatter
The absence of backscatter near the cavities or where the beam exits the head is not
taken into account. This results in the displayed dose near the surface being higher
than the actual dose.

Off-Axis Ratio
The OAR is assumed to be independent of depth, and only dependent on the
distance from radiation source. This assumption is valid since the collimators are
small and span only the central area of the linear accelerator’s broad beam.
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Beam Energy Limits
The nominal energy defined for the treatment unit must be between 6MV and 10MV
inclusive. During configuration the configuration program verifies that the nominal
energy parameter (Table 28 on page 139) is within these limits.

Valid Range of SSD and Depth
The valid range of SSD values is from 70.1 cm to 100 cm. The sum of SSD and depth
of any calculation point must be less than 130 cm.

Configuration of the CDC Algorithm
The input of the Cone Dose Calculation configuration program consists of specific
measured beam data and parameter values that are defined by the user. The
parameters describe the measurement geometry and the physical characteristics of
the beam.

Information on configuring the CDC: Configuring the CDC by Importing New
Measured Data on page 145.
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Note: When performing measurements and configuring the CDC, notice the following:
■ The instructions for beam data measurements are recommendations only. Varian Medical

Systems is not responsible for incorrect measurements or inaccurate configuration
resulting from erroneous measurements.

■ Clinical physicists responsible for the measurements must always use their own judgment
in deciding the level of acceptable accuracy of the measurements in relation to the
calculations, and find the compromises needed for each specific accelerator as far as
measurements are concerned.

■ It is important to configure the system so that it corresponds to the characteristics of the
treatment machine.

■ Periodically perform follow-up measurements and compare with the dosimetric beam data
used for configuring the beam. If fluctuations are large and the configured beam data no
longer represents the average beam delivered by the machine, reconfigure the beam data
using the newer dosimetric beam data.

■ Measure all dosimetric beam data in as stable conditions as possible.
■ Perform all measurements as accurately as possible.
■ Use the same file naming conventions in beam data measurements (input files) and in

Beam Configuration (Therapy Unit name), and name the input files so that it is easy to
match the beam data to the treatment unit during the configuration process.

■ Due to the small fields used in stereotactic radiosurgery, partial volume effects are
noticeable if large volume detectors are used.

■ Although direct measurement of TMR is possible, it is fairly common practice to measure
PDDs and then convert them to TMRs. It is very difficult to measure PDD reliably for
very small fields. When PDDs are measured and then converted to TMRs, you need to
ensure that the detector remains centered in the field at all depths. Measuring TMR
directly is more reliable in these cases since the detector does not move during the
measurement.

■ Commission your beam configuration with high precision. Consider validating the
calculation configuration following the guidelines set by IAEA32. If you notice anything
unexpected in the configured data, trace the source of the error to a problem in the
measured data, and correct the measured data. Do not proceed to patient treatments until
the issues have been resolved.

Detailed information on using Beam Configuration: Beam Configuration Reference
Guide. Information on how to select a calculation model for dose calculation in
Eclipse Cone Planning: Eclipse Cone Planning Online Help.

32 Commissioning and Quality Assurance of Computerized Planning Systems for Radiation
Treatment of Cancer, Technical Reports Series No. 430 (IAEA).
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General Configuration Parameters
The CDC requires that the general treatment unit parameters (in the table) for
importing measured beam data and for dose calculation are either read from RT
Administration or defined in Beam Configuration. When configuring the CDC, verify
that the parameters read from RT Administration are correct, and ensure that no
required parameters are missing.

Table 28 General Parameters

Parameter Description

Therapy unit name Therapy unit name. Define this parameter in Beam
Configuration.

Nominal energy This parameter is read from RT Administration.

Radiation type This must be “photon”. This parameter is read from RT
Administration.

Vendor This parameter is read from RT Administration.

Source-to-axis distance expressed in
cm

This parameter is read from RT Administration.

Absolute Dose Calibration Parameters
The CDC requires the listed absolute dose calibration parameters in Beam
Configuration.

Table 29 Absolute Dose Calibration Parameters

Parameter Description

Absolute dose reference
field size [mm]

Size of the reference field used in configuration, expressed in milli-
meters. This should be the same size that was used to normalize
the measured output factors (that is, the field size for which the
output factor = 1.0).

Absolute dose calibra-
tion depth [mm]

Depth of the reference point used in configuration, expressed in
millimeters.

Absolute dose calibra-
tion source-phantom
distance

Distance between the source and the surface of the phantom (SPD)
used during the absolute dose calibration, expressed in millime-
ters.

Reference dose at cali-
bration depth [Gy]

Absolute dose in water for the reference field size at the reference
point at the calibration depth, expressed in Gray.
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Parameter Description

Reference MU at calibra-
tion depth [MU]

MU given to produce the reference dose for calibration.

Required Beam Data Measurements
The CDC needs specific measured beam data for performing dose distribution
calculations. All beam data must be measured under the same setup conditions.

For configuring the algorithm, the following measurements are required:
■ Absolute Dosimetry for a reference field (for example, a 10 cm × 10 cm open field).
■ Output Factors for all cones relative to absolute dosimetry reference field.
■ Tissue Maximum Ratio for at least three cones (for example, 10 mm, 20 mm and

30 mm)
■ Off-Axis Ratio for at least three cones (These may be measured with the same

cones that were used to measure tissue-maximum ratio, but that is not necessary.)

Measurement Methods

There are minimum practical limits to the physical size of detectors used for beam
measurements. The recommended detector systems are:
■ Diodes: Choose a diode with a small active volume (a stereotactic diode) and with

an energy response suitable for beam data acquisition.
■ Film: Film has potentially the best spatial resolution. Note however, that optical

density does not respond to absorbed dose linearly and independently of the
beam quality. Read the films with a high class digitizer, so that the spatial
resolution of the film as well as the depth of optical density can be maintained.

■ Small Ionization Chambers: Air filled ionization chambers are not recommended
to be used for any measurements if the field size is smaller than four times the
greatest dimension of the chamber. Ionization chambers are recommended for
absolute dose measurements and for calibrating film and diode detectors in
central axis beams that fulfill the field size criteria stated above.

■ Phantom: Measure the beam data in tissue or water equivalent media.

Absolute Dosimetry Measurements

The absolute dose measurement of the reference field and the output factor
measurements must be performed using the same phantom geometry. However, you
can use any field size for absolute dosimetry measurements. More information on the
parameters: Absolute Dose Calibration Parameters on page 139.
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Output Factor Measurements

Note: The jaw size defined in the treatment unit configuration must be used for all measurements,
and the same jaw size should always be used for treatment. Using a different jaw size will cause
the machine output to differ from the conditions defined in CDC configuration and could lead to
higher or lower delivered dose. The jaw size should be between 4 and 5.6 cm inclusively.

The Output Factor (OF) is the relative dose at reference geometry as a function of
collimator size, normalized to unity for field size used in the absolute dose
calibration (Absolute Dosimetry Measurements on page 140). In other words, the
output factor is a relative measurement against the dose calibration for the linear
accelerator in use. Consider measuring the absolute dose and output factors in a
geometrical setup that is as close to the treatment geometry as possible. For example,
for a 6 MV beam: SSD = 95.0 cm and depth to point of interest = 5.0 cm.

The dose calculation algorithm uses the absolute dose calibration and the output
factors for calculating monitor units (MU). An output factor is required for every
circular collimator you use for radiosurgery.

If you import measurement data from FastPlan, the configuration program reads the
output factors from the FastPlan configuration files. The dose calculation algorithm
then uses the same reference geometry as FastPlan for calculating MU values.
FastPlan assumes the machine is calibrated in such a way that 100 MU produces a
dose of 1 Gy at the depth of maximum dose for the reference field. Information on
importing existing FastPlan data: Eclipse Photon and Electron Algorithms Reference
Guide for version 13.0.

Tissue Maximum Ratio Measurements

Tissue Maximum Ratio (TMR), in a water phantom irradiated by a photon beam, is
the ratio of absorbed dose at any build-up depth along the beam axis to the dose at
the same point with the surface of the phantom moved so that the build-up depth is
at the depth of maximum absorbed dose. During measurement, the source-to-
detector distance should be 100 cm with measurements taken with increasing build-
up depth. TMR is a function of depth, beam quality, and collimator geometry.

Any collimator for which data are not entered has its data calculated by linear
interpolation and extrapolation from the measured collimator data. While data
should be measured for a representative set of collimators, the data entered for the
minimum set of three collimators is sufficient for Beam Configuration to determine
the TMR for all collimators.
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Measure the TMR data using a resolution that is as accurate as possible. However,
the recommended minimal data set should contain measured data in at most 0.5 cm
increments from the surface to 1.0 cm past the point of dose maximum, and after that
in at most 1.0 cm increments to define the exponential region to the 20.0 cm build-up
depth. This data can be imported to Beam Configuration in w2CAD format.

Correct measurement of TMR is crucial for dose calculation accuracy. Therefore,
consider validating the TMR data using at least two instruments which use different
physical approaches.

Off-Axis Ratio Measurements

The off-axis ratio (OAR), in a water phantom irradiated by a photon beam, is the ratio
of absorbed dose at any point to the absorbed dose on the beam axis at the same
depth.

OAR data from at least one source-to-target distance (STD) are required. If more data
are provided, these are used for averaging the input data for the fitting routine.
Measure the OAR data at the depth of the dose maximum of a cone or deeper
(typically, the dose maximum for a 6 MeV beam is at the depth of 1.5 cm) for at least
three collimators. Sample the data at least every millimeter (that is, 1.0 mm spacing)
regardless of the STD used and the collimator size.

Adaptation of Measurements in the Configuration
Before calculating the configured beam data, the CDC configuration program verifies
the measured beam data and adapts the measured values if necessary. You can
review the adapted and original measurements in the Beam Data workspace of Beam
Configuration (Evaluating the Configured CDC Data on page 147).

The CDC configuration program performs the following detections and adaptations:
■ Tissue-maximum ratios have negative values (for example, a few of the

measurement points are in air): These values are removed.
■ Symmetric profiles are provided: Only values with positive coordinates are used.
■ Tissue-maximum ratio curves or profiles drop to zero before the measurement

ends: These values are removed.
■ Tissue-maximum ratio curves normalized to some other value than 100% at

maximum dose: The curves are re-normalized to 100% at maximum dose.
■ Profiles normalized to some other value than 100% at the central axis: The curves

are re-normalized to 100% at the central axis.
■ Projected X-coordinate of the 50% value of the profile deviates more than 1 mm

from the assumed field edge position at the distance of SAD=100cm: An error
message is shown.
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Generating TMR Configuration Data from Adapted Measured Data
The CDC configuration program generates adapted TMR data, interpolates it linearly
up to 10 mm past the maximum dose, and then fits the data to the expression in the
equation. TMR values between the shallowest value entered and 0 mm are obtained
by linear extrapolation from the two shallowest data points. TMR values are
calculated as follows:

Equation 41

TMR(d)=A x exp(-μ x d)+h(d)

where   

h(d) = B × db × exp ‐ d
d1

10
 , where d1=2x(dmax+10mm)

is a power law correction to the exponential function required to im-
prove the continuity of the fitted function in the vicinity of dmax+10 mm.

d = Depth

dmax = Depth of dose maximum.

A,μ,Β,β = Curve fitting parameters used in CDC configuration; μ can be considered
as the linear attenuation coefficient for the given cone.

The parameters A and μ are obtained by fitting the exponential function to the
adapted TMR data starting from the depth dmax+10mm. Subtracting the resulting
exponential curve from the adapted data results in a difference curve that is used for
obtaining parameters B and b by fitting the power law function to that difference
curve in the interval dmax+10 mm, d1.

Any collimator for which data are not entered has its data calculated by power law
interpolation and extrapolation from the measured collimator data. While data
should be measured for a representative set of collimators, the data entered for the
minimum set of three collimators is sufficient for Beam Configuration to determine
the TMR for all collimators.
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Generating OAR Configuration Data from Adapted Measured Data
The CDC configuration program generates adapted OAR data and applies a curve fit
algorithm using the following double exponential model:

Equation 42

 

OAR r =
0.5+0.5 × f r − f r0

f 0 − f r0 r ≤ r0

0.5 × g r − 1
g r0 − 1 r > r0

 

where   

r = Distance from the central axis to the point of interest

r0 = Collimator radius corrected for source-to-target distance

f(r) = (1-exp(α1 x (r-r0)))x(1-exp(α2 x (r-2 x r0)))

g(r) = (1-exp(β1 x (r0-r)))x(1-exp(-β2 x r))

where   

α1, α2,
β1, β2

 Curve fitting parameters used in CDC configuration

Long tails of measured OAR curves are disregarded. The equation (Equation 42 on
page 144) is fitted to the data points for which r<rcut off, where rcut off=0.75 ×
r0+0.5(cm). This approximates the spot where OAR has dropped below 1.5%.

Within measurable accuracy in the case of cone collimator fields, the shape of a
rescaled OAR curve exhibits practically no dependence on the source-to-target
distance (STD). Hence, for a given cone size, the OAR curves for all STDs can be
obtained from one OAR curve by the rescaling:

Equation 43

 
OAR r, STD2 = OAR STD2

STD1
× r, STD1

 

Before fitting the equation (Equation 42 on page 144) to measured OAR curves, all
curves are rescaled (Equation 43 on page 144) to one reference STD, STDref.

The resulting fitting parameters are interpolated by power law for all cone sizes. This
gives OAR curves for each cone at STDref. The OAR for any other STD is obtained by
using the equation (Equation 43) again.
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Data Generated in the Configuration
After the configuration is completed, the data items shown in the focus window
include measured data and generated data.

The measured data items shown are:

■ Measured Output Factors
■ Measured Tissue-Maximum Ratios
■ Measured Off-Axis Ratios
■ Absolute Dose Calibration Parameters
■ FastPlan Import Files (This data item is present only when the CDC algorithm has

been configured using FastPlan data.)

The data that the CDC configuration program generates:

■ Processed Tissue-Maximum Ratios
■ Processed Off-Axis Ratios
■ Calculated Tissue-Maximum Ratios
■ Calculated Off-Axis Ratios
■ Gamma Errors for Tissue-Maximum Ratios
■ Gamma Errors for Off-Axis Ratios
■ Gamma Error Histogram

Information on using this data for evaluating the configured CDC data: Evaluating
the Configured CDC Data on page 147.

Configuring the CDC by Importing New Measured Data

Note: Before starting to configure the algorithm, you need to configure the cone applicators
(Configure Cone Applicators in RT Administration on page 148).

When you are configuring the CDC algorithm by importing new measured beam
data, you need to import the Off-axis Ratio and Tissue-Maximum Ratio data in
w2CAD format. More information on the w2CAD format: Appendix C File Formats
for Measured Beam Data on page 304. In addition, you need to manually add the
absolute dose calibration and output factor data.

You need to verify the following in the TMR data file:

■ The %TYPE parameter in the heading must be defined as TMR.
■ If you have cone collimators with the diameter precision of 0.5 mm, make sure

that the decimals are represented correctly in the file. They must not be rounded
up or down to the nearest full millimeter.
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You need to verify the following in the OAR data file:
■ The %TYPE parameter in the heading must be defined as OPP (Open Field Profile).
■ You also need to make sure that the %SSD and depth (%DPTH) are defined for all

measurements.

Configure the CDC Using New Measured Data

1. Configure the cone applicators in RT Administration (Configure Cone
Applicators in RT Administration on page 148).

2. In Beam Configuration, go to the Beam Data workspace. Instructions on how to
use the Beam Configuration: RT and Imaging Online Help or Beam Configuration
Reference Guide.

3. Add a new calculation model, beam data container and new beam data.
4. Verify the validity of the treatment unit parameters (General Configuration

Parameters on page 139).
5. Add a new add-on of type Cone set.
6. In the Focus window, right-click the add-on and choose Match and Assign Add‐

Ons.
7. In the match and Assign Add-Ons dialog box, do the following:

a. Select the beam data row of the cone set.
b. Select the In Use check box.
c. Under Automatic Match, click All.
d. Click Close.

Review the match to make sure that is valid.
8. In the Focus window, right-click an add-on and choose Insert > New Absolute

Dose Calibration Parameters.
9. Type in the absolute dose calibration parameters (Table 29 on page 139).

10. In the Focus window, right-click the add-on and choose Insert  > Measured
Output factors.

11. Do the following:

a. Type the cone sizes and corresponding output factor values in the Measured
Output Factors table.

b. Specify the output factor measurement source-to-phantom distance.
c. Specify the output factor measurement depth.
d. Specify the X and Y jaw positions (in mm) that were used during output

factor measurement.
12. In the Focus window, right-click the add-on and choose Import  > Measured

Tissue Maximum Ratios.
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13. In the Look in list box, navigate to the folder containing the files in w2CAD
format to be imported and click OK to start the import.

If you notice errors in the measured data, stop the import process. Trace the
source of the error to a problem in the measured data, and correct the measured
data before resuming the import procedure.

14. Specify the Tissue Maximum Ratio measurement source-to-detector distance.
15. Repeat step 12 and step 13 to import the Off-axis ratios.
16. Right-click the add-on in the focus window and choose Calculate Beam Data.
17. Verify the calculated data (Evaluating the Configured CDC Data on page 147).

Remember to save and approve your configured beam data. Validate the
configured beam data in the Beam Data workspace. If you need to continue the
configuration after validating the data, unapprove the data first. Instructions for
approving, validating and unapproving beam data: Beam Configuration Reference
Guide.

Evaluating the Configured CDC Data
You can evaluate the configured CDC data by reviewing the processed data or by
evaluating Gamma error histograms and pointwise gamma errors. You can also
create a plan with static fields, and use that for evaluating the configured data.

Evaluating the Adapted Data

The CDC configuration program adapts the measured beam data, for example, by
removing unphysical values from the measured curves. The adapted data is called
processed data, and it can be reviewed after the configuration program has
completed in the Beam Data workspace. Each measured curve has a corresponding
processed curve which is used in configuring the beam data. You can see each
processed curve individually or through a Compare object displayed in the Focus
window. The Compare object shows both curves in the same axis.

Evaluating Gamma Error Histograms

Using the fully configured Eclipse Cone Dose Calculation model, the gamma error33

is calculated for each processed measurement curve by comparing it with adapted
measurement points. For this purpose, the adapted points and calculated curves are
superimposed to the same graph, in which the X-axis corresponds to position (mm)
and the Y-axis to relative dose (%) as in the figure.

33 Daniel A. Low, William B. Harms, Sasa Mutic, and James A. Purdy: A technique for
the quantitative evaluation of dose distributions. Medical Physics 25 (5), 656–661
(1998).
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Figure 21 Definition of Pointwise Gamma Error

In the figure, the continuous line represents the calculated profile, the black dot
indicates the adapted point ‘p’, and the blue dot indicates the point closest to point
‘p’ on the calculated curve.

The CDC configuration program calculates the gamma error for each processed
measurement curve at each point by comparing the measured value with the
calculated curve. These errors are shown at each point for each measured tissue-
maximum ratio curve and profile. The unit used for the relative dose difference is 1%
and the unit of the distance is 1 mm. The resulting gamma error in the example in the
figure is approximately 2.24.

The gamma error histograms for both TMR and OAR curves are calculated from the
pointwise gamma errors.

Configure Cone Applicators in RT Administration
You need to configure the cone applicators in RT Administration before you start to
configure the CDC algorithm.
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Note: The field size defined on the applicator tab during the configuration is important,
because it is used in dose calculation. Varian recommends the use of appropriate collimation to
narrow the high-dose treatment field. Exceeding this limit will cause extra leakage outside the
cone mount, which may result in excessive radiation dose to the patient. For all cones, the field
size must be bigger than the diameter of the cone applicator, but it must not exceed
56 mm × 56 mm.

1. In RT Administration, select the Radiation & Imaging Devices tab.
2. Select the treatment machine you are configuring.
3. Select the Applicator tab.
4. Click New Applicator.
5. On the General tab, do the following:

a. In the ID field, type an ID for the cone applicator. The ID is shown in the
Eclipse Cone Planning user interface, so it should state the size of the cone.

b. In the Name field, type a name for the cone applicator. This can be identical
with the ID.

c. In the Internal Code field, type an integer you want to use as the internal
code.

d. If you are using PAVS and you want to print the bar code labels for the cones,
select the External Verification check box.

6. Go to the Applicator tab in the Applicator Properties dialog.
7. Do the following:

a. Make sure that the Rectangular check box is not selected.
b. Select the Stereotactic check box.
c. In the Field Size group box enter the cone diameter in centimeters in the X

text box. The value must be between the defined operating limits. You can
adjust the operating limits if necessary.

d. Define the distance from the source to the head of the applicator.
8. Click the Slots tab, and assign a slot from the All Slots available list.
9. Click OK.

10. Repeat from step 4 to step 9 for the other cones.
11. Select the Configured EMT tab and do the following:

a. In the Configured EMT group, select the Arc technique for the energy mode
you want to use.

b. When the Add‐on Validation for <nn> X / ARC group is active, select the
check boxes of the SRS cones you created to enable the add-on validation for
them.

c. To enable static cone fields, in the Configured EMT group, select the Static
technique for the energy mode you want to use.
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d. When the Add‐on Validation for <nn> X / STATIC group is active, select the
check boxes of the SRS cones you created to enable the add-on validation for
them.

Repeat this step for all the energy modes you are going to use.
12. Select the Applicator tab and double-click the ID of the applicator you created.
13. Select the Applicator tab in the dialog box, and click Configure Jaw Size.
14. Type the jaw sizes for the cone for each energy you configured the cone for, and

click OK.

The jaw sizes you define must be the same you used for measuring the Output
Factors.

15. Repeat from step 12 to step 14 for all cone applicators you are configuring. You
can keep the Applicator Properties dialog box open, and click Apply to apply
your changes when switching from one applicator to the next.

16. Click OK to close the Applicator properties dialog box.
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Chapter 8    Electron Monte Carlo Algorithm (eMC)

Electron Monte Carlo (eMC) Algorithm
Note: The eMC algorithm does not support the use of electron arc fields, although Eclipse
External Beam Planning allows selecting the ARC field technique for an electron field.

The electron Monte Carlo (eMC) algorithm is a fast implementation of the Monte
Carlo method designed for the calculation of the dose distribution from high-energy
electron beams. The eMC algorithm consists of two models:
■ Transport model, Macro Monte Carlo (MMC) method that transports electrons

and calculates the dose deposited along the particle trajectories.34,35

■ Electron beam source model that describes the electrons and photons emerging
from the treatment head of the linear accelerator.36

Since the eMC uses material-specific properties during the particle transport and also
when converting absorbed energy to dose, you will see the following text when a
plan calculated with eMC is displayed on screen: “Transport in Medium, Dose to
Medium”.

The algorithm models collimator jaws. MLC is modeled only indirectly as a part of
jaw modeling on the machines that have fixed jaws or no jaws parallel with the MLC.
Blocks are supported. Tray transmission is not taken into account in dose calculation.

If a bolus is linked to a field, the eMC algorithm takes the bolus into account in dose
calculation and the dose is visualized inside the bolus. All support structures, for
example couches, are ignored. For other structures, only parts that are inside the
body structure are taken into account.

34 Neunschwander H, Mackie TR & Reckwerdt PJ: MMC—a high performance Monte
Carlo code for electron beam treatment planning. Physics in Medicine and Biology,
1995 April; 40(4) 543–574.

35 M. K. Fix et al.: Monte Carlo dose calculation improvements for low energy electron
beams using eMC. Physics in Medicine and Biology, 2010; 55: 4577-4588.

36 M. K. Fix et al.: Generalized eMC implementation for Monte Carlo dose calculation
of electron beams from different machine types. Physics in Medicine and Biology, 2013;
58: 2841-2859.
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Transport Model (MMC)
The transport model of the eMC algorithm is the Macro Monte Carlo (MMC) method,
which is an implementation of the Local-to-Global Monte Carlo (LTG MC) method.
Basically, the LTG-MC method is a two-step procedure:

1. Conventional MC simulations of electron transport are performed in a well-
defined local geometry.
The result of these calculations is a library of probability distribution functions
(PDFs) of particles emerging from the local geometry. These PDFs are calculated
only once for a variety of clinically relevant materials and energies.

2. MC calculations are performed in a global geometry. Particles are transported
through the CT volume in macroscopic steps based on the PDFs generated in the
local calculation.

Local Geometry Calculations

The MMC method uses spherical volume elements, referred to as spheres, for the
local calculations. The probability distribution functions (PDFs) were generated in
extensive pre-calculations by employing the EGSnrc code system.37 The pre-
calculations simulated the transport of incident electrons of variable energies through
macroscopic spheres of sizes and materials likely to be needed for actual MMC
calculation. If more than one electron emerges from a sphere, the electron with the
highest energy is called the primary electron. The other particles are called secondary
particles (secondary electrons and Bremsstrahlung photons). All PDFs are stored in
the MMC database as a static part of the eMC beam data.

MMC Database

The MMC database contains PDFs for the emerging particles with the following
parameters:
■ 5 different materials: air, lung (phantom material), water, lucite, and solid bone

(phantom material) (see the table)
■ 5 spheres of diameter d equal to 1.0, 2.0, 3.0, 4.0, and 6.0 mm. The maximum

sphere size depends on the particle's initial energy: 2 mm for 4MeV, 3 mm for
5MeV, 4 mm for 6MeV, 6 mm for 7,5MeV and higher energies.

■ 30 incident energy values T i (0.2, 0.4, 0.6, 0.8, 1, 1.5, 2, 3, ... 24, 25 MeV)

37 I. Kawrakow and D.W.O. Rogers: The EGSnrc Code System: Monte Carlo Simulation
of Electron and Photon Transport. Ionizing Radiation Standards, National Research
Council of Canada, NRCC Report PIRS-701, April 19, 2002.
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For each combination of these parameters, the following information is stored:
■ Exit energy T f  , exit position α and exit direction θ of the primary electrons.
■ Energy direction and probability (weight) of secondary electrons.
■ Energy and probability (weight) of secondary photons.

The table lists the mass densities of the five preset materials.

Table 30 Mass Densities of Preset Materials

Material Density [g/cm3]

Air 0.0012

Lung phantom 0.30

Water 1.0

Lucite 1.19

Solid bone phantom 1.84

Example: If the average density within a sphere is 1.12 g/cm3, there is a 12/19 chance
that the material is lucite, and a 7/19 chance that it is water.

The figure shows the local geometry used in the MMC algorithm.
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Figure 22 Local Geometry Used in MMC

Preprocessing the CT Volume

At each position in the CT volume, the preprocessing step determines sphere sizes
and mean sphere densities. This is done over the whole CT volume prior to the MMC
simulation.
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The CT volume is first converted into a mass density volume with a user-defined
resolution (0.1–0.5 cm), applying appropriate CT-to-mass density conversion factors.
The resulting density volume is then scanned for heterogeneity. To each voxel of the
density-volume, a sphere index is assigned that corresponds to the maximum sphere
radius that can be used from the current voxel center without the corresponding
sphere reaching into the other material. The maximum allowed sphere size depends
on the electron energy (more information: MMC Database on page 152). In addition
to this constraint large changes in adjacent sphere sizes are prevented.

The process results in:
■ Small spheres assigned to voxels located near interfaces between materials
■ Large spheres assigned to voxels at greater distances from material interfaces (see

the figure)

A voxel of the density volume is considered to be part of a heterogeneous volume if
the density ratio of the voxel and its neighbors exceeds the limit of 1.5. If the densities
in both voxels are below the threshold of 0.05 g/cm3, the ratio is not evaluated.
Entering a density threshold prevents noise in low-density data from being
interpreted as heterogeneity. For densities and density ratios below the limits
mentioned above, the MMC algorithm is capable of processing differences in the
material without decreasing the step size.

The material assigned to each sphere depends on the average mass density within
the sphere. If the average mass density of a sphere is exactly equal to the mass
density of one of the preset materials, that preset material is selected for the sphere. If
the mass density of a sphere is between two preset material values, the material is
randomly selected from these two materials each time a particle enters the sphere.
The probability for a material to be selected is proportional to the closeness of a
sphere’s average mass density to the mass density of the material (Table 30 Mass
Densities of Preset Materials on page 153). If the mass density of a voxel exceeds the
maximum mass density in the eMC database (1.84 g/cm3), the maximum mass
density will be used and scattering may not be based on the correct material.
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Figure 23 Result of a Preprocessed CT Slice

Primary Particle Transport and Energy Deposition

The scanning and averaging processes of the CT volume (Preprocessing the CT
Volume on page 154) reduces the determination of the appropriate sphere size and
mean sphere density for an MMC step to a table lookup for the density voxel
containing the current sphere center. The sphere center is placed at a distance from
the current position of the primary electron in the direction of motion of the primary
electron. This distance equals one radius of the maximum allowed sphere size of the
previous step. The current position of the primary electron is the exit position on the
previous sphere.

The algorithm stops a particle at the interface between different materials (6 in the
figure), and restarts the transport with a new sphere in the new material. Stopping at
interfaces is only necessary if the ratio of linear stopping powers in dose-volume
voxels on both sides of the interface exceeds a limit of 1.5. For stopping power ratios
below this limit, the MMC algorithm steps across material interfaces without
stopping the particle at the interface.

The figure shows a schematic illustration of the primary electron transport algorithm.

156 Eclipse Photon and Electron Algorithms Reference Guide



1

2

3

4

5

6

7

1. Material 1

2. Material 2

3. Electron direction and step size from previous sphere

4. Step size reduction near boundary

5. Heterogeneity

6. Stop at interface

7. Boundary crossing between materials

Figure 24 Primary Electron Transport

Energy of the primary electron is deposited along a straight line from the point
where the primary electron enters the sphere to the point where it leaves. The energy
Tvox deposited in each voxel along a ray is determined according to:

Equation 44

 
Tvox = Tdep

Svox

Skug

lvox

ldep
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where   

lvox = Length of the line inside the voxel

ldep = Total length of the current transport step

Tdep = Primary electron energy to be deposited in the current step

Svox = Linear stopping power of the voxel material

Skug = Linear stopping power of the sphere that was used to look up the re-
sulting electron parameters of the current transport step

As described above, the electron is stopped at a voxel boundary if the ratio of linear
stopping powers between neighboring voxels along the line is above a limit.

Primary photons lose their energy through the following interactions:
■ Compton scatter
■ Pair production
■ Photo electric effect

Electrons and positrons created from these interactions are treated as primary
particles. The direction of the primary photon may change in these interactions.
Distance between the subsequent primary photon interactions is chosen randomly
based on the photon’s mean free path and the attenuation coefficient at the given
density and the photon’s remaining energy. The primary photon is traced until it has
lost all its energy.

Secondary Particle Transport and Energy Deposition

Each macro step generates one secondary electron and one secondary photon (or
only one secondary photon) with associated weight w(T i) , which is the probability
that the secondary particle occurs in the local simulation of the incident electron of
energy T i (Figure 22 on page 154). The energy and the direction of the secondary
electrons are sampled from the distributions obtained from the local simulations. For
the secondary photons only the energy is sampled, direction is taken from the
incident electron.

The amount of secondary electron energy deposited along its direction in each voxel
is calculated as follows:

Equation 45

 
ΔEe = w(T i) × 2 MeV

cm × Δl × Svox

Swater
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where   

ΔEe = Energy deposited to voxel from the secondary electron.

w(T i) = Weight of the secondary particle emerging from incident electron of en-
ergy T i .

Δl = Length of the line inside the voxel.

Svox = Linear stopping power of the voxel material.

Swater = Linear stopping power of water.

For the secondary photon, the distance to the next interaction is determined by
taking the local mass attenuation of the material into account and applying ray
tracing from the sampled starting position along the direction of the incoming
primary electron. At the interaction position, the energy which is transferred from
the photon to the electron is sampled from a PDF depending on the photon energy
using data from XCOM.38 The weight of the electron is set to the weight of the
photon. While the photon is no longer tracked, the energy of the electron is deposited
along the photon’s direction according to the above equation.

Statistical Uncertainty

The eMC algorithm defines the overall statistical accuracy as the average relative
statistical uncertainty of all voxels in the region of interest. The region of interest
contains all voxels within the body structure with a dose larger than the user-defined
value P% of the maximum dose. The average statistical uncertainty SP is calculated as
follows:

Equation 46

 
SP = 1

NP
∑

Di jk > P%Dmax

ΔDi jk

 

where   

P = Value of the Dose threshold for uncertainty set in calculation op-
tions.

NP = Number of voxels satisfying the condition Di jk > P%Dmax .

Di jk = Dose at point ( i, j, k ) within the body structure.

38 Berger M. J. et al.: XCOM: Photon Cross Section Database version 1.5. National
Institute of Standards and Technology, Gaithersburg, MD. 2010.
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Dmax = Maximum dose within the body structure

ΔDi jk = Relative standard deviation of the dose deposited to point ( i, j, k )

Dose Smoothing

The dose distributions from Monte Carlo simulations necessarily contain statistical
noise due to the random nature of the simulation process. The final dose distribution
can be smoothed to reduce the statistical noise. Strong smoothing may deteriorate the
shape of the dose distribution in the high gradient areas.

The eMC algorithm supports two different dose smoothing methods, the Gaussian
and the median smoothing.

Gaussian Dose Smoothing
The Gaussian dose smoothing is a convolution smoothing method that uses a kernel
representing the shape of a Gaussian (bell-shaped) curve.

Before the convolution, the Gaussian distribution is limited by truncating the kernel
at the point of about three standard deviations from the mean. This is done to be able
to restrict the convolution kernel to a practical size. After a suitable kernel size has
been achieved, the Gaussian dose smoothing is performed using standard 3D
convolution methods.

The degree of the Gaussian smoothing is determined by the standard deviation of the
Gaussian (eMC Calculation Options on page 161). The size of the deviation affects
the size of the kernel required so that larger standard deviation of the Gaussians
require larger convolution kernels.

The Gaussian smoothing produces a weighted average of each pixel’s neighborhood,
with the average weighted more towards the value of the central pixels.

Median Dose Smoothing
The median dose smoothing determines the value of a pixel by examining the pixel
values in its neighborhood on a slice and taking the median of these values. Each
pixel and its neighbors are considered in turn. If a pixel is considered representative
of its surroundings, it is replaced with the median of the pixel values in the
neighborhood. The median is calculated by first sorting the pixel values into
numerical order and then replacing the pixel with the middle value. If the
neighborhood contains an even number of pixels, the average of the two middle pixel
values is used. The median smoothing is performed slice by slice.
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The median smoothing does not conserve the sum of the pixel values in the volume
(the sum of the median values is not equal to the sum of the original values). If the
window size is too large, this can lead to distortions in dose volume histograms. The
eMC algorithm uses fairly small window sizes to minimize the error caused by
distortions.

eMC Calculation Options

The following calculation options can be configured for eMC:
■ Statistical uncertainty: Average relative statistical uncertainty inside the body in

the region where dose exceeds P% of the maximum dose (Statistical Uncertainty
on page 159). Reducing the statistical uncertainty from 2% to 1% also increases the
required amount of particle histories to be simulated, and the time required for
completing the simulations, four times.

When using a value higher than the statistical uncertainty limit, no MU will be
given. This option is not used if the value of the Number of particle
histories parameter is other than 0.

■ Statistical uncertainty limit: Limits the MU calculation from a dose with high
statistical uncertainty.

■ Dose threshold for uncertainty: Defines the dose threshold for the region as a
percentage of the maximum dose inside body in which to calculate the statistical
uncertainty. With a lower value, the a lower statistical uncertainty is achieved.

■ Calculation grid size in cm: Defines the resolution of the dose calculation.
■ Random generator seed number: Defines the random number sequence used in

the particle generator. If the seed value is set to 0, the EMC algorithm uses a
randomly selected seed. The seed value used in the simulation is reported in the
dose calculation log.

■ Number of particle histories: Defines the number of particles used in in the
simulation. 0 value means that this option is not used; instead the simulation uses
as many particles as required to reach the statistical uncertainty set in Statistical
uncertainty option.

The eMC algorithm uses batches of particles in the simulation, each batch
consisting of 10,000 particles. The value given for the Number of particle
histories option is always rounded up to the nearest number divisible by
10,000. For instance, if the given value is 10,001, eMC simulates two batches
(equalling to 20,000 particles). The number of particles used in the simulation is
reported in the dose calculation log.

When the Monte Carlo field parallelizaton factor is larger than 1, the statistical
uncertainty goal for one servant is calculated as Statistical uncertainty ×
sqrt(Ν)), where N is the number of servants used in the calculation of one field.

■ Smoothing method: Defines the method of dose distribution smoothing. Possible
values are No smoothing, Gaussian and Median.
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■ Smoothing level: Defines the strength of the dose smoothing. Possible values are
Low, Medium and Strong. Smoothing changes the dose distribution, which then
may change the MU for the plan.

Default calculation options are defined in Beam Configuration. Monte Carlo field
parallelization factor defines the number of servants used in the calculation. The
factor is defined in DCF settings.

Electron Beam Source Model
The electron beam source model is a multiple source model39,40. It contains the
following sub-sources:
■ Main source (electrons and photons) as a point source near the scattering foil
■ Jaws source (electrons and photons)
■ Scraper sources for electrons scattered at the upper applicator scrapers
■ Edge source for electrons scattered at the last applicator scraper or insert
■ Transmission photons

The model is based on pre-calculated data for different machine types (Elekta,
Siemens and Varian), and it is configured using measured beam data.

Main Source

The main source is a point source for the electrons and photons coming from the
scattering foil. The distance of the focus is 10 cm below the nominal target, and the
particles are sampled on a plane located 95 cm below the nominal target, inside the
shape defined by the applicator or the insert.

39 Fix M. K. et al.: Monte Carlo dose calculation improvements for low energy electron
beams using eMC. Physics in Medicine and Biology 2010; 55: 4577–88.

40 Fix M. K. et al.: Generalized eMC implementation for Monte Carlo dose calculation
of electron beams from different machine types. Physics in Medicine and Biology 2013;
58: 2841–2859.
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Figure 25 Main Diverging Beam

The directions of the photons and electrons are determined as follows:
■ The direction of the photons is given by the sampled position on the plane and the

Z-position of the focus (10 cm below the nominal target).
■ The mean direction of the electrons is given by the sampled position in the plane

and the position of the nominal target. The direction is then varied according to a
Gaussian distribution with an energy dependent variance.

Jaws Source

The jaws source describes electrons and photons scattered at the 4 jaws X1, X2, Y1,
and Y2. The origin of the particles is sampled uniformly from 4 horizontal line
segments located along the center of the inner side of the jaws. Like for the main
source, the particles are sampled on a plane at 95 cm inside the shape defined by the
applicator or the insert.
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Figure 26 Jaws Source

The directions of the photons and electrons are determined as follows:
■ The direction of the photons is given by the sampled position in the plane and the

sampled origin position.
■ The mean direction of the electrons is given by the sampled position in the plane

and the sampled origin position. The direction is then varied according to a
Gaussian distribution with an energy dependent variance.

Scraper Sources

For each upper applicator scraper there is a line source along the edges of its opening
containing scattered electrons.

Figure 27 Scraper Sources

There are two types of scraper sources:
■ Electrons coming from the upper rim of the cutout. They are produced by main

electrons entering the scraper material on the upper plane.
■ Electrons coming from the inner side of the cutout. They are produced by main

electrons entering the scraper material on the inner side.
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The electrons are sampled from pre-calculated scatter kernels.

Edge Electrons

The edge electrons sub-source is a line source along the edges of the opening of the
last applicator scraper or the insert containing scattered electrons.

Figure 28 Edge Electrons

There are two types of edge electrons:
■ Electrons from the upper rim of the cutout, and produced by main electrons

entering the cutout material on the upper plane.
■ Electrons from the inner side of the cutout, and produced by main electrons

entering the cutout material on the inner plane.

The edge electrons are sampled by use of pre-calculated scatter kernels.

Transmission Photons

Transmission photons are sampled using pre-calculated kernels. They exit from the
outer rim of the applicator and from the insert material.

Figure 29 Transmission Photons

The following three types of transmission photons are taken into account:
■ Main photons passing through the insert material without interaction. They have

the same direction as the main photons but a different energy distribution.
■ Scattered photons produced by main photons in the insert material, sampled by

using a pre-calculated kernel.
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Machine Type Parameters in the Electron Beam Source Model

The machine type parameters are used for creating pre-calculated data for the
electron beam source model. The machine type parameters describe some of the
physical properties of a treatment unit, and may vary between different treatment
units. The following tables list the information on the properties of the supported
machine types.

Note: For machine types which do not have X jaws, the jaw positions in the following tables refer
to the positions of the MLC leaf banks.

Machine Type Varian

Table 31 Parameters for Machine Type Varian

Parameter Value

Focus position of main source 10 cm

Position of the jaws source, Y jaws 32 cm

Position of the jaws source, X jaws 40 cm

Position of the scraper 1 65.4 cm

Thickness of the scraper 1 1.6 cm

Position of the scraper 2 78.5 cm

Thickness of the scraper 2 2.0 cm

Lower end of the last applicator scraper 95 cm

Thickness of the lowest applicator scraper or
block

1.4 cm

Applicator or block material Cerrobend

Supported energy modes 4e, 6e, 9e, 12e, 15e, 16e, 18e, 20e, 22e

Supported applicators 6 ×6, 10×6, 10×10, 15×15, 20×20, 25×25

Table 32 Modeled Jaw Positions for Machine Type Varian

Energy/
Applicator
X x Y

6x6 10x6 10x10 15x15 20x20 25x25

4e 20×20 16×13 20×20 20×20 25×25 30×30

6e 20×20 16×13 20×20 20×20 25×25 30×30

9e 20×20 16×13 20×20 20×20 25×25 30×30
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Energy/
Applicator
X x Y

6x6 10x6 10x10 15x15 20x20 25x25

12e 11×11 16 ×11 14×14 17×17 25×25 30×30

15e 11×11 16×10 14×14 17×17 23×23 28×28

16e 11×11 16×10 14×14 17×17 23×23 28×28

18e 11×11 16×10 14×14 17×17 22×22 27×27

20e 11×11 16×10 14×14 17×17 22×22 27×27

22e 11×11 16×10 14×14 17×17 22×22 27×27

Note: Slight deviations (approximately up to 10%) between the jaws positions given in the above
table and actual positions set by the machine are not expected to affect the accuracy.

Machine Type Elekta

Table 33 Parameters for Machine Type Elekta

Parameter Value

Focus position of main source 10 cm

Position of the jaws source, X jaws 33 cm

Position of the jaws source, Y jaws 45 cm

Position of the scraper 1 55 cm

Thickness of the scraper 1 0.6 cm

Position of the scraper 2 77 cm

Thickness of the scraper 2 1.2 cm

Position of the scraper 3 86 cm

Thickness of the scraper 3 1.2 cm

Lower end of the last applicator scraper 95 cm

Thickness of the lowest applicator scraper or
block

1.0 cm

Applicator or block material Cerrobend

Supported energy modes 6e, 8e, 9e, 10e, 12e, 15e, 18e

Supported applicators 6×6, 10×10, 14×14, 20×20, 25×25
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Table 34 Modeled Jaw Positions for Machine Type Elekta

Energy/Appli-
cator X x Y

6x6 10x10 14x14 20x20 25x25

6e 16×14 22×20 26×24 30×28 36×34

8e 16×14 22×20 26×24 30×28 36×34

9e 16×14 22×20 26×24 28×26 34×32

10e 16×14 22×20 26×24 28×26 34×32

12e 16×14 22×20 24×22 28×26 34×32

15e 16×14 20×18 22×20 26×24 34×32

18e 16×14 20×18 22×20 26×24 34×32

Note: Slight deviations (approximately up to 10%) between the jaws positions given in the above
table and actual positions set by the machine are not expected to affect the accuracy.

Machine Type Siemens

Table 35 Parameters for Machine Type Siemens

Parameter Value

Focus position of main source 10 cm

Position of the jaws source, Y jaws 24 cm

Position of the jaws source, X jaws 32 cm

Position of the scraper 1 56.6 cm

Thickness of the scraper 1 0.6 cm

Position of the scraper 2 85.0 cm

Thickness of the scraper 2 3.2 cm

Lower end of the last applicator scraper 95 cm

Thickness of the lowest applicator scraper or
block

1.3 cm

Applicator or block material Cerrobend

Supported energy modes 6e, 7e, 9e, 13e, 17e, 20e

Supported applicators 10×10, 15×15, 20×20, 25×25
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Table 36 Modeled Jaw Positions for Machine Type Siemens

Energy/Appli-
cator X x Y

10x10 15x15 20x20 25x25

6e 19×19 23×23 27×27 32×32

7e 19×19 23×23 27×27 32×32

9e 19×19 23×23 27×27 32×32

13e 19×19 23×23 27×27 32×32

17e 19×19 23×23 27×27 32×32

20e 19×19 23×23 27×27 32×32

Note: Slight deviations (approximately up to 10%) between the jaws positions given in the above
table and actual positions set by the machine are not expected to affect the accuracy.

MU Calculation and Dose Normalization
The electron Monte Carlo (eMC) algorithm is configured using measured depth dose
curves and profiles, to which pre-calculated data is fitted. The source weights are
calibrated to give the best fit against the applicator depth dose curve in units of
absolute dose.

During dose calculation, the eMC algorithm tracks individual electrons through the
patient geometry and calculates the energy deposited into each dose voxel along the
electron path. The number of electrons tracked depends on the patient and field
geometries, and the user-defined statistical uncertainty or number of particle
histories. After all the required electrons have been tracked, the energy deposited
into each dose voxel is converted to dose (in Gy) by dividing it with the density and
the volume of the voxel. Then, the dose is scaled to the units of cGy/MU with a factor
calculated from the ratio of the number of particles used in the simulation and the
source weights. The algorithm provides the scaling factor (displayed as MU/Gy)
which scales the simulated dose distribution from the internal dose scale to the units
of Gy/MU.

Due to the statistical and non-deterministic nature of Monte Carlo calculations, it
should be noted that the resulting dose distribution contains noise. The relative
magnitude of the noise depends on the statistical uncertainty of the calculation
(Statistical Uncertainty on page 159). The lower the statistical uncertainty, the lower
the magnitude of the noise peaks. However, the maximum dose value is always an
overestimate. The location of the dose maximum point may also be incorrect. Thus
the dose maximum value should not be used alone to normalize the dose or evaluate
the goodness of the distribution. Similarly, caution should be taken when prescribing
dose to a single point. Prescription to a volume is more robust.
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The absolute dose distribution is converted to relative units (percentage) and
normalized. The dose calculated by the eMC is normalized to 100% at the dose
maximum of the volume dose, if the No Plan Normalization method is used.

Note: If the body surface curvature is not taken into account in the manual MU calculation,
the calculation results will have some MU difference when compared to the eMC calculation.41

Known Limitations of the eMC Algorithm

About the accuracy
The accuracy of the Transport (MMC) model and the electron beam source model is
typically within 3% of the dose maximum. However, deviations exceeding 3% may
occur for:
■ Unusual body contour shapes, or presence of extreme heterogeneities.
■ Suboptimal or incorrect beam data.

Block material thickness
Although the block material (cutout material), thickness and transmission value can
be configured in RT Administration, the eMC algorithm does not use these for dose
calculation. Instead the algorithm uses the cutout parameters defined in the electron
beam source model. If the cutout material and/or thickness in use differs from that
defined in the electron beam source model, the calculated dose under the cutout may
deviate from the measured dose at the same point, especially when using high
energies.

41 E. R. Ritenour, R. K. Cacak, W. R. Hendee: Ionization produced by electron beams beneath
curved surfaces. Medical Physics 10 (1983) 669.
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Configuration of the eMC Algorithm
Note: When configuring fluence delivery algorithms, notice the following:
■ It is important to configure the system so that it corresponds to the characteristics of the

treatment machine.
■ Periodically perform follow-up measurements and compare with the dosimetric beam data

used for configuring the beam. If fluctuations are large and the configured beam data no
longer represents the average beam delivered by the machine, reconfigure the beam data
using the newer dosimetric beam data.

■ Measure all dosimetric beam data in as stable conditions as possible.
■ Use the same file naming conventions in beam data measurements (input files) and in

Beam Configuration (Therapy Unit name), and name the input files so that it is easy to
match the beam data to the treatment unit during the configuration process.

■ When measuring depth dose curves and profiles, use sufficiently fine measurement interval
to accurately represent the beam properties.

Open Field Measurements
The following full open-field measurements (without the applicator, with collimator
jaws open at 40 cm × 40 cm) must be provided for each electron energy:
■ Depth-dose curve in water at the Source-to-Phantom Distance (SPD) = 100 cm
■ One profile in air at 95 cm. The measurement must extend at least up to a

distance, which corresponds to the diagonal length of the largest applicator size.

Applicator Measurements
For each energy/applicator combination the following measurements must be
provided:
■ Depth-dose curve in water at the Source-to-Phantom Distance (SPD) = 100 cm
■ Absolute dose in water, expressed in [cGy/MU], at the calibration point on the

depth dose curve (usually the dmax or a point close to it)

The following measurements are optional:
■ Inplane (gantry-table direction) and crossplane (perpendicular to inplane) profiles

in air at 95cm with jaws positions set according to the applicator, but without the
applicator in place. Beam data can be configured with no applicator air profiles,
one applicator air profile, or two applicator air profiles. File formats for the inline
and crossline air profiles: w2CAD Files for the eMC Algorithm on page 310.
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The beam measurement data must be in the w2CAD format in order to transfer it to
Beam Configuration (Appendix C File Formats for Measured Beam Data on
page 304).

Note: Note the following regarding applicator measurements:
■ The applicator size is read from the database to the General Parameters file. Verify that the

value is correct.
■ The field size is determined by the selected electron applicator. The electron applicator field

size is entered in Beam Configuration. The jaw settings entered in Eclipse External
Beam Planning have no effect on the calculated dose distribution.

Configuration Parameters for Electron Beams
Specific parameters need to be defined for each treatment unit to be configured
before importing measured beam data. Part of these parameters are read into Beam
Configuration from RT Administration. When configuring the eMC algorithm,
verify that the parameters read from RT Administration are correct, and add
whatever parameters may be missing.

General Parameters
The eMC algorithm requires defining the following general treatment unit
parameters for importing measured beam data and for dose calculation:

■ Therapy unit name (defined in Beam Configuration).
■ Nominal energy (read from RT Administration).

The nominal energy is interpreted as the energy of the incoming monoenergetic
electron beam hitting the scattering foil. Its value determines the set of
precalculated data fitted to measurements when configuring eMC algorithm. The
fitting process can compensate for small deviations between the real electron
beam energy and the eMC nominal energy.

■ Source-axis distance in cm (read from RT Administration). Only 100.0 cm is
supported.

Configuration Parameters
The configuration parameters are:

■ Machine model: Defines the electron beam model parameters.
■ Statistical uncertainty (%) for configuration: Statistical uncertainty that is used in

simulation during the configuration. More information: Statistical Uncertainty on
page 159

Applicator Parameters
The applicator parameter defines the applicator size in the units of cm × cm.
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Beam Data Created Based on the Measurements

Open Field Depth Dose Curve
A set of pre-calculated open field mono-energetic depth dose curves for the main
electron source together with the pre-calculated photon depth dose curve of the main
photon source are fitted to reproduce the measured depth dose curve. This fit
produces the energy spectrum of the electrons from the main source.

Applicator Depth Dose Curve
Applicator depth dose curve is used to determine the electron energy spectrum for
the jaws source. The energy spectrum of the photons from the jaws source is pre-
calculated. The weight of the jaws source is set so that its contribution to the total
dose is 10%.

Applicator Absolute Dosimetry
All electron beam source weights are calibrated to give the best fit against the
applicator depth dose curve in units of absolute dose.

Open Field Air Profiles
Open field air profiles are used to construct the radial fluence f (r) .

Applicator Air Profiles
The applicator air profiles and the open field radial fluence f (r) is used to construct
two-dimensional fluence f (x, y) that is used in dose calculation for the given
applicator.

The applicator air profiles are optional inputs for configuration. If no applicator air
profile measurements are provided, then radially symmetric fluence f (r) from the
open field air profile is used during dose calculation. In cases where the fluence
within the applicator opening is different from the open field air profile, it is
recommended to include applicator air profiles.

The configuration program symmetrizes all the measured air profiles around the
central axis.

Configure the eMC Algorithm in Eclipse
1. In Beam Configuration, go to the Beam Data workspace. Instructions on how to

use Beam Configuration: Beam Configuration Reference Guide.
2. In the Focus Window, select the treatment unit and energy to be configured.
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3. To insert new beam data, choose Insert > New Beam Data.
4. Define the name for the therapy unit.
5. To import the depth dose curve for the open field, choose File > Import >

Measured Open Beam Depth Dose.

Note the format of the depth dose curve files (Appendix C File Formats for
Measured Beam Data on page 304).

6. Check the value for the Source-Phantom distance of the depth dose curve, and
add if missing.

7. To import the profile data for the open beam, choose File > Import > Open Beam
Profile in Air.

8. Check the value of the Source-Phantom distance of the profile curve, and add if
missing.

9. Check the machine type and statistical uncertainty value for the configuration in
Configuration Parameters.

10. To insert the applicators, choose Insert > New Add‐On.
11. Enter the field size for the applicators in the Applicator Parameters window.
12. To match and assign the applicators against the database, choose Beam Data >

Match and Assign Add‐ons.
13. To import depth dose curves for the applicators, choose File > Import >

Measured Applicator Depth Dose.
14. Check the values for Source-Phantom distance, calibration depth, and dose at the

calibration depth of the depth dose curve, and add if missing.
15. To import the applicator specific air profile data, choose File > Import > In‐Air

Profile for Applicator. Check that both the inline and crossline profiles are
correctly imported as intended.

16. To calculate beam data for the applicators, choose Beam Data > Calculate Beam
Data.
Remember to save and approve your configured beam data. Validate the
configured beam data in the Beam Analysis workspace. If you need to continue
the configuration after validating the data, unapprove the data first. Instructions
for approving, validating and unapproving beam data: Beam Configuration
Reference Guide.

Configure eMC Using Existing Beam Data
1. In Beam Configuration, go to the Beam Data workspace. Instructions on how to

use Beam Configuration: Eclipse online help system or Beam Configuration
Reference Guide.

2. Add new beam data.
3. In the Focus Window, select the treatment unit and then choose File > Import >

Eclipse Beam Data.
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4. To navigate to the directory containing the Eclipse beam data, click Browse. The
active directory is shown in the Eclipse data box.

Navigate to the level of general data files of the calculation model. This level is
above the folders containing the configured beam data files.

5. In the list box on the left, select the data set containing the Eclipse beam data to
import.

6. Click OK.

The Eclipse beam data appears in the Context Window.
7. Match and assign the applicators.
8. When importing existing beam data configured for an older eMC, you need to

add the configuration parameters (Insert > Configuration Parameters).
9. Optional: Add the applicator air profiles (File > Import > In‐Air Profile for

Applicator).
10. When you have imported all necessary measured beam data, calculate the

configured beam data for the applicator(s) (Beam Data > Calculate Beam Data).

Remember to save and approve your configured beam data. Validate the
configured beam data in the Beam Analysis workspace. If you need to continue
the configuration after validating the data, unapprove the data first. Instructions
for approving, validating and unapproving beam data: Beam Configuration
Reference Guide.
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Chapter 9    Dose Optimization Algorithms

General Information about Dose Optimization
Algorithms

The dose optimization algorithms used in Eclipse are:
■ Photon Optimization algorithm (PO): Determines the optimal field shape and

intensity by iteratively conforming the dose distribution to the desired objectives
until an optimum solution is reached. Optimizes static field IMRT plans, VMAT
(RapidArc) plans, Elekta VMAT plans and Siemens mARC plans based on
optimization objectives.

■ Dose Volume Optimizer algorithm (DVO): Determines the optimal field shape
and intensity by iteratively conforming the dose distribution to the desired
objectives until an optimum solution is reached.

■ Plan Geometry Optimization algorithm (PGO): Selects the beam angles based on
user-defined dose-volume objectives. The PGO algorithm is based on the DVO
algorithm and uses the same objectives.

■ Progressive Resolution Optimizer algorithm (PRO): Creates VMAT, or RapidArc,
plans based on dose-volume objectives.

■ Multi-Resolution Dose Calculation algorithm (MRDC): Enables fast dose
estimation inside the PO, DVO, PGO and PRO.

Features of Dose Optimization Algorithms
The table is a summary of the features, objectives, parameters and their variants in
the dose optimization algorithms. For details, see the corresponding topics.

Table 37 A Summary of the General Features of Dose Optimization Algorithms

 PO DVO PGO PRO

Heterogeneity correction Yes Yes No Yes

Bolus Yes Yes Yes Yes

Support devices Yes Yes No Yes

Dose-volume Objectives Yes Yes Yes Yes

Mean dose objective Yes No No Yes
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 PO DVO PGO PRO

Minimum dose MU objective
for VMAT

Min. Fluence Min. Fluence MU objective

Normal Tissue Objective Interactive/
Automatic

Static Static Interactive/Auto-
matic

Restarting optimization Yes Yes (from
fluence)

No Yes

Intermediate dose calcula-
tion

Yes Yes No Yes

Output Fluences for
static fields

Leaf sequences
for VMAT
fields

Fluence Beam geom-
etry

Leaf positions and
MU/deg as a func-
tion of gantry
angle

Geometric optimization Arc Geometry
Tool for VMAT

No Local/global Arc Geometry
Tool

Dose calculation algorithm MRDC MRDC MRDC MRDC with pro-
gressive dose cal-
culation segments

gEUD objective Yes No No No

Base dose support Yes Yes Yes Yes

Bolus and Patient Support Devices
Optimization algorithms take bolus and patient support devices (for example couch
structures) into account. They interpret the assigned HU values and handle
overlapping structures in the same way as in the dose calculation algorithm.
However, because of how AAA and Acuros XB use heterogeneity correction in the
full final dose calculation inside bolus and patient support devices, the heterogeneity
correction must be turned on in the optimization algorithms. (Information on AAA
and Acuros XB: Chapter 4 Photon Beam Source Model on page 35.) If optimization is
performed without the heterogeneity correction, the patient support devices are
ignored (a warning is given in the calculation log), and bolus are treated as having
the density of water.

Note: The Plan Geometry Optimization (PGO) does not support heterogeneity correction and
does not take patient support devices into account.
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Target Masking
The point set for the target is projected to the fluence matrix. Only rays within 0.5 cm
from the closest projected point are allowed to have non-zero fluence values. Target
masking includes the MLC geometry. This means that any leaf having any points
within the 0.5 cm range includes all its rays to the field (in the Y-direction). The field
sizes are automatically determined from the masking data.

In the arc optimization algorithms, target masking is used to limit the leaf positions.
The target projection may be very different between different gantry angles. While
gantry is rotating from one gantry angle to another, the leafs may also be open
outside target projection.

Dose Calculation
The dose calculation from the fluences is based on multi-resolution 3D convolution of
Monte-Carlo-generated point-spread function kernels (Multi-Resolution Dose
Calculation (MRDC) Algorithm on page 184).

For the fluence-based static field IMRT optimization, the dose calculation is
straightforward.

The VMAT optimization calculates fluence for dose calculation from a dose
calculation segment, in which the MLC configuration and dose rates are converted
into a fluence. The fluence models the leakage caused by the rounded leaf ends,
tongue-and-groove effect and the transmission through the leafs (Example Sliding
Window Case on page 236).

Information on configuring the dose calculation: System Configuration for Dose
Optimization on page 207.

Dose-Volume Objectives
The optimization is based on dose-volume objectives (upper and lower objectives
defined in the Dose Volume Histogram view inside the Optimization dialog). Dose-
volume objectives are used to define the dose as follows:
■ Upper objective: Used to limit the dose in a given structure (for example, “no more

than 20% of the structure may receive more than 25 Gy”).
■ Lower objective: Used to define desired dose levels in target structures (for

example, “at least 70% of the structure must receive at least 20 Gy”).
■ Upper line objective: Used to limit the dose in a given structure for all volume

levels.
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If the dose-volume objectives are not met, a weighted quadratic cost is added to the
total objective function. For the upper objective, the cost is applied for the portion of
doses that exceed the desired dose value and volume level. For the lower objective,
the cost is applied for the portion of doses that fall short of the desired dose value
and volume level. For example:

Equation 47

 
costD=w × (D‐Dtarget)

2

 

where   

D = Dose

w = Weight

The dose-volume objective of each point introduces discontinuities in the
optimization space, and each additional objective may create thousands of new local
minima. To overcome this, the DVO and PRO also have a more powerful dose-
volume objective form, the line dose-volume objective, that allows using very
complex and expressive dose-volume objectives while creating fewer local minima.
The PO supports optimization of line objectives, but not creation of new ones.

Smoothing Objectives
The fluence needs to be smooth to enable leaf motion calculations with the LMC.
Fluence smoothness is ensured by adding an objective that includes the difference
between the neighboring fluence values (X smooth and Y smooth). This objective is
linear up to the value of 3% of the maximum fluence value, where it saturates to a
constant value. The saturation non-linearity allows for large fluctuations in the
fluence where required. The smoothing is performed in both X and Y-directions of
the fluence, with different user-configurable weightings. Typically, it is more
important to have a smoother fluence in the X-direction to ensure the minimal MU
factor for the LMC.

Smoothing objective is available only for static field IMRT optimization with DVO
and PO.
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MU Objective
The MU Objective can be used to control the number of MU that the PO or PRO
optimizer produces. Minimum and maximum values can be defined. An extra
multiplier is applied to the total objective function value if the number of MU is not
in the desired range. Strength value can be used to modify the strength of the effect.
Because the value is a multiplier to total objective function value, the relative effect of
the MU objective remains the same even when the priorities of the dose-volume
objectives are changed.

Normal Tissue Objective
The Normal Tissue Objective is used for the part of the body which does not include
the PTV to limit the dose level and prevent hot spots in healthy tissue. In addition,
the Normal Tissue Objective can be used for obtaining a sharp dose gradient around
the PTV.

Note: With the PO and PRO algorithms you can also use the automatic Normal Tissue
Objective (Automatic Normal Tissue Objective in PO and PRO on page 182).

Normal Tissue Objective Shape

The shape of the Normal Tissue Objective is controlled with the following
parameters:
■ Distance from PTV border (Xstart)
■ Start dose (f0)
■ End dose ( f ∞ )
■ Fall-off (k)

The shape of the Normal Tissue Objective (f(x)) as a function of the distance from
PTV border (l) is calculated as:

Equation 48

 
f x = f 0e

−k x − xstart + f ∞ 1 − e
−k x − xstart , x ≥ xstart

f 0, x < xstart
 

The figure shows a typical shape of the Normal Tissue Objective.
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Figure 30 Example Shape of the Normal Tissue Objective

The shape of the Normal Tissue Objective presented in the figure has been calculated
with the following parameter values:
■ Xstart = 10 mm
■ f0 = 1.1
■ f ∞ = 0.5
■ k = 0.05

Normalization of the Normal Tissue Objective is done as follows: level 1.0 (100%)
corresponds to the lowest upper objective defined for the target. If no upper objective
is defined, level 1.0 (100%) is 1.05 times the highest lower objective defined.

In addition to the parameters that control the shape of the Normal Tissue Objective,
the importance of the Normal Tissue Objective in relation to the other optimization
objectives is controlled with the Priority parameter. The Normal Tissue Objective is
taken into use by defining a value for the Priority parameter. Then the Normal Tissue
Objective values are calculated for all body points. If there are several PTVs, the
Normal Tissue Objective value for a specific body point is the highest one of the
Normal Tissue Objective values calculated at this point for all the PTVs. If the value
of the Priority parameter is set to zero, the optimization does not use the Normal
Tissue Objective.

Note: Any structure with at least one lower objective is considered a PTV by the Normal
Tissue Objective.
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Normal Tissue Objective Parameters

The table shows the Normal Tissue Objective parameters and their default values.

Table 38 Default Values for the Normal Tissue Objective

Parameter name Range Default Use of Parameter

Distance from PTV/
target border [cm]

-20–20 1.0 Determines the area where the Normal Tissue
Objective value must be constant. Expressed in
centimeters.

Start dose [%] 0–1000 105 Determines the relative dose level in the
Normal Tissue Objective at the PTV border.
Expressed in percentage.

End dose [%] 0–1000 60 Determines the relative dose level in the
Normal Tissue Objective in the area furthest
from the PTV border. Expressed in percentage.

Fall-off 0–100 0.05 Determines the steepness of the Normal Tissue
Objective curve shape.

Priority 0–1000 0 Determines the relative importance of the
Normal Tissue Objective. To use the Normal
Tissue Objective in optimization, the Priority
parameter must have a non-zero value.

Automatic Normal Tissue Objective in PO and PRO
The Automatic Normal Tissue Objective uses a set of internal parameters, so the
parameters in the Normal Tissue Objectives dialog box have no effect on it. The
internal parameters depend on the distances of the high dose areas from the target,
and they are adapted dynamically so that they are suitable for the patient anatomy
and the objectives during the optimization. The Automatic Normal Tissue Objective
monitors the area within a certain distance around the target, and if there are doses
that are exceptionally high considering the distance from the target, it tries to reduce
the dose at the area using the user-defined priority value.
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1. Dose
2. Distance from the target
3. The dose at this point is above the accepted dose level, and therefore the optimization tries to reduce

the dose in this area.
4. Accepted dose level for this case.
5. Points within this region are not affected.

Figure 31 Adjustment Criteria for Automatic Normal Tissue Objective

Automatic Normal Tissue Objective tries to reduce doses the same way as Normal
Tissue Objective, but the key difference is that the accepted dose level curve (4 in the
above figure. See also: Figure 30 on page 181) is not defined by the user, but
calculated automatically.

Volume Representation in DVO, PGO and PRO
Volumes are represented by point clouds generated from user-defined segments. The
sampling density of the point clouds is determined by the resolution and shape of the
user-defined segments. Sub-volumes located close to the surface of the structures are
represented more accurately, and the user-defined resolution is used inside the
volume. If the Normal Tissue Objective (NTO) is used, additional points are used
near target boundary to increase the accuracy (Normal Tissue Objective on page 180).
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Both the representation accuracy of volumes and the total number of points affect the
memory consumption and speed of the optimization algorithms. Using high
numbers of points helps to achieve higher accuracy in the volume representation,
however, it will also increase memory consumption. Reducing the number of points
will decrease memory consumption, but it may affect the accuracy of the volume
representation adversely and compromise the quality of the DVH shown in the
optimization. The optimization algorithms have the following restrictions related to
the volume representation:

■ DVO algorithm: Does not restrict the total number of points.
■ PGO algorithm: Estimates the memory consumption at the beginning of the

optimization. If the memory does not suffice for the optimization, an error
message is shown, instructing the user to decrease either the number of points or
initial fields in the plan.

■ PRO algorithm: Does not restrict the total number of points.

Information on volume representation in PO: Photon Optimization Algorithm (PO)
on page 185.

Minimal Fluence Objective in DVO and PGO Optimization
An additional objective is provided for the definition of the required minimal fluence
(minimize dose defined in the Optimization dialog box). The minimal fluence
objective works on per field basis. The optimization does not value extra fluence
outside the target if no critical organs have been defined there. The minimal fluence
objective allows for natural minimization of the fluence without introducing
additional (or even artificial) critical organs.

Multi-Resolution Dose Calculation (MRDC) Algorithm
The Multi-Resolution Dose Calculation (MRDC) algorithm is used for fast dose
estimation inside the PO, DVO, PRO and PGO algorithms. The high speed of the
MRDC algorithm allows the optimization algorithms to perform full dose
computation during each iteration.

The MRDC algorithm is based on the convolution superposition principle, and it uses
3D convolution scatter computation.

The scatter model is based on 3D superposition of point spread functions in the
patient model. The point spread functions are built from Monte Carlo calculations.

Multi-resolution scatter computation calculates the scatter component using variable
resolutions. Finer resolution is used close to the location of the primary interaction,
while much lower resolution is used to compute the scatter component for larger
distances (as far as 25 cm from the primary interaction). The convolution uses the
divergence-corrected single kernel model in water-equivalent material.
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Energy Spectrum
The energy spectra are based on the Monte Carlo calculations42. The nominal energy
is used to select a spectrum from a set of precalculated data. The spectrum affects the
primary component function and the point spread function. The primary component
is corrected for inhomogeneities. This precalculated spectrum can be slightly
optimized during the configuration of the PO, DVO or PRO algorithm in Beam
Configuration.

Intensity Profile
The intensity model of the primary component is radially symmetric around the
central axis. The intensity profile is optimized from the measurement data. Diagonal
profile measurements may improve the accuracy of MRDC for large field sizes.

Electron Contamination
The MRDC algorithm models the electrons created in air and the secondary
collimators between the photon source and the body. Electron contamination is
modeled as a depth-dependent intensity curve and a fluence-dependent spreading of
contamination electrons, also extended outside the field area. The shape and the
amplitude of the electron contamination curve are optimized during the
configuration of the optimization algorithm.

Modeling of the Second Source
Radiation emerging outside the linac target (for instance, from the flattening filter) is
modeled in the MRDC algorithm as a second photon source. The SSD of the second
source, spreading of the second source photon fluence, effective photon energy, and
the second source amplitude relative to the primary source are optimized during the
configuration of the algorithm.

Photon Optimization Algorithm (PO)
The Photon Optimization algorithm (PO) optimizes static field IMRT plans, VMAT
plans (RapidArc and Elekta VMAT) and Siemens mARC plans.

The PO combines the previous optimization methods used for static field IMRT and
arc field IMRT with DVO and PRO.

42 Mohan et al.: Energy and angular distributions of photons from medical linear
accelerators. Medical Physics 12 (5), Sep/Oct 1985.
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The main difference of the PO algorithm from the earlier optimization algorithms
(DVO and PRO) is that the earlier optimization algorithms used a point cloud model
for defining structures. The PO algorithm uses a new structure model, where
structures, DVH calculation and dose sampling are defined spatially by using one
single matrix over the image.

The voxel resolution of the matrix is using fixed values of 1.25 mm, 2.5 mm or 5 mm.
This resolution defines the planar X and Y resolution in the slices. The Z resolution
orthogonal to the slices is a function of chosen resolution and the slice spacing. For
example, if the original image has a slice resolution of 1 mm × 1 mm and a slice
spacing of 8 mm and the user has defined the optimization resolution to be 2.5 mm,
then the optimizer uses the matrix of 2.5 mm × 2.5 mm × 4 mm.

This matrix defines the locations of the structures and the sampling of the dose, and
it substitutes the previously used point clouds.

The figure illustrates a structure segment sent from the client, the image slices and
the dose matrix samples (stars) that define the voxels that represent the structure
inside the optimizer. These samples also represent the places where the total dose
from each field is evaluated.

1. Image slices

Figure 32 Structure Model in Photon Optimization Algorithm

The DVH for the structure is evaluated using volume weights defined for each voxel.
The volume weight of the voxel defines the ratio of the original structure segment
inside the voxel. For small structures, the DVH is super-sampled from the dose
matrix to make the DVH look smoother.
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In order to minimize the run time memory consumption, the matrix size is first set to
the size of body bounding box. Then the field field-of-views are formed, and the final
matrix size is set to contain only the part of the body bounding box that can receive
radiation from the fields.

Photon Optimization Algorithm and IMRT
For IMRT, the PO determines the optimal field shape and intensity by iteratively
conforming the dose distribution to the desired objectives until an optimum solution
is reached.

For each field, the PO fits the fluence to the target projection with 5 mm margin. Then
the created fluence object is expanded symmetrical to the field isocenter (by adding
fluence pixels with 0 value). The maximum size of the fluence object is 40 × 40 cm.
The size of the fluence object determines the region where the user can edit the
fluence.

The PO performs the optimization for an IMRT plan as a minimization problem
using simple gradient optimization with line minimization. Initially, all the fluences
are zero, or, alternatively, the fluences from a previous optimization can be used as
the initial guess. The optimization modifies these fluences in each iteration and
calculates the dose from the fluences after each modification.

Once the doses at the points of the point clouds representing the patient volumes are
evaluated, the objectives at the points and the derivatives of the point objectives can
be calculated. The cost functionals are evaluated for each point in each volume. The
derivatives of the costs at each point are back-projected to the fluences, forming the
gradient.

The PO uses the gradient search method. The gradient search is divided into two
phases; gradient evaluation and line search. Gradient evaluation generates the
gradient direction and the gradient length, and line search evaluates the objectives on
a line segment along the gradient and finds the minimum along the line segment.

The PO can use a calculated plan dose as an intermediate dose when optimizing an
IMRT plan. The algorithm calculates the difference between the intermediate dose
and the first round optimization result and uses this difference to compensate the
optimization result in the consequent iterations. If a new intermediate dose is
calculated after the first optimization iteration, the difference is calculated again and
it will be used to compensate subsequent iterations. Using an intermediate dose is
particularly useful if the DVH calculated during optimization deviates from the DVH
produced during dose calculation, for example when there is a lot of heterogeneity in
the volume to be treated.
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Photon Optimization Algorithm and VMAT
The PO creates VMAT (RapidArc, Elekta VMAT, Siemens mARC) plans based on
dose-volume objectives. VMAT fields use DMLC, variable dose rate and variable
gantry speeds.

The PO algorithm generates a sequence of control points which define MLC leaf
positions and MU/deg as a function of gantry angle. MU/deg is encoded in DICOM
and the Varian system database with the cumulative meterset weight, which defines
the increase in MU between control points relative to the total MU in the field. This
information is transferred to the treatment machine as such, and the machine control
system determines how dose rate and gantry speed will be modulated to deliver the
plan. After dose is calculated, Eclipse shows estimated dose rate and gantry speed
values in the Field Properties and MLC Properties pages. These estimates are not part
of the information sent to the treatment machine.

The PO algorithm uses an objective function to optimize the plan and to evaluate its
quality. The objective function is the sum of the dose-volume and other user-defined
objectives.

Progressive Resolution

The initial conditions for the PO algorithm are defined using control points to
represent each VMAT field. The algorithm uses multi-resolution approach (first
described in the research on volumetric modulated arc therapy43) to optimize the
plan. This means that the dose is modeled using first a lower number of dose
calculation segments that are distributed evenly in each field. The number of dose
calculation segments increases when moving from one multi-resolution level to
another.

The dose in a dose calculation segment is calculated from the combined fluence
through the MLC apertures at the control points located within a certain sector of the
arc. Leaf motion is modeled by interpolating leaf positions between the control
points. Leaf tongues are modeled by modifying the MLC aperture outline to
effectively account for the tongue-and-groove effect.

The angle resolution of the dose calculation segments gets more accurate as the
optimization progresses, and in consequence, the dose also gets more accurate. The
number of control points remains the same during the whole optimization.

43 Otto, K: Volumetric Modulated Arc Therapy: IMRT in a Single Arc. Medical Physics,
Vol. 35, no. 1, 2008, 310–317.
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At the beginning of the optimization, the initial MLC shapes are conformed to the
targets and the initial dose rates are equal for all dose calculation segments. The MLC
shapes and dose rates of the different control points in the VMAT field are optimized.
During the initial phases of the optimization bigger adjustments are made in leaf
sequencing. The size of these adjustments decreases as the optimization progresses
through the levels.

During the optimization, the algorithm proceeds through multi-resolution levels
progressively increasing the accuracy of the dose calculation. At the first multi-
resolution level, only a few dose calculation segments are used to model the dose,
and each multi-resolution level contains progressively more dose calculation
segments. The angle between the resulting dose calculation segments on the last
multi-resolution level (4) will be approximately 2°-4°.The total number of dose
calculation segments used depends on the span of the arc.

Inside each multi-resolution level there are several steps. Each step has its own
internal calculation parameter set. The optimization allows some discontinuities in
the delivery during early phases of the optimization, and decreases the size of the
discontinuities stepwise as the optimization progresses. At the step borders, the
delivery is forced to be within specified discontinuity levels. This may increase the
objective function values when moving from one step to the next, and a peak in the
objective function curve may be seen. The number of steps in different multi-
resolution levels varies. Due to the nature of the optimization process, the PO
algorithm is not fully deterministic. Therefore successive optimizations with the
same constraints may yield different results.

Avoidance Sectors for VMAT

Avoidance sectors are ranges of gantry rotation with a zero delivered dose rate. You
can define up to two avoidance sectors for each arc field in the optimization. The
minimum length for an avoidance sector is 15 degrees. Similarly, the minimum
length for the beam-on sector between two avoidance sectors, or between gantry
start/stop angles and an avoidance sector is 15 degrees.

Avoidance sectors are supported for Varian treatment units and for Siemens mARC.

Jaw Tracking for VMAT

Jaw tracking dynamically moves the collimator jaws during beam-on to keep them as
close to the actual MLC aperture as possible. This reduces leakage between the MLC
leaves. The initial user-defined collimator jaw positions for the plan are used as the
maximum limit for the jaws. Jaw tracking does not move the collimator jaws outside
this maximum limit. Collimator jaws can follow the MLC aperture inside the target
projection, if necessary.
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Note: Not all VMAT-capable Varian linear accelerators support jaw tracking. The option can
be selected in optimization only for plans to be delivered with a treatment machine that
supports jaw tracking. Jaw tracking is automatically on for Elekta MLCi and MLCi2.

PO supports jaw tracking via the motion modes and speed limits that are defined in
RT Administration for each collimator (IEC X1, X2, Y1, Y2). Motion modes must be
the same for both jaws on the axis. Collimator motion modes override the Field X
setting earlier used for jaw tracking.

The collimator motion mode in RT Administration can have the following values:
■ Empty: Not allowed if jaw tracking is requested.
■ Static: Collimator does not move during the arc delivery.
■ Dynamic: Collimator moves within the set maximum speed limit during the arc

delivery.
■ Pseudo (also known as non-existent or virtual jaw); A static position is

determined for the collimator within the initial field size based on the projection
of the target structure(s) during pre-processing. There is a maximum leaf
transmission value (1%) for using the Pseudo mode. Speed limits are ignored.
Post-processing may re-position the collimators according to validation rules
specific to the treatment unit model.

■ Multiple Static Positions: Collimator can move obeying the set speed limit, but
only between control points where the beam is off. The initial field size is used as
a maximum opening limit.

Biological gEUD Objectives
The PO supports three new objective types for biological optimization using
generalized Equivalent Uniform Dose (gEUD) formalism: lower gEUD, upper gEUD
and the target gEUD constraint. For each objective, the user defines a target gEUD
value, biological parameter a and objective priority w. Optimization then evaluates
the gEUD(a) values for the structure, and a square law cost is applied when an
objective is not met in the same manner as in normal dose-volume objectives:

Equation 49

 
cost(gEUD(a)) = W × (gEUD(a) − EUD)2

 

where   

cost(gEUD) = Square law cost

a = Biological parameter controlling the dose distribution inside the
structure. Typical values range from −40 to +40.

190 Eclipse Photon and Electron Algorithms Reference Guide



W = Priority.

EUD = Target value for EUD.

The above equation describes the target gEUD constraint. For the lower gEUD
constraint, the cost is 0 when gEUD(a)>EUD. For the upper gEUD constraint, the cost
is 0 when gEUD(a)<EUD.

gEUD(a) is defined as:

Equation 50

 

gEUD(a) = 1
V ×∑

v

D x a

1
a

 

where   

a = Biological parameter controlling the dose distribution inside the
structure. Typical values range from −40 to +40.

V = Volume/Structure.

D = Dose in position x inside the volume V.

Mean Dose Objective
Mean dose objective is used to define the mean dose that should not be exceeded for
a structure. The objective defines the mean dose in Gy, but does not define any
percentage of the structure volume that should not receive more than this dose. Mean
dose objective is visualized in DVH during optimization, and it can be adjusted
interactively during optimization. Mean dose objective cannot be used to increase the
dose to a structure.

Intermediate Dose
The existing dose can be used as an intermediate dose when continuing the
optimization. This can be done manually by restarting the optimization and selecting
the option to use the current plan dose as an intermediate dose for optimization, or
automatically by selecting “Automatic intermediate dose” in the Optimization dialog
box when optimizing for the first time. This is useful especially if the DVH calculated
during arc optimization deviates from the DVH produced during dose calculation,
for example when there is a lot of heterogeneity in the volume to be treated.
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The optimization algorithm can adjust the leaf sequences for VMAT fields, or
fluences for static IMRT field based on the intermediate dose. It calculates the error
between the first round optimization result and the dose calculation, and during the
second optimization round, when the optimization is finalized, it compensates for
the differences and tries to achieve a better agreement. For VMAT, the second
optimization round starts at the last multi-resolution level (level 4).

Restarting Optimization
VMAT optimization can be restarted from user-defined arc fields. The user-defined
fields may be produced, for example, in a previous arc optimization, or they may be
created manually.

Before restarting the VMAT optimization, the algorithm re-samples the arc treatment
to suitable control point spacing. The optimization restarts from the last multi-
resolution level that has the most accurate dose modeling. To allow bigger
adjustments to the leaf sequence, the user should rewind the multi-resolution levels.
However, the dose on the earlier multi-resolution levels, calculated with the MRDC
algorithm, is less accurate.

If the arc field does not contain a DMLC, VMAT optimization is started from the first
multi-resolution level.

In IMRT optimization, initially all the fluences are zero, or, alternatively, the fluences
from a previous optimization can be used as the initial guess. The IMRT optimization
modifies these fluences in each iteration and calculates the dose from the fluences
after each modification.

Calculation Options for the PO Algorithm
The PO algorithm has the following calculation options:
■ Inhomogeneity correction: Defines whether tissue heterogeneity correction is

applied during optimization.
■ Air cavity correction: An additional parameter for fine-tuning inhomogeneity

correction. This parameter has no effect if the Inhomogeneity correction
parameter is set to Off. When the air cavity correction option is used, the dose in
an air cavity is smaller than without this option. On the other hand, the target/any
part of the target should not be contoured in air, as the target will not get enough
dose.

Additionally, the following options are available for static IMRT fields:
■ Smooth X: Smoothing of the field fluence on X axis.
■ Smooth Y: Smoothing of the field fluence on Y axis.
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Dose Volume Optimizer (DVO) Algorithm
Eclipse IMRT is capable of creating highly conformal dose distributions by
optimizing the beam intensity modulation from user-defined dose volume objectives.
The algorithm used in Eclipse IMRT, Dose Volume Optimizer (DVO), determines the
optimal field shape and intensity by iteratively conforming the dose distribution to
the desired objectives until an optimum solution is reached.

For each field, the DVO fits the fluence to the target projection with 5 mm margin.
Then the created fluence object is expanded symmetrical to the field isocenter (by
adding fluence pixels with 0 value). The maximum size of the fluence object is
40 × 40 cm. The size of the fluence object determines the region where the user can
edit the fluence.

The dose optimization algorithm performs the optimization as a minimization
problem using simple gradient optimization with line minimization. Initially, all the
fluences are zero, or, alternatively, the fluences from a previous optimization can be
used as the initial guess. The optimization modifies these fluences in each iteration
and calculates the dose from the fluences after each modification.

Once the doses at the points of the point clouds representing the patient volumes are
evaluated, the objectives at the points and the derivatives of the point objectives can
be calculated. The cost functionals are evaluated for each point in each volume. The
derivatives of the costs at each point are back-projected to the fluences, forming the
gradient.

The optimization uses the gradient search method. The gradient search is divided
into two phases; gradient evaluation and line search. Gradient evaluation generates
the gradient direction and the gradient length, and line search evaluates the
objectives on a line segment along the gradient and finds the minimum along the line
segment.

The DVO algorithm can use a calculated plan dose as an intermediate dose when
optimizing a plan. The DVO algorithm calculates the difference between the
intermediate dose and the first round optimization result and uses this difference to
compensate the optimization result in the consequent iterations. If a new
intermediate dose is calculated after the first optimization iteration, the difference is
calculated again and it will be used to compensate subsequent iterations. Using an
intermediate dose is particularly useful if the DVH calculated during optimization
deviates from the DVH produced during dose calculation, for example when there is
a lot of heterogeneity in the volume to be treated.
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Plan Geometry Optimization (PGO) Algorithm
The Plan Geometry Optimization (PGO) algorithm enables the Eclipse Beam Angle
Optimization, an integrated optimization option for the Eclipse treatment planning
system, and is an essential component of effective intensity-modulated radiotherapy
(IMRT). Beam Angle Optimization is an automated tool for selecting the suitable
beam angles based on user-defined dose-volume objectives that speeds up the
planning process for IMRT treatments. Beam Angle Optimization is performed with
the PGO algorithm, which is based on the Eclipse DVO algorithm. Plan Geometry
Optimization is designed to be run prior to Dose-Volume Optimization. The same
DVH-based objectives can be used in both optimizations.

Global Optimization Mode for Plan Geometry
Global optimization creates the new field geometry, which can be either coplanar or
non-coplanar, depending on user-defined optimization parameters. The optimization
starts from a set of uniformly distributed fields, and then narrows the number of
fields down to a set that best fulfils the optimization objectives defined for the patient
structures.

The global optimization mode starts with a large initial number of fields either in a
2D or 3D geometry. The PGO uses a fixed isocenter, which means that all fields in the
initial field distribution share the same isocenter copied from the first field present in
the plan before the PGO is started.

This is done by first optimizing a few fluences and removing fields individually in
each iteration. The effect of this removal is evaluated by calculating the
corresponding objective function value. The fields whose removal causes the smallest
increase in the value of the objective function can be considered less important and
are removed from the field geometry. The iterations are continued until the desired
number of fields for the final plan has been reached. You can control the number of
fields to be excluded after each iteration with a parameter value.

Initial Field Geometries

The way new fields are created depends on the selected global optimization mode.
The optimization mode is defined with the Initial field distribution parameter. The
global optimization mode can be one of the following:
■ Coplanar (2D) field geometry: Creates equally spaced fields by increasing the

gantry values. The couch angle is always zero (in IEC 61217 scale, which
corresponds to 180 degrees in the Varian standard scale).

194 Eclipse Photon and Electron Algorithms Reference Guide



■ Non-coplanar (3D) geometry: Creates fields by uniformly positioning them in
three-dimensional space. The angle of each field to its closest neighbor is
approximately the same for all fields. Opposing fields are avoided.

Note: Both the global and local optimization modes exclude fields that enter the patient
through the end(s) of the CT stack.

The initial number of fields in both geometries is controlled with a parameter. The
maximum initial number of fields is 400.

You can also specify a limit for the collimator angle between adjacent fields. If the
limit is set to zero, the collimators are kept at zero angle. If the limit is set to
180 degrees, the direction of the MLC leaves coincides with the shortest dimension of
the PTV in the BEV.

You can also control the offset for the gantry angles in the coplanar field geometry
with the Coplanar offset angle parameter. This parameter does not affect the non-
coplanar initial field distribution.

In the non-coplanar field geometry, you can enter a limit for the elevation angle of the
fields from the coplanar plane. The fields in the initial field distribution do not have
elevation angle values higher than the specified limit.

Complete list of optimization parameters: Input Parameters for PGO on page 215.

Removing Forbidden Fields from the Initial Field Distribution

The initial field distribution may contain fields that cannot be used for dose
calculations. Some fields might also be impossible to deliver due to the physical
characteristics of the treatment unit (some gantry and/or couch rotations may not be
feasible for the treatment unit). To perform plan geometry optimization only for valid
fields, the following fields are excluded from the initial field distribution:
■ Fields intersecting the end(s) of the CT stack

The field geometry in the initial field distribution is checked for fields entering the
patient through the ends of the CT stack. If found, such fields are removed.

■ Fields with forbidden gantry/couch angle combinations

The PGO reads the forbidden gantry/couch angle combinations from the
GantryCouchAngleCombinations.txt file from the beam data directory root.
If this file is not found in the PGO directory, it is created automatically. You can
edit this file to include individual specifications for forbidden gantry/couch angle
combinations.

The format of the GantryCouchAngleCombinations.txt file is the following:

[n]  [m]    
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[t1]   [t2] ... [tm]

[g1]  0/1 0/1 ... 0/1

[g2]  0/1 0/1 ... 0/1

...      

[gn]  0/1 0/1 ...  

where   

n = Number of limits for gantry angle

m = Number of limits for couch angle

g1 = First limit for gantry angles

gn = Last limit for gantry angles

t1 = First limit for couch angles

tm = Last limit for couch angles

0 = Forbidden gantry/couch angle combination

1 = Allowed gantry/couch angle combination

The following shows an example of the GantryCouchAngleCombinations.txt file.

Table 39  Example Forbidden Gantry/Couch Angle Combinations file

36  36            

 0 10 20 30 40 50 60 70 80 ... 330 340 350

0 1 1 1 1 1 1 1 1 1 ... 1 1 1

10 1 1 1 1 1 1 1 1 1 ... 1 1 1

20 1 1 1 1 1 1 1 1 1 ... 1 1 1

30 1 1 1 1 1 1 1 1 1 ... 1 1 1

40 1 1 1 1 1 1 1 1 1 ... 1 1 1

50 1 1 1 1 1 1 1 1 1 ... 1 1 1

60 1 1 1 1 1 1 1 1 1 ... 1 1 1

70 1 1 1 1 1 1 1 1 1 ... 1 1 1

80 1 1 1 1 1 1 1 1 1 ... 1 1 1

... ... ... ... ... ... ... ... ... ... ... ... ... ...

330 1 1 1 1 1 1 1 1 1 ... 1 1 1

340 1 1 1 1 1 1 1 1 1 ... 1 1 1

350 1 1 1 1 1 1 1 1 1 ... 1 1 1

196 Eclipse Photon and Electron Algorithms Reference Guide



In an automatically created gantry/couch angle combinations file, the limits for
gantry and couch angles are specified with 10-degree intervals. Additional ranges for
the limiting angles can be entered in, for example, MS Excel.

Note: The number of specified gantry limits must be equal to n, and the number of specified
couch limits equal to m; otherwise the PGO cannot read the gantry/couch angle combinations
file.

Final Number of Fields in the Plan

The final number of fields left in the treatment plan after the global optimization is
controlled with the following parameters:
■ Minimum number of fields: If this value equals the maximum number of fields,

the specified number of fields is left in the final plan
■ Maximum number of fields: If this value exceeds the Minimum number of fields,

the final field geometry has an optimal number of fields which belongs to the
specified range.

The optimal number of fields is determined from the value of the objective function
as follows: if the value of the objective function increases because of the removal of
fields, the removal is canceled and the value of the field reduction rate is reduced to
one half of the original value. Then the optimization iteration is re-calculated with
the reduced field reduction rate. This is continued until the
■ Decreased value of the objective function is obtained, and fields are removed

according to the current field reduction rate, or
■ Removal of the fields is canceled and the global optimization stops.

The effect of the number of fields on the objective function is adjusted with the field
number objective (Field Number Objective on page 198).

Number of IMRT Iterations

The number of IMRT iterations run during one PGO iteration in the global
optimization mode is controlled with a parameter value. It is recommended to use
the minimum value of 3 for this parameter.

Field Reduction

The number of fields to be removed at the end of a global optimization iteration is
controlled with the Field reduction rate (FRR) parameter. The number of fields to be
removed is calculated as:

Equation 51

nremoved=FRR x (nleft-nmin)
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where   

nremoved = number of fields to be removed

nleft = number of fields which are currently included in the plan

nmin = minimum number of fields to be left in the final plan

As a result, global optimization aims at leaving nmin fields in the plan.

Field Number Objective

1

2

3

1. Field number objective
2. Constraint value
3. Number of fields in the plan

Figure 33 Shape of the Field Number Objective

With the Field Number objective, the number of fields in the final plan is typically
limited to fewer than 10 fields. The strength of the objective is adjusted with a weight
parameter.
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Lateral Inhibition

To prevent the PGO from removing all fields entering from a bad direction during
the first global optimization iterations, the algorithm performs a lateral inhibition
calculation. Lateral inhibition enhances the values of the objective function close to
removed fields. The inhibition gives increased objective function values to fields
located close to removed fields, which results in retaining these fields in the plan. The
calculation of the lateral inhibition is cumulated in the values of the objective
function within one iteration. The effect of lateral inhibition is reset when the next
iteration starts. The shape of the lateral inhibition function (LI) is a linear
combination of cosine powers:

Equation 52

LI=C x (cos2.5α+cos18α) x std

where   

C = value of the weight parameter to control the strength of the lateral inhibi-
tion

α = angle to the removed field

std = standard deviation of the field removal effects

The shape of the lateral inhibition function with std = 1 is shown in the figure.

Chapter 9    Dose Optimization Algorithms 199



1

2

3

1. Lateral inhibition
2. Function value
3. Angle to the removed field

Figure 34 Shape of the Lateral Inhibition Function

The values of the objective function (OF) are then updated with the lateral inhibition
as:

Equation 53

OFnew=OFold+LI
Thus, the importance of fields located close to a removed field is increased in relation
to the remaining fields.

Proximity Effect

Sometimes the PGO results in plans containing fields located close to each other. In a
final treatment plan, this is usually considered undesirable, because it can easily
produce hot spots in normal tissue. To avoid closely located fields in the final
treatment plan, the PGO performs a proximity effect calculation. The proximity effect
is calculated similarly to the lateral inhibition, but in this case α is the angle to the
closest field in the plan. The weight for the proximity effect calculation is adjusted
with a parameter value. The amount of the proximity effect is then subtracted from
the original values of the objective function to decrease the importance of fields
located close to each other.
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Minimum Field Separation Angle

The PGO can exclude fields located close to each other by using a limiting value for
the angle between fields in the final field configuration. The value for the limiting
angle can be controlled by a parameter value.

Initial Field Removal Effects

The values of the field removal effects calculated during the first iteration are
preserved for further use. These values contain information about the geometry of
the patient, which is not included in the following iterations. The retained initial field
removal effect values are included in the subsequent iterations by adding their
weighted values into the current values of the objective function. The weight given to
the initial field removal effects can be adjusted with a parameter value.

Local Optimization Mode for Plan Geometry
The local optimization continues from the result of the global optimization by fine-
tuning parameters controlling the couch angles (for non-coplanar field geometry)
and gantry angles (for both coplanar and non-coplanar field geometries). The
collimator angles are also calculated if the limiting value for the collimator angle
separation between adjacent fields is larger than zero. The local optimization does
not change the number of fields in the plan, but it can test any couch and gantry
angle combinations to find the optimal geometry. The progress of the local
optimization is shown with the objective function curve and the Number of iterations
parameter.

The local optimization can be performed in two modes that are defined as a
calculation option for optimization: the Downhill Simplex method and the Powell
method44. In addition to the mode, the maximum number of local optimization
iterations is controlled with a calculation option.

The information about the best field configuration found is stored throughout the
local optimization to make it always available if the local optimization is interrupted.

The local optimization can also be run alone without first running the global
optimization. This might be useful for testing purposes. However, the best beam
angle optimization results are achieved by running both global and local
optimizations.

44 William H. Press, et al.: Numerical Recipes in C: The Art of Scientific Computing,
(information about the optimization methods), Cambridge University Press, 1992.
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Note: The Simplex and the Powell methods require the objective function evaluations only, not
the derivatives.

Number of IMRT Iterations in Objective Function Evaluations

The number of fluence optimization iterations to be run within the local optimization
iteration can be controlled with a parameter value.

Initialization Phase

Initialization Phase in the Simplex Algorithm
In the initialization phase of the Simplex algorithm, the corner points of the original
simplex are generated. The number of the corner points is N + 1, where N is the
number of parameters to be optimized, that is, the gantry angles in the 2D case, and
the gantry and couch angles in the 3D case. The generation of each corner point
requires a calculation of the objective function. The distance from each corner point
to the starting point (the amount of change applied to each parameter in the
construction phase of the simplex) is controlled by a parameter value. This value is
common for gantry and couch angles.

Initialization Phase in the Powell Algorithm
The Powell algorithm calculates line minimizations along the specified search
directions. The search directions are initialized with unit vectors. Thus, in the first
Powell iteration, each parameter is optimized separately. The initial step size is
controlled with the same parameter value as is used for the Simplex algorithm. The
search space for each parameter is expanded until there is a minimum point found
between the line end points.

Optimization Phase

Optimization Phase in the Simplex Algorithm
After the construction of the original Simplex, the corner points are modified
according to the algorithm schema. New corner points are found in Simplex
iterations. At the beginning of a Simplex iteration, the stopping criteria for the
algorithm are checked. If none of the criteria are met, the algorithm continues by
finding a new position for the worst corner point in the Simplex. If there is no
improvement found in the value of the objective function, the Simplex stops.
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Optimization Phase in the Powell Algorithm
After initializing the search directions with unit vectors, the Powell proceeds
according to the algorithm schema by finding the conjugate search directions. The
calculations performed during the line minimizations along the current search
directions are called Powell iterations. At the beginning of a Powell iteration, the
stopping criteria for the algorithm are checked first.

Additional Stopping Criteria

In addition to the conditions in the optimization phase, the local optimization uses
the following three additional stopping criteria.

Number of Objective Function Calculations
The maximum number of objective function calculations, that is, the number of local
optimization iterations, can be used as a stopping criterion in the local optimization
mode. This parameter is included in the list of input parameters for the PGO.
However, it is not recommended to define a low value for this parameter, because the
algorithm may not have reached a minimum point if the execution is stopped too
early.

Note: In the Powell algorithm, the number of the calculated local optimization iterations is
checked only at the beginning of a Powell iteration, not during the iteration. Therefore, the total
number of local optimization iterations may exceed the given input parameter value.

Convergence of the Algorithm
The convergence of the algorithm stopping criterion is used only for the Simplex
algorithm.

The convergence of the algorithm is checked at the beginning of a Simplex iteration.
If no significant changes are detected in the value of the objective function during
recent iterations, the Simplex algorithm is stopped.

The evaluation of the convergence is controlled by the following parameter values:
■ Number of Simplex iterations which is included in the evaluation.
■ Limit value for the amount of change in the value of the objective function, which

determines whether the optimization is continued.

These parameters are not PGO input parameters.

Invalid Field Parameters
Depending on the properties of the patient geometry and/or the definition of the
valid gantry and couch angles, valid field parameters may not be found when
generating new field directions in the local optimization. If valid field parameters
cannot be found after a certain number of trials, the local optimization is stopped.

Chapter 9    Dose Optimization Algorithms 203



Progressive Resolution Optimizer (PRO) Algorithm
The Progressive Resolution Optimizer (PRO) algorithm creates VMAT (RapidArc)
plans based on dose-volume objectives. VMAT fields use DMLC, variable dose rate
and variable gantry speeds.

The PRO algorithm generates a sequence of control points which define MLC leaf
positions and MU/deg as a function of gantry angle. MU/deg is encoded in DICOM
and the Varian system database with the cumulative meterset weight, which defines
the increase in MU between control points relative to the total MU in the field. This
information is transferred to the treatment machine as such, and the machine control
system determines how dose rate and gantry speed will be modulated to deliver the
plan. After dose is calculated, Eclipse shows estimated dose rate and gantry speed
values in the Field Properties and MLC Properties pages. These values are estimates,
and they are not part of the information sent to the treatment machine.

The PRO algorithm uses an objective function to optimize the plan and to evaluate its
quality. The objective function is the sum of the dose-volume and other user-defined
objectives.

Progressive Resolution
The initial conditions for the PRO algorithm are defined using control points to
represent each VMAT field. The algorithm uses multi-resolution approach (first
described in the research on volumetric modulated arc therapy45) to optimize the
plan. This means that the dose is modeled using first a lower number of dose
calculation segments that are distributed evenly in each field. The number of dose
calculation segments increases when moving from one multi-resolution level to
another.

The dose in a dose calculation segment is calculated from the combined fluence
through the MLC apertures at the control points located within a certain sector of the
arc. Leaf motion is modeled by interpolating leaf positions between the control
points. Leaf tongues are modeled by modifying the MLC aperture outline to
effectively account for the tongue-and-groove effect.

The angle resolution of the dose calculation segments gets more accurate as the
optimization progresses, and in consequence, the dose also gets more accurate. The
number of control points remains the same during the whole optimization.

45 Otto, K: Volumetric Modulated Arc Therapy: IMRT in a Single Arc, Medical Physics,
Vol. 35, no. 1, 2008, 310–317.
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At the beginning of the optimization, the initial MLC shapes are conformed to the
targets and the initial dose rates are equal for all dose calculation segments. The MLC
shapes and dose rates of the different control points in the VMAT field are optimized.
During the initial phases of the optimization bigger adjustments are made in leaf
sequencing. The size of these adjustments decreases as the optimization progresses
through the levels.

During the optimization, the algorithm proceeds through multi-resolution levels
progressively increasing the accuracy of the dose calculation. At the first multi-
resolution level, only a few dose calculation segments are used to model the dose,
and each multi-resolution level contains progressively more dose calculation
segments. The angle between the resulting dose calculation segments on the last
multi-resolution level (4) will be approximately 2°-4°.The total number of dose
calculation segments used depends on the span of the arc.

Inside each multi-resolution level there are several steps. Each step has its own
internal calculation parameter set. The optimization allows some discontinuities in
the delivery during early phases of the optimization, and decreases the size of the
discontinuities stepwise as the optimization progresses. At the step borders, the
delivery is forced to be within specified discontinuity levels. This may increase the
objective function values when moving from one step to the next, and a peak in the
objective function curve may be seen. The number of steps in different multi-
resolution levels varies. Due to the nature of the optimization process, the PRO
algorithm is not fully deterministic. Therefore successive optimizations with the
same constraints may yield different results.

Avoidance Sectors
Avoidance sectors are ranges of gantry rotation with a zero delivered dose rate. You
can define up to two avoidance sectors for each arc field in the optimization. The
minimum length for an avoidance sector is 15 degrees. Similarly, the minimum
length for the beam-on sector between two avoidance sectors, or between gantry
start/stop angles and an avoidance sector is 15 degrees.

Avoidance sectors are supported only for Varian treatment units.

Mean Dose Objective
Mean dose objective is used to define the mean dose that should not be exceeded for
a structure. It defines the mean dose in grays, but does not define any percentage of
the structure that should not receive more than this dose. Mean dose objective is
visualized in DVH during optimization, and it can be adjusted interactively during
optimization. You can add one mean dose objective per structure. Mean dose
objective cannot be used to increase the dose to a structure.
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Jaw Tracking
Jaw tracking dynamically moves the collimator jaws during beam-on to keep them as
close to the target projection as possible. This reduces leakage between the MLC
leaves. The initial user-defined collimator jaw positions for the plan are used as the
maximum limit for the jaws. Jaw tracking does not move the collimator jaws outside
this maximum limit.

Note: Not all VMAT-capable Varian linear accelerators support jaw tracking. The option can
be selected in VMAT Optimization dialog box only for plans to be delivered with a treatment
machine that supports jaw tracking. Jaw tracking is automatically on for Elekta MLCi and
MLCi2.

For PRO, the collimator speed in jaw tracking is set by defining the maximum speed
value for Field X in a treatment unit operation limits in RT Administration.

Intermediate Dose
With the PRO algorithm you can optimize the plan, calculate the dose, and then use
the calculated dose as an intermediate dose when continuing the optimization. This
can be done manually by restarting the optimization and selecting “Use current plan
dose as an intermediate dose for optimization” or automatically by selecting
“Automatic intermediate dose” in the VMAT optimization dialog box when
optimizing for the first time. This is useful especially if the DVH calculated during
arc optimization deviates from the DVH produced during dose calculation, for
example when there is a lot of heterogeneity in the volume to be treated.

The optimization algorithm can adjust the leaf sequences based on the intermediate
dose. It calculates the error between the first round optimization result and the dose
calculation, and during the second optimization round, when the optimization is
finalized, it compensates for the differences and tries to achieve a better agreement.
The second optimization round starts at the last multi-resolution level (level 4).

Restarting Optimization
Optimization can be restarted from user-defined arc fields. The user-defined fields
may be produced, for example, in a previous arc optimization, or they may be
created manually.
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Before restarting the optimization, the algorithm re-samples the arc treatment to
suitable control point spacing. The optimization restarts from the last multi-
resolution level that has the most accurate dose modeling. To allow bigger
adjustments to the leaf sequence, the user should rewind the multi-resolution levels.
This will allow more flexibility in changing the leaf sequence. However, the dose on
the earlier multi-resolution levels, calculated with the MRDC algorithm, is less
accurate.

If the arc field does not contain a DMLC, optimization is restarted from the first
resolution level, and the DMLC is not taken into account in the optimization.

Calculation Options for the PRO Algorithm
The PRO algorithm has the following calculation options:
■ Inhomogeneity correction: Defines whether tissue heterogeneity correction is

applied during optimization.
■ Air cavity correction: An additional parameter for fine-tuning inhomogeneity

correction. This parameter has no effect if the Inhomogeneity correction
parameter is set to Off. When the air cavity correction option is used, the dose in
an air cavity is smaller than without this option. On the other hand, the target/any
part of the target should not be contoured in air, as the target will not get enough
dose.

System Configuration for Dose Optimization
Note: When configuring dose optimization algorithms, note the following:
■ It is important to configure the system so that it corresponds to the characteristics of the

treatment machine.
■ Periodically perform follow-up measurements and compare with the dosimetric beam data

used for configuring the beam. If fluctuations are large and the configured beam data no
longer represents the average beam delivered by the machine, reconfigure the beam data
using the newer dosimetric beam data.

■ Measure all dosimetric beam data in as stable conditions as possible.
■ Use the same file naming conventions in beam data measurements (input files) and in

Beam Configuration (Therapy Unit name), and name the input files so that it is easy to
match the beam data to the treatment unit during the configuration process.

Beam Data Measurements for Dose Optimization
The configuration of the PO, DVO, PRO and PGO algorithms requires the same basic
measured beam data as the calculation algorithms used for the dose calculation.
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The following basic measured beam data is required for the configuration of all three
optimization algorithms:

■ Open field profiles (OPP) for several field sizes at five depths. The minimum
number of measured profiles required is three, but using five is recommended.

■ Open field diagonal profile (DPR) for largest field size at five depths. It is possible
to configure PO, DVO, PRO and PGO algorithms without diagonal profiles.
However, using diagonal profiles may improve the accuracy. It is recommended
to use five measured diagonal profiles.

■ Open field depth dose curves (OPD) for same field sizes as profiles.
■ Source-phantom distance (SPD) in cm.
■ Calculation grid size in cm. The calculation grid size used by MRDC dose

calculation during optimization. For DVO and PGO, the calculation grid size is
fixed to 0.25 cm. The default calculation grid size for PO and PRO is 0.25 cm.
When configuring PO and PRO for Elekta Beam Modulator, the grid size of
0.20 cm must be used.

■ Nominal energy (In MRDC, the nominal energy is a parameter related to the
maximum energy in MV of the photon spectra. The configuration program
further modifies the photon spectra together with other configuration parameters
so that the calculated dose matches with the measurements.)

■ Profile measurement depths in cm.

Note: The source-to-phantom distance (SPD) must be the same in the configuration of the dose
calculation algorithm and the configuration of the PO, DVO and PRO algorithms. The SPD
value is defined in the General Parameters in Beam Configuration.

The PO, DVO, PRO and PGO have some special beam data configuration
requirements:

■ The maximum field sizes must be defined in the General Parameters (for instance,
a 40 × 40 cm2 field)

■ Due to the characteristics of the optimization algorithm, the nominal energy
(defined in the General Parameters) may not exceed 30 MV.

Detailed description of the measured depth dose curves and the measured profile
curve field sizes: Configuration of Photon Beams on page 45.

Based on the measured beam data, the configuration produces the Model Parameters
for the MRDC and an indicator parameter (Maximum Error for Dose Estimation) for
the successfulness of the configuration. The parameter is the maximum gamma index
with the criteria of 1% for dose difference and 1 mm for the distance to agreement.
(Typically, the value for a successful configuration should be smaller than 5. If the
value is higher, the reason could lie in the measured beam data). For PO and PRO,
the configuration also produces a parameter (Scaler for Absolute Dose Calculation)
that informs how the internal reference geometry is scaled to the absolute dose
geometry.
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Model Parameters for the Progressive Resolution Optimizer (PRO)

The table lists the parameters that need to be defined in Beam Configuration for the
configuration of the PRO algorithm.

Table 40 Absolute Dose Calibration Parameters for PRO

Parameter Description

Absolute dose reference
field size [mm]

Size of the reference field used in configuration, expressed in milli-
meters. Usually, this should be the same size that was used to nor-
malize the measured output factor table (that is, the field size for
which the output factor = 1.0).

Absolute dose calibra-
tion source-phantom
distance

Distance between the source and the surface of the phantom (SPD)
used in configuration, expressed in millimeters. (Illustration of the
geometry: Absolute Dosimetry Geometry on page 85.)

Absolute dose calibra-
tion depth [mm]

Depth of the reference point used in configuration, expressed in
millimeters. (Illustration of the geometry: Absolute Dosimetry Ge-
ometry on page 85.)

Reference dose at cali-
bration depth [Gy]

Absolute dose in water for the reference field size at the reference
point at the calibration depth, expressed in Gray.

Reference MU at cali-
bration depth [MU]

MU given to produce the reference dose for calibration.

Configuration of PO in Beam Configuration
You can configure the PO algorithm based on:
■ Previously configured beam data for a dose calculation algorithm (AAA/

Acuros XB).
■ Previously configured beam data for a photon optimization algorithm

(PRO/DVO/PGO). Instructions on copying the beam data from another
calculation model: Beam Configuration Reference Guide.

■ Basic measured beam data.

Note: The recommended procedure is to first configure the dose calculation algorithm (AAA/
Acuros XB), and then configure the PO based on that.

More details on using Beam Configuration: Beam Configuration Reference Guide.
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Configure PO based on Configured AAA/Acuros XB

1. Go to Beam Configuration.
2. To add a calculation model for the PO algorithm if not available, choose Beam

Data > Configure Calculation Models and add the model.
3. Verify that the dose calculation model you want to use (AAA/Acuros XB) is

correctly configured in the system.
4. In the Scope window, select the optimization model to configure.
5. Choose Insert > New Beam Data.
6. Select the Copy existing calculation model data to the optimization model

option.
7. Select the configured calculation model to use for the configuration of the new

optimization model.
8. Click OK.
9. In the Focus window, select Dose Calculation Parameters, and select the

calculation grid size in cm from drop down list. More information on the grid
size: Beam Data Measurements for Dose Optimization on page 207.

10. In the Focus window, select the Open Field add-on and choose Beam Data >
Calculate Beam Data.

11. If prompted to do so, select the beam data to be generated and click OK to start
the calculation.

12. If the configuration was successful, approve the data.

Configure PO based on Configured PRO

1. Go to Beam Configuration.
2. To add a calculation model for the PO algorithm if not available, choose Beam

Data > Configure Calculation Models and add the model.
3. In the Scope window, select the PO calculation model and choose Insert > New

Beam Data.
4. Define a therapy unit name for the calculation model and select the Start with

empty data option.
5. Choose File > Import > Eclipse Beam Data, browse to the location of the

appropriate beam data and import the data.
6. Match and assign the open field add-on.
7. In the Focus window, select Open Field, then choose Insert > New Absolute

Dose Calibration Parameters, and type the same values to the parameters as are
used in the AAA/Acuros XB configuration.

The parameter values must be the same as in the AAA/Acuros XB configuration.
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8. In the Focus window, select Dose Calculation Parameters, and select the
calculation grid size in cm from drop down list. More information on the grid
size: Beam Data Measurements for Dose Optimization on page 207.

9. In the Focus window, select the Open Field add-on and choose Beam Data >
Calculate Beam Data.

10. If the configuration was successful, approve the data.

Configure PO based on Measured Beam Data

1. Go to Beam Configuration.
2. To add a calculation model for the PO algorithm if not available, choose Beam

Data > Configure Calculation Models and add the model.
3. In the Scope window, select the PO calculation model and choose Insert > New

Beam Data.
4. Define a therapy unit name for the calculation model and select the Start with

empty data option.
5. Absolute Dose Calibration Parameters default values are added.
6. Type the same values to the Absolute Dosimetry Calibration Parameters as are

used in the AAA/Acuros XB configuration.

The parameter values must be the same as in the AAA/Acuros XB configuration.
7. In the Focus window, select Dose Calculation Parameters, and select the

calculation grid size in cm from drop down list. More information on the grid
size: Beam Data Measurements for Dose Optimization on page 207.

8. To add the open field add-on, choose Insert > New Add‐On.
9. To import the beam data in the w2CAD format, go to the Focus window, select

Open Field, choose File > Import > Measured Diagonal Profiles, Measured
Depth Doses, or Measured Profiles, depending on the measurement type, and
navigate to the location of your measured beam data files.

10. In the Focus window, select the Open Field add-on and choose Beam Data >
Calculate Beam Data.

11. If the configuration was successful, approve the data.

Configuration of DVO in Beam Configuration
You can configure the DVO algorithm based on:

■ Previously configured beam data for a dose calculation algorithm (AAA/
Acuros XB).

■ Previously configured beam data for a photon optimization algorithm
(PRO/DVO/PGO). Instructions on copying the beam data from another
calculation model: Beam Configuration Reference Guide.

■ Basic measured beam data.
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Note: The recommended procedure is to first configure the PRO algorithm (if available), and
then configure the DVO based on that. If the PRO algorithm is not available, it is
recommended to configure the DVO based on a dose calculation algorithm (AAA/Acuros XB).

More details on using Beam Configuration: Beam Configuration Reference Guide.

Configure DVO based on Configured AAA/Acuros XB

1. Verify that the dose calculation model you want to use (AAA/Acuros XB) is
correctly configured in the system.

2. In the Scope window, select the optimization model to configure.
3. Choose Insert > New Beam Data.
4. Select the Copy existing calculation model data to the optimization model

option.
5. Select the configured calculation model to use for the configuration of the new

optimization model.
6. Click OK.
7. In the Focus window, select Dose Calculation Parameters, and select the

calculation grid size in cm from drop down list. More information on the grid
size: Beam Data Measurements for Dose Optimization on page 207.

8. In the Focus window, select the Open Field add-on and choose Beam Data >
Calculate Beam Data.

9. If prompted to do so, select the beam data to be generated and then click OK to
start the calculation.

Configure DVO based on Configured PRO/DVO/PGO

1. Go to Beam Configuration.
2. To add a calculation model for the DVO algorithm if not available, choose Beam

Data > Configure Calculation Models and add the model.
3. In the Scope window, select the DVO calculation model and choose Insert > New

Beam Data.
4. Define a therapy unit name for the calculation model and select the Start with

empty data option.
5. Choose File > Import > Eclipse Beam Data, browse to the location of the

appropriate beam data and import the data.
6. Match and assign the open field add-on.
7. In the Focus window, select Dose Calculation Parameters, and select the

calculation grid size in cm from drop down list. More information on the grid
size: Beam Data Measurements for Dose Optimization on page 207.

8. In the Focus window, select the Open Field add-on and choose Beam Data >
Calculate Beam Data.
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9. If the configuration was successful, approve the data.

Configure DVO based on Measured Beam Data

1. Go to Beam Configuration.
2. To add a calculation model for the DVO algorithm if not available, choose Beam

Data > Configure Calculation Models and add the model.
3. In the Scope window, select the DVO calculation model and choose Insert > New

Beam Data.
4. Define a therapy unit name for the calculation model and select the Start with

empty data option.
5. In the Focus window, select Dose Calculation Parameters, and select the

calculation grid size in cm from drop down list. More information on the grid
size: Beam Data Measurements for Dose Optimization on page 207.

6. To add the open field add-on, chooseInsert > New Add‐On.
7. To import the beam data in the w2CAD format, go to the Focus window, select

Open Field, choose File > Import > Measured Diagonal Profiles, Measured
Depth Doses, or Measured Profiles, depending on the measurement type, and
navigate to the location of your measured beam data files.

8. In the Focus window, select the Open Field add-on and choose Beam Data >
Calculate Beam Data.

9. If the configuration was successful, approve the data.

Configuration of PRO in Beam Configuration
You can configure the PRO algorithm based on:
■ Previously configured beam data for a dose calculation algorithm (AAA/

Acuros XB).
■ Previously configured beam data for a photon optimization algorithm

(PRO/DVO/PGO). Instructions on copying the beam data from another
calculation model: Beam Configuration Reference Guide.

■ Basic measured beam data.

Note: The recommended procedure is to first configure the dose calculation algorithm (AAA/
Acuros XB), and then configure the PRO based on that.

More details on using Beam Configuration: Beam Configuration Reference Guide.
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Configure PRO based on Configured AAA/Acuros XB

1. Verify that the dose calculation model you want to use (AAA/Acuros XB) is
correctly configured in the system.

2. In the Scope window, select the optimization model to configure.
3. Choose Insert > New Beam Data.
4. Select the Copy existing calculation model data to the optimization model

option.
5. Select the configured calculation model to use for the configuration of the new

optimization model.
6. Click OK.
7. In the Focus window, select Dose Calculation Parameters, and select the

calculation grid size in cm from drop down list. More information on the grid
size: Beam Data Measurements for Dose Optimization on page 207.

8. In the Focus window, select the Open Field add-on and choose Beam Data >
Calculate Beam Data.

9. If prompted to do so, select the beam data to be generated and click OK to start
the calculation.

Configure PRO based on Configured PRO/DVO/PGO

1. Go to Beam Configuration.
2. To add a calculation model for the PRO algorithm if not available, choose Beam

Data > Configure Calculation Models and add the model.
3. In the Scope window, select the PRO calculation model and choose Insert > New

Beam Data.
4. Define a therapy unit name for the calculation model and select the Start with

empty data option.
5. Choose File > Import > Eclipse Beam Data, browse to the location of the

appropriate beam data and import the data.
6. Match and assign the open field add-on.
7. In the Focus window, select Open Field, then choose Insert > New Absolute

Dose Calibration Parameters, and type the same values to the parameters as are
used in the AAA/Acuros XB configuration.

The parameter values must be the same as in the AAA/Acuros XB configuration.
8. In the Focus window, select Dose Calculation Parameters, and select the

calculation grid size in cm from drop down list. More information on the grid
size: Beam Data Measurements for Dose Optimization on page 207.

9. In the Focus window, select the Open Field add-on and choose Beam Data >
Calculate Beam Data.
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10. If the configuration was successful, approve the data.

Configure PRO based on Measured Beam Data

1. Go to Beam Configuration.
2. To add a calculation model for the PRO algorithm if not available, choose Beam

Data > Configure Calculation Models and add the model.
3. In the Scope window, select the PRO calculation model and choose Insert > New

Beam Data.
4. Define a therapy unit name for the calculation model and select the Start with

empty data option.
5. Absolute Dose Calibration Parameters default values are added.
6. Type the same values to the Absolute Dosimetry Calibration Parameters as are

used in the AAA/Acuros XB configuration.

The parameter values must be the same as in the AAA/Acuros XB configuration.
7. In the Focus window, select Dose Calculation Parameters, and select the

calculation grid size in cm from drop down list. More information on the grid
size: Beam Data Measurements for Dose Optimization on page 207.

8. To add the open field add-on, choose Insert > New Add‐On.
9. To import the beam data in the w2CAD format, go to the Focus window, select

Open Field, choose File > Import > Measured Diagonal Profiles, Measured
Depth Doses, or Measured Profiles, depending on the measurement type, and
navigate to the location of your measured beam data files.

10. In the Focus window, select the Open Field add-on and choose Beam Data >
Calculate Beam Data.

11. If the configuration was successful, approve the data.

Configuration of PGO in Beam Configuration
The appropriate way of creating a PGO calculation model is to have it use the same
beam data as the DVO calculation model. This is defined in the Add Calculation
Model dialog box in Beam Configuration (choose Beam Data  > Configure
Calculation Models). It is not possible to assign existing beam data from another
model to the PGO in the Insert New Beam Data dialog box. More information on
Beam Configuration: Beam Configuration Reference Guide.

Input Parameters for PGO

The table lists the input parameters for the PGO algorithm used to control the
execution. The table also includes information about the parameter types, their value
ranges and default values (IEC 61217 for couch, gantry or collimator angles).
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Table 41 Input Parameters for the PGO

Parameter name Range

(IEC 61217
for couch,
gantry or
collimator
angles)

Default
value

(IEC 61217
for couch,
gantry or
collimator
angles)

Use of Parameter

Initial field distri-
bution

Coplanar,
Non-
coplanar,
None

Coplanar Information on the creation of the initial co-
planar (2D) and non-coplanar (3D) field geo-
metries: Initial Field Geometries on page 194.
Selecting None skips the global optimization
and uses the active plan in Eclipse as input for
local optimization.

Initial number of
fields

2–400 71 Defines the initial number of fields to be cre-
ated for the global optimization. However, the
field geometry is checked before running the
global optimization for fields that enter the pa-
tient through the end(s) of the CT stack (these
fields are excluded). The number of fields left
in the initial field distribution after the check
may be lower than the number specified by this
parameter.

Minimum
number of fields

2–15 5 Defines the lower limit for the number of fields
to be left in the plan after global optimization.

Maximum
number of fields

2–15 9 Defines the upper limit for the number of fields
to be left in the plan after global optimization.
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Parameter name Range

(IEC 61217
for couch,
gantry or
collimator
angles)

Default
value

(IEC 61217
for couch,
gantry or
collimator
angles)

Use of Parameter

Maximum colli-
mator variation
[deg]

0–180 0 Controls the variation of the collimator angle
values between adjacent fields in the initial
field distribution.

0 = Leaves the collimators to zero angle
(IEC 61217 scale, which corresponds to 180 de-
grees in the Varian Standard scale).

180 degrees = The collimators are rotated be-
tween 270 degrees (that is, −90 degrees) and
90 degrees so that the direction of the MLC
leaves coincides with the shortest dimension of
the PTV in the BEV. This choice aims at the
lowest possible number of carriage groups, and
often also minimizes the exposure of healthy
tissue.

> 180 degrees = The collimator angles stay
within the specified limit. The movement direc-
tion of the leaves coincides with the shortest di-
mension of the PTV.

Individual machine limits for collimator angle
rotation are not taken into account by the PGO.
Constraining the collimator angle values to
270–90 degrees is considered sufficient for most
linear accelerators.

Coplanar offset
angle [deg]

0–90 0 Adjusts the offset to the starting gantry angle
(default = 0 degrees in IEC 61217, which corre-
sponds to 180 degrees in the Varian Standard
scale) for coplanar initial field distribution.
Does not affect the non-coplanar initial field
distribution.

Maximum eleva-
tion angle for
non-coplanar
fields [deg]

0–90 90 Controls the maximum elevation from the co-
planar plane for non-coplanar initial field dis-
tribution.

Fluence iterations
per global geo-
metric iteration

1–20 3 Defines the number of fluence optimization
iterations to be run in the global optimization.
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Parameter name Range

(IEC 61217
for couch,
gantry or
collimator
angles)

Default
value

(IEC 61217
for couch,
gantry or
collimator
angles)

Use of Parameter

Field reduction
rate

0–1 0.5 Controls the number of fields to be removed
from the plan during the global optimization.
Increasing the value also increases the number
of fields to be removed in each global geometry
iteration, which makes the algorithm faster.
However, it is not recommended to increase
this value above 0.5.

Field number
constraint weight

0–1 0.4 Controls the cost for leaving more fields in the
final plan (Field Number Objective on
page 198).

First global itera-
tion weight

0–1 0.1 Description of the use of this parameter: Initial
Field Removal Effects on page 201.

Lateral inhibition
weight

0–1 0.4 Description of the use of this parameter: Lateral
Inhibition on page 199.

Proximity effect
weight

0–1 0.4 Description of the use of this parameter: Prox-
imity Effect on page 200.

Minimum field
separation angle
[deg]

0–90 10 Controls how close to each other the fields are
allowed to stay in the final plan after the global
optimization. The parameter also applies to the
local optimization.

Local geometric
optimization
mode

Simplex,
Powell,
None

Simplex Defines the mode for the local optimization. Se-
lecting None skips the local optimization.

Fluence iterations
per local geo-
metric iteration

1–20 3 Defines the number of fluence optimization
iterations in the local optimization.

Maximum
number of local
optimization iter-
ations

0–500 40 Defines the upper limit for the number of ob-
jective function evaluations to be calculated in
the local optimization and controls the execu-
tion time of the local optimization (Local Opti-
mization Mode for Plan Geometry on
page 201).

Initial step size in
local optimization
[deg]

1–180 10 Defines the initial distance between the original
and the new field direction in the local optimi-
zation. Used by Simplex and Powell optimiza-
tion.
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Chapter 10    DVH Estimation Algorithm for
RapidPlan

DVH Estimation Algorithm for RapidPlan
DVH estimation algorithm is used for creating and applying DVH estimation models
to be used in treatment planning with RapidPlan. The main purpose of the DVH
estimation algorithm is to estimate what would be an achievable Dose-Volume
Histogram (DVH) for various critical organs. The estimations are based on the actual
DVHs achieved in earlier planned patient cases. These estimated DVHs can be
translated into optimization objectives. The optimization objectives are set so that the
optimizer tries to achieve the estimated DVHs.

The algorithm is divided into model configuration and the DVH estimation
components. The model configuration component is used for configuring new DVH
estimation models that can then be used in the DVH estimation component to get
estimates for a single plan. The model configuration component consists of two
phases, the data extraction phase and the model training phase. The DVH estimation
component consists of estimation generation and objective generation phases.

It is possible to use up to three different target dose levels. You can define 1-3 target
structures in a DVH estimation model.

The information needed for estimations is stored in a DVH estimation model. This
model is created by using the training phase of the DVH estimation algorithm and a
set of earlier planned cases, that have been added to a training set by performing the
extraction phase of the DVH estimation algorithm. During the extraction phase, the
original plans must contain structure sets, field geometry, dose matrices and plan
prescriptions. The scope of this algorithm is limited to IMRT and VMAT plans.

Model Configuration Component
In the model configuration component, a set of plans in the Varian system database
are transferred into binary information required to generate DVH estimates. The
model configuration as a general task has two phases: extraction and training. Thus
the model configuration component of the DVH Estimation algorithm also has these
two phases: the data extraction phase and the model training phase. In the data
extraction phase, the information related to a structure set, dose, and field geometry
related to a single plan is converted into few characteristic curves and parameter
values. These are later used together with all the other extracted data to perform
model training.

Chapter 10    DVH Estimation Algorithm for RapidPlan 219



Data Extraction Phase

The data extraction phase prepares the training data that the configuration
component needs in order to train a model. As input, the data extraction component
takes a set of IMRT or VMAT plans, in particular the structure sets and dose matrices
associated to them.

The structure set uses a volume segment model for representing each of the
structures. The volume segment model is based on the discretization of the whole
image in same-sized 3D units, called voxels. All the metrics calculated by the DVH
estimation algorithm are voxel based. All structure volumes in a structure set are
converted into 2.5 mm resolution and transformed into volumetric presentation
where each voxel has a value from 0.0 to 1.0 representing the fraction of the voxel
volume belonging to the structure.

For each training plan and for each structure matched to any model OAR structure,
the data extraction phase first divides the volume of the structure into functionally
different regions:

■ Out-of-field region is the part of the structure not visible from the jaw aperture of
any of the fields (or in case of an arc-field, from any of the control points).

■ Leaf-transmission region is the part of the structure visible at least from one jaw
aperture, but has no overlap with the target projection from any of the fields.

■ In-field region is the part of the structure that has overlap with target projection at
least from one field.

■ Overlap region is the part of the volume that is also inside any structure matched
to one of the model target structures.

Together the four regions (overlap, in-field, leaf transmission and out-of-field) define
all structure volumes inside the body.

For each region, the relative volume of the region is calculated, as well as the
cumulative volume histogram of the given dose matrix (sampled into 2.5 mm
resolution). Similarly, the geometric distribution of the region is evaluated as a
cumulative volume histogram of GED matrix (information on GED: Geometry-Based
Expected Dose (GED) Metric on page 226). All volume histograms are calculated
based on those voxels that have at least 0.5 volume fraction belonging to the region.
However, any voxel having at least 0.5 volume fraction inside the total structure
would be counted into one of the regions.

The following geometrical features are calculated for the whole structure:

■ Set of Geometry-based Expected Dose histograms (GEDs) of the OAR
(cumulative).

■ The anatomical features of the patient's OAR:

■ OAR volume in cm3
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■ Overlap volume percentage of the OAR with the union of all the targets
■ Out-of-field volume percentage of the OAR
■ Joint target volume in cm3

Model Training Phase

The model training phase of the DVH estimation algorithm is used for creating DVH
estimation models. The model training phase produces a DVH estimation model,
which is actually a set of DVH estimation models of separate Organs-at-Risk (OAR).
The DVH estimation model for each OAR is also composed as a set of DVH
estimation models, one model per OAR region. Each OAR-region model is calculated
separately using the same steps. There are three possible models available for each
OAR-region:
■ The more complex model uses a combination of Principal Component Analysis

(PCA) and regression techniques. Only the in-field region of the OAR uses this
model.

■ The more simplistic model uses the mean and standard deviation (std) of the
OAR region DVHs.

■ Region-specific default models.

In the PCA-regression model, the model training phase uses the metrics that were
calculated by the data extraction phase as input. Over those metrics, the model
training phase applies the PCA to the GEDs of all OARs (from the whole training set)
to extract the information (features) contained in the GEDs. The same procedure is
applied to the DVHs. As a result of this step, the model training phase usually finds 2
to 3 values (principal component scores) to represent each histogram. The exact
number of components depends on how many components are needed to reconstruct
the original histograms with less than 5% error.

The extracted principal component scores of the GED are then combined with the
anatomical features of the patient's OAR and the target volume in voxels. The result
of the combination consists in all the first and second order terms between the values,
plus the zero order term (the intercept term). This set of terms is the input for the
regression model.
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In the next step, the model training phase applies stepwise regression separately for
each principal component of the DVH. The stepwise regression model is constructed
following an iterative process of forward and backward methods until convergence.
During the first iteration, the forward method is used. The algorithm keeps adding
parameters to the model as long as they have a level of significance higher than 5%.
After the forward regression stops, the backward method begins taking away
parameters whose significance is less than 5%. This process continues until there are
no parameters to add or remove. The resulting regression model is a set of
coefficients that can be used to estimate the principal component scores of the DVH
from the geometric parameters. In addition, standard error of each DVH principal
component score estimate is calculated in order to later determine the upper and
lower bounds of the estimation range.

The whole PCA-regression model for an OAR is composed of the following:
■ The mean and principal components of the GEDs.
■ The mean and principal components of the DVHs.
■ The regression model.
■ A series of statistical information, such as means and standard deviations of the

scores and of the anatomical features, and regression model errors. This
information is used for outlier detection during both configuration and while
applying the DVH estimation model to a plan.

■ The range of the target coverages found in the training set.

If the PCA-regression model does not receive enough in-field regions as input, the
model for that OAR is not trained.

The means-and-std model is composed of the mean and standard deviation of the
DVHs. If the means-and-std model does not receive enough structure regions as
input, it switches to a region-specific default model. The following region-specific
default models exist:
■ Default overlap model: all the overlap volumes of the structure that receive 100%

of the prescribed dose.
■ Default leaf-transmission model: all the leaf-transmission volumes of the structure

that receives leaf-transmission dose, which is defined as 4% of the prescribed
dose.

■ Default out-of-field model: all the out-of-field volumes of the structure that
receives 0 Gy.

No default model exists for the in-field region.
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DVH Estimation Component
The DVH estimation component of the DVH estimation algorithm is used for
generating estimated DVHs and optimization objectives for a plan. As input, the
DVH estimation component takes a trained DVH estimation model, a structure set
from the plan and the dose levels of targets. The DVH estimation algorithm outputs a
set of DVHs representing upper and lower boundary estimates for each of the
supported OAR structures and a set of optimization objectives. The optimization
objectives are set so that the optimizer tries to achieve the estimated DVHs.

The DVH estimation component consists of two phases: the estimation generation
phase, and the objective generation phase.

Estimation Generation Phase

The estimation generation phase calculates for each supported structure the same
metrics that were calculated during the data extraction of the DVH estimation model,
except for the DVH. For each structure matched to any model OAR structure, the
geometry is evaluated in a similar manner than in the data extraction phase of model
configuration, including the structure partition, cumulative volume histogram for
GED, and the anatomical features.

An anatomical feature is flagged as significantly off from the training set statistics if
either X>Xmax; X<Xmin, or if one of the following in the equation is true.

Equation 54

 
(X − Xmed)
X90 − Xmed

> 1.56

or

X − Xmed

Xmed − X10
> 1.56

 

where   

X = The value of the geometric feature calculated for the applied plan.

Xmax = The largest value in the training set.

Xmin = The smallest value in the training set.

Xmed = The median value in the training set.

X90 = The 90% percentile of the values in the training set.
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X10 = The 10% percentile of the values in the training set.

For in-field region, modeled with the PCA-regression model, the GED histogram is
further parameterized by using the principal components calculated during the
model training phase and stored into the model data. The regression model is
applied to estimate corresponding DVH principal component scores. The most
probable DVH curve is then constructed using the stored DVH principal
components. The upper and lower bound is generated from the most probable DVH
estimate. The variation curve is constructed by adding together the point-wise
squared DVH principal components multiplied by the standard error related to the
regression model. Finally, the square root is performed pointwise to the summed
curve to obtain final variation curve. The upper and lower bound is obtained by
adding and subtracting this variation curve.

For other regions using the means-and-std model, the upper and lower curves are
simply calculated by adding and subtracting the stored std curve to the stored mean
DVH.

Finally, the curves from different regions are summed together weighting them
individually by the corresponding relative volumes of each region. This is done
separately for the upper and lower bound curves.

Note: It is possible that the direct reconstruction of the DVH from the principal component
scores obtained from the regression model could produce a curve that is not monotonically
decreasing. In such cases, the final curve is obtained by replacing each value in the estimated
cumulative DVH by the largest value in the estimated curve with a dose value larger than the
current dose value.

Optimization Objectives Placing Phase

When the estimation generation phase has estimated the upper and lower bound
DVHs, the optimization objectives placing phase converts them into optimization
objectives. The objectives are set based on user preferences. For OARs, a variety of
different estimate-based and fixed objective types are possible. The optimization
objectives for OARs are set so that the optimization tries to achieve the estimated
DVHs. Because the users also aim at improving organ sparing as long as the target
coverage is not compromised, the optimization objectives are constructed as
described below.
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Firstly, the objective drives the current DVH towards the objective. Since users try to
improve both target coverage and critical organs sparing, whenever organ sparing is
good, the target coverage is also good, and vice versa. The objectives pull all parts of
the DVH curve with the same strength, fitting the DVH curve to a profile similar to
the one of the objective line. If part of the objective line is below the DVH curve, that
part of the line has no effect on the DVH curve shape. Only those line parts that are
located above the DVH curve have a pulling effect on the curve. To find the
optimization objectives, the force (gradient of the cost function to be optimized) that
pulls from the target lower bound FT, L(LB) should equal the sum of the forces that
tries to reduce dose from each of the OAR upper bounds FOAR, U(UB), and vice versa.
This constraint guarantees that if optimization finds the solution fulfilling the
estimates, it also minimizes the cost function. The following equation is for a model
with nOAR OAR structures:

Equation 55

 ∑
i = 1

nT

Fi
T, L(LB) =∑

i = 1

nT

Fi
T, U(UB) +∑

i = 1

nOAR

Fi
OAR, U(UB)∑

i = 1

nT

Fi
T, L(UB) = ∑

i = 1

nT

Fi
T, U(LB) + ∑

i = 1

nOAR

Fi
OAR, U(LB)

 

 

where   

nT = Number of target structures.

nOAR = Number of OAR structures.

LB = Lower bound of the feasible region of the DVH. For a critical
organ this is the lower bound of the estimated DVH range.

UB = Upper bound of the feasible region of the DVH. For a critical
organ this is the upper bound of the estimated DVH range.

Fi
T, L x = Total gradient from the lower objectives of target i when the

corresponding target DVH is at x.

Fi
T, U(x) = Total gradient from the upper objectives of target i when the

corresponding target DVH is at x.

Fi
OAR, U(x) = Total gradient from the upper objectives of critical organ i

when the corresponding critical organ DVH is at x.
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Fi
OAR, U and Fi

T, U are equal; each structure has the same emphasis. If one OAR or
target has more than one upper object, the gradients of the individual objects are
considered to be equal. These equations will determine the location (the dynamic
part of the objective) and the priority of the objective. In practice the optimization
objectives of OARs are set to the left side (smaller doses to less volume) of the lower
bound, so that the lower bound can be achieved. All priorities are given relative to
the priorities of the target lower bound. By setting the target priority to a certain
value, the rest of the parameters can be uniquely determined. The priority value can
be overridden by defining a new value in the DVH Estimation Model Configuration
workspace.

As an additional condition, the line objective has the same shape than the lower
estimate, so that it can be below the lower bound at every dose-volume if the same
shift is used. Thus, the line objective has constant shift to the left from the lower
estimate, that is, the shift is the same at every volume percentage.

In the high dose volume corresponding the target overlap volume, the line objective
is modified so that it does not conflict with the target lower objectives. Instead of
following the lower estimate, the line objective continues with horizontal segment at
that volume until the target dose prescription is reached, and then with vertical
segment until the 0 volume is reached. From the algorithm point of view, the line
objective is a collection of dose-volume pairs. The line is generated in a way that
there are as few pairs as possible. The pair values are not set at equal intervals. The
algorithm considers the form of the line and tries to put the objectives in the points
where the line changes the most (that is, concave/convex turns). The user cannot
configure these values.

DVH estimation models contain manually defined (fixed) optimization objectives.
The manually defined objectives can be defined partially (missing some optimization
parameter values) or fully (all optimization parameter values set). The fully defined
optimization objectives are passed as they are, while the values missing from the
partially defined ones are calculated and filled by the DVH estimation component.

Geometry-Based Expected Dose (GED) Metric
The Geometry-based Expected Dose (GED) metric represents, in a manner, how far
away the different voxels in the structure are from the targets surfaces. The
“distance” value consists of the amount of dose that each target contributes to in a
particular voxel given the current field geometry.

The metric depends solely on the patient anatomy; the desired dose to deliver to
every target (target level) and the field setup (position and orientation). The GED
metric measures how much dose a certain voxel would receive if we only were to
take into account the previously mentioned values. This way, the GED metric
resembles a conformal dose.
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For calculating the GED metric, the body volume is discretized into same-sized 3D
units, called voxels. For a particular field, the relative “dose-distance” value in voxel
v (gedfv), is defined as:

Equation 56

 

ged f v = F λ f , d f v   =   e
−λ f × d f v

d f v
2

 

where   

dfv = Euclidean distance from field f origin to voxel v.

λ f = Parameter that depends on the nominal energy of field f.

The total “dose-distance” value in voxel v (gedv), is defined as:

Equation 57

 

gedv = ∑
t = 1

m

δt × ∑
f = 1

n

Ctv × ged f v

 

where   

m = Number of target levels.

δt = Incremental target level (current desired target level minus
the previous [in ascendant order of value] target level).

n = Number of fields.

Ctv = Scaling factor that modulates the radiation in each field’s
beamlet given the target geometry.

The ctv is introduced to allow certain modulation inter- and intra-field and get a
smoother looking GED metric. Smoother GED metrics are linked to smoother GED
histograms which are easier to parametrize in later steps.

The figure shows an example of an GED metric.
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1. Field origin
2. dF1,j
3. OAR
4. Geometry-based expected dose from field F1 = 0
5. Voxel i
6. Voxel j
7. Voxel k
8. Geometry-based expected dose from field F1 = Equation 58 on page 228
9. d, length of the target along the fanline (13)

10. Target 2
11. Target 1
12. Field edge
13. Fanline going through voxel j
14. Gantry rotation plane

Figure 35 Geometry-based Expected Dose

Equation in the illustration:

Equation 58

 

HF1 × dosetarget2 ×
e

−λF1 × dF1, j

dF1, j
2 × G(d)

 

where in addition   

G(d) = Intra-field modulation factor.

HF1 = Inter-field modulation factor.
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The inter-field modulation means that the amount of radiation delivered by each
field can be different. That is, there are preferred directions for dose delivery. The
inter-field modulation factor is calculated by dividing the longest d in the field by the
average of d in the field. In particular, it is considered that fields that are
perpendicular to the main target direction of asymmetrically shaped target give less
radiation than those that are aligned with it. The relative strength of the dose
delivered by a field depends on the maximum number of target voxels that any
field’s beamlet crosses in its path.

The intra-field modulation means that the amount of radiation delivered by each
beamlet within a field can be different. That is, there is some kind of MLC
modulation taken into account. Each field beamlet is scaled according to the number
of target voxels it crosses in its path. The concrete beamlet modulation value is the
number of target voxels crossed by a beamlet divided by the average number of
target voxels crossed by all beamlets in the field.

Lastly, for all the voxels that are visible under any field jaw, but that have less than a
certain threshold value l as their “dose-distance” value, the value will be increased
up to l. This represents the leaf transmission contribution. This leaf transmission
value, as the modulation, has as principal goal to smooth the GED metrics.

Outlier Metrics
Components of the DVH estimation algorithm (model configuration component and
DVH estimation component) perform outlier detection. Outliers are found by
applying different statistical metrics (such as Z-statistic, modified Z-statistic and
studentized residuals) over the Organ-at-Risk (OAR) metrics (anatomical features
and principal component scores), target metrics (volumes and relative doses) and
plan metrics (dose prescription). More information on outliers: Eclipse Photon and
Electron Reference Guide.
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Chapter 11    Fluence Delivery Modeling Algorithms

General Features of Fluence Delivery Modeling
Algorithms

In Eclipse, the final dose calculation for all MLC fields is based on fluences.
Moreover, some of the optimization algorithms give their results as fluences. DMLC
produces the arbitrary fluence patterns and field apertures for arc fields on a
treatment unit.

Features that are taken into account in all fluence delivery modeling algorithms
include leaf transmission, dosimetric leaf gap, and tongue-and-groove modeling.
They are used in the final fluence calculation for all fields that contain an MLC, such
as static MLC fields, IMRT fields and all arc fields. These features are also taken into
account in the PRO algorithm.

Fluences needed by the final dose calculation are calculated as part of the dose
calculation. This means that the actual fluence of IMRT fields can be visualized after
dose calculation.

Note: Version 11.0 or later dose calculation algorithms require the use of version 11.0 or later
of the LMC algorithms. The previous dose calculation algorithms work only with previous
LMC algorithms (version 10.0 or earlier).

Transmission in Fluence Delivery Modeling Algorithms
The MLC leaves do not block the radiation completely, but transmit a small amount
of radiation directly through the leaves. The amount of the transmission can be
configured for a given treatment unit and energy in Beam Configuration (more
information on using Beam Configuration: Beam Configuration Reference Guide). The
configured transmission factor is used in all fluence calculations, including the
internal fluence calculation of Leaf Motion Calculators (LMC) and final fluence
calculation for static MLC, DMLC and arc fields. Transmission factor is defined also
for block materials and the transmission factor for physical jaws is 0. In order to
minimize the effects of the transmitted radiation, LMCs also compensate for the
transmission while generating a leaf sequence. More information on measuring the
leaf transmission factor: Measuring the Leaf Transmission Factor on page 255.
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Dosimetric Leaf Gap in Fluence Delivery Modeling Algorithms
To achieve better off-axis dosimetric characteristics, the ends of the MLC leaves are
rounded in some MLC devices. Because of the rounded shape, some radiation passes
between the leaves even through completely closed leaf pairs. This phenomenon is
called the rounded leaf end transmission.

The fluence delivery algorithms deal with the rounded leaf end transmission by
means of the dosimetric leaf gap configuration parameter. The algorithms model the
shape of the leaf edges as sharp (as opposed to rounded) and take the rounded leaf
transmission into account by shifting the leaf tip positions in the actual fluence
calculation. Leaf tips are shifted by pulling each of them back by half the value of the
dosimetric leaf gap parameter so that the gap between a fully closed leaf pair equals
the dosimetric leaf gap parameter. The dosimetric leaf gap parameter can be defined
in RT Administration for each treatment unit and energy (Configuration of the MLC
Parameters on page 254). The spot size parameter affects effectively the penumbra
shape (Tuning of the effective spot size parameters on page 47).
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Figure 36 Rounded Leaf End Transmission

Tongue-and-Groove Modeling in Fluence Delivery Modeling
Algorithms

To minimize the inter-leaf leakage, some MLC device models have a tongue-and-
groove design.
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Figure 37 Tongue-and-Groove Design

An exposed tongue in a field modifies the delivered fluence by blocking some of the
additional radiation. The amount of blocking is proportional to the ratio between the
tongue and leaf widths. (The groove also modifies the fluence, but that effect is
smaller and is not modeled in the algorithms.) This is called the tongue-and-groove
effect.

The tongue-and-groove effect is modeled in the fluence delivery algorithms by
extending the leaf projections in the direction perpendicular to the leaf motion with
an approximate extension parameter (Figure 37 on page 233), which is slightly
smaller than the real tongue width. This parameter is not user-configurable, and it
depends on the MLC model and algorithm version.

The tongue-and-groove effect is taken into account in all fluences used in dose
calculation and is visible in the actual fluence shown for IMRT fields. The effect is
more significant in DMLC and arc treatments than static MLC delivery techniques.
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Leaf Motion Calculator (LMC)
The Leaf Motion Calculator (LMC) program calculates the DMLC leaf motion
patterns required to deliver the dose defined by the optimal fluence46. Because of
physical and mechanical characteristics of the DMLC device, the produced DMLC
leaf motion patterns can deliver an actual fluence that only approximates the desired
optimal fluence.

The LMC supports two delivery techniques for the dose dynamic delivery of an
IMRT treatment:

■ Sliding Window (SW) technique (Varian and BrainLab MLC devices)
■ Multiple Static Segments (MSS) technique (Varian, BrainLab, Siemens and Elekta

MLC devices)

The leaf motion patterns for the MSS technique used in Siemens and Elekta MLCs are
calculated using an advanced optimization method that takes into account the
interdigitation limitations of the MLC device, while the leaf motion patterns for both
the sliding window and MSS techniques used in Varian MLCs are calculated using a
more direct algorithm.

Sliding Window Method
The Sliding Window method is one of three commonly used DMLC intensity
modulation methods, in addition to the Multiple Static Segments and Close-In
methods.

The main idea of the Sliding Window method is to sweep MLC leaf pairs of varying
aperture sizes and speed over a field during the beam-on. To achieve clinically
applicable results, the following objectives must be respected:

■ The beam-on time must be short to speed up the treatment and to avoid extra
dose resulting from transmission and leakage.

■ Because of the rounded leaf end transmission (Dosimetric Leaf Gap in Fluence
Delivery Modeling Algorithms on page 231) and the minimum leaf gap, leaf pairs
exposing the target to a low dose start behind the main collimators. This
minimizes the additional dose for leaf pairs that give a very small total dose.

■ The rounded leaf end transmission is configured as the dosimetric leaf gap
parameter in the Beam Configuration. Information about this and the minimum
leaf gap configuration parameter: System Configuration for Fluence Delivery
Modeling on page 247.

46 Another discussion on the topic: Spirou SV & Chui CS: Generation of Arbitrary
Intensity Profiles by Dynamic Jaws or Multileaf Collimators. Medical Physics, 1994,
Jul; 21 (7): 1031–41.
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■ The physical characteristics of the MLC device must be respected. This requires
techniques for handling multiple carriage groups needed for larger fields, and leaf
movement objectives. The maximum leaf speed and the minimum leaf gap must
be respected.

Implementations of the Sliding Window method for field widths under the Effective
Leaf Out of Carriage Distance (ELOC)47 use the following strategy:
■ Start of delivery (see the figure): Leaf pairs are at the left border of the target. Leaf

pairs exposing the target to a normal or large amount of radiation are open and
inside the target. Leaf pairs giving a very low dose remain behind the left
collimator for some time at the beginning of the treatment. These leaf pairs start
moving at the maximum speed once it is safe to include them in the treatment.
This minimizes leaf gap effects.

■ End of delivery: All leaf pairs are at the right edge of the target (see the figure).
■ At least one leaf of a pair always moves at the maximum speed to minimize the

delivery time. Because of the requirements for the beginning and the end of the
delivery presented above, and the differences in the complexity of the image
planes, the maximum speed is individual for each leaf pair.

47 Leaf out of Carriage Distance (LOC, leaf span). The maximum FX distance of
adjacent MLC leaves. Also the maximum width of a subfield for the conventional
sliding window method.

Effective Leaf out of Carriage Distance (ELOC). Same as LOC, but the leaf parking
and the collimator FX margin distances are reduced from it. Defines the field size
crossover point between a single carriage group and double carriage group
treatments.

Chapter 11    Fluence Delivery Modeling Algorithms 235



1

2

3

1. Fluence to be delivered
2. First segment: Leaf pairs parked at the left border of the target
3. Last segment: Leaf pairs parked at the right edge of the target

Figure 38 
First and Last Segment Delivering a Fluence

Example Sliding Window Case

Input data
Consider the example of a 5 × 3 fluence matrix (three leaf pairs) in the table.

Table 42 Simple Fluence Matrix

Slice 0 0 0.5 1 0.6 0.8

Slice 1 0.2 0.5 0.7 0.5 0.2

Slice 2 0 0 0.4 0.6 0.3

Between the given points, the profile is considered linear. The individual slices are
plotted in the figure. There are two local maxima in slice 0, while in slice 1 and 2
there is only one each.

236 Eclipse Photon and Electron Algorithms Reference Guide



0.0

0.2

0.4

0.6

0.8

1.0

0.1

0.2

0.3

0.4

0.5

0.6

0.7

0.8

0.0

0.1

0.2

0.3

0.4

0.5

0.6

1 1 1

2 2 2

3 4 5

1. Intensity level
2. Position
3. Slice 0
4. Slice 1
5. Slice 2

Figure 39 Plotted Intensity Profiles (Distributions) for Each Slice

Max leaf speed
The complexity Σ of a slice in terms of the Sliding Window method is given by the
number and intensity deltas of incrementing segments.

Slice 0: Σ = 0.5 + 0.5 + 0.2 = 1.2

Slice 1: Σ = 0.2 + 0.3 + 0.2 = 0.7

Slice 2: Σ = 0.4 + 0.2 = 0.6

Slice 0 is the most complex slice, which gets the absolute (physical) maximum leaf
speed as the maximum speed. Assuming a field width of 10 cm, a physical maximum
leaf speed of 2 cm/s, a dose rate of 600 MU/min (= 10 MU/s) and a desired output
maximum of 200 MU (at intensity 1), it takes 10.0/2 = 5 s to sweep the field at the
physical maximum speed, during which 50 MU or 1/4th of the output maximum will
be delivered. The beam-on time, measured in intensity T, is thus 1.2 + 0.25 = 1.45 (the
total machine output is 290 MU).

The leaf motion plan for slice 0 is shown in the figure.
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Figure 40 Leaf Motions for Slice 0

The width of the sliding window (the horizontal distance between the two
trajectories) is thus, for instance, 0 cm at intensity level 0, approximately 4.7 cm at
level 0.6, approximately 5 cm at level 1.1, and 0 cm again at level 1.45.

For all other slices, the leaf pairs are also closed at the right edge of the field at 1.45
(290 MU), so accordingly, their maximum speeds decrease.

For small fields with a width below ELOC, the other slices could be delivered with
the same maximum speed, the leaf pair could stop closed at the right edge under a
collimator jaw. However, this approach is not universal for all fields.

Transmission and leakage
If the above motion plan is put on the treatment unit, the profile delivered would not
be the desired one, but the desired profile plus a certain amount of transmitted or
leaked radiation at every point. Let Ix be the desired intensity at position x
(x = -5.0, -2.5, 0, 2.5, 5 cm in this example) and α = 0.025 an estimated weighted
average of leakage and transmission factors. What would be delivered at every point
would then be I’=Ix+α(T-Ix), which is considerably different to the initial data
(Table 42 on page 236).
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Table 43 Desired Intensity + Transmission and Leakage

Slice 0 0.04 0.52 1.01 0.62 0.81

Slice 1 0.23 0.52 0.72 0.52 0.23

Slice 2 .0.4 0.04 0.43 0.62 0.33

The above figures are not only realistic, they also show that the significance of the
unwanted extra radiation grows when the desired intensity decreases. This effect can,
however, be corrected to some extent by solving the above equation for Ix, replacing
every intensity point with Inew

x=(1-α)-1(Ix-αT) and feeding the new matrix to the
algorithm. Negative values are clamped to zeros in the corrected intensity file.

Large-Field DMLC

With modulated fields wider than the Effective Leaf Out of Carriage Distance
(ELOC), the carriages cannot move while the beam is on. In this case, the original
field is split into subfields which are narrower than the ELOC and a Sliding Window
algorithm is performed for each subfield separately. Because it is practically
impossible to connect sharp edges of subfields accurately, the subfields are given an
overlapping area. When the beam is turned off for a carriage shift, all leaf pairs are
required to form a window inside the overlapping area. An optimization strategy has
been implemented to find out:
■ How many subfields are required
■ Where the field must be split

Consider a leaf plan similar to Table 42 on page 236, but with a field width of 16 cm.
One choice for the overlapping area for one slice would then be as shown in the
figure. Toff would be the beam-on time intensity equivalent at which the beam is
turned off for the carriage displacement. At that time, for this very slice, the window
width is inside the physical carriage limits. Carriage groups would be from -8.0 cm to
+4.5 cm and -4.2 cm to +8.0 cm, thus conforming to the ELOC, at maximum 14.5 cm.
To reduce the sensitivity to uncertainties in patient and MLC leaf positioning, the
window width should be as large as possible.

The field wider than the ELOC is split into two or three subfields, each smaller than
the ELOC. The split to three fields is performed at fixed locations so that the
maximum jaw over carriage distance is not exceeded. The two-field split minimizes
the sum of the T-factors by selecting the crossfade position and width.

The additional leakage due to the collimator X-margins is modeled and reduced from
the optimal fluences. Once the actual fluence is calculated for the first field, the actual
fluence is subtracted from the initial optimal fluence, resulting in a new optimal
fluence for the next carriage group.
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Figure 41 Overlapping Area

The algorithm must ensure that the overlapping area is correctly chosen for all slices
at the same time.

The maximum width of optimal fluence that can be treated with a single carriage
group is based on the maximum leaf span for the MLC, reduced by 0.5 cm due to the
need to park closed leaves under the jaws. For example, if the maximum leaf span for
an MLC is 15 cm, the optimal fluence becomes 14.5 cm.

When fixed, user-defined, jaw positions are used, the original optimal fluence is
modified before determining the need to use multiple carriage groups. If the fluence
extends behind the jaws (seen from the BEV), the pixels from the original optimal
fluence that are entirely behind the jaws are cleared. The pixel that is located at the
jaw position is not cleared. The next outward pixel is cleared if the whole pixel is
more than half a pixel width away from the jaw position.
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Calculation of the Actual Fluence

When calculating the final dose distribution of a modulated treatment, the clinician
wants to know as accurately as possible which dose will be delivered to the patient. If
the final dose calculation is based on a fluence map generated from simplified
physics and delivery models incorporated in the DVO, the calculated dose
distribution may significantly differ from a distribution obtained through
measurements. To be able to see the actual fluence, you need to calculate the dose
after running the LMC.

Calculation of MUFactor

In the LMC, the beam-on time equivalent in intensity, MUFactor, is given as:

Equation 59

 
MUFactor = w ⋅ smin + C

C = max j ∑ j

 

where   

Σj = sum of positive intensity deltas in slice j

C=maxj{Σj} = maximum of these sums for all slices, complexity constant for a cer-
tain fluence matrix, depending on (relative) intensity values of the
matrix only.

w = width of the field in cm, constant for a given matrix as well

smin = minimal slope for a leaf trajectory in cm-1, depending on leaf speed,
dose rate and MU maximum of the field as follows:
Smin = R/(60 x D x v)
where

  R = dose rate in MU/min

  D = field maximum in MU

  v = maximum leaf speed in cm/s

LMC is required to know R, D and v to achieve correct results.
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Although the MLC controller can adjust the dose rate (R), the exact MUFactor value
must be known for transmission correction. It depends on smin which is a ratio of R,
D and v. If the correct transmission correction is to be achieved, at least this ratio
must be the same for the leaf motion calculation and the delivery of the calculated
plan. Once a leaf plan has been calculated, the MUFactor is implicitly contained in it.

If, for instance, upon delivery, D is changed by specifying a different number of total
monitor units O, (D = O/MUFactor), the MLC controller will adjust the machine
parameters, and the dose distribution will be correct, but the delivery will not be
optimal anymore in terms of minimal beam-on time.

Calculation of MUfactor for Smart LMC
The MUFactors for Smart LMC are calculated from the actual fluence as:

Equation 60

 
MUFactor = 1

max j, i f i, j

 

where   

f(i, j) = A cell in the opening ratio matrix of the leaf sequence calculated from
the final leaf sequence using the same pixel size as in optimal fluence.
The highest value is taken from a matrix that describes the relative
transmission compared to the total transmission of open field
( 0 ≤ f i, j ≤ 1 ).

Multiple Static Segments Method for Varian MLC Devices
The Multiple Static Segments (MSS) method is an alternative to the Sliding Window
method. The MSS method is embedded in exactly the same framework as the Sliding
Window method, that is, it uses the same input data and produces the same types of
output data. MSS modulation may also be combined with portal imaging. The MSS
and Sliding Window use the same physics model for the MLC.

In the MSS method, the smallest entity making up the fluence profile is a static MLC
shape. The MSS field consists of several static MLC shapes.

Overview of the Algorithm

The Sliding Window algorithm is first applied to the fluence. The leaf trajectories are
sampled to a smaller number of segments. The number of segments to be sampled is
MU Factor × IntensityLevels. For example, with an intensity spacing of 10
and an MU Factor of 1.6, there are 16 static MLC shapes in the MSS field.
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These shapes are fine-tuned after this process by iteratively adjusting a “working
fluence”. This process takes into account the transmission effects.

Calculation of MUFactor

The MUFactor is calculated similarly to the Sliding Window method. However, in the
MUfactor calculation, leaf speed is assumed to be infinite, because the beam is never
on during leaf movement. This leads to a simpler equation, where the MUFactor is
directly obtained from the complexity constant:

Equation 61

MUFactor = C

where   

Σj = sum of positive intensity deltas in slice j
C=maxj{Σj} = maximum of these sums for all slices, complexity constant for a cer-

tain fluence matrix, depending on (relative) intensity values of the
matrix only.

The MUFactor is iteratively modified using the “working fluence” optimization to
compensate for the leaf transmission.

Multiple Static Segments Method in Smart LMC
The Multiple Static Segments (MSS) method is an alternative to the Sliding Window
method. The optimization method used in the MSS method of Smart LMC to
minimize fluence discrepancies is not based on the Sliding Window method. Instead,
the optimal set of apertures is obtained by iteratively correcting leaf positions and
segment weights to minimize the difference between actual and optimal fluence. The
optimization starts from an initial estimate formed using the Close-In method. The
optimization prevents the creation of single apertures that are very small in size, but
does not explicitly eliminate segments solely because of their small weight.
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Multiple Static Segments Method for Siemens and Elekta MLC Devices
The Multiple Static Segments (MSS) method is an alternative to the Sliding Window
method. The MSS method for Siemens and Elekta machines uses an optimization
method to minimize fluence discrepancies. This method is able to observe restrictions
set by the MLC hardware, for example, the interdigitation constraint that apply to
certain MLCs. The number of iterations is user-defined, and the progress of the
objective function may be monitored during the calculation. The optimization
method is also capable of processing uneven MU per aperture, which provides better
results, but is slower than the traditional MSS leaf motion calculation algorithm used
for Varian's multi-leaf collimators.

MLC devices with a leaf span shorter than the full field width can also be used. In
such cases, all apertures in the final MLC sequence will be narrower than the leaf
span.

Jaw Tracking Capability of Smart LMC
Jaw tracking dynamically moves the collimator jaws during beam-on to keep them as
close to the target projection as possible. This reduces leakage between the MLC
leaves.

Smart LMC can generate leaf sequences during which the jaws are moving, or, in
other words, jaw position changes while the beam is on. If the Jaw Tracking option is
chosen, the jaws are set at each control point to bound the MLC aperture without
using any jaw setbacks. The jaw position and speed limits are taken into account.
Since the maximum speed of jaws is typically slightly slower than the maximum
speed of leaves, in some cases it is possible that jaws do not always follow the MLC
aperture. Leaf tail exposure is nevertheless taken into account.

For Smart LMC, the collimator speed in jaw tracking is set by defining the maximum
speed value for each collimator (IEC X1, X2, Y1, Y2) in a treatment unit operation
limits in RT Administration.

If the Jaw Tracking option is used together with the Fixed Field Borders option, the
jaw positions are still set dynamically at each control point, but the user defined jaw
positions are considered as a bounding box for the possible jaw positions.
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MU Calculation in the LMC
The MU to dose calibration factor MUGy(x,y) is defined as the number of monitor
units required to get 1 Gy on the field central axis at the 10 cm depth for a
rectangular field with a X × Y cm2 collimator opening in a water equivalent medium,
SSD being the same as during the beam profile measurements (SPD). Specifically, the
value of MUGy for a 10 × 10 cm2 field, MUGy(10,10), serves as an absolute fluence
calibration point for the MU calculation system in IMRT planning. In addition to the
reference level provided by MUGy(10,10), it must be possible to calculate the
patient scatter and collimator backscatter for absolute dosimetry.

The collimator backscatter factor CBSF(x,y) is calculated from MU table by
removing the phantom scatter part PSF(x,y) from the measurements of different
openings. More information on the calculation of the CBSF: 
Chapter 3 Implementation of AAA and Acuros XB in Eclipse on page 22, Equation 1
on page 23.

In addition to the collimator backscatter factor and MUGy(10,10), the MU value is
affected by the plan normalization and the dose prescription percentage. A
normalization factor NF is calculated according to:

Equation 62

 
NF = Dtotal

Nfraction

PlanNORM%
100

100
DPresc%

 

Inside the DVO, the phantom scatter factor is calculated using the 3D convolution
algorithm, and is not separately modeled.

Finally, the total monitor units MUtotal are calculated in accordance with the
following equation. The fluence used in patient treatment provides two values for the
optimization; the maximum value of the optimal fluence OFmax, and the intensity
modulation factor MUFactor that depends on the shape of the fluence, which are
multiplied in the total number of MU:

Equation 63

 
MUTotal = MUGy 10, 10 × NF × MUFactor × OFmax

CBSF x, y

 

Example:
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When the plan normalization is set to 100%, the dose prescription percentage to
100%, and the fraction dose is set to 1.0, and there is a unit fluence of size 10 × 10, that
is, when all elements are set to value 1.0, the obtained dose should be 1.0 Gy in the
measurement geometry, when the field MU contribution is MUGy(10,10).

MUtotal Calculation in Smart LMC

Since Smart LMC can handle moving jaw positions, the monitor units cannot be
calculated directly using the equation (Equation 63 on page 245), which assumes that
CBSF is the same for all control points. Instead the MUtotal is given by:

Equation 64

 
MUtotal = MUGy 10, 10 × NF × MUFactor × OFmax

CBSFeff

 

   

where  CBSFeff = 1

sum i
wi

CBSF xi, yi

where   

sum{i} = Sum is taken over all control points, i.

xi, yi = The opening at control point i.

wi = Non-cumulative meterset weight of individual control points.

Fluence Normalization

The fluence normalization is such that constant 10 × 10 cm2 fluence with value 1.0
provides the measured dose at 10 cm depth with the specified SPD for semi-infinite
water phantom for the given amount of MU. The SPD for the normalization
geometry is the same that is used in the configuration of the treatment unit. The
normalization is based on superposition, that is, a 20 × 20 cm2 field with a constant
fluence of 1.0 leads to roughly 1.1 times the dose (+10% of the dose) at the depth of
10 cm, while a 5 × 5 cm2 field gives only around 0.9. The dose values are obtained by
multiplying the values by NF (Equation 62 on page 245).

The fluence values do not compensate for the CBSF effect. CBSF is only compensated
for in the MU calculation.
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Arc Fields in Fluence Delivery
The arc fields are modeled as a sum of individual sub-fields with a static gantry
angle. Each of these sub-fields represents a range of gantry angles in arc field. The
leaf positions and dose rate within the angular range are interpolated and the
average fluence is calculated. This average fluence is then assumed to be delivered
from the static gantry angle for each contributing sub-field. The dose for the whole
arc field is the sum of the doses of the static gantry angle sub-fields.

System Configuration for Fluence Delivery Modeling
Note: When configuring fluence delivery algorithms, note the following:
■ It is important to configure the system so that it corresponds to the characteristics of the

treatment machine.
■ Periodically perform follow-up measurements and compare with the dosimetric beam data

used for configuring the beam. If fluctuations are large and the configured beam data no
longer represents the average beam delivered by the machine, reconfigure the beam data
using the newer dosimetric beam data.

■ Measure all dosimetric beam data in as stable conditions as possible.
■ Use the same file naming conventions in beam data measurements (input files) and in

Beam Configuration (Therapy Unit name), and name the input files so that it is easy to
match the beam data to the treatment unit during the configuration process.

Configuration of the Default LMC Technique
The LMC supports two fluence delivery techniques:
■ Sliding Window (SW) technique (Varian and BrainLab MLC devices)
■ Multiple Static Segments (MSS) technique (Varian, BrainLab, Siemens and Elekta

MLC devices)

The default technique to be used can be defined in the Default LMC tab of the Task
Configuration dialog box. The delivery technique selection is clinic-wide, and
making changes in it affects all treatment units using the same MLC model.

The default LMC technique and related parameters (for example, the number of
control points) are used in all new plans. However, if you modify the default LMC
technique or parameters for a specific plan when calculating leaf motions (Planning >
Calculate Leaf Motions > Edit Options > Calculation Options), the changes are
saved with the plan. Each time you calculate leaf motions for this same plan, the
plan-specific settings are used instead of the settings defined in Task Configuration.
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Note: Versions 11.0 or later of the AAA and Acuros XB dose calculation algorithms require
versions 11.0 or later of the LMCs.

Configure the Default LMC Technique

1. In External Beam Planning, choose Tools > Task Configuration.
2. Select the Default LMC tab.
3. To select the LMC algorithm version you want to configure, click the cell in the

Algorithm Name And Version column and select the algorithm version from the
drop-down list that opens.

4. Do one of the following:
■ If you selected MSS Leaf Motion Calculator in the previous step: Click OK to

close the Task Configuration dialog box, or continue by configuring the MSS
delivery mode (Configuration of Multiple Static Segments Mode on
page 251).

■ If you selected Varian Leaf Motion Calculator or Smart LMC: Continue from
the next step.

5. Click Edit.
6. In the left pane, select LMCV calculation options, or Smart LMC options (only

for treatment machines with jaw tracking available).
7. In the default delivery method drop-down list, select the default technique

(Sliding window, Multiple Static Segments or None).
8. Click OK.

Continue by configuring the sliding window mode (Configuration of Sliding
Window Mode on page 248).

The delivery technique selection is clinic-wide, and making changes in it affects
all treatment units using the same MLC model.

Configuration of Sliding Window Mode
The Sliding Window technique uses DMLC to produce complex intensity-modulated
dose distributions to the target volume. In Eclipse, the linear motion of the DMLC is
divided into field segments. The more segments that are used in the treatment, the
closer the actual dose distribution will be to the dose distribution produced with the
pre-calculated optimal fluence.

The Sliding Window segment data is transferred from Eclipse to the treatment unit
via the 4D Integrated Treatment Console or TrueBeam Treatment Console. For
complex fluences, this may be a time-consuming process. Moreover, older treatment
units cannot deal with a multitude of segments. Slower hardware and network
connections may also slow down the process in complex treatments.
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To avoid unnecessary delays, Eclipse allows you to limit the number of Sliding
Window segments. Using fewer segments, however, can affect the quality of the
treatment, so modifying the number of sliding window segments always entails
trade-offs between the speed and quality of the treatment.

You can define the number of Sliding Window segments by:

■ Letting Eclipse choose the necessary number of segments up to the defined
maximum level (Normal mode). The number of Sliding Window segments is
determined dynamically per subfield, based on the intensity levels and the field
complexity (MU factor: Calculation of MUFactor on page 241). To ensure the
quality of all treatments, Eclipse uses an internal constant minimum number of
segments (64).

■ Defining a constant number of segments (Fixed mode).

Note: When doing changes in the Sliding Window parameters, note the following:
■ The Sliding Window parameters are clinic-wide, and making changes in them affects all

treatment units using the same MLC model.
■ Using the Normal mode with the default settings is recommended for best results.
■ Modifications in the segment parameters only affect the fluences that have not yet been

calculated.
■ You can also modify the Sliding Window options in External Beam Planning, when you

start the leaf motion calculation (more information: Eclipse Photon and Electron Reference
Guide).

Sliding Window in Normal Mode

The following value ranges and default values are used in the Normal mode:

■ Number of intensity levels: from 30 up to the maximum number of control points;
default = 70.

■ Maximum number of control points (per subfield): range: 64-320; default = 166.
■ The defined Maximum number of control points value is first multiplied by the

number of subfields and then divided optimally between carriage groups based
on subfield complexity (defined by the MU factor, more information: Calculation
of MUFactor on page 241). The resulting number of segments per subfield is
always relative to the MU factor per subfield.

■ If the Maximum number of control points set for the MLC is smaller than the
Maximum number of control points set for the LMC, the MLC setting overrides
the LMC setting. The MLC setting is defined in RT Administration (Radiation &
Imaging Devices > MLC > MLC Configuration Properties > MLC tab).

■ Large IMRT fields: If the total number of control points (of all the subfields)
exceeds the maximum level of the MLC, it depends on the treatment machine
how the control points are handled.
If the treatment machine supports large IMRT fields, the maximum number of
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control points is evenly distributed between carriage groups, which means that
the actual number of control points per subfield may become smaller than the
defined value in the Maximum number of control points field. After the DMLC
leaf motion patterns have been calculated, you can check the actual number of
used control points in the Field Properties dialog box (Calculation tab).
If the treatment machine does not support large IMRT fields, the total number of
control points of all the subfields can be over the maximum, because the fields are
always split.

Sliding Window in Fixed Mode

The following value range and default value are used in the Fixed mode:
■ Number of control points (per subfield): range: 64-320; default = 166
■ The defined Number of control points value is first multiplied by the number of
subfields and then evenly divided between carriage groups.

■ If the Maximum number of control points set for the MLC is smaller than the
number of control points for the LMC, the MLC setting overrides the LMC setting.
The MLC setting is defined in RT Administration (Radiation & Imaging Devices
> MLC > MLC Configuration Properties > MLC tab).

■ Large IMRT fields: If the total number of control points (of all the subfields)
exceeds the maximum level of the MLC, it depends on the treatment machine
how the control points are handled.

If the treatment machine supports large IMRT fields, the maximum number of
control points is evenly distributed between carriage groups, which means that
the actual number of control points per subfield may become smaller than the
defined value in the Number of control points field. After the DMLC leaf motion
patterns have been calculated, you can check the actual number of used control
points in the Field Properties dialog box (Calculation tab).

If the treatment machine does not support large IMRT fields, the total number of
control points of all the subfields can be over the maximum, because the fields are
always split.

Configure the Sliding Window Mode

1. In External Beam Planning, choose Tools  > Task Configuration.
2. Select the Default LMC tab.
3. To select the LMC algorithm version you want to configure, click the cell in the

Algorithm Name And Version column and select the algorithm version from the
drop-down list that opens.

4. Click Edit.
5. In the left pane, select LMCV calculation options.
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6. In the Default delivery method drop-down list, choose Sliding Window (SW).
7. Select Sliding window options in the left pane, and select the desired mode from

the Mode drop-down list.
■ To allow Eclipse to define the number of Sliding Window segments

dynamically:
■ In the Mode drop-down list, choose Normal.
■ Select Normal mode options in the left pane, and define the desired

number of intensity levels and maximum number of control points in the
text boxes.

■ To use a constant number of Sliding Window segments:
■ In the Mode drop-down list, choose Fixed.
■ Select Fixed mode options in the left pane, and define the number of

segments.
8. Click OK.

The Sliding Window parameters are clinic-wide, and making changes in them
affects all treatment units using the same MLC model.

Configuration of Multiple Static Segments Mode
The Multiple Static Segments technique always needs to have the desired number of
intensity levels (Varian Leaf Motion Calculator) or static segments (MSS Leaf Motion
Calculator, Smart LMC) defined. The detailed significance of this parameter depends
on the selected LMC algorithm:
■ When Varian Leaf Motion Calculator is used (Varian MLC or BrainLab), the final

number of segments of each field is multiplication of the optimal fluence
complexity (MU Factor), the requested number of intensity levels, and the
number of carriage groups in the field.

■ When MSS Leaf Motion Calculator is used (Siemens, Elekta), the total number of
segments is redistributed between the fields based on their complexity: a more
complex field gets a larger suggested value. These suggested values can be
changed in the MSS Leaf Motion Calculator (LMSMSS) Delivery Options dialog
box to further control the LMC calculation (more information: Eclipse Photon and
Electron Reference Guide).

■ When Smart LMC is used, the final number of segments of each field is the
multiplication of the requested number of segments, and the number of carriage
groups in the field.

In all cases, the final number of static segment can vary a little from the requested
one.
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Configure the Multiple Static Segments Mode

1. In External Beam Planning, choose Tools  > Task Configuration.
2. Select the Default LMC tab.
3. To select the LMC algorithm version you want to configure, click the cell in the

Algorithm Name And Version column and choose the algorithm version from
the drop-down list that opens.

4. Click Edit.
5. Do one of the following:

■ For Varian Leaf Motion Calculator:
■ In the Default delivery method drop-down list, choose Multiple Static

Segments (MSS).
■ Specify the default number of intensity levels in the text box.

■ For MSS Leaf Motion Calculator, specify the default number of static
segments in the text box.

6. Click OK.

The Multiple Static Segments parameters are clinic-wide, and making changes in
them affects all treatment units using the same MLC model.

Configuration of Sliding Window Mode and Multiple Static Segments
Mode for Smart LMC

The Sliding Window mode for Smart LMC is similar to the fixed mode in LMCV
(Configuration of Sliding Window Mode on page 248). That is, you define a constant
number of Sliding Window segments.

The following value ranges and default values are used in the Sliding Window mode
for Smart LMC:
■ Number of control points: range: 64-500; default = 166.
■ The defined Number of control points value is divided between carriage groups.

When multiple carriage groups are used, the total number of control points might
differ slightly from the defined number. This happens, for example, if the defined
number cannot be divided evenly between the subfields or if additional control
points are needed because of carriage position changes.
If the Maximum Number of Control Points defined for the treatment machine in
RT Administration (in Radiation & Imaging Devices  > MLC  > MLC
Configuration Properties  > MLC tab) is smaller than the number of control
points set for the LMC, the value from RT Administration overrides the LMC
setting.

■ Default jaw tracking: On / Off. If jaw tracking is set to Off, jaws are not moving
while beam is on.
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The Multiple Static Segments mode for Smart LMC is handled in the same way as
sliding window, except that the number of static control points means the control
points required to produce the desired number of static segments.

Configure the Sliding Window Mode for Smart LMC

1. Choose Tools  > Task Configuration.
2. Select the Default LMC tab.
3. To select the LMC algorithm version you want to configure, click the cell in the

Algorithm Name And Version column and choose the algorithm version from
the drop-down list that opens.

4. Click Edit.
5. In the left pane, select Smart LMC options.
6. In the Default delivery method drop-down list, choose Sliding Window (SW).
7. Select Sliding window options in the left pane, and do the following:

■ Define the number of segments in the text box.
■ Select whether to use jaw tracking in the Default jaw tracking drop-down list.

8. Click OK.

The Sliding Window parameters for Smart LMC are clinic-wide, and making
changes in them affects all treatment units using the same MLC model.

Configure the Multiple Static Segments Mode for Smart LMC

1. Choose Tools  > Task Configuration.
2. Select the Default LMC tab.
3. To select the LMC algorithm version you want to configure, click the cell in the

Algorithm Name And Version column and choose the algorithm version from
the drop-down list that opens.

4. Click Edit.
5. In the left pane, select Smart LMC calculation options.
6. In the Default delivery method drop-down list, choose Multiple Static Segments

(MSS).
7. Select MSS options in the left pane, and do the following:

■ Define the number of control points in the Number of static segments text
box.

■ Select whether to use jaw tracking in the Default jaw tracking drop-down list.
8. Click OK.

The Multiple Static Segments parameters for Smart LMC are clinic-wide, and
making changes in them affects all treatment units using the same MLC model.
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Configuration of the MLC Parameters
To have the dose calculation, PO and PRO algorithms, and LMC work correctly, the
MLC parameters must be correctly defined in RT Administration, with particular
attention paid to the following:
■ Minimum dose dynamic leaf gap: Defines the minimum gap to be maintained at

all times between moving DMLC leaves during the treatment. The recommended
values are 0.05–0.10 cm.

■ Maximum number of control points: If the Maximum number of control points
defined for the treatment machine in RT Administration (in Radiation & Imaging
Devices  > MLC  > MLC Configuration Properties > MLC tab) is smaller than the
number of control points set for the LMC, the value from RT Administration
overrides the LMC setting.

■ Dose dynamic leaf tolerance: Defines the allowed inaccuracy in the DMLC leaf
motions. The default of 0.2 allows for some slack in the moving leaves.

■ Dosimetric leaf gap: Accounts for dose transmission through the rounded MLC
leaves. The exact value of the parameter depends on the MLC device and the
energy spectrum of the accelerator (Dosimetric Leaf Gap in Fluence Delivery
Modeling Algorithms on page 231). The dosimetric leaf gap needs to be measured
for each MLC and rechecked as part of treatment machine QA, especially when
MLC calibration is performed.

The dosimetric leaf gap includes the contribution from the penumbra region. The
shape of the penumbra is affected by the Spot size parameter (Tuning of the
effective spot size parameters on page 47).

■ MLC transmission factor: To define the MLC transmission factor, define the
material used for each MLC, match the MLC of the beam data with the MLC of
the treatment unit for each MLC configured in RT Administration, and define the
transmission factor for the MLC.

Configure Dosimetric Leaf Gap
1. In RT Administration, create the add-on material for the MLC to be used for

DMLC treatments.
2. Assign beam energies for the MLC material.
3. Define the material for the MLC device and the dosimetric leaf gap to the

dosimetric data of the MLC material.

More information: RT Administration Reference Guide.

254 Eclipse Photon and Electron Algorithms Reference Guide



Measuring the Leaf Transmission Factor
In order to get the dose of an IMRT field to match the measurements, the MLC leaf
transmission factor (LTF) and Dosimetric Leaf Gap (DLG) should be calibrated. The
leaf transmission factor can be estimated as the ratio of the measured dose in an open
field and the measured dose when using the same field size with all MLC leaves
closed behind the jaws. The leaf transmission factor is an effective parameter that
describes the average transmission and it does not take into account local variations
in leaf width or in the energy spectrum of the beam.

Since the effective leaf transmission depends slightly on the field size and
measurement depth, the measurement geometry should be similar to clinically
relevant geometries. In Y direction the field should be wide enough so that the
different types of leaves in the MLC are exposed. For example, for Millennium 120
MLC this means full and half leaves. For Varian HD-120 MLC the recommended field
size is 10 cm × 15 cm (X, Y), and for Millennium 120 MLC the recommended field size
is 10 cm × 25 cm (X, Y). In all cases symmetric jaw positions should be used.
Measurements should be done in a homogeneous phantom at 10-15 cm depth at
isocenter plane (SSD 85-90 cm; the measurement depth must be deeper than dmax). A
separate measurement should be done for both leaf banks.

The figure shows the measurement setup for leaf bank A of HD-120 MLC using the
recommended field size of 10 cm × 15 cm. Except the first leaf pair, all leaves are
closed at 9 cm off the central axis behind the X1 jaw (position: -9 cm). The first leaf
pair is positioned at 6 cm off the central axis to the opposite direction, just behind the
X2 jaw (position: +6 cm). Note that the positions are chosen so that the maximum leaf
span is just reached. The purpose of the first leaf pair position is to force the carriage
box of bank A behind the X2 jaw. It should also be verified that the first leaf pair is
completely behind the Y1 jaw.
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1. Leaf Bank A

2. Leaf Bank B

3. Leaves closed behind X1 jaw at 9 cm from the central axis.

4. First leaf pair forces the carriage box of Bank A completely behind the X2 jaw.

Figure 42 Leaf Positions in Static Field for Measuring Leaf Transmission for Varian HD-120 MLC

The exact measurement procedure depends on the measuring devices used. The leaf
transmission measurement can be performed using a large variety of measurement
devices, such as ion chamber, film or portal imager. It is very important that the
measurements are done in several positions and the average of the values are used.
This ensures that leaf transmission factor contains effects from inter leaf leakage and
takes into account small variations in leaf thickness. The measurement should be
repeated for the leaf bank B by using a mirrored image of the leaf positions described
above.

Measure the Leaf Transmission Factor

1. Measure the transmission for leaf bank A using the leaf positions described in 
Figure 42 on page 256.

2. Measure the transmission for leaf bank B using a mirrored image of the leaf
positions described above.

3. Do the measurements for an open field.
4. For each of the measurements above, calculate an average over a spatially

representative area. The averaging needs to be done in the same way for all three
measurements.

5. Calculate the total average of bank A + bank B transmission.
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6. Compare total average of bank A + bank B with the average of the open field.

Measure Dosimetric Leaf Gap
You can measure the dosimetric leaf gap (DLG) with a series of DMLC setups using
the procedure described by LoSasso et al.48 and Arnfield et al49.

1. Measure leaf transmission factor (Measure the Leaf Transmission Factor on
page 256).

2. Measure the dose of sweeping gap DMLC motion with various gap widths (for
example, 0.5, 0.7, 1.0, 2.0, 5.0 mm).

3. Subtract the contribution from leaf transmission from the sweeping gap
measurements.

4. Plot the corrected sweeping gap measurements against nominal gap width and
fit a regression line to the measurement points.

5. Obtain the dosimetric leaf gap by extrapolating the regression line to zero
measurement and reading the corresponding gap width. The extrapolated gap
width should be negative and DLG is the absolute value of it (see Figure 7 in
LoSasso et al.).

Note: When producing the DMLC motion files for various gap widths, make sure to split the
leaf motion to several control points so that leaves do not move more than 1 cm between any
two consecutive control points. This is necessary because the leaf position correction (to take
into account how the rounded leaf tip cuts the beam) is applied only in the control point
locations.

48 T. LoSasso, C.-S. Chui, and C. C. Ling: Physical and dosimetric aspects of a multileaf
collimation system used in the dynamic mode for implementing intensity
modulated radiotherapy. Medical Physics 25, 1919-1927 (1998).

49 M. R: Arnfield, J. V. Siebers, J. O. Kim, Q. Wu, P. J. Keal, and R. Mohan: A method for
determining multileaf collimator transmission and scatter for dynamic intensity
modulated radiotherapy. Medical Physics 27, 2231-2241 (2000).
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Chapter 12    Portal Dose Calculation (PDC)

Portal Dose Calculation (PDC)
Portal Dose Calculation (PDC) is used to calculate portal dose images for fields
containing fluences as part of pre-treatment verification for IMRT planning. The pre-
treatment verification is performed by using a portal imager in order to compare the
accuracy of the planned fluence produced by the treatment planning system with the
fluence delivered by the DMLC motions. This comparison is done in the absolute
mode of Portal Dosimetry. Since the fluence cannot be measured directly, and since
the detector response is sensitive to photon energy, PDC enables comparing the
planned fluence to the delivered fluence measurement.

PDC can also be used for VMAT and conformal arc fields. For these fields Eclipse
calculates the planned fluence by summing up the individual aperture fluences from
the control points of the field. The dynamic dose rate is taken into account in the
summing, and the fluence accumulated between control points is also accounted for.
The PDC algorithm calculates the predicted image based on this sum fluence in the
same way as for IMRT fields. The configuration of the PDC algorithm must be done
with IMRT fields, but once done, it is valid also for arc fields.

Note: When actual fluence is mentioned in this chapter, it also refers to the summed-up
fluences of the individual aperture fluences for arc fields.

Workflow for Dosimetry for IMRT and VMAT Plans Using PDC
Portal Dosimetry is used to acquire images of the fluence, while Eclipse is used to
compute a corresponding dose picture. Both images can be viewed and
quantitatively compared in Portal Dosimetry.

The figure describes the process of using calculated and measured portal images for
the verification of IMRT and VMAT plans.
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1. Treatment plan containing an actual fluence and calculated DMLC leaf motions

2. Create verification plan

3. Verification plan containing the calculated portal image (circled)

4. Generate calculated portal image

5. Transfer treatment plan to Clinac

6. Measured portal image acquired of the delivered

7. Acquire portal image

8. Compare calculated and measured portal dose images

9. Calculated and measured portal images

Figure 43 Verification of Plans Using Calculated and Measured Portal Images

The table describes the process of using calculated and measured portal images for
the verification of IMRT and VMAT plans.

Table 44 Dosimetry Workflow Using PDC

Step Application/Module

Create an IMRT or a VMAT plan  

Create the plan and optimize the dose. External Beam Planning

Create a verification plan of the optimized
IMRT or VMAT plan

External Beam Planning

Create more fractions for the plan. External Beam Planning

Planning approve the verification plan. External Beam Planning
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Step Application/Module

Prepare the plan for treatment  

Verify the plan and calculated portal image. Plan Parameters

Update reference point limits, if needed. Reference Points

Schedule the plan and set the method for ac-
quiring the image for each field in the plan
(integrated image).

Scheduling

Treatment Approve the plan. Treatment Preparation

Deliver the dose at the treatment unit  

Create an appointment for the Clinac.  

Deliver the verification dose at the Clinac. Clinac

Evaluate the dosimetry in Portal Dosimetry  

Review the calculated and delivered images
next to each other.

Portal Dosimetry

Align the images to correct for small inaccur-
acies in the imager position calibration.

Portal Dosimetry

Compare the images using different analysis
tools.

Portal Dosimetry

PDC Algorithm
PDC is determined at the detector plate of the portal imager ignoring the couch or
the patient. PDC produces an image in terms of calibrated unit (CU). PDC always
takes the measurement source-to-detector distance (SDD) into account. The image
resolution is then projected to the source-to-axis distance (SAD), and correct
collimator rotation is applied.

Although PDC and portal dose measurements can be performed at any SDD, the
optimum accuracy is achieved when working at a single SDD, namely at the distance
used for the detector calibration. It is recommended to perform calibration,
configuration, and PortalVision acquisition at a fixed distance, as close to the
isocenter as possible (SDD = 100 cm for Exact Arm, SDD = 105 cm for the R-arm in the
Clinical mode). The IAS2 can exhibit significant saturation effects for the higher dose
rate modes at the closest SDD. The precise onset of saturation depends on the local
machine calibration (MU/Gy in reference conditions), but as a general guideline it is
not recommended to exceed a dose rate of 400 MU/min at SDD =  100 cm.
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PDC calculates the portal dose image by convolving the fluence with Gaussian
kernels as:

Equation 65

 

P = f ′ × k ⋅ SAD
SDD

2 OF fsx, fsy

PSF fsx, fsy

 

where   

P = Calculated portal dose image in terms of CU

f’ = Input fluence corrected by the intensity profile and scaled by detector
distance

x = Convolution operator

k = Portal imager dose kernel

SDD = Source-to-detector distance of the portal image measurement

SAD = Source-to-axis distance of the treatment unit

fsx = Field size at the SAD in the FX-direction

fsy = Field size at the SAD in the FY-direction

PSF(fsx,fsy) = Phantom scatter factor for field size fsx, fsy, defined at SAD

OF(fsx,fsy) = Output factor for field size fsx, fsy, defined at SAD and normal-
ized to a 10 × 10 cm field

Parameters for PDC
PDC uses input data from the PDC configuration performed in Beam Configuration,
and from the verification plan created in External Beam Planning. The following
input data is taken from the PDC configuration:
■ Output factors for the selected energy/mode (measured on the central axis for

each field size)
■ Kernels for the selected energy/mode
■ Intensity profile describing the fluence off-axis dependence
■ SAD (configured treatment machine’s SAD, which is copied to Beam
Configuration)

The following input data is taken from the verification plan:
■ Actual fluence and the corresponding MU factor
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■ Source-to-detector distance (SDD) of the portal image during measurement (best
results are achieved at a distance close to the isocenter)

■ Collimator rotation (may differ from the actual collimator rotation)

Correction with Intensity Profile and MU Factor
The open field fluence output of a radiation device is typically not uniform across the
field. PDC compensates for the non-uniformity of the open beam fluence by
modifying each pixel as:

Equation 66

 

f′ x, y = f x, y v rx, y

MUfactorOFmax

 

where   

f’ = Corrected actual fluence

f = Actual fluence from the planning system (dose picture)

x,y = Coordinates of a point in the beam

v(r) = Radially symmetrical intensity value

rx,y = Radial distance from the beam axis

MUfactor = MU factor from the dose calculation, used to scale the fluence

OFmax = Maximum value of the optimal fluence, used to scale the fluence

Phantom Scatter Factor
The phantom scatter factor is calculated by constructing a flat intensity image for a
rectangular field where the intensity is defined as 1.0 within the field and equal to 0.0
outside the field. Then the fluence is convolved with the kernel. The value of the
center pixel is used as the PSF value. This calculation is done at the SAD.
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Calculation of Configured Beam Data for PDC
The configured beam data (the kernel) is calculated for the PDC model by
performing deconvolution with the Tikhonov regularization. A special test fluence is
used to ensure the accuracy of the kernels (Overview of the Test Fluence on
page 270). The kernel derived from measurement is radially symmetrical, and it
consists of a sum of Gaussians of different amplitudes ai and sizes σi:

Equation 67

 

k r = ∑
i

ai
1

2πσi
e

−r2/2σi
2

 

where r = distance from origin

The number of kernel components (Gaussian components) is set to 10 in the
configuration.

The following mandatory input data is used in Beam Configuration for calculating
the kernels for PDC:
■ Output factors for the chosen energy/mode (measured dose on central axis for

each field size). Measure the output factors for a sparse grid of points, and Beam
Configuration interpolates the remaining values.

■ Intensity profile describing the off-axis behavior of the fluence. The format of the
intensity profile is a one-dimensional circularly symmetric curve. The value at
center should be 1.0; the scaling at the isocenter.

■ Actual fluence and the corresponding MU factor for the test plan
■ Portal images of the test plan
■ MU amount used to produce the image
■ Collimator rotation
■ SAD
■ Monitor unit (MU) value corresponding to 100 calibrated units (CU) at

SDD = SAD; usually 100 MU

The PDC algorithm requires the measurement of the acquired portal dose image at a
user-specified distance. To compute a correction factor for the SDD, it is
recommended to acquire a second portal dose image at a different SDD. The first
image should be acquired preferably at the default SDD for portal dose acquisition
(mostly SDD = 100 cm). The second image acquired at a different SDD is not
mandatory but allows for better kernel configuration when measurements are going
to be performed at multiple SDDs.
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Accuracy of PDC
As a general guideline, after careful alignment, a gamma evaluation of PDC and
measurement should be within the acceptance criteria for >95% of the portal image
when using 4%, 4 mm gamma analysis criteria.

In cases where the field size defined by jaws is much larger than the aperture defined
by an MLC, the difference between the predicted and measured values can exceed
4%. This can be compensated by rescaling the Output Factors table in PDC beam
data.

System Configuration Required for IMRT, VMAT and SRS
Dosimetry

To be able to use IMRT, VMAT or SRS dosimetry, and have the PDC algorithm
function correctly, you need to configure the system correctly. Either follow the
system-specific configuration procedure, or use a preconfigured set of calibration
files (Portal Dosimetry pre-configuration (PDPC) package).

The Portal Dosimetry pre-configuration package consists of:
■ Pre-configured beam data for the “Portal Dose Image Prediction” calculation

model.
■ A two dimensional beam profile correction file to be imported during “Dosimetry

Calibration” on the 4DITC workstation.
■ A set of verification plans ensuring the proper installation of the package.

The PDPC package supports various machine types, beam energies and source-
imager distances. Beside a simplified calibration procedure, it provides an optimal
beam profile correction along with a backscatter correction for MV imagers mounted
on Exact Arms. The Portal Dosimetry pre-configuration package is available on
my.varian.com.
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Note: When configuring fluence delivery algorithms, note the following:
■ It is important to configure the system so that it corresponds to the characteristics of the

treatment machine.
■ Periodically perform follow-up measurements and compare with the dosimetric beam data

used for configuring the beam. If fluctuations are large and the configured beam data no
longer represents the average beam delivered by the machine, reconfigure the beam data
using the newer dosimetric beam data.

■ Measure all dosimetric beam data in as stable conditions as possible.
■ Use the same file naming conventions in beam data measurements (input files) and in

Beam Configuration (Therapy Unit name), and name the input files so that it is easy to
match the beam data to the treatment unit during the configuration process.

Workflow for Configuring the System for PDC
Step Application/Module See

Calibrate the aS detector   

Calibrate the aS detector in
the absolute mode.

PortalVision, AM Mainte-
nance

Calibrating the Detector for
Dosimetric Acquisition on
page 266

Create and measure a test
plan

  

To ensure correct visualiza-
tion of the collimator rotation,
create an artificial image for
each treatment field.

Plan Parameters Creating a Test Plan for De-
riving the Kernels on
page 270

Create the calibration test
plan using the test fluence for
deriving the kernels.

External Beam Planning, Plan
Parameters

Create the Calibration Test
Plan in Eclipse on page 272

Measure the calibration test
plan.

4DITC or PortalVision Treat-
ment Acquisition

Measure the Calibration Test
Plan on page 273

Measure the output factors   

Create a dummy patient for
storing the output factor
measurements.

Plan Parameters Create a Test Patient for
Storing the Output Factor
Measurements on page 275

Measure the output factors. 4DITC or PortalVision Treat-
ment Acquisition

Measure the Output Factors
on page 277

Configure the PDC algo‐
rithm

  

Configure the algorithm pa-
rameters for PDC.

Beam Configuration Configuring the PDC Algo-
rithm on page 278
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Step Application/Module See

Verify the PDC configuration   

Verify the configuration of
PDC by creating a verification
plan and an artificial image
for the fields.

External Beam Planning, Plan
Parameters

Verify the Configuration of
PDC on page 281

Compare the predicted and
measured doses.

Portal Dosimetry Compare the Predicted and
Measured Doses on page 281

Calibrating the Detector for Dosimetric Acquisition
The calibration of the aS detector enables PortalVision to create a dosimetric image
from the grayscale image acquired by the aS detector. Doing the calibration in
absolute mode means that the dosimetric image created in PortalVision will be in CU,
which is the unit used in the calculated portal dose images produced by PDC.

To be able to account for the changes in the behavior of the aS detector over time, the
calibration is done in reference to a 10 × 10 cm2 field by fixing the amount of pixel
counts in this reference field to correspond to, for instance, 1 CU. This calibration
value must match the PDC Dose Rate Table calibration.

To complete the calibration of the aS detector for PDC, you must first calibrate the
detector for dosimetric acquisition in the IMRT scanning mode, and then calibrate the
detector for the absolute mode.

Note: In the calibration of the aS detector, note the following:
■ It is recommended to calibrate, configure and acquire the calibration image at a fixed

distance, as close to the isocenter as possible (for example, SDD = 100 cm for ExactArm,
SDD = 105 cm for the R-arm in the Clinical mode).

■ In the Portal Dosimetry Calibration mode, the IAS2 takes longer to get ready for data
acquisition than in the Normal (Dosimetric) Acquisition mode. Wait for 10 to 15 seconds
after pressing Start before starting the beam-on in calibration.

Calibration of the aS detector for PDC is performed using the:
■ AM Maintenance application if the imager is connected to the 4DITC, or the
■ PortalVision application running in a PortalVision workstation in the case of a stand-

alone installation.

More details on using these applications: User documentation for each application or
the online help system50.

50 More details on the aS detector characteristics and the PDC algorithm: Van Esch A,
Depuydt T, Huyskens DP: The use of an aSi-based EPID for routine absolute
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Calibrate the Detector in the IMRT Scanning Mode

Before the dosimetric calibration, perform initial dark field (no radiation) and flood
field (full signal) calibration. Calibration datasets for IMRT read out mode are stored
independently of datasets for normal imaging modes. The calibration needs to be
performed using Service Monitor.

1. In the treatment room, align the arm of the PV imager with the beam central axis,
for example, SDD = 105 cm (Vrt = -5.0, Lng = 0, Lat = 0). The arm will retain this
position throughout the entire calibration procedure.

2. Close the Treatment application.
3. Open the MLC Workstation application and put the MLC to the Park mode.
4. Open the AM Maintenance application.

■ If you use PortalVision in the Standalone mode, open the PortalVision
application and select the Maintenance workspace.

5. Choose Maintenance  > Service monitor.
6. Select the Treatment Acquisition Modes tab and choose energy and dose rate.
7. To perform the dark field (no radiation values) and flood field (maximum values)

calibration, let the system acquire at least 50 frames and then stop the acquisition.
8. Click Save Calibration Set/Update Calibration Set to store data into IAS2/IAS3

unit.
9. Repeat the calibration for all other acquisition modes used for portal dosimetry.

The maximum field size for the flood field calibration at SDD = 105 cm is
X = 38 cm, Y = 28.5 cm (0° collimator rotation).

10. To finish the calibration, click Close.

Calibrating the Detector in the Absolute Mode

Before starting the aS detector calibration, prepare a w2CAD file for the calibration so
that it contains the measured diagonal profile for a large field size at the dmax
(measured in water) and no other curves. If you have configured the AAA, Acuros
XB or PBC algorithm in Eclipse and used equidistant measurements for the open
field diagonal profile, no new measurement is required. You can use the open field
diagonal profile for the calibration of the detector. However, you may need to edit the
w2CAD file in a text editor and remove all other curves except the diagonal profile. If
the previous measurements for the diagonal profile have not been equidistant, you
need to re-measure the profile using equidistant measurement points.

dosimetric pre-treatment verification of dynamic IMRT fields. Radiotherapy and
Oncology, 2004 May; 71(2): 223–34.
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Note: Note the following when preparing the w2CAD file for the detector calibration:
■ The file must not contain any other curves.
■ The curve has to start at the (0;0;depth) location (at the central axis) and ascend to a

positive value.
■ The position data points along the curve may change only at one axis.
■ The measurement points along the diagonal profile must be equidistant.

Calibrate the Detector for the Absolute Mode

1. Choose Maintenance  > Dosimetry Calibration.
2. Select each energy and dose rate to be calibrated for dosimetric use and click OK.
3. Select Dose normalization and Beam Profile Correction, and define, for

example, IDU Vrt = -0cm (for SDD = 100 cm).
4. Navigate to the folder where you have the w2CAD files (either those used for the

AAA, Acuros XB or PBC algorithm configuration or those created for this
calibration) and select the diagonal profile file for each energy.

5. Perform the absolute calibration:

a. Start Clinac in the Service Mode.
b. Set up the parameters for the calibration field (field size = 10 × 10 cm, 100 MU,

selected dose rate).
6. IMPORTANT: In case of the IAS2, click Start and wait for at least 15 seconds after

the message “Acquisition ready” is displayed. Then switch the beam on and
irradiate the calibration field. In case of the IAS3, no additional waiting time is
required.

7. Define the measured dose as follows:

In principle, the calibration value can be chosen by the user as long as the imager
calibration value corresponds to the calibration defined in the PDC configuration.
However, to avoid discrepancies, it is recommended to set the calibration of the
detector to a value of 1 CU for 100 MU delivered with a 10 × 10 cm2 field at
SDD = 100 cm. When performing the actual calibration procedure at a different
SDD, for example, SDD = 105 cm, you have to apply the inverse square law

correction to correct for this small difference in distance: 100
105

2 = 0.907 CU

The small Dose Measurement window is sometimes hidden behind the larger
Dose Normalization window. If the Dose Measurement window does not appear
after Beam Off, and the application seems to “freeze”, move the Dose
Normalization window to see the Dose Measurement window.

8. Click OK.
9. Repeat the above for each beam energy and dose rate.

10. Save all data.
11. Exit the AM Maintenance application.
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Note: To undo the dosimetry calibration, you can delete the existing calibration files from the hard
disk of the Treatment Console workstation or the PortalVision workstation. The calibration files
are located in the following folders, depending on the installation:
■ 4D Integrated Treatment Console: ...\Oncology\Treatment\AM\config\AM\do.
■ Standalone PortalVision installation: ...\RV71\Vision\config\pv\do.

Calibrate the Detector in the SRS Mode

Before the dosimetric calibration, perform initial dark field (no radiation) and flood
field (full signal) calibration.

1. In Service Mode on the Clinac, set the mode to SRS Fixed to set the energy to 6X
and the dose rate to 1000MU/Min.

2. Open the MLC Workstation application and put the MLC to the Park mode.
3. Open the AM Maintenance application.

■ If you use PortalVision in the Stand-alone mode, open the PortalVision
application and select the Maintenance workspace.

4. Choose Maintenance > Service monitor.
5. To perform the dark field (no radiation values) calibration, let the system acquire

at least 60 frames and then stop the acquisition. After each dark field acquisition,
click Save Calibration Set/Update Calibration Set to store data into IAS2/IAS3
unit.

6. Set the imager SDD to 140 cm.
7. Set the field size to X = 28.5 cm and Y = 21.5 cm. You need to override the Coll

interlock to allow treatment with this field size.
8. To perform the flood field (maximum values) calibration, let the system acquire

at least 30 frames and then stop the acquisition. After each flood field acquisition,
click Save Calibration Set/Update Calibration Set to store data into IAS2/IAS3
unit.

9. To finish the calibration, click Close.
10. Choose Maintenance  > Dosimetry Calibration.
11. Select the acquisition mode for 6X, 1000 MU/Min, SRS-Integrated and click OK.
12. Select Dose normalization and Beam Profile Correction, and define IDU

Vrt = -40cm (for SDD = 140 cm).
13. Navigate to the folder where you have the w2CAD files (either those used for the

AAA, Acuros XB or PBC algorithm configuration or those created for this
calibration) and select the diagonal profile file for each energy.

14. Perform the absolute calibration:

a. Start Clinac in the Service Mode.
b. Set up the parameters for the calibration field (field size = 10 × 10 cm, 100 MU,

selected dose rate).
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15. IMPORTANT: In case of the IAS2, click Start and wait for at least 15 seconds after
the message “Acquisition ready” is displayed. Then switch the beam on and
irradiate the calibration field. In case of the IAS3, no additional waiting time is
required.

16. In the Dose Measurement dialog box, keep the SDD at 140 cm and set the
measured dose value to 51.0. This is the measured dose value when the inverse

square of 100
140

2
 is applied.

The small Dose Measurement window is sometimes hidden behind the larger
Dose Normalization window. If the Dose Measurement window does not appear
after Beam Off, and the application seems to “freeze”, move the Dose
Normalization window to see the Dose Measurement window.

17. Click OK.
18. Save all data.
19. Exit the AM Maintenance application.

Continue by creating the calibration test plan (Create the Calibration Test Plan in
Eclipse on page 272) and measuring the test plan (Measure the Calibration Test Plan
on page 273).

Creating a Test Plan for Deriving the Kernels
The kernels are derived from the actual fluence contained in a test plan, which
ensures optimum quality of the kernel creation.

Creating a test plan with the test fluence requires using Eclipse External Beam
Planning, Plan Parameters, ARIA RTM Treatment Acquisition and Portal Dosimetry.
Details on how to use these applications: the user documentation for each application
or the online help system.

Overview of the Test Fluence

The test fluence is an optimal fluence specially designed for the configuration and
verification of PDC. It is easy to verify the configuration and test images because of
the specific characteristics of the test fluence.

The installation of the PDC algorithm copies the test fluence to the calculation server
directory \\<Server name>\dcf$\client\PreconfiguredBeamData
\Portal Dose Image Prediction <version>\PDIP-
configuration.optimal_fluence. Import the test fluence into a PDC test plan
(Creating a Test Plan for Deriving the Kernels on page 270) for use in the
configuration of the algorithm. The format of the fluence is the same as in
dcm2ascii with additional field size parameters.
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The test fluence is pyramid-shaped and contains multiple rectangular slabs. The
fluence consists of a port of 120 × 250 mm (or 120 × 220 mm for the HDMLC) with
5 rectangular slabs of the intensity of 1.0 and fluence of 0.0 outside the slabs.

1

2

3

4

5

6

7

8

9

1. 10 x 30 mm
2. 30 x 30 mm
3. 60 x 30 mm
4. 90 x 30 mm
5. 120 x 30 mm
6. 10 mm space on top (Y2)
7. 20 mm separation
8. Fluence outside: 0
9. Fluence inside: 1

Figure 44 Test Fluence
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Create the Calibration Test Plan in Eclipse

Tip: If necessary, to show the Context Window, choose Window  > Context Window.

1. Go to External Beam Planning.
2. Open any test phantom patient. Make sure that you include a structure set.

The structure set only enables creating the test plan. It is not used for the dose
distribution calculation. Therefore, any available structure set (patient or
phantom) can be used for creating the test plan.

3. For each beam energy, create a new plan containing one field. For SRS, select 6X-
SRS energy for the field.

4. In the Field Properties dialog box, select the Geometry tab, and define the
following values:
■ Collimator Rotation: 90°
■ Field X: 12 cm
■ Y1: −13 cm
■ Y2: 12 cm (IEC 61217).

For the HDMLC, set Field X to 12 cm and Y to 22 cm.

For SRS, set Field X to 12 cm and Y to 15 cm.
5. To import the configuration optimal fluence, in the Focus window, right-click the
field and select Import Optimal Fluence.

6. In the Import Optimal Fluence dialog box, navigate to \\<ServerName>\DCF$
\client\PreconfiguredBeamData\Portal Dose Image Prediction
<version>\, and select the PDIP-configuration.optimal_fluence file
for the Standard and Millenium MLC (80 and 120) or the HDMLC-PDIP-
configuration.optimal_fluence file for the HDMLC, and then click Open.

7. For SRS: Open Fluence Editor and erase the fluence outside the Y jaw settings (3
middle bars will stay).

8. In the Info Window, select the Dose Prescription tab and define the following
dose prescription for the configuration plan: 2 fractions, 1.0 Gy/Fraction.

9. Calculate the dose distribution for the current plane. Make sure that the
calculation grid size is 2.5 mm.

10. In the Leaf Motion Calculator dialog box, select the appropriate LMC and click
OK.
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11. In the Varian Leaf Motion Calculator (LMCV) Delivery Options dialog box, set
the delivery method to Sliding window, select Fixed Jaw and click OK.

The dose distribution is calculated only to obtain the actual fluence. The spatial
dose distribution itself does not play a role. Therefore, it suffices to calculate the
dose to a single plane.

The Dosimetric Leaf Gap and MLC Leaf Transmission parameters significantly
affect the value calculated by the LMC. Make sure that these parameters have the
correct values.

12. To save the calibration test plan, choose File  > Save All.
13. Go to the Plan Parameters workspace by using the Quicklinks menu.

If necessary, to show the Context Window, choose Window > Context Window.
14. In the Viewing Pane, define the appropriate values for treatment time, tolerance

table, SSD, couch positions and imager positions.
15. To planning approve the verification plan, in the Context window, right-click the

plan and choose Plan Approval  > Planning Approved. 
The Plan Validation dialog box shows warnings and errors. You can ignore
warnings and click OK. If there are errors, the plan cannot be approved.

16. In the Authorization for Status Change dialog box, type in your user name and
password.

17. Go to the Plan Scheduling workspace.
18. Select the plan and click Schedule.
19. Display the field and select the scheduled fractions by painting them with the

mouse.
20. To add portal imaging to all fields in verification plan, click Add imaging and

choose the acquisition mode set option for portal dosimetry (for example,
Integrated Image).

21. Approve the plan for treatment.
22. Save your work.

Continue by measuring the calibration test plan by delivering the calculated
fluences at the 4DITC.

Measure the Calibration Test Plan

1. Schedule the calibration test patient for treatment in Time Planner.
2. Start the Treatment application and log in.
3. Align the PV imager with the beam CAX to the selected SDD (for instance, for

SDD = 105 cm, use: Vrt = -5.0, Lng = 0, Lat = 0).
4. On the 4DITC console, click Open Patient, and then in the Today’s Schedule

dialog box, select the calibration patient and click OK.
5. Select the calibration plan and click Mode Up.
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6. Mode up the treatment unit and deliver the test field.

If Advanced imaging (OBI) is installed on the delivery system, make sure that the
OBI application is opened.

7. Repeat steps 1–6 with the PV imager at the extended SDD (for example, for
SDD = 145 cm, use Vrt = -45.0, Lng = 0, Lat = 0).

Acquiring and using a second image at the extended SDD is optional.
8. Go to the Portal Dosimetry workspace and open the calibration test patient.
9. Select the verification plan. Make sure that you select the correct one.

10. In the Field tab, right-click the first acquired image and choose Export to Text
File.

11. Navigate to a save location that is accessible throughout the network, define the
file name and save the text file.

12. Optional: To export the second acquired image, repeat steps 9–11.

Measuring the Output Factors
Beam Configuration uses output factors for calculating the kernels for PDC. Other
input for the configuration: Calculation of Configured Beam Data for PDC on
page 263. The output factors are measured for the selected energy or mode, and they
consist of the measured dose on central axis tabulated for each (fsX, fsY) pair.

Note: Calibrate the detector before doing output factor measurements to have dosimetry
images available in CU.

Table 45 Recommended Field Sizes for Output Factor Measurements

 Width (FX)

Height
(FY)

 S1 5 10 15 20 28 38

S1 S × S S × 5 S × 10 S × 15 S × 20 S × 28 S × 38

5 5 × S 5 × 5 5 × 10 5 × 15 5 × 20 5 × 28 5 × 38

10 10 × S 10 × 5 10 × 10 10 × 15 10 × 20 10 × 28 10 × 38

15 15 × S 15 × 5 15 × 10 15 × 15 15 × 20 15 × 28 15 × 38

20 20 × S 20 × 5 20 × 10 20 × 15 20 × 20 20 × 28 20 × 38

28 28 × S 28 × 5 28 × 10 28 × 15 28 × 20 28 × 28 28 × 38

38 38 × S 38 × 5 38 × 10 38 × 15 38 × 20 38 × 28 38 × 382

1. S = smallest field size.2. For 40 x 40 imager only.
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Doing the output factor measurements requires using Plan Parameters, ARIA RTM
Treatment Acquisition and Portal Dosimetry. Details on using these applications: the
user documentation for each application or the online help system.

Create a Test Patient for Storing the Output Factor Measurements

1. Go to the Plan Parameters workspace.
2. Choose Tools  > Task Configurationand select the Advanced feature set check

box.
3. Restart the Plan Parameters workspace to activate the setting.
4. In the Patient Explorer, create a new test patient.

Name your test patient so that it is easily recognizable. For instance, use naming
such as: Last Name: “Output factors”, First Name: “PDC”, ID: “PDC001”.

5. Insert a new course and then insert a new plan.
6. Go to the General tab of the Plan Properties dialog box and select the patient

orientation from the Patient Position drop-down list.
7. Go to the Dose tab and set Number of Fractions to 5 and Prescribed Dose/

Fraction to 100 cGy.
8. Save your modifications.
9. Go to the Reference Points workspace.

10. Add a new Patient Volume for the test patient.
11. Add a new Reference Point and define the dose limit values for it.
12. Save your modifications.
13. Select the created reference point in the Reference Point column.
14. Go to the Plan Parameters workspace.
15. Insert one new treatment field.
16. To save your work, choose File  > Save All.

Tip: If necessary, to show the Context Window, choose Window  > Context Window.

17. In the Context Window, right-click the test plan and then choose Copy Plan.
18. To create a verification plan out of the test plan, in the Context Window, right-

click the course of the calibration test plan and choose Paste  > Plan as
Verification Plan.
Perform the remaining steps using the verification plan. After successfully
completing and saving the verification plan, you can delete the original treatment
plan.

19. Edit the Plan Properties, and change the Plan ID to “Y03” to indicate a plan
where all FY sizes are 3 cm. Click OK.

Chapter 12    Portal Dose Calculation (PDC) 275



20. In the Viewing Pane, do the following:
■ Change the Field ID.
■ Define the MU value (from 50 to 100 MU).
■ Define the Treatment Time.
■ Set the imager position.
■ Change the Field X (FX) and Field Y (FY) values.

This procedure assumes source to imager position of 0 (SID = 100 cm). For
SID > 100 cm, scale the field sizes accordingly to cover only the active part of the
DU. This may be necessary for R-Arm

21. To create one field for each FX size to be measured, copy and paste the initial
field as many times as is necessary to create the desired number of fields.
For example, use field sizes such as 3 × 3 cm2, 5 × 3 cm2, 10 × 3 cm2, 15 × 3 cm2,
20 × 3 cm2, 28 × 3 cm2, and 38 × 3 cm2.

22. To create a set of the fields with the same FY size (for example, 3 × 3 cm2 to 38 ×
3 cm2), edit the Field ID and Field X value of each field.

23. Copy and paste the verification plan to the same course.
24. Increment the ID of the new plan to indicate the next FY size (for example,

change the ID from “Y03” to “Y05”).
25. Increment the Field Y value for all the fields in the new plan.
26. Repeat steps 17–19 for other FY sizes to be created.
27. For the 40 × 30 imager only: In the plan for FY = 38, delete the 38 × 38 field and

change the collimator rotation of the remaining fields to 90°.
28. To save your work, choose File  > Save All.
29. Go to the Plan Scheduling workspace.
30. In the Viewing Pane, right-click the plan ID and choose Fill Plan for all the

verification plans.
31. Select the Show Sequence Image Scheduling check box.
32. Highlight all the active sessions for all the plans with the mouse, right-click and

choose Integrated Image.
33. To save your work, choose File  > Save All.
34. Go to the Reference Point workspace.

Tip: If necessary, to show the Context Window, choose Window  > Context Window.

35. To treatment approve all plans, in the Context Window, right-click each plan and
then choose Plan Approval  > Treatment Approved.

36. To save your work, choose File  > Save All.
37. Open Time Planner and create an appointment for the test patient.
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Measure the Output Factors

Note: Calibrate the imager first! Make sure that all acquisition technique parameters are set
correctly. Perform Dark and Flood Field calibration for the energy/dose rate combination to be
used. Perform the dosimetry calibration of the imager.

Note: When performing and recording the output factor measurements using a 40 × 30 imager,
notice that with a collimator rotation of 0°, you can only measure field sizes up to 38 cm in the FX
direction and 28 cm in the FY direction. To measure the output factors for field size of 38 cm in the
FY direction, the collimator rotation needs to be 90° and the field sizes in FX direction set to
values ≤ 28 cm. More information: Create a Test Patient for Storing the Output Factor
Measurements on page 275.

1. In Treatment Delivery, deliver all planned fields and acquire the Integrated
Images.

2. Open Portal Dosimetry.
3. Open the test patient created for storing the output factors.
4. From the Plan drop-down list, select the plan for the first field size (the field with

the smallest Y-size).
5. In the Field display, select the first acquired image to be evaluated (the field with

the smallest X-size).
6. Choose Tools  > Output Factor tool.
7. Define Averaged Area and then click Get Dose at Isocenter.
8. Select the acquired image for the field with the next larger X-size, and click Get

Dose at Isocenter.
9. Repeat step 8 for all the fields in the plan, proceeding in the order of increasing

the FX size, for example, from 3 × 3 cm2, 5 × 3 cm2, 10 × 3 cm2 and so on, to 38 ×
3 cm2.

10. Repeat steps 7–9 to measure output factors for all the plans, opening the plans in
order of increasing FY size.

11. Click Copy to Clipboard. The values are comma-delimited as required by the
MUTAB format used for the output factors.

12. Paste the copied result into a blank text document.
13. Save the text document.

Note: Clinical physicists responsible for the measurements must always use their own
judgment in deciding the level of acceptable accuracy of the measurements in relation to
the calculations, and find the compromises needed for each specific accelerator as far as
measurements are concerned.
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Configuring the PDC Algorithm
Configuring the PDC algorithm requires using Beam Configuration. More
information: Beam Configuration Reference Guide or RT and Imaging Online Help.

The purpose of the configuration of the PDC algorithm in Beam Configuration is to
have the kernels calculated for the PDC model. More information on how the
calculation is done: Calculation of Configured Beam Data for PDC on page 263.

Kernel Data in Beam Configuration

The calculation results are shown in Beam Configuration as a kernel curve and
numerical data about the kernel. The figure shows an example of a calculated kernel.

Figure 45 Example Kernel Curve [k(r)]

The shape of the kernel curve should be steeply descending, with all values close to 0
(zero), with no negative values, and free of oscillations.

If you compare the data (Equation 67 on page 263), the Kernel Shape curve shows the
k(r) part of the equation, whereas the two columns in the Kernel Shape table show
the σi (left column) and ai (right column) parts. The individual Gaussians have no
physical meaning, and small negative values of ai can occur. It is only the summed
kernel that reflects the response of the portal imager.

Configure the PDC Algorithm

1. Make sure that the PDC calculation model is activated (choose Beam Data >
Configure Calculation Models). The name of the calculation model is “Portal
Dose Image Prediction” (PDIP) in Beam Configuration.

2. In the Context window, select the PDC calculation model.
3. To insert new beam data
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a. In the Focus window, select the PDC model and choose Insert  > New Beam
Data.

b. Select Start with empty data and define the data set name.
4. Insert the open field add-on.

a. In the Focus window, select the PDC model and choose Insert  > New Add‐
on.

b. Select Open Field and click OK.
5. In the Focus window, select PDIP Parameters, and type value 100.0 to the

Calibration MU parameter.
6. To define the portal image parameters, go to the Focus window, select Portal

Image Parameters and type the following values to the parameters:

■ Number of Portal Images: Number of dosimetric images (2) acquired of the
calibration test plan.

■ Image 1 - Import Portal Image File From Path: File path and file name of the file
containing the first dosimetric image (as exported after acquisition). To
navigate to the file, choose Beam Data  > Parameter Values > Browse File
Path to Parameter Value.

■ Image 1 - Rotation: 90.0 degrees.
■ Image 1 - Mu: MU used for the dosimetric image acquisition.

7. Repeat step 6 for the second dosimetric image.
8. Save all changes.
9. Import the intensity profile from the configured Pencil Beam Convolution (PBC),

Anisotropic Analytical Algorithm (AAA) or Acuros External Beam (Acuros XB)
calculation model:

a. In the Focus window, select the open field add-on and choose Insert  > New
Intensity Profile.

b. In the Scope window, click the PBC, AAA or Acuros XB object.
c. In the Focus window, click the Intensity Profile under Open Field.
d. In the Object window, click the thumbnail of the intensity profile at the dmax

or a depth as close to the dmax as possible and then choose Edit  > Copy
Curve.

e. In the Scope window, click the PDC model.
f. In the Focus window, click the empty Intensity Profile that you just created

and choose Edit > Paste Curve.
g. Define the Distance From Source parameter for the intensity profile. The

distance is defined as target - profile distance.
10. Import the actual fluence from the test plan to the configuration data:

a. In the Focus window, select the Open Field add-on created in step 4.
b. Choose File > Import  > Actual Fluence from Database.
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c. In the Patient Explorer, navigate to the test plan that contains the test fluence
(Creating a Test Plan for Deriving the Kernels on page 270), select the fluence
and click OK.

The actual fluence data object appears in the Focus window.
11. Define the output factors:

a. Choose Import  > Output Factors.
b. To complete the values in the output factor table, choose Beam Data  >

Interpolate missing values.
12. To calibrate the Output Factors Table, right-click Output Factors, choose

Calibrate Dose Rates and type the calibration value in the New Output Factor
box. The value should correspond to that used in the calibration of absolute dose
values (Calibrating the Detector for Dosimetric Acquisition on page 266). The
calibration value in the Output Factors table assumes SDD = 100 cm. If the
recommended calibration values were used for the absolute calibration of the
portal imager, the output factors should be normalized to the 10 × 10 cm2 field,
that is, OF 10, 10 ≅ 1 .

13. Choose File  > Save All.
14. To generate the calculated beam data, go to the Focus window, select Open Field

and choose Beam Data  > Calculate Beam Data.

The calculated kernel curve and kernel data are displayed (Kernel Data in Beam
Configuration on page 278).

15. In the Focus window, select the therapy unit (object under the PDC model) and
choose Beam Data  > Approve.

Tip: The intensity profile can also be defined as follows:
■ Define the intensity profile curve values manually using the Curve Editor. You need a profile

measurement at the SAD and at a shallow depth for this.
■ Record the intensity profile to a w2CAD file and import it. Make sure that the value of the

TYPE attribute in the w2CAD file is IntensityProfile.

Tip: The output factors can also be defined as follows:
■ Record the output measurements to a w2CAD file and import it.
■ Record the output measurements to a spreadsheet file, such as an Excel file, and copy/paste the

values to the output factor table.
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Verify the Configuration of PDC
You can verify the PDC configuration either by using the verification plans in the
Portal Dosimetry pre-configuration package, or by using Eclipse External Beam
Planning and Portal Dosimetry. Details on how to use these applications: the user
documentation for each application or RT and Imaging Online Help.

1. Go to External Beam Planning.
2. Open your calibration test plan and verify that the MU value in the Field

Properties correspond with that used for measuring the image.
3. Create a verification plan.

■ Choose Planning  > Create Verification Plan. Select a course to which the
verification plan will be stored or create a new one.

■ Select the Portal Dose Prediction option.
■ Define the SDD at which one of the dosimetric test images was acquired.
■ Clear all field geometry changes check boxes.
■ Select a tolerance table with large tolerance levels on the treatment couch.

Eclipse calculates the predicted dosimetric portal image.

The calculated dosimetric portal image is not displayed in the image views. The
predicted portal dose image icon appears in the Focus window under the field in
the verification plan.

4. Approve the created verification plan:
■ Choose Edit  > Plan Approval  > Planning Approved.
■ Select the Calculate treatment times for treatment fields check box and define

a multiplication factor.
5. Go to the Plan Parameters workspace.
6. Open the verification plan.
7. Right-click the target field and choose Add field image.
8. Browse to select the portal dose image acquired for the original calibration test

plan.
9. To save your work, choose File  > Save all.

Continue to Portal Dosimetry to compare the predicted and measured doses.

Compare the Predicted and Measured Doses
1. Open Portal Dosimetry.
2. To align the acquired and predicted images to correct for small inaccuracies in

the imager positioning, select the measured portal dose and then select the
Alignment tab.
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3. Move the image with the arrow keys until the line profiles show good positional
alignment, or click Auto Align.

Inaccuracies in the imager position calibration exceeding 3 mm in any direction
can cause sub-optimal kernel calculation during the configuration of the PDC. If
considerable adjustment (> 3 mm) is necessary to align the acquire test image
with its prediction, it is recommended to redo the imager position calibration and
acquire a new image for the configuration.

4. To accept the new image coordinates, click Set Aligned.
5. Select the Evaluation tab.
6. Click Options and define the values of the evaluation options as follows:

■ Dose Tolerance: 4%.
■ DTA: 4 mm.
■ Area Gamma: < 1.0 > 99%.

7. Click OK.
8. Click Perform Analysis to apply the criteria to the images.

Gamma Evaluation should produce a near-blank image where
gamma < 1 for 99% of the field for criteria of 4%, 4 mm. Since the default
evaluation takes the entire detector plate into account, the results may be affected
by an occasional error caused by stray pixels outside the range. If necessary, use
the ROI (region of interest) settings to focus on the irradiated area. Additionally,
misalignment of the images may also affect the evaluation; misalignment below
~2 mm should result in an acceptable evaluation.
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Flood Fill Algorithm
The flood fill algorithm iteratively fills a smoothly connected volume with similar
reference image values. A goodness value is calculated for all the voxels connected to
but not included in the volume at hand. The goodness value is defined as a sum of
image similarity value and a smoothness value. If the sum is below a user-defined
threshold, the voxel is attached to the volume.

k-NN Extension of Segments
The k-Nearest Neighbor (k-NN) algorithm is a classical classification algorithm. In
Eclipse segmentation it is used to classify voxels into those belonging or not
belonging to a segment. The algorithm extends the segment from source plane to the
destination plane.

Points close to the segment to be continued on the source plane are mapped to a six-
dimensional feature space. The features of interest are spatial coordinates on the
plane, the image value, the smoothed image value and image value gradients. Before
being mapped to the feature space, the components are transformed by calculating a
weighted sum of a normalized feature value and an equalized feature value after a
sigmoidal transformation. For each point in the destination area of interest (points
close to the source segment), a set of closest points in the feature space are searched.
These points use a weighted voting method to decide whether a point belongs to the
segment or not.

Automated Spine Segmentation
Automated spine segmentation is based on the k-NN algorithm. The segmentation
starts from a user-defined seed. The seed is then extended in the positive and
negative Z-direction of the volume. Extending is performed on a plane-to-plane
basis. Extending stops at a plane where no continuity is found.

Automated Lung Segmentation
Automated lung segmentation first finds a slice with most air inside the body
structure in two connected areas. A flood fill algorithm is then used to fill the lungs,
starting from points inside the two largest connected areas. The volume that can be
filled is limited by the Volume of Interest (VOI) and the body structure.
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Automated Brain Segmentation
Brain segmentation is started by finding and selecting bones resembling the skull on
planes inside the body structure using area and momentum criteria. A flood fill
algorithm with weaker filling parameters is used to fill most of the brain. Planes that
are too far from planes containing skull-like bones are cleared. The produced volume
is then dilated and used as a constraining volume for a more powerful flood fill.

Automated Eye Segmentation
Eye segmentation consists of two phases. In the first phase, a point inside each eye is
found, and in the second phase, the eye segment is generated around these points.

The first phase is initiated by calculating an eyeness map. A point in the map
describes how much the local neighborhood of a given point resembles a
neighborhood of a point where eyes are likely to appear. The following information
is used to estimate the local eyeness value:
■ Distance from the point to the body outline
■ Distance from the point to the skull-like bone
■ Distance from the point to the maxillary sinus-like volume
■ Distance from the point to air
■ Distance from the point to the symmetry axis in the image planes

Information on how skull-like bones are found: Automated Brain Segmentation on
page 284. The maxillary sinus-like volume is generated by searching air pockets
inside the body that fulfill the area requirements.

After the eyeness volume has been generated, two connected areas with the highest
integrated eyeness values are selected. Within these volumes, the eyeness-weighted
center points are calculated. These points are then used in the second phase.

In the second phase, the flood fill algorithm starts from the most probable eye locations
found in the first phase. First, weaker filling parameters are used to produce a rough
segment containing the interior of an eye. The rough eye segment is then used to
estimate the volume and center point of the eye. A stronger flood fill is then started
from the estimated center point. This second fill is constrained by a ball-shaped
Volume of Interest (VOI), which is centered to the estimated center point of the eye
and has a slightly larger volume than the rough eye segment.

Automated Bone Segmentation
Bones are segmented by selecting points with a CT value typical of bone structures.
Very small bone segments (smaller than 50 mm3) are removed.
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MRI Body Search Algorithm
The body search algorithm for MR images uses an adapted watershed transformation
algorithm. The algorithm operates on a slice-by-slice basis.

The principle of the algorithm is that the MR image is considered as a topographic
surface where the pixel intensity constitutes elevation. A rising water level is
simulated by repeatedly flooding the surface of the image with varying threshold
levels. The flooding is initiated from slice local minima. In each iteration, the area
above the water level is considered the body segment. As the water level rises, the
algorithm evaluates its progress and determines the appropriate level which denotes
the final body segment. The decision is based on predefined knowledge of the
expected results, such as the expected size of the body contour, results from the
segmentation of previous slices, and the expected progression of the algorithm close
to the body contour.

To reduce possible noise, the algorithm operates on a gaussian smoothed copy of the
MR image. The current Window/Level parameters defined by the user are applied to
the working copy prior to smoothing.

Algorithm for Stereotactic Radiosurgery (SRS)
Localization

The Stereotactic Radiosurgery (SRS) localization algorithm is used in the Eclipse SRS
Localization module for determining the position of the localizer box in the patient
CT image and, based on this, for creating a stereotactic 3D image for use in
stereotactic treatment planning. (Information on using the Eclipse SRS Localization
module: Eclipse Photon and Electron Reference Guide.)

The stereotactic 3D image created by the Eclipse SRS Localization module is aligned
with the SRS coordinate system, which is determined by the localizer box. Because
the localizer system uses one coordinate system (SRS coordinate system) and the CT
image uses a different coordinate system, translations and rotations are needed in the
alignment. The SRS Localization algorithm determines the required coordinate
transformations (shifts and rotations).

The SRS Localization algorithm identifies the localizer box in the CT image in the
following steps:

1. Detection of rod positions: The algorithm automatically finds the localizer rod
positions in the CT image.

2. Automatic identification of the localizer model: The algorithm automatically
identifies the localizer model based on the detected rod positions.
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3. CT slice localization: The algorithm determines the position and orientation of
individual CT slices in the SRS coordinate system.

4. Validation of slice localization: The algorithm validates the detected slice
positions and orientations in the SRS coordinate system.

5. Creation of the stereotactic 3D image: The algorithm creates the stereotactic 3D
image, which is aligned with the SRS coordinate system.

Detection of Rod Positions in the CT Slices
The SRS localization algorithm first automatically detects the rod positions in the CT
slices. It identifies contiguous regions consisting of pixels with an image intensity
value greater than or equal to a user-specified detection threshold. These regions are
then modeled as circles by determining the smallest circle that completely encloses
the corresponding pixel region. The centers of these circles are candidates for the rod
center points.

Identification of the Localizer Model
After detecting the rod positions, the SRS Localization algorithm automatically
recognizes the localizer model based on the rod positions. The algorithm first forms
continuous cylinders using the circles found in rod position detection, by stacking
circles that overlap from slice to slice. Only circles with radii between 0.5–7 mm are
considered. The resulting cylinders are compared with the vertical rods found in the
geometrical description of the localizer models. The geometrical descriptions are
predefined in the configuration of the planning system and are not user-definable.
The first geometrical description that is an adequate match is used to define the
detected localizer box. If none of the geometrical descriptions match closely enough,
the localizer model remains undefined.

CT Slice Localization
CT slice localization determines the position and orientation of the individual slices
in the input CT image in relation to the stereotactic coordinate system, which is
defined by the localizer. This can be performed for each slice only when all rod
positions have been defined on the slice (automatically or manually).

The figure shows how the slice localization is performed.
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Figure 46 Localization of an Image Slice Intersecting a Localizer Box (VMS Model)

In the figure, the position and orientation of a CT slice are described by a translation
s of the CT slice center point in relation to the localizer center (stereotactic origin),
the direction of the CT slice normal vector t (tilt vector) and an angle β (spin angle)
of rotation about that normal vector. The tilt angle is the angle between the Z-axis
and the normal vector. The intersection points of the CT slice and the localizer rods
are described in the SRS system as points on the localizer rods and as points on the
slice plane. On the slice plane, these points are described using planar coordinates
(qi,x and qi,y) and normalized row and column vectors u and v.
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The slice plane position and orientation in the SRS coordinate system can thus be
obtained by solving a system of linear equations or a linear least squares fit,
depending on the number of known rod intersection points.

Validation of Localization
After the slice localization is completed, the average spin angles and tilt directions
are calculated from the values obtained from the individual slices. Furthermore, a
linear fit of the detected slice center positions is made. Then the algorithm excludes
slices with spin, tilt and center position values deviating from the average by more
than a configurable amount, slices with detected position outside the localizer box,
and re-calculates the average values. The average values are used to produce the final
output.

The algorithm does not allow creation of the stereotactic 3D image if one of the
following criteria applies:
■ Less than 70% of the range defined by the lowermost and uppermost localized

slice overlaps with the localizer box range.
■ Average spin or tilt angle is greater than 30 degrees.

In addition to the above criteria, the algorithm also checks that not more than 10% of
the slices contain localization errors and that the average spin or tilt angle is below 5
degrees. If these criteria are not met, a warning message is shown, but the algorithm
still allows the creation of a stereotactic 3D image in the next step.

Creation of Stereotactic Volume
The stereotactic volume is a 3D image created from all input slices and aligned with
the stereotactic coordinate system using the average rotations. The stereotactic
volume pixels are shifted in the X, Y and Z-direction using a slice-specific translation
value (obtained from a linear fit calculation through the detected rod positions), and
the center of the localizer box is set at X  = 0, Y = 0, Z = 0. Finally, the stereotactic
volume is placed to a position where the stereotactic origin is at X = 0, Y = 0, Z = 0 in
the patient space.

The stereotactic origin for the VMS and BRW localizer models is conventionally at
the center of the localizer box and the head ring (in the X and Y-directions), and at
80 mm cranial of the head ring upper edge.
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Volume Interpolation Algorithm
Eclipse models structures using shape-based interpolation in segmentation tools,
volume calculation, 3D visualization and dose volume histogram calculation. Shape-
based interpolation is obtained by tri-linear interpolation of a stack of 2D distance
transforms of transaxial shapes.

The shape-based interpolation model is able to reproduce structures (shapes with
curvature) that closely correspond to anatomical shapes. However, in the case of
geometrical structures, such as boxes, the model rounds the ends of the box, which
affects the calculated volume of the structure. As an example, Eclipse approximates
the volume of a box with dimensions 4 cm × 4 cm × 3 cm to 40 cm3 instead of the
exactly calculated volume of 48 cm3. The volume of a sphere is, however, reproduced
more accurately.

The figure describes the shape-based interpretation of structure volumes.
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4

1. Shape-based interpolation
2. Slice planes
3. Shape interpolation, sphere
4. Slice planes

Figure 47 Shape-Based Interpretation of Structure Volumes
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In the figure, 1 shows how the shape-based interpolation model treats the outermost
planes in a box-like structure; 3 shows how the system interpolates and extrapolates
a spherical shape, reproducing the curvature between the planes accurately.

Distance Transform
The shape-based interpolation algorithm is based on a distance transform51. This
interpolation method linearly interpolates the shape of the structure between image
planes, and smooths the structure boundaries. The distance transform is calculated
for the structure boundary on each image plane. The minimum distance of each voxel
from the structure boundary on the current plane is calculated and stored in the
voxel. The interpolation algorithm marks the distances with negative values inside
and positive values outside the structure. The structure boundary is formed by points
that have values near zero (zero-crossing values). After the distance calculation, the
distance values are used for the linear interpolation that approximates a continuous
model of the structure. To determine the distance of a point from the structure
boundary, the distance value of the point is calculated by interpolating the value
from the nearest two image planes. The interpolation is always performed tri-
linearly, that is, linearly in the directions of the three coordinate axes.

Surface Modeling
The surface model that is used for visualizing structures three-dimensionally is a
triangle mesh. The position of the surface of a structure is located at the zero-crossing
of the linearly interpolated distance transform.

Volume Calculation
The volume calculation to determine the total volume of a structure is based on the
distance values. The total volume is calculated by integrating the volume for which
the interpolated distance values are negative.

DVH Calculation
The DVH is formed by binning the dose values inside the volume of the specified
structure. The shape-based interpolation method is used to determine the structure
shape. First, the distance transform of the structure is resampled over the dose
matrix. Then the software uses the distance transform values to determine which
dose values fall inside the structure. The dose values inside the structure are used to
compute the DVH by linearly interpolating between neighboring dose voxels.

51 Herman GT & Zheng J, Bucholtz CA: Shape-based interpolation. IEEE; Computer
Graphics and Applications, (1992), 12: 69–79.
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A dose-volume histogram is calculated in dose matrix coordinates. In Eclipse, the
grid of a structure does not necessarily match the grid of the dose matrix exactly,
leading to small differences in the volume calculation. The differences may be larger
if the dose matrix and the structure grids have different orientations or Z-positions.
In normal use, Eclipse creates dose matrices that have a co-aligned grid structure,
leading to minor resampling errors. However, imported DICOM data may have dose
and structure data in different orientations and Z-positions, leading to more
significant levels of resampling inaccuracies. Also, miniscule structures may have a
higher relative level of resampling inaccuracy. The DVH algorithm in Eclipse reports
the resampling accuracy by comparing structure volumes before and after
resampling.

Verification of the Effective Depth
The effective depth value is used for manually verifying the MU calculation. The
effective depth, the PSSD (reference point SSD) and the depth of the reference point
are printed to the treatment report under the reference point information of each
field in an external plan. These values are calculated to take into account any bolus
that may be present. Information on treatment reports: Eclipse Photon and Electron
Reference Guide.

Calculation of the Effective Depth
The effective depth is calculated along the fanline from the source to the reference
point, starting from the body outline:

Equation 68

 

de f f =∫
0

Depth

ρ
e− l dl

 

where   

Depth = Depth of reference point from the surface along the fanline

ρ
e‐ l = Electron density at depth l along the fanline

The algorithm only considers areas that are inside either the bolus or the Body
structure.
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Figure 48 Effective Depth Calculation

First, the fanline line from the source to the reference point is calculated. Then the
algorithm calculates the intersection of the fanline with each bolus and the Body
structure, and the path lengths inside them. The length of the path inside the bolus is
multiplied by the electron density. If the Body structure has a CT value assigned to it,
the CT value is used in the calculation of the fanline inside the Body structure,
otherwise CT value integration along the fanline path is used. If other structures that
the fanline intersects have CT values assigned to them, the CT values are used in the
calculation of the fanline inside the structures, otherwise, CT value integration is
used. The PSSD is calculated by comparing the distances along the reference point’s
fanline from the source with the intersection points of the Body and bolus structures.
The shortest distance is returned as the PSSD.

Dose Data of Large DMLC Fields
Large planning fields with multiple MLC carriage groups are divided into subfields,
each containing one MLC carriage group. The dose contribution of each original
planning field is divided into subfield dose contributions, which sum up to the field
dose contribution of the original field. The MU are calculated in the same way.
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The MU for the subfields are calculated as follows:

Equation 69

 
MUsub = CMWlast − CMWfirst

FCMW ⋅ MUtotal
 

where   

CMWlast = Cumulative meter set weight at the last control point of the subfield

CMWfirst = Cumulative meter set weight at the first control point of the subfield

FCMW = Final cumulative meter set weight of the field

MUtotal = Total MU of the field

The subfield dose contributions to reference points are calculated as follows:

Equation 70

 
FDCsub = CMWlast − CMWfirst

FCMW ⋅ FDCtotal
 

where   

CMWlast = Cumulative meter set weight at the last control point of the subfield

CMWfirst = Cumulative meter set weight at the first control point of the subfield

FCMW = Final cumulative meter set weight of the field

FDCtotal = Total dose contribution of the field to the reference point

Fit-and-Shield Algorithm
The Fit-and-Shield algorithm is implemented in the Eclipse Fit-and-Shield
optimization tool, which positions MLC leaves around the target structure to expose
the target while covering critical organs. The Fit-and-Shield optimization is mainly
designed for modified hollow-out planning, which is a treatment technique
employing conformal arc fields, but it can also be used for static fields and static arc
fields. The tool creates the necessary number of fields or conformal arc fields and
automatically determines the MLC leaf positions in each arc field segment. More
information about using the Fit-and-Shield tool: Eclipse Photon and Electron Reference
Guide.
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The Fit-and-Shield algorithm is divided into the following parts:
■ Calculation of the field geometry: The field geometry is considered by the Fit-and-

Shield algorithm as a binary optimal fluence from each BEV projection along the
field. The binary fluence is constructed by first projecting the target, which may be
partially or completely cleared by the projections of the critical organs, depending
on the direction of the projection.

■ Estimation of number of arc fields: The number of arc fields required is determined
from the maximum sum of the positive differences along the leaf trajectory (for
each fluence and leaf pair). The maximum number of arc fields can also be
manually defined. Each segment is assigned to its specific arc, and then the
segments are optimized to match the motion limits of the DMLC with a minimal
difference between the optimal and actual fluences. The Fit-and-Shield algorithm
calculates the DMLC motions for one or more arc fields, attempting to match the
target projection using the DMLC.

■ Calculation of DMLC leaf positions: The Leaf Motion Calculator (Leaf Motion
Calculator (LMC) on page 234) is used to construct the arc field segments, formed
by the DMLC leaf apertures. To make the DMLC leaf apertures feasible for the
MLC device, the LMC applies machine-specific limitations to each MLC segment.

Approximated Minimum Distance Estimation in the Arc
Geometry Tool

The Arc Geometry Tool shows approximated distances from the treatment unit head
model to the couch model and to the patient model.The treatment unit head for
Varian machines is modeled as a cylinder with the diameter of 80 cm. For Elekta
treatment units, the diameter is 72 cm. The bottom of the cylinder for Varian
machines is at 60 cm from the source level. For Elekta treatment units, the value is
58 cm. The whole cylinder is taken into account when measuring the distances, so the
distances are also approximated from the edge of the cylinder, and not only along the
central axis.

Treatment Unit Head to Patient Distance
The treatment unit head model to patient model distance estimation uses the
contoured Body structure, and it approximates the shortest distance from the
cylindrical treatment unit head model to the Body structure.

Note: If part of the body is not contoured, it is not taken into account when approximating the
distances.
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Treatment Unit Head to Couch Distance
The treatment unit head to couch algorithm approximates the shortest distance from
the cylindrical treatment unit head model to the edge of the couch model.

The algorithm places a 53 cm wide default couch under the Body. The smallest
possible box is fitted around the Body, and the couch is positioned under this box
symmetrically in lateral direction.

All couch structures, and patient support and fixation structures, in the image are
taken into account. If the image has not been enlarged when the couch was added
(the widest part of the couch extends all the way to the image edge on both sides), a
default width of 53 cm is used. If the widest couch structure does not extend out of
the image on both sides, then just the visible width of the couch in the image is used.

In both cases, the thickness of the couch used in calculations is 3 cm. The length of
the couch is not modeled (it is infinite). If couch rotation exceeds 15 degrees, distance
calculation is disabled.

Irregular Surface Compensation Algorithm
The irregular surface compensation algorithm constructs an irregularly shaped
surface. The intensity of each beamlet is modulated to achieve a uniform dose on this
irregular compensation surface. The surface is calculated from the penetration depths
of the fanline rays, which are traced through the patient. The compensation surface
automatically includes the effects of beam divergence. Patient geometry is considered
in determining the compensation surface, but heterogeneity is accounted for in the
field fluence calculation, not in determining the compensation surface. Smoothing
options can be set for the algorithm. If more uniform border area fluence is desired,
smoothing can be set to zero.

The irregular surface compensation calculation is performed with the Dose Volume
Optimizer (DVO) algorithm, which uses the gradient method (Dose Volume
Optimizer (DVO) Algorithm on page 193). The algorithm checks the penumbra area
to keep the difference in the fluence between the margin area and areas nearer to the
fluence center under 20%. The volumetric dose calculation within the optimization is
performed with the MRDC model (Multi-Resolution Dose Calculation (MRDC)
Algorithm on page 184).
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Volume Construction for Irregular Surface Compensation
The irregular compensation surface is constructed from the surfaces of the Body
structure within the field aperture. First, the front and back Body surfaces are
calculated using the depth buffering technique. The compensation surface is then
interpolated from the Body surfaces, using a user-specified interpolation factor.

To reduce the effect of border compensation caused by high fluence at field edges,
three compensation surfaces are constructed:
■ Border surface: Includes points that are closer than from 5 mm (low energies) to

7.5 mm (high energies) from the field edge. To avoid overshoots at the edges due
to scatter compensation, the border surface is allowed to receive 80% to 100% of
the prescribed dose.

■ Corner surface: To avoid overshoots at the edges of the fluence due to scatter
compensation, the corner surface is allowed to receive 62% to 100% of the
prescribed dose.

■ Center surface: The center surface is allowed to receive 100% of the prescribed
dose.

Isocenter Spacing in Cone Planning
When a stereotactic cone plan includes multiple isocenters, Cone Planning checks the
spacing between all isocenters. If an isocenter is too close to another isocenter, a
warning message is shown. The check is based on a predefined chart of optimal
distances between isocenters defined for each collimator size (Table 46 on page 296).

The warning message is shown when a change that affects the isocenter location or
cone sizes is made. The warning threshold between any two isocenters can be seen in
the Isocenter Spacing tool. The Isocenter Spacing tool also allows the distance
between isocenters to be set to a suggested value derived from the collimator spacing
chart.

Table 46 Chart of Optimal Distances Between Isocenters
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The chart is used as follows:
■ If the distance between any two isocenters is smaller than the value in the chart +

0.7 mm, the hotspot warning is shown.
■ The Auto spacing in the isocenter spacing tool sets the distance between

isocenters to the value in the chart + 1.2 mm.
■ If there are cones of different sizes at one isocenter, (for example, 1 × 10 mm cone

and 4 × 12 mm cones) the value of the largest cone (in this example, the 12 mm
cone) is used.

■ If there are cones the sizes of which are not included in the chart, the closest
available value is used (for example, 17.5 mm is rounded up to 18 mm). If the cone
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size falls exactly between two values in the chart, the higher value is used (for
example, for a 15 mm cone the value for a 16 mm cone would be used).
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Appendix A    Acronyms and Abbreviations

Acronyms and Abbreviations
BSF Back Scatter Factor

CSSD Central Axis Source-to-Skin Distance. Distance from the radiation source to
the surface of the skin along the field central axis.

dmax Depth of the field dose maximum at the central axis.

Dmax Dose maximum

EDW Enhanced Dynamic Wedge field accessory.

EqTAR Equivalent TAR inhomogeneity correction method.

GPB Generalized Pencil Beam algorithm for electron calculations.

ICRU International Commission on Radiation Units and Measurements.

MLC Multileaf Collimator field accessory.

MU Monitor Unit.

NACP Nordic Association of Clinical Physics.

PDD Percentual Depth Dose. Absorbed dose at a specified depth expressed as a
percentage of the absorbed dose at a reference depth on the central field
axis.

PSF Peak Scatter Factor. Ratio of the measured dose in water-equivalent
phantom at the depth of the dmax in air and the dose to the same point,
defined for a given source-detector distance and field size.

SAD Source-to-Axis Distance. Distance between the radiation source and the
isocenter of the treatment unit. All field sizes are defined at the SAD.

SAR Scatter-air ratio. Ratio of the scattered dose at a specified point in the
phantom to the dose at the same point in free space.

SDD Source-to-Detector Distance

SFED Source-Field Entry Point Distance.

SID Source-to-Imager Distance
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SMR Scatter-maximum ratio. Ratio of the scattered dose at a specified point in
the phantom to the effective primary dose at the same point at the refer-
ence depth of the maximum dose. Special case of SAR, where the reference
point is different.

SPB Single Pencil Beam algorithm for photon calculations.

SPD Source-to-Phantom Distance. Distance between the radiation source and
the surface of the water phantom. Used in beam data measurements.

SSD Source-to-Skin Distance. Distance between the radiation source and the
surface of the patient’s skin. Used in beam data configuration and treat-
ment planning.

STT Segmented Treatment Data Table. Describes the treatment unit movements
during a segmented treatment field.

TAR Tissue-Air Ratio. Ratio of the absorbed dose at a given point in the
phantom to the absorbed dose at the same point in free space.

TMR Tissue-Maximum Ratio. Ratio of the absorbed dose at a point in the
phantom to the same point when it is at the dmax. Special case of the TPR,
where the reference depth is the dmax.

TPR Tissue-Phantom Ratio. Ratio of the absorbed dose at a point in the
phantom to the absorbed dose at the reference depth.

w2CAD Waterphantom-CadPlan file format for water phantom data. Used to
transfer the measured beam data from water phantom devices.
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Appendix B    Definition of Field Geometry

Definition of Field Geometry
The figure shows the definitions of the field dimensions as seen from the Beam’s Eye
View. The gantry is at the top if the collimator angle is 0°.

x′ = SAD
CSSD + d1

∙ x1   and   y′ = SAD
CSSD + d1

∙ y1

Figure 49 Field Size and Grid Point Geometry at SAD Level from BEV

The following figure shows the definitions of the distances used in calculations of
depth dose and oblique corrections.
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Figure 50 Distances Used in Depth Dose Calculations and Oblique Corrections

Table 47 Variables in Field Geometry Definitions

Variable Meaning

CSSD Central axis Source-to-Skin Distance.

d1 Shortest distance between parallel planes, perpendicular to the
field central axis, intersecting the grid point and the point where
the field central axis intersects the body contour.

d2 Shortest distance between the plane perpendicular to the field cen-
tral axis, intersecting the grid point and the point where the fan-
line from the grid point to the focus intersects the body contour.

dbc Distance between the grid point and the body contour, measured
along the fanline from the grid point to the focus.

dfe Distance between the grid point and the plane perpendicular to
the field central axis where the central axis intersects the body
contour, measured along the fanline.

FSSD Fanline Source-to-Skin Distance.

FX Symmetrical lateral field size, defined at the SAD.

FY Symmetrical longitudinal field size, defined at the SAD.

SAD Source-to-Axis Distance.

SPD Source-to-Phantom distance.
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Variable Meaning

SSD Source-to-Skin distance.

x Distance of the grid point from the field central axis in the field
lateral direction, defined at grid point level.

X1 Lateral field size on the left side of the field, defined at the SAD.

X2 Lateral field size on the right side of the field, defined at the SAD.

y Distance of the grid point from the field central axis in the field
longitudinal direction, defined at grid point level.

Y1 Longitudinal field size on the lower side of the field, defined at the
SAD.

Y2 Longitudinal field size on the upper side of the field, defined at
the SAD.

z Axis parallel to the central axis.
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Appendix C    File Formats for Measured Beam Data

w2CAD File Format
The w2CAD (waterphantom-CadPlan) file format is used to transfer the measured
beam data from various water phantom devices. Beam data measurements must be
saved into ASCII files that can be read in any text editor. For examples of w2CAD
table formats, see Appendix D Table Input Formats on page 316.

Note: Keep all open field depth dose curves and profiles in one file, and the depth dose curves
and profiles for each wedge in a separate file. The diagonal profiles and wedge longitudinal
profiles can be saved in separate files or in the same files with the depth dose curves and
profiles, respectively. Do not include any other type of data in these files.

Store depth dose curves starting from the water surface. Store all profiles in the same
order, either from left to right or right to left.

Initial Characters and Separation Between Measurements
The initial characters and the delimiter tags between measurements are the same in
the w2CAD files for all algorithms.

Table 48 Meaning of Initial Characters in w2CAD Files

Text Meaning

$ Separation between measurements

# Comment text1

% Header line

<xyz> Measurement data, points x, y, z

1. Comment text can be placed anywhere in the file.

Table 49 Separation between Measurements

Text Meaning

$STOM: Start of one measurement

$ENOM: End of one measurement

$ENOF: End of the file
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Text Meaning

$NUMS XXX: Number of measurements in this file (not necessary)

w2CAD Files for the AAA and the Acuros XB Algorithms
The w2CAD files contain several measurements (one curve represents one
measurement). Each measurement consists of a header and data information.

Table 50 Header lines

Text Meaning

%DATE DD-MM-
YYYY:

Date of the measurement

%VERSION XX: Version of W2CAD file format

The current version number is 02. In the previous w2CAD file format,
a version number was not used.

%DETY XXX: Detector type

CHA = Ionization chamber

DIO = semiconductor detector

DIA = Diamond

%BMTY XXX: Beam type

PHO = High energy photons (MV energies)

COB = Photons from cobalt unit (AAA only)

%TYPE XXX: Measurement type

OPD = Open field depth dose curve

OPP = Open field profile

WDD = Wedge depth dose curve

WDD_SSD80 = Wedge depth dose curve, SSD 80 cm (AAA and
Acuros XB only)

WDD_SSD120 = Wedge depth dose curve, SSD 120 cm (AAA and
Acuros XB only)

WDP = Wedge profile

WLP = Wedge longitudinal profile

DPR = Diagonal profile

%WDGL XX: Wedge name (2 characters, wedged fields only)
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Text Meaning

%WDGD X: Wedge direction (wedged fields only)

L = Thin edge left (negative in X-direction as in IEC 61217)

R = Thin edge right (positive in X-direction as in IEC 61217)

%AXIS X: Measurement axis

X, Y = Horizontal Axes

Z = Vertical Axis (the depth axis)

D = Diagonal Axis

%AXIS must be D, when both the X and Y horizontal axis values are
given for the diagonal profile. %AXIS can be X or Y if only one hori-
zontal axis is used to store the point distance from the origin. %AXIS Z
defines the measurement axis with the other measurement types.

%PNTS NNN: Number of points

%STEP XXX: Point separation in 1/10 mm

%SSD XXXX: SSD in mm

%FLSZ XXX*XXX: Field size in mm

Each value consists of three characters. For measurements under
100 mm, type 0 in front of the value, or use spaces in front of and after
the asterisk (*), for instance, %FLSZ 010*010 or %FLSZ 10 * 10.

%DPTH XXX: Measurement depth in mm (only profiles)

The measurement data is in the format

<SXXX.X SYYY.Y SZZZ.Z SDDD.D>
where   

S = Sign (+/-)

XXX.X = X-coordinate in mm

YYY.Y = Y-coordinate in mm

ZZZ.Z = Z-coordinate in mm

DDD.D = Dose values in %

Example of a file with one depth dose curve and one profile made from 10 × 10 cm
open field measurement:

$NUMS 002
$STOM
#
#CLINAC 2 6 MV PHOTONS
#FIELD SIZE 10x10 cm
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#
%DATE 12-12-1997
%DETY CHA
%BMTY PHO
%TYPE OPD
%AXIS Z
%PNTS 051
%STEP 050
%SSD  1000
%FLSZ 100*100
#
<+000.0 +000.0 +000.0 +030.0>
<+000.0 +000.0 +005.0 +076.0>
<+000.0 +000.0 +010.0 +093.4>
<+000.0 +000.0 +015.0 +098.7>
<+000.0 +000.0 +020.0 +100.0>
<+000.0 +000.0 +020.0 +099.2>
.
.
.
<+000.0 +000.0 +245.0 +034.4>
<+000.0 +000.0 +250.0 +033.7>
$ENOM
$STOM
#
#CLINAC 2 6 MV PHOTONS
#FIELD SIZE 10x10 cm
#
%DATE 12-12-1997 
%DETY CHA
%BMTY PHO
%TYPE OPP
%AXIS X
%PNTS 037
%STEP 025
%SSD  1000
%FLSZ 100*100
%DPTH 050
#
<-090.0 +000.0 +050.0 +002.4>
<-087.5 +000.0 +050.0 +002.6>
<-085.0 +000.0 +050.0 +002.8>
<-082.5 +000.0 +050.0 +003.0>
<-080.0 +000.0 +050.0 +003.4>
<-077.5 +000.0 +050.0 +003.8>
<-075.0 +000.0 +050.0 +005.3>
<-072.5 +000.0 +050.0 +012.6>
<-070.0 +000.0 +050.0 +061.5>
<-067.5 +000.0 +050.0 +094.9>
<-065.0 +000.0 +050.0 +098.3>
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.

.

.
<+087.5 +000.0 +050.0 +002.9>
<+090.0 +000.0 +050.0 +002.5>
$ENOM
$ENOF

w2CAD Files for the CDC Algorithm
The w2CAD files for the Cone Dose Calculation (CDC) algorithm contain several
measurements (one curve represents one measurement). Each measurement consists
of a header and data information.

Table 51 Header lines

Text Meaning

%DATE DD-MM-YYYY: Date of the measurement

%VERSION XX: Version of W2CAD file format

The current version number is 02. In the previous
w2CAD file format, a version number was not used.

%DETY XXX: Detector type

CHA = Ionization chamber

DIO = semiconductor detector

DIA = Diamond

%BMTY XXX: Beam type

PHO = High energy photons (MV energies)

%TYPE XXX: Measurement type

TMR= Tissue Maximum Ratio

OPP = Off-axis Ratio. The same tag is used for Open
field profile and Off-axis ratio in the w2CAD files.

%AXIS X: Measurement axis

X or Y = Horizontal Axes

Z = Vertical Axis (the depth axis)

%PNTS NNN: Number of points (optional).
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Text Meaning

%FLSZ X.X*X.X: Field size in mm

For cone sizes containing decimals, use decimal
points. For instance, when measuring with a 7.5 mm
cone, type the filed size as %FLSZ 7.5*7.5.

%DPTH XXX: Measurement depth in mm (only profiles)

The measurement data is in the format

<SXXX.X SYYY.Y SZZZ.Z SDDD.D>
where   

S = Sign (+/-)

XXX.X = X-coordinate in mm

YYY.Y = Y-coordinate in mm

ZZZ.Z = Z-coordinate in mm

DDD.D = Dose values in %

Example of a file with one depth dose curve and one profile made from 7.5 × 7.5 mm
cone field measurement:

$NUMS 002
$STOM
#CLINAC 2 6 MV PHOTONS
#FIELD SIZE 0.75 cm CONE
#
%DATE 12-12-2008
%VERSION 02
%DETY CHA
%BMTY PHO
%TYPE TMR
%AXIS Z
%PNTS 076
%FLSZ 7.5*7.5
<+000.0 +000.0 +000.0 +040.6>
<+000.0 +000.0 +002.5 +065.7>
<+000.0 +000.0 +005.0 +090.5>
<+000.0 +000.0 +007.5 +098.3>
<+000.0 +000.0 +010.0 +100.0>
.
.
.
<+000.0 +000.0 +164.9 +041.8>
<+000.0 +000.0 +167.4 +041.3>
<+000.0 +000.0 +169.9 +040.8>
$ENOM
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$STOM
#CLINAC 2 6 MV PHOTONS
#FIELD SIZE 0.75 cm CONE
#
%DATE 12-12-2008
%DETY DIO
%BMTY PHO
%TYPE OPP
%AXIS X
%PNTS 053
%STEP 005
%SSD  0900
%FLSZ 7.5*7.5
%DPTH 100
<+000.0 +000.0 +100.0 +100.0>
<+000.5 +000.0 +100.0 +099.1>
<+001.0 +000.0 +100.0 +097.5>
<+001.5 +000.0 +100.0 +094.8>
<+002.0 +000.0 +100.0 +090.4>
<+002.5 +000.0 +100.0 +082.2>
<+003.0 +000.0 +100.0 +070.5>
<+003.5 +000.0 +100.0 +055.1>
.
.
.
<+009.5 +000.0 +100.0 +001.6>
<+010.0 +000.0 +100.0 +001.4>
<+010.5 +000.0 +100.0 +001.2>
<+011.0 +000.0 +100.0 +001.1>
<+011.5 +000.0 +100.0 +001.0>
$ENOM  
$ENOF

w2CAD Files for the eMC Algorithm
To import and configure the eMC algorithm correctly, Beam Configuration requires
the following parameters to specify the data in the w2CAD files.

Table 52 Mandatory Parameters

Text Meaning Status

%VERSION
02

w2cad file format version, must be 02.

This parameter is mandatory, if you want to import the fol-
lowing parameters: %SPD, %CalibrationDepth and %Cal-
ibrationFactor.

Mandatory

%BMTY ELE Beam type, must be ELE (= electron) Mandatory
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Text Meaning Status

%FLSZ
xxx×xxx

Field size in mm.

Each value consists of three characters. For measurements
under 100 mm, type 0 in front of the value, or use spaces in
front of and after the asterisk (*), for instance,
%FLSZ 010*010 or %FLSZ 10 * 10.

Mandatory parameter for applicator fields.

Mandatory

%TYPE xxx The measurement type parameter must be one of the fol-
lowing:

 

 xxx = MeasuredDepthDo-
sesForOpenBeam

Depth dose curve without ap-
plicator

Mandatory

 xxx = MeasuredProfile-
ForOpenBeam

Open beam profile Mandatory

 xxx = MeasuredDepthDo-
sesForApplicator

Depth dose curve with appli-
cator

Mandatory

 xxx = MeasuredProfile-
ForApplicator

Applicator specific open
beam profile

Mandatory

%ID xxx Curve identifier.  

 xxx = Open Open beam curve. This is a
recommended parameter for
open beams. If not included,
no legend is shown for open
field curves in Beam Configu-
ration.

Recom-
mended

 xxx = Crossline Direction of the applicator
specific open beam profile.

Mandatory

 xxx = Inline Direction of the applicator
specific open beam profile.

Mandatory

%SPD x.x Source-Phantom Distance in [cm] for all curves. Optional

%Calibra-
tionDepth
x.x

Depth of the calibration point in [cm] for applicator depth
dose curves.

Optional

%Calibra-
tionFactor
x.x

Absolute dose in [cGy/MU] at the calibration point for appli-
cator depth dose curves.

Optional
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Examples of w2CAD Files for the eMC Algorithm and Electron Beam Source
Model:
Measured open beam depth dose:

$NUMS 1
$STOM
#6e open 40x40 depth-dose ssd=100
#DATE: 01-01-01
%BMTY ELE
%CalibrationDepth 1.0
%CalibrationFactor 0.910936
%FLSZ 400.0*400.0
%TYPE MeasuredDepthDosesForOpenBeam
%PNTS 150
%DETY UNKNOWN
%STEP 1
%VERSION 02
%SPD 100
%ID Open
%AXIS Z
<+000.0000 +000.0000 +000.0000 +000.7272>
<+000.0000 +000.0000 +001.0000 +000.7262>
…
<+000.0000 +000.0000 +148.0000 +000.0020>
<+000.0000 +000.0000 +149.0000 +000.0020>
$ENOM
$ENOF

Open beam profile in air:

$NUMS 1
$STOM
#6e open 40x40 cp profile in air
%BMTY ELE
%FLSZ 400.0*400.0
%SPD 95.0
%PNTS 479
%DETY UNKNOWN
%STEP 1
%VERSION 02
%TYPE MeasuredProfileForOpenBeam
%ID Open
%AXIS X
<−239.0000 +000.0000 +000.0000 +014.7000>
<−238.0000 +000.0000 +000.0000 +015.0000>
…
<+238.0000 +000.0000 +000.0000 +016.3000>
<+239.0000 +000.0000 +000.0000 +015.6000>
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$ENOM
$ENOF

Measured Applicator beam depth dose:

$NUMS 1
$STOM
#6e appl 10x10 depth-dose ssd=100
%BMTY ELE
%CalibrationDepth 1.0
%CalibrationFactor 0.918
%FLSZ 100.0*100.0
%TYPE MeasuredDepthDosesForApplicator
%DETY UNKNOWN
%STEP 1
%VERSION 02
%SPD 100
%PNTS 151
%AXIS Z
<+000.0000 +000.0000 +000.0000 +000.7230>
<+000.0000 +000.0000 +001.0000 +000.7230>
…
<+000.0000 +000.0000 +149.0000 +000.0040>
<+000.0000 +000.0000 +150.0000 +000.0040>
$ENOM
$ENOF

Crossline in-air profile for applicator

$NUMS 1
$STOM
#6e open 20x20 cp profile in air
%BMTY ELE
%FLSZ 200.0*200.0
%SPD 95.0
%PNTS 381
%DETY UNKNOWN
%STEP 1
%VERSION 02
%TYPE MeasuredProfileForApplicator
%ID Crossline
%AXIS X
<−190.0000 +000.0000 +000.0000 +003.4000>
<−189.0000 +000.0000 +000.0000 +003.5000>
…
<+189.0000 +000.0000 +000.0000 +003.6000>
<+190.0000 +000.0000 +000.0000 +003.8000>
$ENOM
$ENOF
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Inline in-air profile for applicator

$NUMS 1
$STOM
#6e open 20x20 ip profile in air
%BMTY ELE
%FLSZ 200.0*200.0
%SPD 95.0
%PNTS 401
%DETY UNKNOWN
%STEP 1
%VERSION 02
%TYPE MeasuredProfileForApplicator
%ID Inline
%AXIS Y
<+000.0000 −200.0000 +000.0000 +004.8000>
<+000.0000 −199.0000 +000.0000 +004.7000>
…
<+000.0000 +199.0000 +000.0000 +004.9000>
<+000.0000 +200.0000 +000.0000 +004.8000>
$ENOM
$ENOF

Compensator Attenuation Curve Data File Format
A user-defined compensator attenuation curve data can be imported in Beam
Configuration in a separate file. You need to manually create the file for the import.
To enable Beam Configuration to read the file, it must use a specified file format.

The file must be a text file that consists of two columns separated by a space. The first
column is for the energy (in MeV), the second column is for the mass attenuation
coefficient μ/ρ (in cm2/g).

The following shows an example of a compensator attenuation curve data file.

1.00E-02    2.22E+02
1.50E-02    7.67E+01
2.00E-02    3.50E+01
3.00E-02    1.13E+01
4.00E-02    5.06E+00
5.00E-02    2.72E+00
6.00E-02    1.65E+00
8.00E-02    7.90E-01
1.00E-01    4.73E-01
1.50E-01    2.26E-01
2.00E-01    1.58E-01
3.00E-01    1.13E-01
4.00E-01    9.46E-02
5.00E-01    8.39E-02
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6.00E-01    7.65E-02
8.00E-01    6.62E-02
1.00E+00    5.92E-02
1.25E+00    5.27E-02
1.50E+00    4.81E-02
2.00E+00    4.22E-02
3.00E+00    3.61E-02
4.00E+00    3.33E-02
5.00E+00    3.19E-02
6.00E+00    3.13E-02
8.00E+00    3.10E-02
1.00E+01    3.13E-02
1.50E+01    3.28E-02
2.00E+01    3.45E-02
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Appendix D    Table Input Formats

Output Factor Table Format for AAA and Acuros XB
An output factor table, required by the configuration program for photon beams, can
be imported into Beam Configuration in a separate measurement file. To enable Beam
Configuration to read the file, it must use a specified file format.

The output factor table file consists of a header section and a data section. The table
describes the format to be used in the header section.

Table 53 Output Factor Table Format

Text Meaning

%VERSION XX Version number.

%DATE DD-MM-YYYY Date of measurement.

%BMTY nnn Beam Type:

PHO = High energy photons (MV energies)

COB = Photons from cobalt unit (AAA only)

%TYPE nnn Type of the output factor table.

Elekta Beam Modulator treatment unit:
BMOutputFactorTable
Other treatment units: OutputFactorTable

%SourcePhantomDistance nnn Source to phantom distance used for the
measurements, expressed in millimeters.

%DetectorDepth nnn Detector depth, expressed in millimeters.

# Line containing a comment. These lines are
not mandatory, and they can be inserted any-
where in the file.

The output factor measurement data is recorded to the Data section of the file. The
Data section must use the following format:
■ First line—X field sizes (in accordance with IEC 61217 and expressed in

centimeters) for the table, each value separated by a comma: X1, X2, X3,,,Xn.
■ Following lines—Output factor values for all field sizes in cm, organized to lines

by the Y field sizes. Each line starts with the Y field size, and then lists the output
factor values for the X field sizes (specified in the first line). The values are
separated by a comma.
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The following shows an example of a Beam Modulator Output Factor Table file:

#
# Example Output factor table for Beam Modulator
#
%VERSION 03
%DATE 27-08-2010
%BMTY PHO
%TYPE BMOutputFactorTable
%SourcePhantomDistance 1000
%DetectorDepth 50
# Data
2.4, 3.2, 4, 5.6, 8, 10.4, 12, 16, 21
2.4, 0.810, 0.824, 0.833, 0.845, 0.857, 0.862, 0.865, 0.868, 
0.872
3.2, 0.832, 0.844, 0.860, 0.870, 0.883, 0.899, 0.894, 0.900, 
0.904
4.0, 0.836, 0.854, 0.872, 0.890, 0.904, 0.913, 0.921, 0.926, 
0.929
5.6, 0.854, 0.872, 0.886, 0.910, 0.935, 0.948, 0.950, 0.967, 
0.967
8.0, 0.860, 0.887, 0.905, 0.936, 0.967, 0.977, 0.986, 1.004, 
1.015
10.4, 0.862, 0.893, 0.918, 0.948, 0.980, 1.000, 1.005, 
1.023, 1.040
12.0, 0.865, 0.896, 0.918, 0.951, 0.990, 1.012, 1.016, 
1.034, 1.047
16.0, 0.870, 0.905, 0.924, 0.964, 0.996, 1.020, 1.030, 
1.051, 1.066

Beam Configuration can still read the CSV based (CadPlan) output factor table
format. However, the new format explicitly shows the measurement geometry and
includes fractional field sizes.

Absolute Point Doses File Format for AAA and Acuros XB
The absolute point doses required for the configuration of the AAA and Acuros XB
for Elekta Beam Modulator can be imported into Beam Configuration in a separate
measurement file. You need to manually create the file for the import. For each
measured field, the absolute point doses table indicates the asymmetrical jaw
positions, the detector position and the measured point dose at the detector. To
enable Beam Configuration to read the file, it must use a specified file format.

The file consists of a header section and a data section. The table describes the format
to be used in the header section.
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Table 54 AAA and Acuros XB Absolute Point Doses File Format, Header Section

Text Meaning

%VERSION XX Version number. The current version number is
01.

%DATE DD-MM-YY Date of measurement.

%BMTY PHO Beam Type. Only PHO is supported.

%TYPE PointDoseTableIEC Must be PointDoseTableIEC
%SourcePhantomDistance nnn Source to phantom distance used for the measure-

ments in mm.

# Line containing a comment. These lines are not
mandatory, and they can be inserted anywhere in
the file.

The measurement data must be recorded in the Data section of the absolute point
doses file. The Data section must use the following format:

Table 55 AAA and Acuros XB Absolute Point Doses File Format, Data Section

Text Meaning

X1[mm], X2[mm], Y1[mm],
Y2[mm], X[mm], Y[mm],
Z[mm], Dose[cGY/MU]

First line in the Data section. The first line in the data sec-
tion identifies the column header for the subsequent data
point lines. It must follow this format. The measurement
values must be separated with a comma.

R<n> Identifier of each measurement. <n> is the measurement
number.

X1[mm] Position of the X1 jaw, expressed in millimeters and in ac-
cordance with IEC 61217.

X2[mm] Position of the X2 jaw, expressed in millimeters and in ac-
cordance with IEC 61217.

Y1[mm] Position of the Y1 jaw, expressed in millimeters and in ac-
cordance with IEC 61217.

Y2[mm] Position of the Y2 jaw, expressed in millimeters and in ac-
cordance with IEC 61217.

X[mm] X-coordinate of the measurement point (detector position)
taken from the intersection of the CAX and the phantom
surface, expressed in millimeters and in accordance with
IEC 61217.

Y[mm] Y-coordinate of the measurement point (detector position)
taken from the intersection of the CAX and the phantom
surface, expressed in millimeters and in accordance with
IEC 61217.
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Text Meaning

Z[mm] Z-coordinate of the measurement point (detector position)
taken from the intersection of the CAX and the phantom
surface, increasing depth from the phantom surface to
floor, expressed in millimeters.

Dose[cGY/MU] Measured point dose at the detector, expressed in
cGy/MU.

The following shows an example of an Absolute Point Doses Beam Data file.

#
# Example of PointDoseTableIEC file
#
%VERSION 01
%DATE 12-02-10
%BMTY PHO
%TYPE PointDoseTableIEC
%SourcePhantomDistance 950
# Data
  ,X1[mm], X2[mm], Y1[mm], Y2[mm], X[mm], Y[mm], Z[mm], 
Dose[cGY/MU]
R1, −20, 20, −20,  20,  0,  0, 50, 0.881
R2, −20, 20,  40,  80,  0, 60, 50, 0.900
R3,  65, 105, −20, 20,  85, 0, 50, 0.912
R4,  20, 60,  20,  60, 40, 40, 50, 0.904
R5,  65, 105, 40,  80,  85, 60, 50, 0.923
R6, −52, 52, −52,  52,  0,  0, 50, 0.951
R7, −52,  52, −24, 80, 0,  28, 50, 0.966
R8,  1, 105, −52, 52, 53, 0, 50, 0.966
R9,  1, 105, −24, 80, 53, 28, 50, 0.971
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Appendix E    Beam Data Measurement Forms

Forms for Recording Beam Data Measurements
Table 56 Open Field PDDs1

 Field Size

Field Smallest 4 6 8 10 12 15 20 25 30 35 Largest

Open             

1. Measured in the surface–30 cm range

Table 57 Wedged Field PDDs1

 Field Size  

Field Smallest 4 6 8 10 12 15 20 Largest
square

Largest
rectan-
gular

Wedge 1           

Wedge 2           

Wedge 3           

Wedge 4           

1. Measured for all hard and motorized wedges in the surface–30 cm range

Table 58 Open Field Profiles at 5 Depths

 Field Size

Depth Smallest 4 6 8 10 12 15 20 25 30 35 Largest

1. dmax_10             

2.             

3.             

4.             

5.             
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Table 59 Wedged Field Profiles at 5 Depths

Wedge 1  

 Field Size  

Depth Smallest 4 6 8 10 12 15 20 Largest
square

Largest
rectan-
gular

1. dmax_10           

2.           

3.           

4.           

5.           

Wedge 2  

 Field Size  

Depth Smallest 4 6 8 10 12 15 20 Largest
square

Largest
rectan-
gular

1. dmax_10           

2.           

3.           

4.           

5.           

Wedge 3  

 Field Size  

Depth Smallest 4 6 8 10 12 15 20 Largest
square

Largest
rectan-
gular

1. dmax_10           

2.           

3.           

4.           

5.           
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Wedge 4  

 Field Size  

Depth Smallest 4 6 8 10 12 15 20 Largest
square

Largest
rectan-
gular

1. dmax_10           

2.           

3.           

4.           

5.           

Table 60 Open Diagonal Profiles1

 Field Size

Depth Largest

1. dmax_10  

2  

3  

4  

5  

1. Measured at 5 Depths

Table 61 Wedge Longitudinal Profile1

 Largest measured field size (AAA and Acuros XB)

Depth

Field dmax_10 5 10 20 30

Wedge 1      

Wedge 2      

Wedge 3      

Wedge 4      

Wedge 5      

1. Mandatory at 1 depth for all hard and motorized wedges
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Table 62 Block and MLC Transmission Factors1

 Results Rtray + block Rtray

Material    

1    

2    

3    

4    

5    

1. Measure Rtray and Rtray + block in water for each block material using a small field

Table 63 Shadow Tray Factors1

 Results Ropen Rtray

Tray Model    

1    

2    

3    

4    

5    

1. Measure Rtray and Ropen in water for each shadow tray model using a mid-range field size

Table 64 Open Field Output Factors

 Field Size, Width (FX)

Field Size,
Height (FY)

Smallest 4 6 8 10 12 15 20 25 30 35 Largest

Smallest             

4             

6             

8             

10             

12             
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 Field Size, Width (FX)

15             

20             

25             

30             

35             

Largest             

Table 65 Wedged Field Output Factors1

Wedge 1

 Field Size, Width (FX)

Field Size,
Height (FY)

Smallest 4 6 8 10 12 15 20 25 30 35 Largest

Smallest             

4             

6             

8             

10             

12             

15             

20             

Largest             

Wedge 2

 Field Size, Width (FX)

Field Size,
Height (FY)

Smallest 4 6 8 10 12 15 20 25 30 35 Largest

Smallest             

4             

6             

8             
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10             

12             

15             

20             

Largest             

Wedge 3

 Field Size, Width (FX)

Field Size,
Height (FY)

Smallest 4 6 8 10 12 15 20 25 30 35 Largest

Smallest             

4             

6             

8             

10             

12             

15             

20             

Largest             

Wedge 4

 Field Size, Width (FX)

Field Size,
Height (FY)

Smallest 4 6 8 10 12 15 20 25 30 35 Largest

Smallest             

4             

6             

8             

10             

12             

15             
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20             

Largest             

1. Measure for all hard and motorized wedges

Table 66 Treatment Unit Parameters and Limits

General Parameters

Source axis distance  

Source phantom distance  

Collimator skin distance  

No. of wedges and wedge codes Code 1 Code 2 Code 3 Code 4

Gantry Parameters

Angle of minimum rotation  

Direction of the increase Clockwise/Counterclockwise

Start angle in CW direction  

Stop angle in CW direction  

Collimator Parameters

Angle of minimum rotation  

Direction of the increase Clockwise/Counterclockwise

Start angle in CW direction  

Stop angle in CW direction  

 FX FY

Field edge, X direction   

Field edge, Y direction   

 X1/Y1 X2/Y2

Jaw labels, X direction   

Jaw labels, Y direction   

 Up Down Left Right

Wedge direction labels   

Allowed wedge directions Up/down/left/right
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Field Size X Direction Y Direction

Minimum open field size   

Maximum open field size   

Minimum field size wedge 1   

Maximum field size wedge 1   

Minimum field size wedge 2   

Maximum field size wedge 2   

Minimum field size wedge 3   

Maximum field size wedge 3   

Minimum field size wedge 4   

Maximum field size wedge 4   

Couch Parameters

Angle of minimum rotation  

Direction of the increase Clockwise/Counterclockwise

Start angle in CW direction  

Stop angle in CW direction  

(Couch height at isocenter)  

(Couch height at lowest)  

(Couch height at position)  

Multileaf Collimator Parameters

(MLC model) Internal/External

Leaf direction X/Y

Number of leaves  

Leaf width at SAD  

Minimum opening  

Maximum opening  

 X1/Y1 X2/Y2

Leaf labels   
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Maximum overtravel X1/Y1   

Maximum leaf span   

Maximum leaf tolerance   
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A
AAA

parameters for cobalt machine 62
AAA (Anisotropic Analytical Algorithm)

about 95
absolute dosimetry 72, 85
absolute point doses file format 317
Beam Configuration 86
beam modifiers 43
beamlets 97
calculation options 28
clinical beam modeling 35
compensator parameters 70
configuration 45
configuration program 74
measurement geometries 83
parameters 57
steps 78
steps for compensators 80
steps for hard wedges 79
steps for open field 78
with CadPlan beam data 88
with existing beam data 88
with measured ASCII beam data 87
with Varian Eclipse Beam Data 90

contaminating electrons 104
conversion of energy to dose 105
defining machine type parameter 60
dose 96
dose calculation 96, 99
dose calculation, convolution 99
electron contamination 37, 42
Elekta Beam Modulator 50, 54–56, 71
Elekta motorized wedge 66
Elekta OmniWedge 67, 68
Enhanced Dynamic Wedge parameters 66
evaluating
backscatter factor table 92
configured data 92
electron contamination curve 92
energy spectrum 93
gamma error histograms 93
radial energy 93
wedge transmission curve 93

extra-focal source 37
General Parameters 57

generated beam data 80, 81
geometries, configuration 83
geometry for absolute dosimetry 85
handling CT image data 16
heterogeneity history correction 102
implementation in Eclipse 22
importing measured beam data 87, 88
intensity profile 40
known limitations 44
machine parameter library 72
mean energy 39
measurement geometries 83
measurements 48

adaptation in configuration 75
compensators 54
configuration 75
geometries 83
open fields 48
wedges 51

modeling of primary source 38
modeling of second source 41
MU calculation 23
normalization 25
open beam parameters 63
optional measurements

wedge depth doses 53
wedge point doses 53
wedges 52

output factor measurement geometry 84
output factor parameters 71
parameters 59
patient scatter model 96
phase space model 38
photon dose calculation 100
photon energy spectrum 39
primary source 37
scaling of photon scatter kernels 102
scatter kernels 96
second source 37
second source energy fluence 41
second source parameters 42
Siemens Virtual Wedge parameters 69
small field support 46
superposition 105
target spot parameters 62
Varian Eclipse Beam Data 72, 90
wedge scatter 38
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AAA (Anisotropic Analytical
Algorithm):configuration 45

configuration
with Varian Eclipse Beam Data 90, 91

abbreviations 299
absolute dose, calibration parameters for CDC

139
absolute dose, calibration parameters for PRO

209
absolute dosimetry

AAA 85
AAA geometry 85
AAA parameters 72
Acuros XB 85
Acuros XB geometry 85
Acuros XB parameters 72
parameters generated in configuration 83

accuracy of algorithms 18
acronyms 299
actual fluence

calculation 241
Acuros XB (Acuros External Beam algorithm)

about 106
absolute dosimetry 72, 85
absolute point doses file format 317
angular discretization 119
background 109
Beam Configuration 86
beam modifiers 43
calculation options 28
calculation steps 107
clinical beam modeling 35
comparison with Monte Carlo 106
compensator parameters 70
configuration 45
configuration program 74
parameters 57
steps 78
steps for compensators 80
steps for hard wedges 79
steps for open field 78
with CadPlan beam data 88
with existing beam data 88
with measured ASCII beam data 87
with Varian Eclipse Beam Data 90, 91

configuring beam data 89
CT to material mapping 122
defining machine type parameter 60
discretization errors 129
dose calculation 106
electron contamination 37, 42

Elekta Beam Modulator 50, 54–56, 71
Elekta motorized wedge 66
Elekta OmniWedge 67, 68
energy discretization 118
Enhanced Dynamic Wedge parameters 66
evaluating
backscatter factor table 92
configured data 92
electron contamination curve 92
energy spectrum 93
radial energy 93
wedge transmission curve 93

factors affecting memory consumption
130

factors affecting runtime 130
fluence to dose conversion 120
General Parameters 57
generated beam data 80, 81
geometries
configuration 83

geometry for absolute dosimetry 85
handling CT image data 16
implementation in Eclipse 22
intensity profile 40
known limitations 44
machine parameter library 72
material compositions 124
material mass densities 124
material properties 122
mean energy 39
measurement geometries 83
measurements 48

adaptation in configuration 75
compensators 54
configuration 75
geometries 83
open fields 48
wedges 51

modeling of primary source 38
modeling of second source 41
MU calculation 23
normalization 25
open beam parameters 63
optional measurements

wedge depth doses 53
wedge point doses 53
wedges 52

output dose grid control 129
output factor measurement geometry 84
output factor parameters 71
overlapping density ranges 123
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parameters 59
phase space model 38
photon and electron sources 114
photon energy spectrum 39
primary source 37
second source 37
second source energy fluence 41
second source parameters 42
Siemens Virtual Wedge parameters 69
small field support 46
solution methods 110
spatial discretization 117
spatial transport cutoff 119
structures with density and material 123
supported materials 124
target spot parameters 62
Varian Eclipse Beam Data 72, 90
wedge scatter 38

additional stopping criteria in PGO 203
angular discretization in Acuros XB 119
Anisotropic Analytical Algorithm

see AAA
arc fields in fluence delivery 247
arc geometry tool

approximated minimum distance 294
treatment unit head to couch distance 295
treatment unit head to patient distance

294
aS500

calibrating for PDC 266
use of fixed SDD in calibration for PDC

260
automated bone segmentation 284
automated brain segmentation 284
automated eye segmentation 284
automated lung segmentation 283
automated spine segmentation 283
automatic normal tissue objective in PO and

PRO 182
avoidance sector in PO 189
avoidance sector in PRO 205

B
backscatter factor table

evaluating (AAA) 92
evaluating (Acuros XB) 92

Beam Configuration
AAA 86
Acuros XB 86

beam data
configuring for Acuros XB 89
generated for compensators 82
generated for Elekta Motorized Wedge 82
generated for open fields for AAA 80
generated for open fields for Acuros XB

80
generated for wedges for AAA 81
generated for wedges for Acuros XB 81
importing for AAA 87, 88
measurements for AAA 48
measurements for Acuros XB 48
measurements for CDC 140
measuring for dose optimization 207

Beam data measurement forms 320
beam modifiers

for AAA 43
for Acuros XB 43

beamlets in AAA 97
body search

in MR images 285
bolus in optimization 177

C
calculation

local geometry for eMC 152
calculation options

for eMC 161
calibration

detector for PDC 268
detector for PDC, SRS mode 269
use of fixed SDD in detector calibration for

PDC 260
calibration fluence

creating calibration test plan in Eclipse
272

creating test plan for PDC 270
measuring calibration test plan 273
PDC 270

CDC (Cone Dose Calculation Algorithm)
absolute dosimetry 139, 140
configuration 137

by importing new measured data 145
cone applicators 148
configuration program 142
curve fit algorithm for OAR 144
generated data items 145
generated OAR configuration data 144
generated TMR configuration data 143
interpolating and fitting TMR data 143
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measured data items 145
parameters 139
required measurements 140
steps 146

dose calculation model 132
limitations 135

dose matrix 134
evaluating

adapted data 147
configured data 147
gamma error histograms 147

General Parameters 139
measurement methods 140
measurements

absolute dosimetry 140
adaptation in configuration 142
Off-Axis Ratio (OAR) 142
output factors 141
tissue maximum ratio (TMR) 141

outline of dose calculation 132
pointwise gamma error definition 147

clinical beam modeling
in AAA 35
in Acuros XB 35

cobalt machine
AAA parameters for 62
compensator point dose data 54
dose calculation for 34
measurements for compensator field 54
measurements for open field 48

compensator
attenuation curve data file format 314
generated beam data 82
irregular surface compensation 295

compensator parameters
in AAA 70
in Acuros XB 70

Cone Dose Calculation Algorithm
see CDC

Cone Planning
cone applicator configuration steps 148
configuration of cone applicators 148
dose calculation 132
dose matrix 134
isocenter spacing 296
MU (Monitor Unit) calculation 135

configuration
AAA 45
AAA geometries 83
Acuros XB 45
Acuros XB geometries 83

Acuros XB using AAA beam data 89
adaptation of AAA measurements 75
adaptation of Acuros XB measurements

75
adaptation of CDC measurements 142
CDC 137
data used for eMC 166
default LMC technique 247, 248
DMLC in RT Administration 254
DMLC parameters 254
DVO 211
DVO based on AAA/Acuros XB 212
DVO based on PRO/DVO/PGO 212
DVO from measured beam data 213
eMC 171
eMC with existing beam data 174
for dose optimization 207
LMC 247
Multiple Static Segments mode 251, 252
Multiple Static Segments Mode for Smart

LMC 252, 253
output factor measurements for PDC 274
parameters for AAA 57
parameters for Acuros XB 57
PDC 278
PGO 215
photon beam source model 45
PO 209
PO from AAA/Acuros XB data 210
PO from measured beam data 211
PO from PRO data 210
PRO 213
PRO from AAA/Acuros XB data 214
PRO from measured beam data 215
PRO from PRO/DVO/PGO data 214
procedure in Beam Configuration for

eMC 173
program in AAA 74
program in Acuros XB 74
program in CDC 142
rounded leaf end transmission 231
Sliding Window mode 248, 250
Sliding Window Mode for Smart LMC 252,

253
steps for AAA 78
steps for Acuros XB 78
steps for CDC 146

configuration and measurement geometries
for AAA 83
for Acuros XB 83
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configuration parameters
for AAA 57
for Acuros XB 57

configuration parameters for CDC 139
configuration program

for AAA 74
for Acuros XB 74

configuration program for CDC 142
configuration steps for AAA 78
contaminating electrons in AAA 104
convergence in PGO 203
conversion of energy to dose in AAA 105
couch structures

see patient support devices
CT image data, handling in

AAA 16
Acuros XB 16
Eclipse algorithms 16
eMC 16
MRDC 16

CT to material mapping
in Acuros XB 122
overlapping ranges in Acuros XB 123
structures with density and material in

Acuros XB 123
CT volume

preprocessed for eMC 154
preprocessing for eMC 154

customer support 14

D
definition of field geometry 301
detector

calibrating for PDC 266
modifications in calibration for PDC 268
use of fixed SDD in calibration for PDC

260
discretization errors in Acuros XB 129
DMLC
configuration in RT Administration 254
configuration of rounded lead end

transmission 231
dose data of large fields 292
Fit-and-Shield algorithm 293
measuring leaf transmission factor 255,

256
DMLC parameters

dose dynamic leaf tolerance 254
dosimetric leaf gap 254
maximum number of control points 254

minimum dose dynamic leaf gap 254
dose

AAA 96
calculating with Acuros XB 106

dose calculation
AAA 96, 99
Acuros XB 106
CDC 132
convolution in AAA 99
for cobalt machines 34
in optimization 178

dose matrix
CDC 134

dose normalization in eMC 169
dose optimization

algorithm features 176
configuration

measured beam data 207
dose calculation 178
general about algorithms 176
MU objective 180
NTO 180
objectives 178
optimization objectives 178
target masking 178
volume representation 183

dose smoothing
eMC 160
Gaussian in eMC 160
Median in eMC 160

Dose Volume Optimizer
see DVO

dose-volume objectives
PRO 178

dosimetric leaf gap
configuration 254
measuring 257

DVH (Dose-Volume Histogram)
volume construction 289, 290

distance transform 290
dose calculation 290

volume interpolation
surface modeling 290
volume calculation 290

DVH estimation algorithm 219
data extraction phase 220
DVH estimation component 223
Estimation generation phase 223
GED metric 226
model configuration component 219
model training phase 221
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optimization objectives placing phase 224
outlier metrics 229

DVH estimation component
estimation generation phase 223
optimization objectives placing phase 224

DVH estimation model
algorithm 219

DVO (Dose Volume Optimizer)
configuration based on measured beam data

213
configuration in Beam Configuration 211
configuring based on AAA/Acuros XB 212
configuring based on PRO/DVO/PGO 212
dose-volume objectives 178
electron contamination 185
energy spectrum 185
fluence normalization 246
intensity profile 185
minimal fluence objective 184
MLC transmission factor 254
MRDC algorithm 184
optimization objectives 178
overview 193
second source modeling 185
smoothing objectives 179
target masking 178
volume representation 183

E
Eclipse configured beam data 16
edge electrons in eMC 165
effective depth

calculation 291
verification 291

electron beam source model
multiple source model in eMC 162

electron beam source model in eMC 162
electron contamination

AAA 37, 42
Acuros XB 37, 42

electron contamination curve
evaluating in AAA 92
evaluating in Acuros XB 92

electron Monte Carlo
see eMC

Elekta Beam Modulator
absolute point dose measurements

for AAA 50
for Acuros XB 50

open field measurements
for AAA 54
for Acuros XB 54

output factor measurements
for AAA 55
for Acuros XB 55

output factors
for AAA 71
for Acuros XB 71

required measurements 54
target spot parameters

for AAA 62
for Acuros XB 62

wedge field measurements
for AAA 56
for Acuros XB 56

Elekta Motorized Wedge
beam data generated for 82

Elekta motorized wedge parameters
in AAA 66
in Acuros XB 66

Elekta OmniWedge
configuration for AAA 68
configuration for Acuros XB 68
parameters

for AAA 67
for Acuros XB 67

Elekta Virtual Wedge
OmniWedge for AAA 67
OmniWedge for Acuros XB 67
parameters for AAA 67
parameters for Acuros XB 67

emailing Varian customer support 14
eMC

calculation options 161
configuration 171
dose normalization 169
edge electrons 165
generated beam data 173
handling CT image data 16
jaws source 163
known limitations 170
local geometry calculations in database

152
main source 162
measurements for open field 171
MMC database 152
MU calculation 169
multiple source model 162
overview 151
primary particles 156
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scraper sources 164
secondary electrons 158
secondary particles 158
statistical uncertainty 159
transmission photons 165

energy deposition
primary particles in eMC 156
secondary electrons in eMC 158
secondary particles in eMC 158

energy discretization in Acuros XB 118
energy spectrum

evaluating in AAA 93
evaluating in Acuros XB 93

energy, conversion to dose in AAA 105
Enhanced Dynamic Wedge parameters

for AAA 66
for Acuros XB 66

evaluating
backscatter factor table in AAA 92
backscatter factor table in Acuros XB 92

evaluating configured data
in AAA 92
in Acuros XB 92

evaluating configured data in CDC 147
excluded fields in PGO 194

F
field geometry
definition 301

Field Number objective in PGO 198
field reduction in PGO 197
final number of fields in PGO 197
Fit-and-Shield algorithm 293
flood fill algorithm 283
fluence

calibration fluence for PDC 270
dose data of large DMLC fields 292

fluence delivery modeling
system configuration for 247

fluence delivery modeling algorithms 230
dosimetric leaf gap 231
tongue-and-groove modeling 232
transmission 230

fluence to dose conversion in Acuros XB 120
forms for measuring beam data 320

G
gamma error histograms

evaluating in AAA 93

evaluating in CDC 147
General Parameters

AAA 57
Acuros XB 57
CDC 139

generated beam data
for Elekta Motorized Wedge 82
in AAA 80, 81
in Acuros XB 80, 81

generated OAR configuration data in CDC 144
generated TMR configuration data in CDC 143
gEUD objectives in PO 190
global optimization mode in PGO 194

H
hard wedge parameters 65
heterogeneity history correction in AAA 102

I
image acquisition, use of fixed SDD in PDC

260
importing beam data

for AAA 87, 88
importing measured beam data for AAA 87,

88
IMRT iteration

in objective function evaluations in PGO
202

number of iterations in PGO 197
information in this guide 12
initial field geometries in PGO 194
initial field removal effects in PGO 201
initialization phase

PGO 202
Powell algorithm in PGO 202
Simplex algorithm in PGO 202

input parameters for PGO 215
intensity profile

AAA 40
Acuros XB 40

intermediate dose in PO 191
intermediate dose in PRO 206
invalid field parameters in PGO 203
irregular surface compensator 295

volume construction 296
isocenter spacing

in Cone Planning 296
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J
jaw tracking

in PO (Photon Optimization Algorithm)
189

in PRO (Progressive Resolution
Optimizer) 206

in Smart LMC 244
jaws source for eMC 163

K
k-NN algorithm 283
known limitations

AAA 44
Acuros XB 44
eMC 170

L
lateral inhibition in PGO 199
Leaf Motion Calculator

see LMC
leaf transmission factor

measuring 255, 256
limitations in CDC model 135
LMC (Leaf Motion Calculator) 234
configuration 247
configuration of default technique 247,

248
configuration of MSS 251, 252
configuration of Sliding Window 248, 250
MSS (Multiple Static Segments) technique

242
Sliding Window 234

local geometry
calculation in eMC 152

local optimization
iterations in Powell for PGO 203
mode in PGO 201

M
machine parameter library

in AAA 72
in Acuros XB 72

machine type
for eMC 166
parameters for eMC 166

machine type supported for eMC 166
main source for eMC 162

mARC
dose calculation 34

material compositions in Acuros XB 124
material properties in Acuros XB 122
mean dose objective in PO 191
mean dose objective in PRO 205
mean energy

in AAA 39
in Acuros XB 39

measurement
AAA 48
AAA configuration 75
AAA geometries 83
Acuros XB 48
Acuros XB configuration 75
Acuros XB geometries 83
adaptation in configuration for AAA 75
adaptation in configuration for CDC 142
adaptation in configuration in AAA 75
adaptation in configuration in Acuros XB

75
beam data for dose optimization 207
compensator point dose data for AAA 54
compensator point dose data for Acuros

XB 54
dosimetric leaf gap 257
eMC 171
geometry for AAA 83
geometry for Acuros XB 83
leaf transmission factor 255
open fields for AAA 48
open fields for Acuros XB 48
output factor for PDC 274
overview for CDC 140
photon beam source model 48
wedges for AAA 51
wedges for Acuros XB 51

minimum distance estimation in arc geometry
tool 294

minimum field separation angle for PGO 201
modeling of primary source

for AAA 38
for Acuros XB 38

modeling of second source
AAA 41
Acuros XB 41

MR body search algorithm 285
MRDC algorithm

handling CT image data 16
PRO 184
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MSS technique (Multiple Static Segments) 242
Elekta MLC 244
Siemens MLC 244
Smart LMC 243
Varian MLC 242

algorithm 242
MU calculation 243

MU (Monitor Unit) calculation
AAA 23
Acuros XB 23
CDC 135
eMC 169

MU factor, calculation for LMC (Sliding
Window method) 241

MU factor, calculation for Smart LMC (Sliding
Window method) 241

MU objective, in dose optimization 180
Multi-Resolution Dose Calculation algorithm

see MRDC algorithm
multiple source model

in eMC 162
Multiple Static Segments technique

see MSS technique (Multiple Static
Segments)

MUtotal in Smart LMC 246
my.varian.com 14

N
Normal Tissue Objective

see NTO
normalization

AAA 25
Acuros XB 25
eMC 169

Normalization 25
NTO (Normal Tissue Objective)
definition of PTV 180
parameters 182
shape 180

O
OAR

see off-axis ratio
objective function

evaluations in Powell in PGO 201
evaluations in Simplex in PGO 201

objective function calculation
number of in PGO 203

off-axis ratio
file requirements in CDC configuration

145
measuring for CDC 142

online customer support 14
open beam parameters

for AAA 63
for Acuros XB 63

open field
generated AAA beam data 80
generated Acuros XB beam data 80
output factor, examples for PDC 275

optimization algorithms 176
features 176

optimization phase
PGO 202
Powell algorithm 202
Simplex algorithm 202

ordering product documents by phone 14
outlier metrics in DVH estimation 229
output dose grid control in Acuros XB 129
output factor

examples for open fields for PDC 275
measurement geometry for AAA 84
measurement geometry for Acuros XB 84
measuring for CDC 141
parameters for AAA 71
parameters for Acuros XB 71

output factor table for AAA and Acuros XB
316

P
parameters

AAA 59
AAA absolute dosimetry 72
AAA configuration 57
absolute dosimetry for AAA 72
absolute dosimetry for Acuros XB 72
Acuros XB 59
Acuros XB absolute dosimetry 72
Acuros XB configuration 57

patient scatter model in AAA 96
patient support devices

algorithms accounting for 22, 177
PDC (Portal Dose Calculation)

accuracy 264
calculation of configured beam data 263
calibrating detector 266

absolute mode 267
IMRT scanning mode 267
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calibration 258, 264
calibration fluence 270
clinical routine 264
comparing predicted and measured doses

281
configuration 258, 264
configuration workflow 265
configuring calculation model 278

kernel data 278
input for calculation 261
intensity profile 262
measuring output factors 277
MU factor 262
output factor measurements 274

creating test patient 275
overview of process 258
PDC algorithm 258, 260
phantom scatter factor 262
verifying configuration 281

PGO (Plan Geometry Optimization)
additional stopping criteria 203
configuration 215
convergence 203
excluded fields 194
Field Number objective 198
field reduction 197
final number of fields 197
global optimization mode 194
initial field geometries 194
initial field removal effects 201
initialization phase 202
initialization phase in the Powell

algorithm 202
initialization phase in the Simplex algorithm

202
input parameters 215
invalid field parameters 203
lateral inhibition 199
local optimization iterations in Powell 203
local optimization mode 201
minimal fluence objective 184
minimum field separation angle 201
Normal Tissue Objective parameters 182
Normal Tissue Objective shape 180
number of IMRT iterations 197
number of IMRT iterations in objective

function evaluations 202
number of objective function calculations

203
objective function evaluations in Powell

201

objective function evaluations in Simplex
201

optimization phase 202
optimization phase in the Powell

algorithm 202
optimization phase in the Simplex algorithm

202
overview 194
proximity effect 200
removing forbidden fields 195

phantom scatter factor
PDC 262

phase space model
in AAA 38
in Acuros XB 38

photon and electron sources in Acuros XB 114
photon beam source model 35

AAA 35
Acuros XB 35
configuration 45
configuring in Beam Configuration 86

photon beam source model:configuration 45
steps 78

photon dose calculation in AAA 100
photon energy spectrum

in AAA 39
in Acuros XB 39

Photon Optimization algorithm
see PO (Photon Optimization Algorithm)

Plan Geometry Optimization algorithm
see PGO

plan verification
PDC (Portal Dose Calculation) 258

PO (Photon Optimization Algorithm)
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